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Overview 

NEMIS 

The National Emergency Management Information System (NEMIS) is a 
database system used to track disaster data for FEMA and Recipient emergency 
management offices.  
NEMIS supports emergency management at a disaster site and enables FEMA 
to integrate preparedness and planning operations with FEMA programs and 
disaster assistance. NEMIS enables data to be coordinated throughout a 
disaster, from monitoring an incident to providing assistance to communities and 
individuals affected by a disaster. 
NEMIS is comprised of modules or application areas for various functions within 
FEMA. The system provides the following functional modules: 

• Incident Activity Manager (IAM); 

• Preliminary Damage Assessment (PDA); 

• Declaration; 

• Public Information; 

• Emergency Support (ES); 

• Infrastructure; 

• Mitigation (MT); and  

• Human Services (HS). 
Each functional module is accessed from the NEMIS menu and functions 
somewhat independently of the others. 

NEMIS HMGP 

NEMIS Hazard Mitigation Grant Program (HMGP) is the Mitigation module of 
NEMIS. You may also hear it referred to as the HMGP System. This system 
module provides a way to administer HMGP information and grant applications. It 
interacts with some of the other NEMIS modules such as Declaration, 
Preliminary Damage Assessment and Emergency Support. 
The users of the NEMIS HMGP system are the Mitigation staffs of: 

• State and tribal offices; and 

• FEMA headquarters, regional and disaster field offices. 
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Super Circular Terminology 

The Office of Management and Budget streamlined the Federal Government’s 
Administrative Requirements, Cost Principles, and Audit Requirements for 
Federal Awards into a consolidated set of regulations. These regulations are 
located in Title 2 of the Code of Federal Regulations, Part 200, and are referred 
to as the Super Circular. 
The Super Circular introduced new terminology relevant to HMGP, including 
"Recipient" instead of "Grantee" and "Subrecipient" instead of "Subgrantee." 
These terminology changes are incorporated in the NEMIS HMGP System 
screens.  

NEMIS HMGP User Manual 

This User Manual provides instructions on how to use the NEMIS HMGP System 
to administer program information and grant applications for HMGP. 
The manual covers the use of the Mitigation functional module throughout the 
HMGP lifecycle, beginning with pre-declaration activities and ending with post-
disaster closeout activities. 
As seen in Table 1-1 below, each unit in this manual corresponds to a NEMIS 
HMGP system process. Each NEMIS HMGP system process reflects a workflow 
process in the HMGP lifecycle.  

Table 1-1: User Manual Unit/ NEMIS HMGP Process 

UNIT NEMIS HMGP PROCESS 

1 NEMIS HMGP Overview and Startup 

2 Use the Reference Library 

3 Manage Disaster Information 

4 Manage the Mitigation Plans 

5 Manage the HMGP Funding Estimate  

6 Manage the HMGP Application 

7 Manage Eligibility Determination 

8 Manage Amendments 

9 Manage Appeals 

10 Manage Allocations and Obligations 

11 Manage Project and Program Oversight Tasks 

12 Manage Project Closeout  

13 Manage Program Oversight and Closeout 

14 Generate Standard HMGP Reports 

Appendix A Attach Documents 
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UNIT NEMIS HMGP PROCESS 

Appendix B Enter a Name from the Personnel Databases 

Appendix C NEMIS HMGP Positions and Roles 

Appendix D Quick Reference Guide 

Except for Unit 1 and the appendices, the units in this manual contain standard 
sections as described below in Table 1-2. 

Table 1-2: Description of Unit Sections 

SECTION NAME DESCRIPTION 
Overview Describes the NEMIS HMGP system process 

Lists the tasks to complete the process 

Information Requirements 
(where applicable) 

Lists the documents and information needed to complete the 
tasks 

Information Available for 
Review 
(where applicable) 

Identifies information that read-only users need to view 

Tasks Describes the steps to complete each task 

References 
(where applicable) 

Provides supplemental information or sample documents 
relevant to the task or process 

Table 1-3 describes the notations used throughout this manual. 
Table 1-3: Notations 

NOTATION NAME/DESCRIPTION 
NOTE Notes provide specific learning points or supporting 

information. 
CAUTION 

 
Caution messages provide specific warnings that users should 
be aware of.  

HINT 
 

Hint messages provide techniques or recommended steps that 
will help users complete system tasks.  

UPDATE ID Button Notation 
Reference to system buttons that the user needs to click are 
displayed in all uppercase letters. 

Disaster Information 
Tab 

System Tab Notation 
Reference to system tabs are displayed in bold font. 

Data Fields Notation Information that needs to be entered into the system or can be 
viewed by users is listed in tables. 
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NEMIS HMGP System Features 

The following functionalities are available in the system to assist users in 
completing their tasks: 

• Attach Documents  
Documents can be linked to a project application to allow all NEMIS HMGP 
users to view supporting documentation. You are strongly urged to read and 
follow the instructions in Appendix A: Attach Documents. 

CAUTION: Attachments cannot be deleted once they have been added to NEMIS 
HMGP. Please make every effort to limit the file attachment size to 
less than 1GB. Allow up to one hour to retrieve and view newly 
attached documents. 

• Add Comments 
Since Mitigation information entry can be performed by several people, 
NEMIS HMGP allows each user to add comments to the project application, 
the mitigation plan and other items. 

• Text-editing Capability 
For all fields marked with a hand pointer, the user can enter text directly onto 
the field or can double-click inside the field to access a text-editing window 
(Figure 1-1). 

 
Figure 1-1: NEMIS HMGP Text-Editing Window 

In the text-editing window, the user can enter text, run spell check and print 
out the text. Previously-entered comments are displayed as read-only in the 
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upper portion of the window. In addition, character limits and availability are 
displayed.  
 
Clicking the OK button returns focus to the calling window and text is copied 
from the Editor dialog box to the calling screen. The system appends the user 
name, the date, and the time of text entry to the end of the text.  

• Track Project Applications 
The NEMIS HMGP Mitigation module can track project applications through 
workflow processes and work packets. For each task in a workflow process, 
NEMIS HMGP generates a work packet. Users access the work packet to 
accomplish the steps in the process.  
The two workflow processes in the Mitigation module are: 

o Manage Eligibility Determination (Unit 7) 
o Manage Allocations and Obligations (Unit 10) 

 
• System-Required Information and Data Fields 

When a data field is required by the system, the field is displayed with green 
shading. When information is required by the system the text is displayed in 
purple font color. Those data fields identified as Property Attributes are shown 
in Navy. Red text indicates a data field that is both required and a Property 
Attribute (Figure 1-2). 

 
Figure 1-2: Required Fields Example 
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NEMIS HMGP System User Roles 

FEMA Enterprise Identity Management System 

The FEMA Enterprise Identity Management System (FEIMS) replaced the 
Network Access Control System (NACS) and the Integrated Security and Access 
Controls (ISAAC). If you had a NACS account, your account was migrated to 
FEIMS automatically.  

From inside the FEMA firewall, you will need to visit the FEIMS portal at 
https://sso.fema.net/feims in order to perform account-related tasks such as 
changing passwords (Figure 1-3), completing Security Awareness Training and 
other functions.  

Figure 1-3: FEIMS Portal 

NOTE:  If you have any questions about your FEIMS account, account access 
or password, please contact the FEMA Enterprise Service Desk Help 
Desk by email at FEMA-Enterprise-Service-Desk@fema.dhs.gov or 
by phone at 1-888-457-3362. 

Access Control through Group and User IDs 

Because the HMGP lifecycle is administered on multiple levels, various user 
groups complete different system processes within NEMIS HMGP. Information 
entered into the system by one user group can be viewed by others, allowing 
each group to participate jointly in one comprehensive system. 

NEMIS HMGP includes system control mechanisms that protect the system and 
information. These mechanisms control the users' level of access to menus and 

https://sso.fema.net/feims/
mailto:FEMA-Enterprise-Service-Desk@fema.dhs.gov
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screens. Security privileges (e.g., read and/or write) are assigned to objects (e.g., 
data fields, screens, or menus). These privileges are then assigned to groups. 
Roles within NEMIS HMGP are determined by a user’s team position. User IDs 
are then established and linked to groups and specific disasters. Based on their 
role(s) in the system processes, users become members of the group(s) that has 
the privileges needed to complete system tasks. 
NEMIS HMGP Positions and Roles are listed in Appendix C. 

Group and Role Assignment Process 

Every FEMA and Recipient Mitigation staff member who needs to work in NEMIS 
must have a user ID and password. To obtain a NEMIS user ID and password, 
please contact your regional mitigation program specialist.  
Remote users can access NEMIS HMGP with non-Government Furnished 
Equipment. For instructions on how to obtain VPN access, please contact your 
regional point of contact. 
After a user account is established, a mitigation program specialist familiar with 
NEMIS HMGP will review the request and define the proper role and team 
assignment before submitting the request to IT for a particular disaster. 
NEMIS HMGP Specialists should review past designations of mitigation staff to 
assess individual role/position titles for the current disaster. 

NOTE: Even if a user was working in NEMIS HMGP on a past disaster, it does not 
mean that the user will be assigned to a role in a current disaster. Users 
are assigned to a role for each disaster upon request. 



September 2016 Unit 1: NEMIS HMGP Overview and Startup 

NEMIS HMGP User Manual MR 3.19.01 Page 1-9 
 

Task 1: Starting NEMIS 

1. Double-click the NEMIS icon on your desktop (Figure 1-4). 

 
Figure 1-4: NEMIS Desktop Icon 

NOTE: If you do not see the icon on your desktop, look for NEMIS in your 
installed programs by completing the following steps: 

1. Click the Windows START button   

2. Select Programs > FEMA Apps > NEMIS > NEMIS (Figure 1-5) 

 
Figure 1-5: NEMIS via Installed Programs 

NOTE: If NEMIS is not in your installed programs contact your local IT office. 
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2. The NEMIS Login dialog box is displayed (Figure 1-6). 

 
Figure 1-6: NEMIS Login Dialog Box 

3. Enter the information listed in Table 1-4. 

Table 1-4: Login Dialog Box Data Fields 

DATA FIELD  INFORMATION TO BE ENTERED 

User ID User identification name assigned to you  

Password Your NEMIS password 

4. Click the OK button. The NEMIS menu bar is displayed. Click the 
MITIGATION icon (Figure 1-7). 

 

Figure 1-7: NEMIS Menu Bar 
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5. The Select Group dialog box is displayed (Figure 1-8). 

 
Figure 1-8: Select Group Dialog Box 

6. Click the drop-down arrow to display the Group ID selection list (Figure 1-
9). The available selection depends on the roles assigned to you. Select 
the Group ID that corresponds to the NEMIS HMGP process you will be 
doing. 

 
Figure 1-9: Mitigation Group ID Selection List 
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7. Click the OK button. The Select Disaster dialog box is displayed (Figure 1-
10). 

 
Figure 1-10: Select Disaster Dialog Box 

8. In the Select Disaster dialog box, enter the disaster number or select a 
disaster number from the drop-down list. The system auto-fills the other 
disaster information fields (Figure 1-11). 

 
Figure 1-11: Disaster Information 

9. Click the OK button. The Mitigation menu bar is displayed (Figure 1-12). 

 
Figure 1-12: Mitigation Menu Bar 
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NOTE: When logging in to enter information that is not disaster-specific, select 
any disaster number from the drop-down list. 

 

HINT: Each time you start a NEMIS - Mitigation Module session, you will need to 
repeat Steps 1-9. You will remain logged in with the Group ID you 
selected and to the Disaster Number that you entered until you click the 
EXIT button on the NEMIS menu bar or you elect to change your Group ID 
or Disaster Number via the Mitigation Menu Bar. 

10. Select the process you want to perform by clicking on your selection 
(Figure 1-13). Hovering over the top items will show you the choices 
available within each item. 

 
Figure 1-13: Mitigation Menu Bar > Projects Menu 

NOTE: Use Table 1-1 to determine which process to select from the menu. Refer 
to the corresponding Unit or Appendix for instructions to complete that 
process. 
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Overview 

NEMIS historically provided a means of storing documents and data in the 
Reference Library. While the ability to store documents in the Reference Library 
has been removed, users can still access these historic documents and data. 
Over the years FEMA Headquarters and Regional Mitigation offices have added 
policy memos, reports, and other references to the library some of which may still 
be pertinent.  
This unit describes the two ways you can access the Reference Library: 

• On the NEMIS Intranet 

• Within NEMIS HMGP  

NOTE: A user ID and password with access to NEMIS HMGP does not allow the 
user to make modifications within the Reference Library. The user 
however, is able to view documents already contained within the 
Reference Library. 

 

HINT: Information on the Hazard Mitigation Grant Program (HMGP) and the 
other Hazard Mitigation Assistance (HMA) programs is available on the 
Federal Insurance and Mitigation Administration (FIMA) page of the 
FEMA website, available at http://www.fema.gov/hazard-mitigation-
assistance. On the FIMA page, click the Programs link. From the list of 
programs, click the program you need additional information on. 

http://www.fema.gov/hazard-mitigation-assistance
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Task 1: Access the Reference Library on the NEMIS Intranet 

1. From within the FEMA Intranet, enter https://nemis.fema.net/nemis/ 
in your browser address bar. The NEMIS Resource Center Main Page is 
displayed (Figure 2-1).  

 
Figure 2-1: NEMIS Home Page 

2. On the left navigation bar, click the MITIGATION (MT) link. The NEMIS 
Mitigation page is displayed (Figure 2-2). 

 
Figure 2-2: NEMIS Mitigation Page 

https://nemis.fema.net/nemis/
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HINT: To obtain the latest NEMIS HMGP reference materials go to the FEMA 
home page , available at http://www.fema.gov/, and click “Search” and 
type “NEMIS HMGP User Manual” in the search bar. Available at 
http://www.fema.gov/. 

3. On the right side, click the region whose documents you wish to view. The 
page for that region is displayed with a map and a list of links to the 
Recipients in that region (Figure 2-3). 

 
Figure 2-3: Region VIII Mitigation Page 

4. Click on a Recipient link. The list of reference documents for that Recipient is 
displayed (Figure 2-4). 

http://www.fema.gov/
http://www.fema.gov/
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Figure 2-4: State Recipient Montana Reference Documents 

5. Click on the document link that you wish to view. The document is displayed 
(Figure 2-5). 

 
Figure 2-5: Sample Document in Reference Library 
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Task 2: Access the Reference Library from NEMIS HMGP  

1. On the NEMIS menu bar, click the NEMIS WIDE button (Figure 2-6). 

 
Figure 2-6: NEMIS Menu Bar 

2. The NEMIS Wide pop-up menu is displayed (Figure 2-7). Click Reference 
Library.  

 
Figure 2-7: NEMIS-Wide Pop-Up Menu 

3. The NEMIS Resource Center Main Page is displayed. Refer to Task 1: 
Access the Reference Library on the NEMIS Intranet.  
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Overview 

A disaster must be declared prior to HMGP processing in NEMIS HMGP. 
Mitigation staff must complete the system tasks that provide disaster-specific 
information. 
Table 3-1 provides an overview of the Manage Disaster Information process in 
NEMIS HMGP. 

Table 3-1: Manage Disaster Information System Process 

 DESCRIPTION 

Purpose Enter disaster-specific information for HMGP 

When does it start? After a disaster declaration 

NOTE: There are Preliminary Damage Assessment (PDA) tasks 
completed in the NEMIS-PDA module BEFORE the disaster 
declaration. 

Who does it? • FEMA Regional Mitigation Staff 

o Hazard Mitigation Officer (HMO role) 

o Mitigation Analyst (MA role) 

• FEMA Regional Operation Support Staff (Financial Officer) 

How is it done? Execute 8 tasks: 

Task 1:  Ensure Declaration Information Is Complete 

Task 2:  Enter Special Mitigation Language for the 

FEMA/State Agreement (FSA) 

Task 3:  Enter Disaster Information 

Task 4:  Manage Recipient Information 

Task 4A: Designate a Recipient 

Task 4B: Edit Designated Recipient Information 

Task 4C: Edit Percentage on a Designated Recipient 

Task 4D:  Edit Admin Link and Mit Plan Link for a Designated 

Recipient 

Task 5:  Enter Federal Public Notice 

Task 6:  Attach Documents 

Task 7:  Enter User to Recipient Link Information 

Task 8:  Enter SF-424 Information 
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Information Requirements 

FEMA Regional Mitigation staff may need the following documents to enter 
disaster information: 

• A copy of the Public Notice; 

• A copy of the Recipient’s Declaration Request; 

• FSA for each Recipient; 

• Submitted SF-424s; and  

• A list of NEMIS HMGP user names and user IDs of the Recipient and Regional 
staff who will be entering project applications (Unit 6: Manage the HMGP 
Project Application). 

Information Available for Review 

Before Mitigation information specific to the disaster can be entered into NEMIS 
HMGP, the FEMA Emergency Coordinator (EC) and Emergency Support (ES) staff 
must enter disaster declaration information in the system. Therefore, State and 
Tribal Recipient staffs are provided with read-only access to disaster information 
entered by FEMA Regional Mitigation staff. Table 3-2 lists where specific disaster 
information can be found in the system. If the General Tab is not completed fully 
and accurately all other tabs will not be available for review. 

Table 3-2: Disaster Information Location in NEMIS 

DISASTER INFORMATION  LOCATION IN NEMIS 
Mitigation Program designation  
for the disaster 

Declaration Module > Declaration > 
Designated Programs >  Designated column 

FEMA/State Agreement (FSA) 
Mitigation Language 

Declaration Module > Declaration > FSA tab > 
Special Mitigation Language box 

View  the following dates: 
• HMGP Applications Final Due 

Date 
• HMGP Total Obligation Date 
• HMGP Closeout Date 
• Disaster Closeout Date 

Mitigation Module > Disaster > Overview >  
Disaster Information tab 

Recipients designated for the 
disaster 

Mitigation Module > Disaster > Overview >  
Recipient Information tab 

SF-424s submitted  Mitigation Module > Disaster > Overview >  
SF424 Information tab 

Public Notice details Mitigation Module > Disaster > Overview >  
Federal Public Notice tab >  
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DISASTER INFORMATION  LOCATION IN NEMIS 
Declaration Request, FSA, and 
other supporting documents 

Mitigation Module > Disaster > Overview >  
Attachments tab 

Users linked to Recipients Mitigation Module > Disaster > Overview >  User 
to Recipient Link tab 
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Preliminary Damage Assessment (PDA) Module Tasks 

A number of system tasks are executed in the PDA Module prior to a disaster 
declaration. Although these system tasks are not directly part of the HMGP 
process in NEMIS HMGP, having the following information entered in the system 
prior to the disaster event will expedite HMGP processing. 

1. On the NEMIS menu bar, click the Mitigation button. The Select Group ID 
dialog box is displayed. 

2. Select "MT Analyst" from the drop-down list. Click the OK button.  

3. The Select Disaster window is displayed. In the Disaster box, enter the Disaster 
No. 

4. Click the OK button. 

5. Select the NEMIS button to return to the main NEMIS menu. 

6. On the NEMIS menu bar, click PDA (Figure 3-1). The PDA information for the 
disaster you selected in Step 4 is displayed. 

 
Figure 3-1: NEMIS > Preliminary Damage Assessment (PDA) Module 

7. The General tab of the PDA Module is displayed by default (Figure 3-2). 

 
Figure 3-2: PDA > General Tab 

8. Under the General tab, there are four sub-tabs. Among them, the Program 
sub-tab is displayed by default (Figure 3-3). Take note if: 

• The HM Program checkbox is checked; and 

• The HM Program Coordinator has been assigned. 



Unit 3: Manage Disaster Information September 2016 
 

Page 3-6  NEMIS HMGP User Manual MR 3.19.01 
 

 
Figure 3-3: PDA > General > Program Tab 

9. On the top part of the screen, click the Planning tab. The Teams information 
for the disaster is displayed (Figure 3-4). 

 
Figure 3-4: PDA > Planning > Teams Tab 

10. On the top part of the screen, click the Individual Assistance (IA) tab.  
Steps 10a - 10c describe the sub-tabs under Individual Assistance. 

a. Under Individual Assistance, there are six sub-tabs. 
b. Among the six sub-tabs, the State Summary sub-tab is displayed by 

default. Under State Summary there are seven sub-tabs. 
c. Among the seven sub-tabs, Cost Summary is displayed by default. The tab 

displays Individual Assistance Cost Summary information for the State 
(Figure 3-5). 
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Figure 3-5: PDA > Individual Assistance > State Summary > Cost Summary Tab 

11. On the top part of the screen, click the Public Assistance (PA) tab. 
Steps 11a - 11d describe the sub-tabs under Public Assistance. 

a. Under Public Assistance, there are seven sub-tabs. 
b. Among the seven sub-tabs, the State Summary sub-tab is displayed by 

default. Under State Summary, there are three sub-tabs. 
c. Among the three sub-tabs, Part I - Applicant Information is displayed by 

default. The tab displays Public Assistance Applicant information for the 
State (Figure 3-6). 

 
Figure 3-6: PDA > Public Assistance > State Summary > Applicant 

Information Tab 



Unit 3: Manage Disaster Information September 2016 
 

Page 3-8  NEMIS HMGP User Manual MR 3.19.01 
 

d.  Next to Part I - Applicant Information, click the Part II - Cost Estimate 
Summary tab. The tab displays Public Assistance Cost Estimate Summary 
information for the State (Figure 3-7). 

 
Figure 3-7: PDA > Public Assistance > State Summary > 

Cost Estimate Summary Tab 

12. On the top part of the screen, click the Hazard Mitigation tab. Steps 12a – 12g 
describe the sub-tabs under Hazard Mitigation. 
a.  Under Hazard Mitigation, there are six sub-tabs. 

b. Among the six sub-tabs, the Program sub-tab is displayed by default. The 
tab displays the PA and IA Cost Summaries (Figure 3-8). 

 
Figure 3-8: PDA > Hazard Mitigation > Program Tab 
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i. In the Adjustment data field located in the lower left corner of the screen, 
enter the dollar amount for adjustments. 

ii. Click the NOTE button. Enter your Adjustment notes in the Cost 
Adjustment Note window (Figure 3-9). Click the OK button to save your 
text. 

 
Figure 3-9: Cost Adjustment Note 

c.  The second sub-tab under Hazard Mitigation is Admin. 

d. The third sub-tab under Hazard Mitigation is Building Code. 

e. The fourth sub-tab under Hazard Mitigation is Environmental. Enter 
environmental and historic preservation information specific to states and 
localities (Figure 3-10). 
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Figure 3-10: PDA > Hazard Mitigation > Environmental > State Tab 

f.  The fifth sub-tab under Hazard Mitigation is Flood (Figure 3-11). 

 
Figure 3-11: PDA > Hazard Mitigation > Flood > NFIP Tab 

g.  The sixth sub-tab under Hazard Mitigation is Issues. Enter the issues 
associated with the event and with the PDA. 

13. To exit from the PDA module, click File-Exit on the PDA menu bar. 



September 2016 Unit 3: Manage Disaster Information 

NEMIS HMGP User Manual MR 3.19.01 Page 3-11 
 

Task 1: Ensure Declaration Information is Complete 

Before Mitigation information specific to the disaster can be entered into NEMIS 
HMGP, FEMA Emergency Coordinator (EC) and Emergency Support (ES) staff 
must enter disaster declaration information in the system. These include ECs 
designating Hazard Mitigation as a program for the disaster and ESs processing 
the initial allocation. 

To ensure that the above tasks have been done in the system, complete the 
following steps: 

1. On the NEMIS menu bar, click Declaration (Figure 3-12). 

 
Figure 3-12: Declaration Module 

HINT: If the Declaration Manager does not appear, check FEIMS for your 
current roles. You must be assigned as a Declaration user to access the 
Declaration module. 

2. On the Declaration menu bar, click File > Open. The Open Declaration Request 
dialog box is displayed (Figure 3-13). 

 
Figure 3-13: Open Declaration Request Dialog Box 

3. Enter the Disaster Number in the Declaration box. 
4. Click the OK button. The Declaration tab is displayed by default. The 

Declaration section at the top half of the tab displays declaration information 
(Figure 3-14). 
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Figure 3-14: Declaration Tab 

5. In the bottom half of the Declaration tab, there are eleven sub-tabs. The 
Designated Programs sub-tab is displayed by default. 

 
a. On the bottom left of the screen, see if the HM selection box is checked. If 

yes, then Hazard Mitigation has been designated as a program for this 
disaster. 

b. If the HM selection box is not checked, contact the Emergency Coordinator 
staff to designate the program for the disaster. 

c. Note also the Designated Date, Cost Share, Filing Deadline and Expiration 
Date of the Hazard Mitigation program in the columns to the right.  

NOTE: FEMA Headquarters processes the initial allocation after the disaster 
has been declared. See Unit 10: Manage Allocations and Obligations, for 
more information on this process. 



September 2016 Unit 3: Manage Disaster Information 

NEMIS HMGP User Manual MR 3.19.01 Page 3-13 
 

Task 2: Enter Special Mitigation Language for the FEMA/State 
Agreement (FSA) 

The Mitigation staff may be asked to contribute to the Declaration module by 
entering Special Mitigation Language found in the FSA.  

1. In the bottom half of the Declaration tab, there are eleven sub-tabs. Click the 
FSA tab. The Special Mitigation Language box is displayed (Figure 3-15). 

 
Figure 3-15: FSA Special Mitigation Language 

2. To add text, right-click inside the box and select Editor (Figure 3-16). The Editor 
screen is displayed. 

 
Figure 3-16: Editor Menu 

3. Enter your comments. 

4. Click the SPELL CHECK button if you wish to use that feature (Figure 3-17). 
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Figure 3-17: Editor/Spell-Check Screen 

5. Click the OK button when you are finished. 
6. The text you entered is now displayed in the Special Mitigation Language box.  
7. To exit from the Declaration module, click File - Exit on the Declaration menu 

bar. 
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Task 3: Enter Disaster Information 

1.  On the NEMIS menu bar, click Mitigation. If prompted, select your Group ID 
and click the OK button. 

2. If the Select Disaster dialog box is displayed, select disaster from the pull-down 
menu. Click OK. 

3. The Mitigation menu is displayed. From the top menu, select Disaster, then 
Overview (Figure 3-18). 

 
Figure 3-18: Mitigation > Disaster > Overview 

4. The Disaster Information tab is displayed by default (Figure 3-19). 

 
Figure 3-19: Mitigation > Disaster > Overview > Disaster Information Tab 

5. Enter the information listed in Table 3-3. 

CAUTION: Do not enter the HMGP - Total Obligation Date or the Closeout Dates 
until the described events actually occur. 

 

NOTE: All validation messages must be addressed. 
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Table 3-3: Disaster Information Tab Data Fields 

DATA FIELD INFORMATION TO BE ENTERED 

Final Due Date for 
New Application 

Closing date for HMGP project applications for the disaster. If 
the disaster has two Recipients with different dates, type the 
latest date on this tab. If an extension is given, this date must 
be updated.  

HMGP – Total 
Obligation Date 

Actual date when all funds have been obligated for all 
Recipients. 

HMGP – Closeout 
Date 
(Reconciliation) 

Actual date when FEMA HQ declares that the HMGP program 
for a particular disaster is financially reconciled (usually also 
includes Hazard Mitigation Technical Assistance Plan). 

Disaster Closeout 
Date (FSA closed by 
HQ) 

Date when FEMA HQ closes the FSA for the entire disaster. 

Disaster Period of 
Performance End 
Date 

Date when the period of performance (POP) ends for the 
disaster. Captures the original POP end date. 

Disaster Closeout 
Date (from 
Declaration Module) 

Auto-filled by the system after the information is entered into 
the Declaration module. 

POP Extension Date Adds capability to capture POP extension end dates granted to 
the original POP. 
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Task 4: Manage Recipient Information 

1. Next to the Disaster Information tab, click the Recipient Information tab 
(Figure 3-20). 

 
Figure 3-20: Mitigation > Disaster > Overview > Recipient Information Tab 

From this tab, you can do the following: 

Task 4A: Designate a Recipient 

Task 4B: Edit Designated Recipient Information 

Task 4C: Edit Percentage on a Designated Recipient 

Task 4D: Edit Admin Link and Mit Plan Link for a Designated Recipient 

CAUTION: At least one Recipient must be designated before you can continue 
with the other disaster tasks. 
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Task 4A: Designate a Recipient 

1. On the Recipient Information tab, click the NEW button. The Look up 
Recipient window is displayed (Figure 3-21). 

 
Figure 3-21: Look Up Recipient Window 

2. Click the SEARCH button. Designated Recipient records are displayed (Figure 
3-22). 

 
Figure 3-22: Recipient Search Results 

3. If the desired Recipient is already listed, click the OK button.  
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4. If the desired Recipient is not listed, complete Steps 4a - 4h. 

a. Click the ADD button to designate a new Recipient.  

b. Click the UPDATE ID button. A table for selecting the county or place 
identification code is displayed (Figure 3-23). 

 
Figure 3-23: County/Place Code List 

c. Highlight the county and place from the table of counties and places, listed 
according to the Federal Information Processing Standards (FIPS) code 
system. 

d. Click the OK button. The Look up Recipient window is displayed with the 
selected County and Place Code. 

NOTE: The State, County, and Place Codes that are displayed on the Look up 
Recipient and Recipient Information windows comprise the FIPS code. 

e. Enter the information listed in Table 3-4 on the Look up Recipient window. 

Table 3-4: Look Up Recipient Window Data Fields 

DATA FIELD INFORMATION TO BE ENTERED 

Name Name of the Recipient if different from the name listed in 
the county/place table 

Tax ID Tax Identification Number of the Recipient (up to 10 alpha-
numeric characters) 

Private Nonprofit Is the Recipient a nonprofit organization?  Select Yes or No 

CID # (Community 
Identification 
Designation) 

If the Recipient is associated with a community, select the 
CID description of the Recipient from the drop-down list 
(the NFIP generates this list) 

Applicant Description Description of the Recipient 
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f. Click the ADD CONTACT button to enter data on a contact for the 
Recipient. The Look up a Contact window is displayed (Figure 3-24).  

 
Figure 3-24: Look up a Contact Window 

g. Follow the instructions in Appendix B for entering Contact information. The 
Contact information is displayed on the Look up Recipient window. 

h. Click the OK button. The Recipient information is displayed on the 
Recipient Information tab (Figure 3-25). 
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Figure 3-25: Recipient Information Tab Information 

5. On the Recipient Information tab, enter the information listed in Table 3-5. 

Table 3-5: Recipient Information Tab Data Fields 

DATA FIELD INFORMATION TO BE ENTERED 

Private Nonprofit Is the Recipient a nonprofit organization? Select one of the 
following: 
• Yes 
• No 

Letter of Intent Rec 
Date 

Date the Letter of Intent was received from the Recipient   

SmartLink Participant Is the Recipient a participant in the system to electronically 
transfer funds? Select one of the following: 
• Yes 
• No 

SmartLink Drawdown 
Date 

The Regions are required to enter, on a quarterly basis, the 
drawdown date (policy guidance) 

Final Due Date for New 
Application 

Closing date for HMGP project applications for this 
Recipient 
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DATA FIELD INFORMATION TO BE ENTERED 

SmartLink Drawdown 
Amount 

The Regions are required to enter, on a quarterly basis, the 
drawdown amount (policy guidance) 

HMGP – Total 
Obligation Date 

Date when all funds have been obligated for this Recipient 
CAUTION: Do not enter HMGP -Total Obligation Date 

until all funds are obligated. 

HMGP – Closeout Date 
(Reconciliation) 

Financial Reconciliation Date  
CAUTION: Do not enter HMGP - Closeout Date until 

financial data for the disaster has been 
reconciled. 

6.  On the bottom right part of the Recipient Information tab, click the SAVE 
button. 
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Task 4B: Edit Designated Recipient Information 

1. Scroll through the Recipients displayed on the Recipient Information tab.  

2. With the desired Recipient displayed, click the MORE RECIPIENT 
INFORMATION button. The Look up Recipient window is displayed. 

CAUTION: Except for Native American Tribes, do not edit the following fields 
directly on the Look Up Recipient screen: Name, Tax ID, Private 
nonprofit, CID Number, and Applicant Description. 

3. To change the information on the Recipient contact, click the EDIT CONTACT 
button. The Look up a Contact window is displayed.  

4. Follow the instructions in Appendix B for entering contact information. The 
Contact information is displayed on the Look up Recipient window. 

5. Click the OK button. The Recipient Information tab is displayed. 

6. If necessary, edit the Letter of Intent Rec Date and SmartLink data fields. 
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Task 4C: Edit Percentage on a Designated Recipient 

1. The Recipient Information tab displays a default percentage in the Recipient 
Percent data field (Figure 3-26).  

 
Figure 3-26: Recipient Information Tab with Default Percentage 

2. When the user is alerted by the warning message that a Recipient has an 
Enhanced Mitigation Plan, the Recipient percentage can be changed by 
completing Steps 2a - 2d. 

a. Click the EDIT PERCENT button. The Comment Editor window is displayed. 

b. In the Recipient Percent box, enter the new percentage. 

c. In the text area, enter the justification for the change in percentage. 
d. Click the OK button (Figure 3-27).  
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Figure 3-27: Edit Percentage 

3. The new percentage is displayed on the Recipient Information tab (Figure 3-
28). 

 
Figure 3-28: Recipient Information Tab with New Percentage 

NOTE: The Recipient Percent value will also be displayed in Mitigation > 
Funding > Estimate > Recipient Worksheet. 
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Task 4D: Edit Admin and Mit Plan Link for a Designated Recipient 

NOTE: Both the Admin and Mitigation Plans must be entered, approved and 
linked to the appropriate disaster for each Recipient. 

1. To add or change the approved HMGP Administrative Plan that is referenced 
by the Recipient for the disaster, complete Steps 1a - 1f. 

a. On the Recipient Information tab, click the EDIT ADM LINK button. 

b. The MT Admin Plan window is displayed (Figure 3-29). 

 
Figure 3-29: MT Admin Plan Window 

c. Click inside the checkbox of the approved MT Admin plan that you wish to 
link to the disaster. 

d. If changing plans, click the APPEND button. 

e. In the text area, enter comments explaining the change. 

f. Click the OK button. The selected Recipient HMGP Administrative Plan 
information is now displayed on the Recipient Information tab. 

2. To add or change the approved HMGP Mitigation Plan that is referenced by the 
Recipient for the disaster, complete Steps 2a - 2f. 

a. On the Recipient Information tab, click the EDIT MIT LINK button. 

b. The MT Mitigation Plan window is displayed (Figure 3-30). 
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Figure 3-30: MT Mitigation Plan Window 

c. Click inside the checkbox of the approved Mitigation plan that you wish to 
link to the disaster. 

d. If changing plans, click the APPEND button. 

e. In the text area, enter comments explaining the change. 

f. Click the OK button. The selected Recipient Mitigation Plan information is 
now displayed on the Recipient Information tab. 
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Task 5: Enter Federal Public Notice 

1. Click the Federal Public Notice tab (Figure 3-31). 

 
Figure 3-31: Mitigation > Disaster > Overview > Federal Public Notice Tab 

2. Enter the information listed in Table 3-6. 

Table 3-6: Federal Public Notice Data Fields 

DATA FIELD INFORMATION TO BE ENTERED 
Appearance Date Date the Public Notice appeared in the publication 

Document of Record Name of the publication that published the Public Notice, 
e.g., the Federal Register 

Point of Contact Name of the point of contact at the publication 

Telephone Number Telephone number of the point of contact 

3. On the bottom right part of the Federal Public Notice tab, click the SAVE 
button. 

4. To enter information for another published notice, click the NEW button. 

5. Repeat Steps 2-3 for each new published notice. 
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Task 6: Attach Documents 

Use the Attachments tab to attach the following documents: 

• Recipient’s Letter of Intent 

• FEMA/State Agreement 

• Federal Public Notices 

• Other supporting documents 

NOTE: Attach SF-424s using the ATTACH button on the SF-424 tab (Task 8: 
Enter SF-424 Information).  

 

CAUTION: Attachments cannot be deleted once they have been added to NEMIS 
HMGP. Please make every effort to limit the file attachment size to less 
than 1GB. Allow up to one hour to retrieve and view newly attached 
documents. 

1. Click the Attachments tab (Figure 3-32). 

 
Figure 3-32: Mitigation > Disaster > Overview > Attachments Tab 

2. You are strongly urged to read and follow the instructions in Appendix A: Attach 
Documents. 
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Task 7: Enter User to Recipient Link Information 

System users who enter project application information in NEMIS HMGP (Unit 6: 
Manage Project Application) must be linked to the Recipient for whom he or she 
will be processing applications. Some suggested users who are linked to 
Recipients are the State Hazard Mitigation Officers (SHMO) and State Specialists. 

NOTE: Users who are linked to Recipients should be assigned to one of the two 
Mitigation positions for the disaster in FEIMS: State Hazard Mitigation 
Officer - Edit privileges; and State Hazard Mitigation Specialist  - Read-
Only  

 

CAUTION: HMGP project applications cannot be entered in the system until 
each person working on the application is linked to the Recipient (Unit 6: 
Manage Project Application). 

1. Click the User to Recipient Link tab. Check to see if your user name is 
already linked to the Recipient (Figure 3-33). 

 
Figure 3-33: Mitigation > Disaster > Overview > User to Recipient Link Tab 
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2. If your name or the name of the person you wish to add is not linked to the 
Recipient, click the NEW button to create a new row in the table.  

3. Enter the information listed in Table 3-7. 

Table 3-7: User to Recipient Tab Screen Data Fields 

DATA FIELD INFORMATION TO BE ENTERED 

User Name NEMIS HMGP User Name – Select from the drop-down list of 
user IDs and names 

Recipient 
Name 

Recipient for the disaster – Select from the drop-down list of all 
Recipients 

4. For each new User to Recipient link, repeat Steps 2 and 3. 

HINT: When adding more than one User to Recipient Link, you might need to 
alternate which data field you enter first. For the first new row, select 
the User Name and then the Recipient Name. For the next new row, select 
the Recipient Name first, and then select the User Name. 

 



Unit 3: Manage Disaster Information September 2016 
 

Page 3-32  NEMIS HMGP User Manual MR 3.19.01 
 

Task 8: Enter SF-424 Information 

NOTE: NEMIS HMGP assumes that one SF-424 is submitted for each Recipient 
with a total funding estimate. As that estimate changes, subsequent SF-
424s that are submitted are considered revisions that supersede the 
previous version. 

Enter SF-424 information only after the tasks in Unit 5: Manage the HMGP 
Funding Estimate have been completed by FEMA Mitigation staff. The funding 
estimate information is then displayed in the SF-424 data fields.  

1. Click the SF424 Information tab (Figures 3-34 and 3-35). 

 
Figure 3-34: SF424 Information Tab - Left Side 
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Figure 3-35: SF424 Information Tab – Right Side 

2. Table 3-8 describes the information displayed in the SF-424 Information tab. 

Table 3-8: SF-424 Information Tab Data Fields 

DATA FIELD DESCRIPTION 
Recipient Name Recipient who submitted the SF-424 

SF 424 Number Sequential number assigned by the system – The first 
Recipient is assigned the number "1," the second Recipient 
the number "2" and so on 

Rev Number Sequential revision number assigned by the system – The 
initial submission is assigned the number “0.” The Rev 
Number changes with each revised form submitted 

Fed Est Funding Amt Estimated amount of Federal HMGP funding for this disaster 
for this Recipient. 

Applicant Est 
Funding Amt 

Estimated amount of funding from the Recipient 

State Est Funding 
Amt 

Estimated amount of State funding – If the State is the 
Recipient, this amount is over and above the applicant 
estimated funding amount 

Local Est Funding 
Amt 

Estimated amount of local funding 
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DATA FIELD DESCRIPTION 
Other Est Funding 
Amt 

Estimated amount of other funding 

Prgm Inc Es Funding 
Amt 

Estimated funding amount from income generated by the 
HMGP 

Total Est Funding 
Amt 

System-generated calculation totaling the amounts entered 

3. To add the SF-424 form submitted by a Recipient, complete Steps 3a - 3d. 

a. Click the NEW button. A new SF-424 row is displayed (Figure 3-36). 

 
Figure 3-36: SF-424 Information - New Row Added 

b. Select the Recipient Name from the drop-down list. 

c. Enter only the Fed Est Funding Amt. The other amounts will not be known 
until all projects are obligated and closed. 

NOTE: Consult the program/grants management guidance for an explanation 
on how the SF-424 amount needs to compare to the total projected in 
Column A of HMGP Financial Activity tab in the Funding Estimate queue. 

d. Attach the submitted SF-424 form by clicking the ATTACH button. You are 
strongly urged to read and follow the instructions in Appendix A: Attach 
Documents. 
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CAUTION: Attachments cannot be deleted once they have been added to NEMIS 
HMGP. Please make every effort to limit the file attachment size to less 
than 1GB. Allow up to one hour to retrieve and view newly attached 
documents. 

4. To add a revision to a previously-entered SF-424, complete Steps 4a - 4c. 

a. Highlight the row in the table of the most recently entered form for this 
Recipient and click the REVISE button. A new row will be created in the 
table with the same SF-424 number and an incremented Rev number. 

b. Enter the necessary information. 

c. Attach the revised SF-424 form by clicking the ATTACH button and 
following the instructions in Appendix A. 

5. To edit information for a previously-entered SF-424, click inside the data field 
that you wish to edit. 
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Overview 

NEMIS HMGP allows FEMA and Recipient users to manage the following 
mitigation plans: 

• Recipient's HMGP Administrative Plan (formerly known as the State 
HMGP Administrative Plan); 

• Recipient's Multihazard Mitigation Plans (formerly known as the State 
Mitigation Plan); and 

• Subrecipient’s Single (local) and multi-jurisdictional Mitigation Plans. 

NOTE: For all disasters declared on or after November 1, 2004, Recipients and 
Subrecipients are required to have an approved Multihazard Mitigation 
Plan. 

Table 4-1 provides an overview of the Manage Mitigation Plans process in 
NEMIS HMGP. 

Table 4-1: Manage the Mitigation Plans 

TOPIC MANAGE THE MITIGATION PLANS 

Purpose Manage HMGP Administrative Plans and Mitigation Plans 

When does it start? “On-Going” to be consistent with 44 CFR 206.437(d) 

Who does it? State Users and MT Analysts enter plan information in NEMIS 
HMGP 

FEMA Regional Mitigation staff with the Hazard Mitigation 
Officer (HMO) role approve and process plans 

How is it done? Execute three tasks: 

Task 1: Enter Recipient Administrative Plan Data 

Task 2: Enter Recipient Mitigation Plan Data 

Task 3: Enter Subrecipient Mitigation Plan Data 

 



September 2016 Unit 4: Manage the Mitigation Plans  

NEMIS HMGP User Manual MR 3.19.01 Page 4-3 
 

Information Requirements 

The HMO, MA and State User and State Approving Official can now enter 
Administrative Plan and Mitigation Plan information in NEMIS HMGP, under 
Disaster Overview, Recipient Information tab.  

The Subrecipient Mitigation Plan is entered on the Application Development, 
Applicant Information tab. This new process captures the plan information in the 
project application, making it redundant to place the information in the Plans 
Repository.  However, the Plans Repository remains available for use should the 
user elect to place the plan in the Plans Repository and then select the 
appropriate plan. 

NOTE: All non-federal plan data is now managed by the Risk Analysis Division 
and Planning Branch using their Mitigation Planning Portal (MPP). 

To enter plan information in NEMIS HMGP, you will need the following 
information depending on the plan: 

• Plan Approval Date 
• Plan Due Date  
• Plan Title 
• Plan Type 
• Plan Approval Type 
• Plan Expiration Date 
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Task 1: Enter Recipient Administrative Plan Data 

1. On the NEMIS menu bar, select Mitigation > Disaster > Overview  

2. Select the Recipient Information tab.  

3. Enter the plan information under the Recipient HMGP Administrative Plan 
section (Figure 4-1). Plan information includes: 

a. Plan Approval Date (must be prior to or equal to the current date) 
b. Plan Due Date (must be within the 90 days of the Declaration Date) 
c. Plan Title 

 
Figure 4-1: Mitigation > Disaster > Overview > Recipient HMGP Administrative 

Plan Section 

NOTE: This process applies to Recipient HMGP Administrative Plans in disasters 
declared after November 14, 2014. For disasters declared before that 
date, please follow the instructions in the NEMIS HMGP User Manual 
version 3.17.00.   
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4. If Close is selected and the Administrative Plan Approval Date and/or the 
Administrative Plan Due Date are not entered correctly, the following 
validation messages will appear: 

a. HMGP – Administrative Plan Approval Date must be less than or equal to 
the current date (Figure 4-2) 

b. HMGP – Administrative Plan Due Date must be within the 90 days of the 
Declaration Date (Figure 4-3) 

5. Address the validation messages by entering the correct date(s). 

 
Figure 4-2: Administrative Plan Approval Date Validation Message 

 
Figure 4-2: Administrative Plan Due Date Validation Message 
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Task 2: Enter Recipient Mitigation Plan Data 

1. On the NEMIS menu bar, select Mitigation > Disaster > Overview. 

2. Select the Recipient Information tab.  

3. Select the Enable Manual Entry of Plan Data check box under the Recipient 
Mitigation Plan Section (Figure 4-4). 

 
Figure 4-4: Mitigation > Disaster > Overview >   

Recipient Mitigation Plan Section 
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4. Enter the plan information under the Recipient Mitigation Plan section. Plan 
information includes: 

a. Plan Type – From the pull-down menu, select Standard State, Standard 
Tribal, Enhanced State, or Enhanced Tribal (Figure 4-5) 

b. Plan Title 
c. Plan Approval Type 
d. Plan Approval Date (must be less than or equal to the current date) 
e. Plan Expiration Date (must be a current or future date) 

 
Figure 4-5: Mitigation > Disaster > Overview > Recipient 

Mitigation Plan Section > Plan Type Pull-down Menu Detail 

5. If Close is selected and the Mitigation Plan Approval Date and/or the 
Mitigation Plan Due Date are not entered correctly, the following validation 
messages will appear: 

a. HMGP – Mitigation Plan Approval Date must be less than or equal to the 
current date 

b. HMGP – Mitigation Plan Expiration Date must be a current or future date 

6. Address the validation messages by entering the correct date(s). 

NOTE:  The Plans Repository is still available to NEMIS HMGP System Users. For those 
who prefer to enter the plan information in the Plans Repository, follow the 
instructions outlined in Unit 4 of the NEMIS HMGP User Manual Version MR 
3.17.00 or earlier. The user may switch back and forth between entering the 
data manually as described or from the plans repository by selecting and 
unselecting the Enable Manual Entry of Plan Data check box.  When switching, 
the data from the previous entry will be deleted. The plans data will be saved 
when the application is submitted for Federal Eligibility.  Only data selected 
from the plans repository will be displayed in the NEMIS-wide plan reports. All 
previous validation messages related to missing or incomplete plans data will 
still apply when saving, verifying or submitting the application to Federal 
Eligibility.  
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Task 3: Enter Subrecipient Mitigation Plan Data 

1. On the NEMIS menu bar, select Mitigation > Projects > Application 
Development > Applicant Information Tab. 

2. Under the Subrecipient Mitigation Plan section (Figure 4-6), select the Enable 
Manual Entry of Plan Data check box. 

3. Enter the plan information under the Subrecipient Mitigation Plan section. 
Plan information includes: 

a. Plan Type – From the pull-down menu, select Multi-Jurisdiction or Single 
Jurisdiction  

b. Plan Approval Date (must be less than or equal to the current date) 
c. Plan Expiration Date (must be a current or future date) 
d. Plan Title 

 
Figure 4-6: Mitigation > Projects > Application Development >  

Applicant Information Tab > Subrecipient Mitigation Plan Section 

4. The same two validation messages are applicable to the Subrecipient 
Mitigation Plan as are applicable to the Recipient Mitigation Plan described in 
Task 2 above. 
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Overview 

The NEMIS HMGP Manage HMGP Funding Estimate (FES) process allows 
FEMA Regional staff members to: 

• Establish Funding Estimates for HMGP Recipients designated for the 
disaster. 

• Update/Revise Funding Estimates as financial information changes 
during the disaster response and recovery phase. 

Table 5-1 provides an overview of the Manage HMGP Funding Estimate 
process. 

Table 5-1: Manage HMGP Funding Estimate Process 

 DESCRIPTION 

Purpose Manage HMGP Funding Estimate 

When does it start? Within 30 days of a disaster declaration 

NOTE: The complete process could last until Disaster Closeout. 

Who does it? FEMA Regional Mitigation staff with the Hazard Mitigation Officer 
(HMO) role 

How is it done? Execute eight tasks: 

Task 1: Ensure Disaster and Recipient Information is Entered 

Task 2: Enter Financial Details 

Task 3: Establish Funding Estimate 

Task 4: Enter Financial Information 

Task 5: Enter Lock-in Information 

Task 6: Enter Comments/Attachments 

Task 7: Review Financial Activity Information 

Task 8: Review Budget Planning Information 
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Information Requirements 

FEMA Regional Mitigation Staff with the Hazard Mitigation Officer (HMO) role will 
need the Disaster Projection Report (DPR) as a source of financial information 
that needs to be entered into the system. The DPR is attached to the CFO Lock-
in memorandum.  
 

NOTE: When using the initial DPR, verify figures with Individual Assistance (IA) 
and Public Assistance (PA). PA figures can be checked by printing the S5 
from the EMMIE/NEMIS − Infrastructure module. For Disaster Numbers 
1778 and newer, contact the Regional Public Assistance Point of Contact. 
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Task 1: Ensure Disaster and Recipient Information is Entered 

Before HMGP Funding Information can be entered into NEMIS HMGP, the 
disaster information must have been entered in the system. Specifically, the 
Recipient(s) for the disaster must have been designated in the system. To 
ensure that this has been done, complete the following steps: 

1. On the MITIGATION menu bar, click Disaster > Overview (Figure 5-1). If 
needed, select your Group ID and enter the Disaster Number. 

 
Figure 5-1: Mitigation >Disaster >Overview 

2. The Disaster Information tab is displayed by default (Figure 5-2). 

 
Figure 5-2: Mitigation > Disaster > Overview > Disaster Information Tab 

3. Click the Recipient Information tab. If Recipient(s) have been designated for 
the disaster, their information is displayed. 

NOTE: If Recipient(s) have not been designated for the disaster, complete the 
steps in Unit 3, Task 4: Manage Recipient Information, before proceeding 
to Task 2 in this Unit. 

4. On the bottom right of the Recipient Information tab, click the CLOSE 
button. 
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Task 2: Enter Financial Details 

1. On the MITIGATION menu bar, click Funding > Estimate (Figure 5-3). 

 
Figure 5-3: Mitigation > Funding > Estimate 

2. The HMGP Financial Activity tab is displayed. At the top left part of the tab, 
select either the Recipient, if only one, or "ALL," if more than one, from the 
Recipient drop-down list (Figure 5-4). 

 
Figure 5-4: Funding Estimate - Select Recipient 

3. Click the Financial Details tab (Figure 5-5). 

 
Figure 5-5: Mitigation > Funding > Estimate > Financial Details Tab 
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4. Under the Human Services section, in the "Cora Brown" data field, enter the 
Cora Brown funding amounts in the “Estimated Fed Share” field. 

5. Under the Mission Assignments section, in the "Other" data field, enter the 
Non-Administrative Mission Assignment funding amounts in the “Estimated 
Fed Share” field. 

6. Under the Other Applicable Funding section, in the “Other Est Amt" data field, 
enter the latest financial information from Infrastructure Support and Human 
Services in the “Estimated Fed Share” field. 

NOTE: After Dec. 13, 2004, the system will no longer auto-fill the amounts in the 
Infrastructure Support and Human Services sections. To get the latest 
financial information, do one of the following:  

Check the Disaster Financial Status Report (DFSR) and PA-S5 

or 

Ask the appropriate regional personnel. 

 

CAUTION: Total dollars entered into these fields must be less than one trillion 
dollars. Overall, the disaster total damages must be less than one 
trillion dollars. 

7. On the bottom right part of the Financial Details tab, click the RECIPIENT 
WORKSHEET button. The Funding Estimate Worksheet is displayed. The left 
side of the screen displays read-only fields (Figure 5-6). 

The Recipient Worksheet has been redesigned so that, if there is more than 
one Recipient, it allows the division of the funds among the Recipients. The 
amount is based on the percentage for each Recipient (depending on the 
type of mitigation plan that is in effect, i.e., Standard Plan or Enhanced Plan). 

 
Figure 5-6: Funding Estimate Worksheet - Left Side 
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8. Review the read-only information listed in Table 5-2. 

Table 5-2: Funding Estimate Worksheet Read-Only Data Fields 

DATA FIELD READ ONLY INFORMATION 

Recipient Name Applicant receiving HMGP funds 

Place Code Place Code, part of the Federal Information Processing Standards 
(FIPS) code 

Cnty Cd County Code, part of the FIPS code 

St Cd State Code 

Total Damages Auto-fills from Total Damages amount in the Financial Details tab 

Recipient 
Estimate 

Current established estimate that can be spent on HMGP by the 
Recipient — auto-fills by multiplying the Total Damages value with 
the Percent value 

IS Est Amount Amount automatically carried over from the Financial Details tab  

9. The right side of the worksheet (Figure 5-7) displays the fields where you can 
enter financial data.  

 
Figure 5-7: Funding Estimate Worksheet – Right Side 

HINT: If the State is the only Recipient, the dollar amounts you enter in the MA 
Est Amount and Other Est Amount fields are the same as those in the 
Financial Details screen. 

10. For each Recipient, enter the information listed in Table 5-3. 
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Table 5-3: Funding Estimate Worksheet Data To Be Entered 

DATA FIELD INFORMATION TO BE ENTERED 

HS Est Amount Estimated funding for Human Services 

MA Est Amount Estimated funding for Non-Administrative Mission 
Assignments for the Recipient (if separate figures are 
available) 

Other Est Amount Amount of all funding assigned to this Recipient that has not 
been entered elsewhere 

St Mgmt Amount State Management Costs authorized  for the Recipient 

Comments Comments or notes. Double-click in the text area to access 
the Comment Editor. 

CAUTION: After entering the information, make sure that the dollar amounts in 
the Worksheet Totals fields match the dollar amounts in the Balances 
from HMGP Financial Details fields. 

11. If the dollar amounts in the Worksheet Totals fields do not match those in the 
Balances from HMGP Financial Details fields, the dollar amounts not 
accounted for are displayed in red (Figure 5-8). 

 
Figure 5-8: Funding Estimate Worksheet 
Error Message -"Amounts Not Accounted For" 

12. Correct the dollar amounts by repeating Steps 2 − 11 until you get matching 
numbers. 

13. Click the OK button to close the worksheet and to return to the HMGP 
Financial Details screen.  
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Task 3: Establish Funding Estimate 

1. Click the Financial Details tab (Figure 5-9). Ensure that the dollar amounts 
displayed are current. 

 
Figure 5-9: Mitigation > Funding > Estimate > Financial Details Tab 

2. Click the COMMIT RECALCS button. The system displays a message 
confirming “Commit estimated obligated funds?” (Figure 5-10). 

 
Figure 5-10: Commit Funds Confirmation Message 

3. Click the OK button. This establishes the Funding Estimate and authorizes 
FEMA to allocate and obligate funds.  
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4. The warning message that it may take some time for this amount to be added 
to the database is displayed (Figure 5-11). 

 
Figure 5-11: Database Warning 

NOTE: When the COMMIT RECALCS button is clicked, a new Current Estimate 
Amount is established and added to the HMGP Financial Info screen. 
Until the new Current Estimate Amount appears on the Financial 
Information Tab, funds cannot be distributed according to the various 
Funding Categories (executed in Task 4: Enter Financial Information). 
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Task 4: Enter Financial Information 

1. Click the Financial Info tab. At the top left of the tab, select either the 
Recipient, if only one, or "ALL," if more than one, from the Recipient drop-
down list (Figure 5-12). 

 
Figure 5-12: Mitigation > Funding > Estimate > Financial Info Tab 

2. On the bottom left part of the tab, the read-only Current Estimate Amount is 
displayed. If more than one row is displayed, each row represents a revision 
of the amount.  
As displayed in Figure 5-12, the top row is the latest revision and is the 
current amount. 

NOTE: This is the Current Estimate Amount that was auto-filled when Task 3: 
Establish Funding Estimate was completed.  
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3. In the top half of the screen, Recipient Lock-In Amounts information is 
displayed (Figure 5-13). 

 
Figure 5-13: Financial Info Details for Recipients 

Table 5-4 describes the Recipient Lock-in Amounts data fields.  

Table 5-4: Recipient Lock-In Amounts Data Fields 

DATA FIELD INFORMATION TO BE VIEWED/ENTERED 

HMGP Lock-In Amount Current Estimate Amount for the Recipient 

Initiative Pct * Percentage of funds set aside for State initiative 
projects. (10 percent if declared for Tornado). System 
default percentage is 5 percent. The percentage can be 
changed on this screen but the maximum value is 10 
percent. 

Initiative Lock-in Amount * State initiative amount, calculated by multiplying the 
HMGP Lock-In Amount by the Initiative Pct. The amount 
may be changed on this screen but the maximum value 
is 10 percent of the HMGP Lock-In Amount. 

Planning Pct  Percentage of funds set aside for planning projects. 
System default percentage is 7 percent. Edit the 
percentage if necessary but the maximum value is 7 
percent.  

Planning Lock-in Amount  Planning amount, calculated by multiplying the HMGP 
Lock-In Amount by the Planning Pct. Edit the dollar 
amount if necessary, but the maximum value is 7 
percent of the HMGP Lock-In Amount. 

State Management Costs 
(SMC) Lock-In Amt 

State Management Amount that was entered in Task 2: 
Enter Financial Details and established in Task 3: 
Establish Funding Estimate. 
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DATA FIELD INFORMATION TO BE VIEWED/ENTERED 

Regular Project Lock-In 
Amount 

For disasters declared before 11/13/2007: 

Remaining funding amount after Initiative, Planning and 
State Management Amounts have been subtracted from 
the HMGP Lock-In amount — auto-filled by the system. 

 

For disasters declared on or after 11/13/2007: 

Remaining funding amount after Initiative and Planning 
have been subtracted from the HMGP Lock-In amount 
— auto-filled by the system. 

4. To add a new row of Financial Info, complete the following steps. 

a. Click the NEW button. A blank row is displayed (Figure 5-14) with the 
default Initiative and Planning Percentages showing. The system auto-fills 
the Date and Time of the new record entry. 

 
Figure 5-14: Financial Info Details - New Row 

b. At the top left of the Financial Info tab, select a Recipient from the drop-
down list. It will either auto-fill or enter the dollar amounts or percentages 
for that Recipient. 

CAUTION: DO NOT DELETE RECIPIENT LOCK-IN AMOUNT ESTIMATES UNLESS 
ABSOLUTELY NECESSARY.  

For audit purposes, all changes or updates must be viewable and not deleted, 
except for typo errors.  

Upon completion of the Financial Info Line for each Recipient, verify funding 
calculations for each Funding Category and Recipient. 
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Task 5: Enter Lock-in Information 

1. Click the Disaster Lock-In Review tab. The Review and Ceiling Lock-in 
Dates and Amounts table is displayed (Figures 5-15 and 5-16). 

 
Figure 5-15: Mitigation > Funding > Estimate > Disaster 
Lock-In Review Tab > Left Side 

 
Figure 5-16: Mitigation > Funding > Estimate > Disaster 
Lock-In Review Tab > Right Side 

2. At the top left part of the tab, select a Recipient from the drop-down list. 

3.  The tab displays a row of information for each of the seven potential lock-in 
stages: 

• Initial Estimate for Program Startup (usually performed 30 days after 
the disaster declaration) 
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• 3-Month Estimate* 

• 6-Month Lock-in 

• 9-month Lock-in* 

• 12-Month Lock-in (usually the final lock-in) 

• 18-Mo Final Lock-in (if exception granted) 

• Other (if exception granted) 

*Note – For the 3-month and 9-month estimates: While the system still 
shows a 3- and 9-month estimate, these are not required by 44CFR Part 
207.5 (b) and usually are no longer provided at these intervals.  

4. Enter the information listed in Table 5-5 for the appropriate lock-in stage. 

Table 5-5: Disaster Lock-in Review Data Fields 

DATA FIELD INFORMATION TO BE ENTERED 

Lock-in Date Date current HMGP Lock-in Amount was established. If Lock-in 
Amount greater than 0 is entered, a valid date must be entered 
to proceed. 

Lock-in Amount HMGP Lock-in Amount currently established for the Recipient 

SMC Lock-In Amount State Management Costs currently established for the 
Recipient 

SMC Lock-In Date Date current SMC Lock-in Amount was established. If SMC 
Lock-in Amount greater than 0 is entered, a valid date must be 
entered to proceed. 

Community Notified Was the Funding Estimate Lock-in Letter sent to the Recipient? 
Select one of the following: 

• Yes 

• No 

If you select "No" and then click the LAUNCH LETTER button, 
the system changes the selection to "Yes.” 

NOTE: A letter must be sent to each Recipient. The form 
letter may be used or another letter that is 
generated manually. 
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DATA FIELD INFORMATION TO BE ENTERED 

Comments Comments regarding the Lock-in Date or Lock-in Amount that 
provide clarification or required additional information. The 
Inspector General may be inquiring how the funding estimate is 
being determined. The supporting Comments may be used to 
support calculations. Double-click inside the text area to 
access the Comment Editor. 

5. Repeat Steps 2 − 5 for each Recipient designated for the disaster. 
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Task 6: Enter Comments/Attachments 

Comments/Attachments are used to capture the historical flow of financial 
information as entered by different system users. 

CAUTION: Attachments cannot be deleted once they have been added to NEMIS 
HMGP. Please make every effort to limit the file attachment size to less 
than 1 GB. Allow up to one hour to retrieve and view newly attached 
documents.  

Do not attach documents in the Funding Estimate area. Funding Estimate 
documentation should only be attached in the Disaster Overview area. 

1. Click the Comments/Attachments tab (Figure 5-17). 

 
Figure 5-17: Mitigation >Funding > Estimate > Comments/Attachments Tab 

2. To add comments, complete Steps 2a − 2d. 

a. Click the ADD button. A new row for Comments is displayed, with the date 
and time of entry and your User Name. 

b. Double-click inside the text field to access the Comment Editor. 
c. In the Comment Editor text area, enter the comments. Click the OK 

button. 
d. The comments you entered are now displayed on the 

Comments/Attachments tab. 
3. To attach documents, click the ATTACHMENTS button. You are strongly 

urged to read and follow the instructions in Appendix A: Attach Documents. 
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Task 7: Review Financial Activity Information 

1. Click the HMGP Financial Activity tab (Figure 5-18). 

 
Figure 5-18: Mitigation >Funding >Estimate >HMGP Financial Activity Tab 

 
2. At the top left part of the tab, select the Recipient from the drop-down list. The 

tab displays five columns for various funding amounts: 
A. Projected (Current Funding Estimate) 
B. Total Allocated in NEMIS HMGP 
C. Available (Projected minus Allocated) 
D. Total Obligated in NEMIS HMGP  
E. Available (Projected minus Obligated) 

CAUTION: There must never be a negative amount in any column on this tab. In 
order to avoid negative amounts or errors when preparing an 
Allocation, always review the information in the HMGP Financial 
Activity and Budget Planning tabs first to ensure there are sufficient 
funds. 

3. Review the read-only information listed in Table 5-6. 
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Table 5-6: HMGP Financial Activity Data Fields 

DATA FIELD INFORMATION TO BE REVIEWED 

HMGP Project Funds Amount available for all project types in the current funding 
estimate, as established in Task 3: Establish Funding 
Estimate 

Regular Projects Amount remaining (minus the Initiative and Planning 
Amounts, if utilized) of project funds 

Initiative Projects Amount calculated from the percentage set aside for State 
initiatives, as set in Task 4: Enter Financial Information 

State Management Costs Amount entered in Task 2: Enter Financial Details 

Planning Projects As authorized by the Disaster Mitigation Act of 2000, this is 
calculated at up to 7 percent of the estimated HMGP funds 
for each disaster 

Estimated Ceiling Total amount of the funding estimate, including the State 
Management Costs (SMC) 

Recipient Admin Costs Estimated administrative costs for the Recipient, calculated 
at approximately 3 percent 

Subrecipient Admin Costs Estimated administrative costs for the Subrecipient, 
calculated at approximately 5 percent 

Admin Cost Sub Total Total of the Recipient and Subrecipient administrative costs 

TOTALS Total of administrative, projects, and State Management 
costs 
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Task 8: Review Budget Planning Information 

The Budget Planning tab displays read-only information on the most current 
Funding Estimate.  

The dollar amounts of projects submitted by the Recipient are added to the 
figures on this screen after the Application is assigned. (Unit 7) 

1. Click the Budget Planning tab (Figure 5-19). 

 
Figure 5-19: Mitigation > Funding > Estimate > Budget Planning Tab 

2. At the top left part of the tab, select the Recipient from the drop-down list. The 
tab displays three columns of information for various funding amounts: 

A. Projected (Current Funding Estimate) 
B. Total Submitted Projects Under Review — Total amount of projects 

submitted by the Recipient for which FEMA has completed the Application 
Completeness Review (as described in Unit 7: Manage Eligibility 
Determination) 

C. Available — (Projected minus Total Submitted Projects Under Review) 

CAUTION: There must never be a negative amount in any column on this tab. In 
order to avoid negative amounts or errors when completing an 
Application Completeness Review, always review the Budget Planning 
tab first to ensure there are sufficient funds. If the amount of the 
project submitted for approval will cause the total available to drop 
below 0, you will not be able to approve the application without first 
adjusting the amount of the current project or previously approved 
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projects down to below the amount available for the project suffix 
under review. 

NOTE: The PROJECT GLOBAL MATCH tab (Figure 5-20) is used to ensure that the 
total of all projects approved for the disaster does not exceed the overall 
Federal share percentage of 75 percent. If utilized, Project Global Match 
must be completed before the Disaster is closed in NEMIS HMGP. 
Information on using this tab is in Unit 11: Manage Project and Program 
Oversight Tasks. 

 
Figure 5-20: Mitigation > Funding > Estimate > Project Global Match Tab 
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References for HMGP Funding Estimate 

To track and document the process of Managing Funding Estimates, the 
following reports can be generated, as described in Unit 14: Generate Standard 
HMGP Reports: 

• Disaster Overview Report (Percentages and Plan Info) 
• Funding Estimate Report 
• Funding Estimate Budget Planning Report 
• Funding Estimate Financial Activity Report 
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Overview 

The Manage the HMGP Application process allows Recipient Mitigation staff to 
create a record for each HMGP project application after a disaster declaration.  
Each project application record contains information about the project and the 
applicant. Table 6-1 provides an overview of the Manage the HMGP Project 
Application process. 

NOTE: In NEMIS HMGP, the terms "Application," "Project," and "Project 
Application" are used interchangeably. Generally, however, the term 
"Project" is used after the application has been approved. 

Table 6-1: Manage the HMGP Application 

TOPIC DESCRIPTION 

Purpose To manage information about each application and applicant 

When does it start? After disaster information has been entered by FEMA Regional 
Staff 

Who does it? Recipient Mitigation Staff 

NOTE: If the Recipient does not have access to NEMIS 
HMGP, the Recipient must contact the Regional 
Mitigation Staff to request access. Although the 
Recipients are responsible for entering the project 
application information into the system, FEMA Regional 
Mitigation staff may also enter the information. 
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TOPIC DESCRIPTION 

How is it done? Execute the following tasks: 

Task 1: Create a New Project Application 

Task 2: Enter Applicant Information 

Task 2A: Enter Recipient Information 

Task 2B: Enter Subrecipient Information 

Task 2C: Enter Subrecipient Mitigation Plan Information 

Task 2D: Enter Subrecipient Application Preparer Information 

Task 3: Attach Problem and Risk Data 

Task 4: Enter Project Information 

Task 5: Enter Work Schedule 

Task 6A: Enter Cost Estimate 

Task 6B: Import Cost Estimate from the Approved Spreadsheet 

Task 7: Enter Match Sources Funds 

Task 8: Enter Cost Effectiveness Information 

Task 9: Attach Maintenance Assurance Information 

Task 10: Enter Public Notice Information 

Task 11: Attach Documents 

Task 12: Enter Eligibility Review Information 

Task 13A: Enter Property Site Inventory Information 

Task 13B: Export, Update, and Import the PSI Information 

Task 14: Enter Latitude and Longitude Information 

Task 15: Enter Authorization Information 

Task 16: Edit an Existing Project Application 

Task 17: Verify and Submit a Project Application 

Task 18: Zero Out a Project 

Task 19: Copy an Un-submitted Project to a More Recent 
Disaster  

There is no limit to the number of project applications you can enter in the 
system. In fact, this is a good way to compare projects before setting priorities 
among the different projects. 

CAUTION: Once a project application record has been created in NEMIS HMGP, 
the record is permanently stored in the database. There is no "delete" 
feature.  
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HINT: Create a new record for each new project - do not attempt to edit an 
existing project record to create a new one. 

The project application can be edited until it has been approved or denied by 
FEMA. After denial or approval, the Recipient can only attach documents to the 
project application. To make other changes to an approved or denied project 
application, follow the instructions in Unit 8: Manage Amendments. 

 



Unit 6: Manage the HMGP Application September 2016 
 

Page 6-6  NEMIS HMGP User Manual MR 3.19.01 
 

Information Requirements 

Some project application information will be entered directly into the system's 
data fields. Other information is entered into the system by attaching documents 
that are linked to the project application record. Before you begin the tasks in this 
unit, ensure that the following documents contain all the required information or 
are ready to be attached. 

• Overall project information, including Federal Information Processing 
Standards (FIPS) code (FEMA will assign one if not included); 

• Subrecipient and contact name; 

• Location and description of project; 

• Cost estimate spreadsheets and documents; 

• Cost-effectiveness of the project comparing the cost to the anticipated 
value of reductions in future damage; 

• Work schedule; 

• Alternative projects considered and justification for selection of the final 
project; 

• Environmental considerations, which may be documented using the 
HMGP’s Environmental Considerations Questionnaire; 

• Report describing the environmental impact of the proposed action with 
supporting documentation, such as maps and technical reports; 

• Compliance assurances, including National Flood Insurance Program 
(NFIP) participation and last CAV date; 

• Decision-making process, including alternatives considered, selection 
made, and reasons for the decision;  

• Project description (you may also type this directly into the Project 
Description field, if less than 8,000 characters); 

• Benefit-Cost Analysis (BCA); 

NOTE: The following problem and risk analysis documents may be contained in 
the local Multihazard Mitigation Plan. 

• Problem description, including 25 years of damage history; and 

• Risk and cost-effectiveness data. 

HINT: In addition to the above documents, other supporting documentation 
(e.g., maps, blueprints, photographs, plats and reports) can be attached. 
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Information Available for Review 

FEMA Regional Mitigation staff can access HMGP Project Application 
information entered by Recipient Mitigation staff. Table 6-2 lists where application 
information can be found in the system. 

Table 6-2: Manage the HMGP Application 

INFORMATION AVAILABLE FOR REVIEW LOCATION IN NEMIS 
Project applicant information Mitigation > Projects>Application Development 

> Applicant Information tab 

Problem and risk data information Mitigation>Projects> Application Development > 
Problem and Risk Data tab 

Project information Mitigation >Projects>Application Development > 
Project Info tab 

Work schedule Mitigation >Project> Application Development > 
Work Schedule tab 

Cost estimate information Mitigation > Projects > Application Development 
> Cost Estimate tab 

Sources and details of non-Federal funding Mitigation > Projects > Application Development 
>Match Sources tab 

Cost effectiveness information Mitigation > Projects > Application Development 
>Cost Effectiveness tab 

Maintenance assurance Mitigation >Projects > Application Development 
>Maintenance Assurance tab 

Public notice Mitigation > Projects> Application Development 
>Public Notice tab 

Supporting project documentation Mitigation>Projects> Application Development 
>Attachments tab 

Reviewer’s name and reviews conducted Mitigation>Projects> Application Development 
>Eligibility Review tab 

Property owners and details Mitigation >Projects> Application Development 
>Property Site Inventory tab 

Property latitude and longitude Mitigation>Projects> Application Development 
>Lat/Lon tab 

Preparer information and authorized 
Recipient’s name; Authorized Applicant 
Agent and Authorized Recipient Official 

Mitigation>Projects> Application Development 
>Authorization tab 

Review application for deficiencies and to 
ensure eligibility 

Mitigation>Projects>Application Development > 
Verify Button 

Submission date and authorization 
information 

Mitigation>Projects> Application Development 
>Authorization tab 
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Task 1: Create a New Project Application 

1. On the MITIGATION menu, click Projects > Application Development. When 
the Application Development screen appears, then select New (Figure 6-1).  

 
Figure 6-1: Mitigation > Projects > Application Development 

2. The Create Application dialog box is displayed (Figure 6-2). 

 
Figure 6-2: Create Application Dialog Box 

3. Enter the information listed in Table 6-3. 
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Table 6-3: Create Application Dialog Box Data Fields 

DATA FIELD INFORMATION TO BE REVIEWED/ENTERED 

Disaster Number Read-only Disaster Number auto-filled by the system 

Application ID Auto-filled sequential number assigned by the system. You can 
change the number if you use your own numbering system to 
track applications. 

CAUTION: This data field accepts numerals only. The system 
will not accept any number higher than 9999. 

Once you click the OK button in the Create Application Dialog 
Box, you can no longer edit the number. 

Project 
Amendment 
Number 

Read-only Project Amendment Number auto-filled by the system 

4. Click the OK button. Fourteen tabs for managing HMGP Application 
Development Information are displayed at the top of the page (Figure 6-3). By 
default, the Applicant Information tab is displayed. 

 
Figure 6-3: HMGP Application Development Tabs 

HINT: Saving Project Application Information 

As you enter information in the different tabs, save frequently so you do not lose 
the data. You can save your work by doing one of the steps below: 

  -On the bottom left part of the screen, click the SAVE button. 

  -Click on another tab. 

  -On the bottom right part of the page, click the CLOSE button. You will be 
prompted to save changes. 
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Task 2: Enter Applicant Information 

On the Applicant Information tab (Figure 6-4) you can perform the following 
sub-tasks: 
Task 2A: Enter Recipient Information 
Task 2B: Enter Subrecipient Information 
Task 2C: Enter Subrecipient Mitigation Plan Information 
Task 2D: Enter Subrecipient Application Preparer Information 

 
Figure 6-4: Mitigation > Projects > Application 
Development > Applicant Information Tab 
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Task 2A: Enter Recipient Information 

1. On the Applicant Information tab, click the MORE RECIPIENT INFO button. 
The Assign Recipient screen is displayed (Figure 6-5).  

2. Information about the first Recipient is displayed. Scroll down to see the 
information on the other Recipients. 

 
Figure 6-5: Recipient Search Results 

HINT: The Recipients that are available for selection are those to which your 
User ID is linked. If the desired Recipient is not displayed, complete the 
steps in Unit 3, Task 8: Enter User to Recipient Link Information. 

3. Make sure that the Recipient you wish to select is displayed on the screen. 
Click the OK button to select that Recipient. Select the Save button. 

4. The Recipient section of the Applicant Information tab now displays the 
Recipient information (Figure 6-6). 
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Figure 6-6: Applicant Information Tab with Assigned Recipient 

5. On the bottom left part of the Applicant Information tab, click the SAVE 
button. 
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Task 2B: Enter Subrecipient Information 

1. On the Applicant Information tab, click the MORE SUBRECIPIENT INFO 
button. The Assign Subrecipient screen is displayed (Figure 6-7). 

 
Figure 6-7: Assign Subrecipient 

NOTE:  In cases where the disaster declaration is only for a tribe, the state 
cannot be the Recipient. 

2. Click the SEARCH button. Information about the first Subrecipient is 
displayed. Scroll down to see the information on the other Subrecipient’s 
(Figure 6-8). 

 
Figure 6-8: Subrecipient Search Results 
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3. If the desired Subrecipient is already listed, make sure that the Subrecipient 
you wish to select is displayed on the screen. Click the OK button to select 
that Subrecipient. Proceed to Step 5. 

4. If the desired Subrecipient is not listed, complete the following steps to add a 
new Subrecipient. 
a. On the Assign Subrecipient screen, click the ADD button. The 

County/Place Code List is displayed (Figure 6-9). 

 
Figure 6-9: County/Place Code List 

b. If the new Subrecipient is associated with a place (e.g., a town within a 
county), click the County Code radio button. A list of Federal Information 
Processing Standards (FIPS) County/Place Codes and Names is 
displayed. 

HINT: Click the County Name or the Place Name column heading to sort the 
contents alphabetically. It may take the system a few minutes to complete 
this process. 

 

CAUTION: When searching for a county in the list, be sure to select the record 
identified with the county in the Place Name column. Since the table 
repeats the county name and the list under Place Name is 
alphabetical, this is seldom the first row when you scroll down to the 
records for that county.  

5. If the new Subrecipient is a public entity (e.g., a building within a town within a 
county), click the Public Entity radio button. A list of Public Entity Names, with 
their ID, County/Place Code and Name is displayed (Figure 6-10). 
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Figure 6-10: Public Entity List 

6. Select the row in the list that applies to the new Subrecipient. Click the OK 
button. 

7. The Assign Subrecipient screen now displays the following read-only 
information about the selected Subrecipient (Figure 6-11): 

• County/Place or Public Entity Information 
• Subrecipient's Name 
• Subrecipient's Tax Id 

 
Figure 6-11: Assign New Subrecipient 

8. In the Private Non-Profit field, click the Yes or No radio button. 

9. In the CID Number field, select the Subrecipient's Community 
Identification Number from the drop-down list. 
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10. In the Applicant Description field, enter a brief description of the 
Subrecipient. 

11. To add a contact for the Subrecipient, click the ADD CONTACT button. 
The Look Up a Contact window is displayed. 

12. Follow the personnel database instructions in Appendix B. You will be 
returned to the Assign Subrecipient screen. 

13. Click the OK button to finish adding the new Subrecipient. 

14. The Subrecipient section of the Applicant Information tab now displays 
the Subrecipient information (Figure 6-12). The County/Place Code that 
you selected is displayed in the FIPS Place Code field. 

 
Figure 6-12: Applicant Information Tab with Assigned Subrecipient 

15. In the NFIP Participation field, select Yes or No. 

16. In the Last CAV Date field of the Subrecipient section, enter the date of the 
last Community Assistance Visit. 

17. On the bottom left part of the Applicant Information tab, click the SAVE 
button. 
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Task 2C: Enter Subrecipient Mitigation Plan Information 

NOTE: To use the Enable Manual Entry of Plan Data feature, see Unit 4 Task 3. 
Manually entered plan information will not be reflected in the plan 
report. 

1. If there is an approved plan, the Plan Type, Approval Date and Expire Date 
information of the plan are displayed in the Subrecipient Mitigation Plan 
section of the Applicant Information tab. 

2. If there is no approved plan, as in the example below, the Plan Type, 
Approval Date and Expire Date fields are empty. A warning message that 
there is no approved plan is displayed in red (Figure 6-13). 

 
Figure 6-13: No Approved Subrecipient Mitigation Plan Warning 

3. To enter Subrecipient Mitigation Plan information complete the following 
steps: 
a. Click the EDIT SUBGR LINK button on the right part of the screen. The 

MT Subrecipient Mitigation Plan screen displays all approved plans for the 
Subrecipient (Figure 6-14). 

 
Figure 6-14: MT Subrecipient Mitigation Plan 
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b. Highlight the Mitigation Plan that you wish to link to this project application. 

c. Click the APPEND button. The Comment Editor is displayed (Figure 6-15). 

 
Figure 6-15: Subrecipient Mitigation Plan Comment Editor 

d. In the text area, add comments relative to the selected plan, or add a 
justification if you are changing the plan currently linked to the 
Subrecipient. 

e. Click the OK button. The comments are now displayed on the MT 
Subrecipient Mitigation Plan screen. The system appends your User 
Name, the date and time to the end of the text. (Figure 6-16). 

 
Figure 6-16: MT Subrecipient Mitigation Plan Comments 
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f. Click the OK button. The Subrecipient Mitigation Plan section of the 
Applicant Information tab now displays the mitigation plan information 
(Figure 6-17).  

g. Close and reopen the application. Notice that in the example below the 
red warning message stating that there is no approved plan is not 
displayed. 

 

Figure 6-17: Applicant Information Tab with Subrecipient Mitigation Plan 

4. On the bottom left part of the Applicant Information tab, click the SAVE 
button. 
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Task 2D: Enter Subrecipient Application Preparer Information 

1. On the Applicant Information tab, click the MORE PREPARER INFO 
button. The Look up a Contact screen is displayed (Figure 6-18). 

 
Figure 6-18: Look up a Contact 

HINT: To speed up the search process, enter information in as many fields as 
possible before clicking the SEARCH button. Appendix B provides 
instructions for selecting a name from the personnel databases. 

2. Scroll down the search results, making sure that the preparer name for this 
project application is displayed. 

3. Click the OK button. The Subrecipient Application Preparer section of the 
Applicant Information tab now displays the preparer information (Figure 6-19). 

 
Figure 6-19: Subrecipient Application Preparer 

4. On the bottom left part of the Applicant Information tab, click the SAVE 
button. 
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Task 3: Attach Problem and Risk Data 

1. Click the Problem & Risk Data tab (Figure 6-20). 

 
Figure 6-20: Mitigation > Projects > Application 
Development > Problem and Risk Data Tab 

2. Click the ATTACH DOCUMENT button for each of the three sections: 
• Problem Description 
• Decision Making Process 
• Risk and Cost Effectiveness Data 

CAUTION: Attachments cannot be deleted once they have been added to NEMIS 
HMGP. Please make every effort to limit the file attachment size to less 
than 1 GB. Allow up to one hour to retrieve and view newly attached 
documents. 

CAUTION: All three documents must be included with the project application 
before it can be approved by FEMA. The documents may be attached 
after you submit the project application.  

3. You are strongly urged to read and follow the instructions in Appendix A: 
Attach Documents. 

4. In the Decision Making Process section, the Alternative Names box will not 
display any alternative solutions until they have been entered in the Env 
Checklist sub-tab under the Eligibility Review Tab (Task12B: Enter 
Eligibility Review Information). If alternative solutions have been entered, the 
Alternative Names box will display the names of the alternative solutions. 
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Task 4: Enter Project Information 

1. Click the Project Info tab (Figure 6-21). 

 
Figure 6-21: Mitigation > Projects > Project Application > Project Info Tab 

2. In the Project Title field, enter a descriptive title for the project. If applicable, 
include the town name and activity in the title. 

3. Double-click inside the Project Description field. The Comment Editor is 
displayed. In the text area, enter the Project Description text. There is an 
8,000 character limit. 

4. Click the OK button. The project description text is now displayed on the 
Project Info tab (Figure 6-22).  

 
Figure 6-22: Project Info Tab with Project Title and Project 
Description 
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NOTE: It is now possible for users to revise previously entered comments when 
creating a new amendment by editing information in the Project 
Description section of the Project Info tab. To edit, double click on the 
Project Description field, modify the comments, and click the OK button. 
The change is only applicable for the current amendment in process. 
Once the project application is approved, those comments are locked.  

5. Click the ATTACH button. The Attach Document dialog box is displayed 
(Figure 6-23). Note that the Document Type defaults to "PROJECT 
DESCRIPTION." 

 
Figure 6-23: Attach Document Dialog Box 

6. You are strongly urged to read and follow the instructions in Appendix A: 
Attach Documents. 

CAUTION: The Project Description document must be included with the project 
application before it can be approved by FEMA. The document may 
also be attached after you submit the project application. 

CAUTION: Attachments cannot be deleted once they have been added to NEMIS 
HMGP. Please make every effort to limit the file attachment size to less 
than 1 GB. Allow up to one hour to retrieve and view newly attached 
documents. 

7. If State Legislative Districts are identified in the project application, add them 
to the Project Information screen by completing the following steps: 
a. On the bottom part of the State Legislative District box, click the NEW 

button. A new row with the two-letter State abbreviation is displayed 
(Figure 6-24). 



Unit 6: Manage the HMGP Application September 2016 
 

Page 6-24  NEMIS HMGP User Manual MR 3.19.01 
 

 
Figure 6-24: State Legislative District 

b. In the District Id column, enter a district name or number. The new State 
Legislative District is now displayed (Figure 6-25). 

 
Figure 6-25: State Legislative District Added 

8. On the bottom half of the Project Info tab, five sub-tabs are available for 
adding project information.  

9. The Project Type sub-tab is displayed by default (Figure 6-26). 
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Figure 6-26: Mitigation > Projects > Application Development > Project 
Info > Project Type Sub-tab 

To add Project Types, complete the following steps. 

a. On the left side where the Project Codes and Descriptions are listed, 
highlight the row(s) you wish to select. 

CAUTION: State Management Cost Codes (700.1-700.4) cannot be selected with 
any other project types. 

b. Click the ADD or ADD ALL (if you highlighted more than one row) button. 
The Project Code(s) and Description(s) you selected are now displayed on 
the right side (Figure 6-27). 

 
Figure 6-27: Project Code and Description Added 

c. When selecting project code 205.7B Retrofitting Private Structures – Wind 
(P804) as shown below (Figure 6-28), additional system requirements will 
need to be met: 
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Figure 6-28:  Retrofitting Private Structures 

i. It is mandatory to select the Hazard Type - Windstorms. 
ii. The property site inventory will require the selection of one of the 

four wind retrofit property site actions (Figure 6-29). 

 
Figure 6-29:  Wind retrofit property site actions 

iii. Under property site inventory, property info, the sections building 
evaluation, building evaluation date (if answer to Building 
Evaluation is YES), and substantial improvement must be selected 
(Figure 6-30). 
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Figure 6-30: Property Site Inventory > Property Info > Building evaluation, 
building evaluation date, substantial improvement 

10. When selecting the new project type 904.1 Advanced Assistance (Figure 6-31), 
additional requirements will apply:  
a. This is a standalone project; no other projects can be selected with it.  
b. Currently, this project type has funding limits equal to the lesser of 10 million 

dollars or 25% of the locked in ceiling. If these amounts are exceeded, during 
federal eligibility cost review (Unit 7) validation messages specific to the 
limiting factor and amount exceeded will be displayed.  Adjustments will need 
to be made to the requested cost of the project for the project to be approved 
if the validation screens appear.   

 
Figure 6-31: New Project Type 904.1 Advanced Assistance 

11. Click the County Code sub-tab (Figure 6-32).  
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Figure 6-32: Mitigation > Projects > Application Development > 
Project Info > County Code Sub-tab 

To add County Codes, complete the following steps. 

a. On the left side where the County Codes and Names are listed, highlight 
the row(s) you wish to select. 

b. Click the ADD or ADD ALL (if you highlighted more than one row) button. 
The County Code(s) and Name(s) you selected are now displayed on the 
right side (Figure 6-33). 

 
Figure 6-33: County Code and Name Added 

12. Click the Congressional District sub-tab (Figure 6-34). 
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Figure 6-34: Mitigation > Projects > Application Development >  
Project Info > Congressional District Sub-tab 

To add Congressional Districts, complete the following steps. 

a. On the left side where the States and District IDs are listed, highlight the 
row(s) you wish to select. 

b. Click the ADD or ADD ALL (if you highlighted more than one row) button. 
The State(s) and District ID(s) you selected are now displayed on the right 
side (Figure 6-35). 

 
Figure 6-35: Congressional District Added 

13. Click the Community Names/Codes*sub-tab (Figure 6-36). 

 
Figure 6-36: Mitigation > Projects > Application Development > 
Project Info > Community Names/Codes Sub-tab 
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To add Community Names/Codes, complete the following steps. 

a. On the left side where the CID Numbers and Community Names are 
listed, highlight the row(s) you wish to select. 

NOTE: For Project Types that require Property Site Inventory (PSI), only the 
Community Names/Codes you select here will be displayed in the 
Application Development  Property Site Inventory tab. 

 

HINT: When a project is not easily associated with a designated area (i.e., a city, 
a county, or statewide), the user should assess what area is best or most 
served by the project and make a judgment call accordingly as to what 
CID number should be selected from the list. 

b. Click the ADD or ADD ALL (if you highlighted more than one row) button. 
The CID Number(s) and Community Name(s) you selected are now 
displayed on the right side (Figure 6-37). 

 
Figure 6-37: Community Names/Codes Added 

NOTE: The CID Number in the Project Info tab identifies the community where 
the proposed project activity will occur; the CID Number in the Assign 
Recipient and Assign Subrecipient screens identifies the community of the 
Project Applicant. 

14. Click the Hazard Type sub-tab (Figure 6-38). 
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Figure 6-38: Mitigation > Projects > Application 
Development > Project Info > Hazard Type Sub-tab 

To add Hazard Types, complete the following steps. 

a. On the left side where the Hazard Descriptions are listed, highlight the 
row(s) you wish to select. 

b. Click the ADD or ADD ALL (if you highlighted more than one row) button. 
The Hazard Description(s) you selected is (are) now displayed on the right 
side (Figure 6-39).  

 
Figure 6-39: Hazard Type Added 

NOTE: For Project Types that require Property Site Inventory (PSI), only the 
Hazard Types you select here will be displayed in the Application 
Development - Property Site Inventory tab. 

15. If the project type AND the hazard type combination require sea level rise 
information, the Sea Level Rise (SLR) sub-tab will appear. If the tab appears, 
and the questions are not answered, the project will not be submitted to 
Federal Eligibility. Click the Sea Level Rise sub-tab (Figure 6-40).  

NOTE: The questions on the Sea Level Rise tab must be answered for select 
project types as indicated by the Admin > Project Type Matrix 
Information screen AND the identified hazard types of Coastal Storm, 
Hurricane, Severe Storm, Tropical Cyclone, Tsunami, Flood and Typhoon. 
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Figure 6-40: Mitigation > Projects > Application 
Development > Project Info > Sea Level Rise Sub-tab 

16. When the project type and hazard selected are applicable to SLR, the SLR 
sub-tab will appear. Answer the following questions: 

a. Are the location of this project and the nature of the project type 
such that the risk to the project is exacerbated by SLR? Select YES 
or NO. If YES, user must answer the next question; if not, the next 
question does not have to be answered. 

b. Was SLR considered and included in the mitigation measures 
implemented in this project? Select YES or NO. 

17.  Once the Sea Level Rise questions are answered, Verification or Submitting 
the project will require additional data on the Cost Effectiveness tab, as 
follows: 

a. Was SLR pursuant to 2011-OPPA-01included in the development 
of the BCA for this project? Answer YES or NO. If YES, user must 
enter a value in green field as follows: 

b. Depth in feet of SLR that was added to the flood profiles: enter 
value in feet with two decimal places (0.00) 

18. On the bottom left part of the Project Info tab, click the SAVE button. 
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Task 5: Enter Work Schedule 

1. Click the Work Schedule tab. 

2. On the bottom left part of the tab, click the NEW button. A new row for 
entering work schedule information is displayed (Figure 6-41). 

 
Figure 6-41: Work Schedule - New Row 

3. In the Description box, enter a description of the phase in the work schedule. 

4. In the Time Frame box, enter the time frame for that phase. 

5. Repeat Steps 2 - 4 for each phase of the work schedule (Figure 6-42). 

 
Figure 6-42: Work Schedule - New Items Added 

  



Unit 6: Manage the HMGP Application September 2016 
 

Page 6-34  NEMIS HMGP User Manual MR 3.19.01 
 

HINT: If you need to re-order the items in the work schedule, highlight and 
retype the numbers in the first column of the table. Click another tab (e.g., 
Public Notice) and then click back on the Work Schedule tab. The items in 
the table will be re-ordered and automatically saved. Clicking the SAVE 
button will NOT reorder the table. 

6. On the bottom left part of the Work Schedule tab, click the SAVE button. 
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Task 6A: Enter Cost Estimate 

1. Click the Cost Estimate tab. A warning message about making changes to 
Cost Estimate or Match Sources is displayed (Figure 6-43). 

 
Figure 6-43: Warning About Cost Estimate or Match Sources Changes 

CAUTION:  If you are revising or amending your cost estimate, it is imperative 
that the instructions in the above warning be followed. Failure to do 
so may prevent project approval, or allocation/obligation.  

CAUTION:  Individual line items cannot be modified for quantity, unit of 
measure, or unit cost. Each line item that is to be revised must be 
deleted in its entirety and reentered using the new desired values. 
Once the Cost Review portion of a submitted application has been 
completed and cost approval is marked as Y it will be necessary to 
rework the approval back to the cost reviewer so that they can 
change the Y to an N to enable editing of the Cost Estimate screen. 

CAUTION:  Once the application is approved it will be necessary to amend the 
application to revise the Cost Estimate.  

2. Click the OK button. The empty Cost Estimate table is displayed (Figure 6-
44). 
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Figure 6-44: Mitigation > Projects > Application 
Development > Cost Estimate Tab 

3. On the bottom left part of the tab, click the NEW button. A new row for 
entering cost items is displayed (Figure 6-45). 

 
Figure 6-45: Cost Estimate - New Row 

4. Enter the information listed in Table 6-4. 
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Table 6-4: Cost Estimate Data Fields 

DATA FIELD INFORMATION TO BE ENTERED 
Item Name 
Required Field 

Descriptive name of cost item 

Unit Qty 
Required Field 

Number of units 

Unit of Measure Standard measure for each unit 

Unit Cost 
Required Field 

Cost per unit. 
CAUTION: Value must never be $0. 

 

Cost Estimate Cost Estimate = Unit Qty x Unit Cost. Auto-filled by the system 
when you press the Enter key after completing the Unit Cost 
data field.  

Total Project 
Cost Estimate 

System-generated running total of the Cost Estimate column 

5. Repeat Steps 3-4 for each cost item you need to add. 

6. Figure 6-46 shows Cost Estimate rows added to the project. 

 
Figure 6-46: Cost Estimate Information Added 

7. Answer the question, “Is this project part of the Initiative?” by clicking inside 
the Yes or No radio button. 

8. On the bottom left part of the Cost Estimate tab, click the SAVE button. 

9. After saving Cost Estimate information, you may edit the information by 
completing Steps 9a - 9d. 
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CAUTION: Steps 9a - 9d are needed to ensure that the old Cost Estimate 
information is deleted from the NEMIS database and that the new 
information is saved. The steps assume that no entries in the Match 
Sources tab have been saved. If Match Sources information has been 
saved, complete Task 7, Step 7 a-e. 

It may not be possible to edit the Cost Estimate if the application has been 
submitted for FEMA approval. If the application has passed the Cost 
Review step in the Eligibility Determination process and the Y option has 
been selected for Cost Approval the Cost Estimate can no longer be edited 
unless reworked. Once the application has been approved, it will be 
necessary to amend the project and update the Cost Estimate tab by 
deleting the Match Sources information, saving, and then deleting the 
Cost Estimate line items in need of revision and reentering the line item 
as part of the amendment process. 

a. Delete all Cost Estimate line items. 

b. On the bottom left part of the Cost Estimate tab, click the SAVE button. 

c. Re-enter the new Cost Estimate information. 

d. On the bottom left part of the tab, click the SAVE button.  
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Task 6B: Import Cost Estimate from the Approved Spreadsheet 

The cost estimate can be developed in a pre-approved spreadsheet template and then 
imported into an HMGP application that is under development or review.  

For the import capability to work, the user must download the HMA-approved Cost 
Estimate Import Spreadsheet template. The approved spreadsheet has pull-down 
menus and validations built in that NEMIS HMGP uses for the import to be successful. 

 CAUTION: User-designed spreadsheets will not work with NEMIS HMGP. Make 
sure you use the HMA-approved spreadsheet. For the most updated 
spreadsheet, please contact your NEMIS HMGP regional POC. 

The spreadsheet validations include:  
 

• Whole Numbers – The user must enter whole numbers ONLY, between the 
values of 1 and 999,999,999. Attempting otherwise will result in the following 
Cost Estimate message:  

 
Figure 6-47: Cost Estimate Whole Number Warning Message 

• Pull-down menu – The approved spreadsheet includes a pull-down menu to 
select the unit of measure. The units of measure in the pull-down menu track 
directly to NEMIS HMGP. Any attempt to enter a value other than a selection 
from the pull-down menu will result in the following message: 

 
Figure 6-48: Invalid Entry Warning Message 

After filling out the spreadsheet completely and accurately, the process to import the 
spreadsheet into the Cost Estimate tab is as follows: 
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1. Click the Cost Estimate tab. A warning message about making changes to 
Cost Estimate or Match Sources is displayed. Read the message and select 
OK. The Cost Estimate tab will appear.  

2. Select the IMPORT button. The Select File window will appear (Figure 6-49). 
Navigate to the folder where the spreadsheet is located, highlight the 
completed cost estimate spreadsheet file, and click Open. 

 
Figure 6-49: Select File Window 

3. If the import is successful,  the following Cost Estimate message will be 
displayed:  

 
Figure 6-50: Import Completed Successfully Message 

4. The NEMIS HMGP Cost Estimate will now show the spreadsheet 
information entered into the NEMIS HMGP Cost Estimate table (Figure 6-
51). 

 

Figure 6-51: Cost Estimate Tab with Imported Values 

5. All rows on the spreadsheet that are partially completed or incomplete will 
be imported exactly as they were entered on the spreadsheet.  Blank text 
for Item Name and Unit of Measure will be blank after the import and 



September 2016 Unit 6: Manage the HMGP Application 
 

NEMIS HMGP User Manual MR 3.19.01 Page 6-41 
  

numerical items such as Unit Qty or Unit Cost will be imported as a 0 
(zero).  These blank entries will be validated by the system during 
verification or submittal as is the process now.  

6. Items that contain a zero will be included in the total project cost estimate 
and may impact the total amount approved for the project or the Match 
Sources tab. 

 
Figure 6-52: Verify Message – Non Fedshare amount is invalid. 

Please refer to the Match Sources tab 
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Task 7: Enter Match Sources Funds 

NOTE: Be sure to enter information in the Cost Estimate tab before entering 
information in the Match Sources tab. 

1. Click the Match Sources tab. A warning message about making changes to 
Cost Estimate or Match Sources is displayed (Figure 6-53). 

 
Figure 6-53: Warning About Cost Estimate or Match Sources Changes 

2. Click the OK Button. The Match Sources tab is displayed (Figure 6-54). 

 
Figure 6-54: Mitigation > Projects > Application 
Development > Match Sources Tab 

3. The top part of the Match Sources tab displays information described in 
Table 6-5. 
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Table 6-5: Data Fields in Top Part of Match Sources Tab 

DATA FIELD DESCRIPTION 

Total Project Cost 
Estimate 

Dollar amount of the total cost estimate of the project. Auto-filled 
by the system with the same value found in the Cost Estimate 
tab - Total Project Cost Estimate field. 

Federal Share 
Percentage 

Required Field 

Percentage of the Total Project Cost Estimate that will be 
federally funded. The default percentage displayed is 75 percent. 
Edit the percentage if necessary. 

Proposed Federal 
Share 

Proposed Federal Share = Total Project Cost Estimate x Federal 
Share Percentage. Auto-calculated by the system. 

Proposed Non-
Federal Share 

Proposed Non-Federal Share = Total Project Cost Estimate - 
Proposed Federal Share. Auto-calculated by the system. 

4. The lower part of the Match Sources tab is the Non-Federal Funding section, 
which is designed to display Non-Federal Funding sources for this project. To 
add a Non-Federal Funding source, complete Steps 4a - 4c. 

a. On the bottom left part of the screen, click the NEW button. A set of 
data fields for entering information about a Non-Federal funding source 
is displayed (Figure 6-55). 

 
Figure 6-55: Non-Federal Funding Source Data Fields 
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b. On the bottom right part of the Match Sources tab, select the Public 
Assistance (PA) or the Human Services (HS) Reference Cost Code 
List that you will need as a reference. Click the DISPLAY button to 
display the reference list. 

c. To complete the data fields for each Non-Federal funding source, enter 
the information listed in Table 6-6. 

Table 6-6: Non-Federal Funding Source Data Fields 

DATA FIELD INFORMATION TO BE ENTERED 

Source Agency Category of the agency that will provide the non-Federal funds. 
Select one of the following: 

• Local 
• Other 
• Private Non-Profit 
• State 

Source Name Name of the agency that will provide the non-Federal funds 

Funding Type Type of funding that will be provided by the source. Select one 
of the following: 

• Administration 
• Cash 
• Consulting Fees 
• Engineering Fees 
• Equipment Operation/Rental 
• Labor 
• Other 
• Program Income 
• Supplies 

Other Funding Type 
Description 

If "Other" is selected for Funding Type, enter the description. 

Funds Availability 
Date 

Required field 

Date the non-Federal funds will be available. 

NOTE: This date must always be entered for any project to 
indicate that the matching non-Federal funds are available 
before FEMA approves the project. No project should be 
obligated without this entry and the accompanying 
documentation in the project file. 

Funds Commitment 
Letter Date   

Required field 

Date the funds will be committed 

NOTE: This date must always be entered for any project to 
indicate that the matching non-Federal funds are 
committed before FEMA approves the project. No project 
should be obligated without this entry and the 
accompanying documentation in the project file. 
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DATA FIELD INFORMATION TO BE ENTERED 
Item Name Descriptive name of item to be used for non federal share. 

Unit Qty Number of units 

Unit of Measure Standard measure for each unit 

Unit Cost Cost per unit 
CAUTION: Value must never be $0. 

 

Total Cost Total Cost = Unit Qty x Unit Cost. Auto-calculated by the 
system when you press the Enter key after completing the Unit 
Cost data field.  

Percent of Non-Fed Percent of Non-Fed = Total Cost/Proposed Non-Federal Share 
Percentage. Auto-calculated by the system. 

d. For each additional source of non-Federal funding, repeat steps 4a - 4c. 
 

5. Figure 6-56 shows two Non-Federal funding sources that were added to the 
Match Sources tab. 

 
Figure 6-56: Match Sources Tab with Two Non-Federal Funding Sources  

NOTE: The total cost dollar amounts under each funding source are added up. 
The sum dollar amount is displayed in the read-only Grand Total Cost 
data field on the bottom right part of the Match Sources tab. The 
percent’s of Non-Fed under each funding source are also added up. The 
sum percentage is displayed next to the Grand Total Cost. 
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CAUTION: When all the non-Federal funding information has been entered, the 
Grand Total Cost dollar amount must match the Proposed Non-
Federal Share dollar amount displayed on the top part of the Match 
Sources tab. 

6. On the bottom left part of the Match Sources tab, click the SAVE button. 

7. After saving Match Sources information, you may edit the information by 
completing Steps 7a - 7k. 

CAUTION: Steps 7a - 7k are needed to ensure that the old Match Sources 
information is deleted from the NEMIS database and that the new 
information is saved.  

a. Select an item by clicking inside any of the Non-Federal Funding fields. 
On the bottom left part of the tab, click the DELETE button. 

b. Repeat Step 2 for additional items that you wish to delete. 

c. On the bottom left part of the tab, click the SAVE button. 

d. Click the Cost Estimate tab and delete all line items.  

e. On the bottom left part of the tab, click the SAVE button. 

f. Still in the Cost Estimate tab, select the NEW button and re-enter the 
new Cost Estimate line items. 

g. On the bottom left part of the tab, click the SAVE button. 

h. Click the Match Sources tab. 

i. Click the NEW button and enter the new Non-Federal Funding item 
information. 

j. Repeat Step 8i for each new Non-Federal Funding item. 

k. On the bottom left part of the tab, click the SAVE button. 
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Task 8: Enter Cost Effectiveness Information 

1. Click the Cost Effectiveness tab (Figure 6-57). 

NOTE: The warning message in red is a reminder that Cost-Effectiveness 
information is required even for exempt projects. 

 
Figure 6-57: Mitigation > Projects > Application Development > 

Cost Effectiveness Tab 

2. On the bottom left part of the Cost Effectiveness tab, click the NEW button. A 
new row for adding cost Effectiveness information is displayed (Figure 6-58). 

 
Figure 6-58: Cost Effectiveness Data Fields - Left Side 

3. Scroll the horizontal bar to the right to view the right-hand part of the new row 
(Figure 6-59). 

 
Figure 6-59: Cost Effectiveness - Right Side 

4. Enter the information listed in Table 6-7. 
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Table 6-7: Cost Effectiveness Data Fields 

DATA FIELD INFORMATION TO BE ENTERED 

Amend # Auto-filled by the system 

Community Community name where project is located. Select from the 
places available in the drop-down list. 

HINT: If there are no places listed in the drop-down 
list, click the Project Info tab. Add Community 
Names/Codes by completing Task 4 - Step 12: Add 
Community Names/Codes. 

Net Present Value of 
Project Benefits (A) 

Project Benefits dollar amount as obtained from the 
Benefit-Cost Analysis (BCA) documentation 

Total Project Cost 
Estimate (B) 

Project Cost dollar amount as obtained from the Benefit-
Cost Analysis documentation 

Benefit-Cost Ratio (A/B) Benefit-Cost Ratio = Net Present Value of Project Benefits/ 
Total Project Cost Estimate. Auto-calculated by the system. 

Analysis Type Type of BCA. Select one of the following: 

• Flood 
• Wildfire 
• DFA 
• Tornado 
• Hurricane Wind 
• Upper Bound 
• Lower Bound 
• Best Data 
• Not Applicable 
• Exempt 
• Seismic 
• Hurricane Shelter 

Exempt Type Type of exemption if the selected Analysis Type is 
"Exempt."  Select one of the following: 

• Initiative Projects (5 percent and 10 percent) 
• Other 
• Plans (7 percent) 
• Substantially Damaged Acquisition 
• State Management Costs 

Reviewer's Name Name of person who reviewed the BCA 
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DATA FIELD INFORMATION TO BE ENTERED 

BCA Performed By Organization of the reviewer. Select one of the following: 

• FEMA 
• State 
• Contractor 

Analysis Date Date the BCA was conducted 

Pre-calculated Benefit Identify and verify if pre-calculated benefits were included. 
Select one or more of the following: 

• None 
• Environmental 
• 100 YR FP Acquisition 
• 100 YR FP Elevation 
• Pre-determined 

Comments Comments or notes about the BCA 

5. Figures 6-60 shows the Cost Effectiveness tab with completed information. 

 

Figure 6-60: Cost Effectiveness Data Fields Completed Showing Pre-
calculated Benefit field 

6. The Cost Effectiveness tab must be completed and saved before the pre-
calculated benefit function can be used.  An entry under Pre-Calculated 
Benefit is required for the application to be submitted. 
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7. Either select None and save and close the dropdown box or select the type(s) 
of Pre-Calculated benefits used in the BCA and save and close the dropdown 
box.  

8. On the bottom left part of the Cost Effectiveness tab, click the SAVE button. 

NOTE: BCA documentation is attached to the project using the Attachments tab. 
Complete the steps in Task 11: Attach Documents. 
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Task 9: Attach Maintenance Assurance Information 

CAUTION: Attachments cannot be deleted once they have been added to NEMIS 
HMGP. Please make every effort to limit the file attachment size to less 
than 1 GB. Allow up to one hour to retrieve and view newly attached 
documents. 

1. Click the Maintenance Assurance tab (Figure 6-61). 

 
Figure 6-61: Mitigation > Projects > Application Development > 
Maintenance Assurance Tab 

2. Click the ATTACH DOCUMENT button. The Attach Document dialog box is 
displayed (Figure 6-62). Notice that the Document Type defaults to 
"MAINTENANCE ASSURANCE." 

 
Figure 6-62: Attach Documents Dialog Box 

3. You are strongly urged to read and follow the instructions in Appendix A: 
Attach Documents. 

4. On the bottom left part of the Maintenance Assurance tab, click the SAVE 
button. 
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Task 10: Enter Public Notice Information 

1. Click the Public Notice tab. The default answer to the question about the 
Project Applicant being required to provide Public Notice of the project is "No" 
(Figure 6-63). 

 
Figure 6-63: Mitigation > Projects > Application 
Development > Public Notice Tab 

2. If the project requires a Public Notice, click inside the Yes radio button. The 
NEW button on the bottom left part of the tab becomes available. 

3. Click the NEW button. The Public Notice data fields are displayed (Figure 6-
64). 

 
Figure 6-64: Public Notice Data Fields 

4. Enter the information listed in Table 6-8. 
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Table 6-8: Public Notice Data Fields 

DATA FIELD INFORMATION TO BE ENTERED 

Appearance Date Date the Public Notice was posted 

Document of Record Name of publication that printed the notice 

Point of Contact Name of the contact person in the publication 

Telephone Number Telephone number of the contact person 

5. For each Public Notice you wish to add, repeat Steps 3 and 4. 

6. On the bottom left part of the Public Notice tab, click the SAVE button. 
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Task 11: Attach Documents 

CAUTION: Attachments cannot be deleted once they have been added to NEMIS 
HMGP. Please make every effort to limit the file attachment size to less 
than 1 GB. Allow up to one hour to retrieve and view newly attached 
documents. 

1. Click the Attachments tab (Figure 6-65). 

 
Figure 6-65: Mitigation > Projects > 
Application Development > Attachments Tab 

2. On the right side of the Attachments tab, click the ATTACH button. The 
Attachment dialog box is displayed. 

3. On the Document Type data field, click the drop-down arrow to display the 
different document types (Figure 6-66). Select the correct type. 

 
Figure 6-66: Attach Documents Dialog Box 

4. You are strongly urged to read and follow the instructions in Appendix A: 
Attach Documents. 

5. On the bottom left part of the Attachments tab, click the SAVE button. 



September 2016 Unit 6: Manage the HMGP Application 
 

NEMIS HMGP User Manual MR 3.19.01 Page 6-55 
  

Task 12: Enter Eligibility Review Information 

1. Click the Eligibility Review tab. Seven sub-tabs are displayed, of which only 
five are available for entering Eligibility Review information. The Overview 
sub-tab is displayed by default. (Figure 6-67). 

 
Figure 6-67: Mitigation > Projects > Application Development > 
Eligibility Review > Overview Sub-tab 

2. In the Eligibility Determination Criteria section, enter the information listed in 
Table 6-9. 

Table 6-9: Eligibility Determination Criteria Section Data Fields 

DATA FIELD INFORMATION TO BE ENTERED 

Applicant 

Required field 
Does the Project Applicant meet the Applicant Criteria in 44 CFR 
206.434(a)? Select one of the following: 

• Y (Yes) 
•  P (Pending) 
•  N (No) 

 Refer to the Recipient checklist, if applicable. 

Project Type 

Required field 

Does the project meet the Project Type criteria in 44 CFR 
206.434(c)? Select one of the following: 

• Y (Yes)  
• N (No) 

Refer to the Recipient checklist, if applicable. 

Project Criteria 

Required field 

Does the project meet the Project criteria in 44 CFR 206.434(b)?  
Select one of the following: 

• Y (Yes) 
• P (Pending) 
• N (No) 
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3. In the Other Reviews section, enter the information listed in Table 6-10. 

 Table 6-10: Other Reviews Section Data Fields 

DATA FIELD INFORMATION TO BE ENTERED 

Cost 
Effectiveness 
Review 

Required field 

Is the Cost Effectiveness Review complete? Select one of the 
following: 

• Y (Yes) 
• N (No) 

Code Compliance 
Review 

Required field 

Has the Project Applicant filed Code Compliance and Permit 
Granted documents? Select one of the following: 

• Y (Yes) 
• N (No) 

Mitigation Plan 
Conformance 

Required field 

Has the Project Applicant documented the part of the Multihazard 
Mitigation Plan with which the project conforms? Select one of the 
following: 

• Y (Yes) 
• N (No) 

Project Reviewer 

Required field 

Name of Recipient Mitigation Staff member who reviewed the 
application for eligibility considerations. It may be the same as the 
name of the preparer. 

Recommended 
for Approval? 

Required field 

Do you recommend this project for approval? Select one of the 
following: 

• Y (Yes) 
• N (No)   

Review Date Auto-filled with the current date once the Project Reviewer field is 
completed. 

4. Click the General Comments sub-tab (Figure 6-68). To enter General 
Comments, complete Steps 3a - 3c. 
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Figure 6-68: Mitigation > Projects > Application Development 
 > Eligibility Review > General Comments Sub-tab 

a. On the bottom left part of the General Comments sub-tab, click the 
NEW button. A new row is displayed with the Comment Date/Time, 
User and Amendment Number fields already filled in by the system 
(Figure 6-69).  

 
Figure 6-69: General Comments Sub-tab with New Row 

b. Double click inside the Comments field. The Comment Editor is 
displayed.  

c. Enter your comments and click the OK button. The comments you 
entered are displayed on the General Comments sub-tab (Figure 6-
70). 
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Figure 6-70: General Comments Sub-tab with Comments Added 

5. Click the Cost Comments sub-tab (Figure 6-71). To enter Cost Comments, 
complete Steps 4a 4c. 

 
Figure 6-71: Mitigation > Projects > Application Development > 
Eligibility Review > Cost Comments Sub-tab 

a. On the bottom left part of the Cost Comments sub-tab, click the NEW 
button. A new row is displayed with the Comment Date/Time, User and 
Amendment Number fields already filled in by the system (Figure 6-66).  
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Figure 6-72: Cost Comments Sub-tab with New Row 

b. Double-click inside the Comments field. The Comment Editor is displayed. 

c. Enter your comments and click the OK button. The comments you entered 
are displayed on the Cost Comments sub-tab (Figure 6-73). 

 
Figure 6-73: Cost Comments Sub-tab with Comments Added 

6. Click the Environmental Comments sub-tab (Figure 6-74). To enter 
Environmental Comments, complete Steps 5a - 5c. 
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Figure 6-74: Mitigation > Projects > Application Development > 
Eligibility Review > Environmental Comments Sub-tab 

a. On the bottom left part of the Environmental Comments sub-tab, click 
the NEW button. A new row is displayed with the Comment Date/Time, 
User and Amendment Number fields already filled in by the system 
(Figure 6-75).  

 
Figure 6-75: Environmental Comments Sub-tab with New Row 

b. Double click in the Comments field. The Comment Editor is displayed. 

c. Enter your comments and click the OK button. The comments you entered 
are now displayed on the Environmental Comments sub-tab (Figure 6-
76). 
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Figure 6-76: Environmental Comments Sub-tab with Comments Added 

7. Click the Env Checklist sub-tab (Figure 6-77). To add Environmental 
Checklist information, complete Steps 6a - 6e. 

 
Figure 6-77: Mitigation > Projects > Application Development > Eligibility 
Review > Env Checklist Sub-tab 

a. Click the NEW button. The New Alternative Name dialog box is displayed 
(Figure 6-78). 

 
Figure 6-78: New Alternative Name Dialog Box 
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b. Enter a name for the alternative solution. Click the OK button. The 
Standard Issues section is displayed (Figure 6-79). This section is a 
table that lists the standard environmental and historical issues in 
Table 6-11.  

 
Figure 6-79: Standard Environmental and Historical Issues 

Table 6-11: Standard Environmental and Historical Issues 

ISSUE EXPLANATION 

Aquatic and Terrestrial 
Biotic Resources 

If the project occurs in an area that has resources designated 
as aquatic or terrestrial, the impact must be documented  

Designated Floodplain/ 
Floodway 

If the project occurs in an area designated by the NFIP as a 
floodplain or floodway, the impact must be documented 

Hazardous Materials If hazardous materials (as designated by EPA’s hazardous 
materials regulations) are present at the project site, the 
impact of managing the materials must be documented 

Historic Structures If historic structures (as designated by the National Historic 
Preservation Act) are present, the impact on those structures 
must be documented 

Hydrology/ Hydraulics If the hydrology or hydraulics of the area might be impacted, 
the impact must be documented  

Land Use/Development 
Patterns 

If land use or development patterns might be impacted, the 
impact must be documented. A document to demonstrate 
consultation with the local government should be attached, 
following the instructions in Task 11: Attach Documents. 

Local Economy/ 
Community/ Services 

If a local economy, community, or services might be affected, 
the impact must be documented. A document to demonstrate 
consultation with the local government should be attached, 
following the instructions in Task 11: Attach Documents. 

Low-Income or Minority 
Populations 

If low-income or minority populations are present, the impact 
must be documented 

Prime Farmland If a prime farmland is present, the impact must be 
documented 

Slopes and Soils If slopes or special soils are present, the impact must be 
documented 
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ISSUE EXPLANATION 

Special Status Natural 
Areas 

If a natural area is present, the impact must be documented 

Threatened/ 
Endangered Species 

If a species designated as threatened or endangered is 
present, the impact on the species must be documented 

Water Quality Water impacts should be documented to meet the Clean 
Water Act requirements 

Wetlands If any wetlands are present, the impact must be documented 

c. For each Standard Issue in the list, complete the following steps. You 
will need to scroll down to display the rest of the Standard issues. 
i. Select the Status of the issue from the drop-down list. Select one 

of the following: 

• Not in project area 

• In project area with no effect 

• Presence in area undetermined 

• In project area - effect unknown 

• Adverse effect 

ii. In the State Agency Consulted checkbox, click inside if the 
appropriate State Agency was consulted. 

iii. In the Fed Agency Consulted checkbox, click inside if the 
appropriate Federal Agency was consulted. 

iv. In the Documentation Attached checkbox, click inside if 
documentation about the issues is attached. 

d. If additional environmental or historical issues were addressed by this 
alternative, click the NEW ISSUE button. A new row under the Other 
Issues section is displayed (Figure 6-80). 
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Figure 6-80: Other Issues Section - New Row 

e. For each new issue, complete the following steps. 

i. Enter a short description of the new issue. 

ii. Select the Status of the issue from the drop-down list. 

iii. In the State Agency Consulted checkbox, click inside if the 
appropriate State Agency was consulted. 

iv. In the Fed Agency Consulted checkbox, click inside if the appropriate 
Federal Agency was consulted. 

v. In the Documentation Attached checkbox, click inside if 
documentation about the issues is attached. 

8. To add another alternative solution, repeat steps 6a - 6e. 

9. After entering three alternative solutions and completing the checklists for 
each one, the Alternative Names are displayed in the top part of the Env 
Checklist sub-tab (Figure 6-81). 
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Figure 6-81: Env Checklist Sub-tab - Alternatives Section 

10. Select the proposed action from the Alternative Names by clicking inside the 
checkbox to the left of the Alternative Name. 

11. On the bottom left part of the tab, click the SAVE button. 

12. Click the FEMA Laws/EOs sub-tab. Read-only Status and Comments 
information are displayed (Figure 6-82). 

 
Figure 6-82: Mitigation > Projects > Application Development  > 
Eligibility Review > FEMA Laws/EOs Sub-tab 

13. Click the FEMA NEPA sub-tab. NEPA review information is displayed (Figure 
6-83). 
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Figure 6-83: Mitigation >Projects >Application Development >Eligibility 
Review >FEMA NEPA Sub-tab 
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Task 13A: Enter Property Site Inventory Information 

NOTE: If the Property Site Inventory tab is grayed out, it means that the project 
type selected on the Project Information tab does not require a Property 
Site Inventory (PSI). 

1. Click the Property Site Inventory tab (Figure 6-84). 

 

Figure 6-84: Mitigation > Projects > Application Development > Property Site 
Inventory Tab 

2. Enter the number of properties included in the project in the Number of 
Properties in Project field. 
NOTE: Unless the matrix indicates the project type is eligible for HMOS 
Validation, at closeout the number of properties in the project field entry must 
match the number of properties entered in the PSI for which the question  “Is 
this property included as part of the final project?” is answered YES!  (See Unit 
12 for additional information. 

3. Click the ADD button. The Look up a Property window is displayed 
(Figure 6-85). 

 
Figure 6-85: Look up a Property 

4. Enter information in the fields that you have data for. 

HINT: Providing more information speeds up the search for the property. 



Unit 6: Manage the HMGP Application September 2016 
 

Page 6-68  NEMIS HMGP User Manual MR 3.19.01 
 

5. Click the Search button. Information for the first property found is displayed. 
6. Scroll down through the search results until you find the property you wish to 

select (Figure 6-86). 

 
Figure 6-86: Displayed Information of a Found Property 

7. Click the OK button. The selected property information is now displayed on 
the Property Site Inventory tab (Figure 6-87). 

 
Figure 6-87: Selected Property Displayed on Property Site Inventory Tab 

8. Below the property information, nine sub-tabs are provided for adding 
Property Site Inventory information. The Owner Info sub-tab is displayed by 
default. 

NOTE: Fields in Purple text are required before a project closeout. Fields in Navy 
or blue text, are property attributes, which means that they will be 
carried over from project to project for a particular property site. If you 
update a blue field in one project, the field will be updated in all projects 
where this property appears. Fields in Red are both. Fields with a green 
background are required at application submission.  

9. To add Owner Information, enter the information listed in Table 6-12. 
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Table 6-12: Owner Information Data Fields 

DATA FIELD INFORMATION TO BE ENTERED 
Is this property 
included as part of the 
final project?  

Is the property included in the final project?  Select one of the 
following: 

• Yes 
• No - If No is selected, no further property 

information is required. 

Note: The response to this field cannot be changed after 
closeout. 

Co-owner Name of the person or organization who jointly owns the 
property.  

County County location of the property. Select from the drop-down 
list. 

Title Holder – Post 
Mitigation 
Required field 

Name of the organization, community, or person who will own 
the title to this property following the mitigation measures. 

MT Property Site –
Funds Paid? 
Required Field 

Were funds paid to the owner for the mitigation of the 
property? Select one of the following: 

• Yes 
• No 

10. Click the MT Property Site sub-tab (Figure 6-88). To add MT Property Site 
information, complete Steps 10a - 10c. 

 
Figure 6-88: Mitigation > Projects > Application Development > 
Property Site Inventory > MT Property Site Sub-tab 
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a. On the left side where the Property Actions are listed, highlight the row(s) 
you wish to select.  

b. Click the ADD or ADD ALL (if you highlighted more than one row) button. 
The Property Action(s) you selected is (are) now displayed on the right 
side (Figure 6-89).  

 
Figure 6-89: Property Action(s) Added 

c. Click inside the checkbox to indicate the one primary action. This is a 
required field for a Property Site Inventory. 

11. Click the Property Info sub-tab (Figure 6-90). To add Property Information, 
enter the information listed in Table 6-13. 

 
Figure 6-90: Mitigation > Projects > Application Development > 
Property Site Inventory > Property Info Sub-tab 

NOTE: Fields in Purple are required before a project closeout. Fields in Navy or 
blue, are property attributes, which means that they will be carried over 
from project to project for a particular property site. If you update a blue 
field in one project, the field will be updated in all projects where this 
property appears. Fields in Red are both. Fields with a green background 
are required at application submission.  
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Table 6-13: Property Information Data Fields 

DATA FIELD INFORMATION TO BE ENTERED 

Age of Structure 
Required field 

Year the structure was built 

Pre-Event Fair Market 
Value 

Dollar amount of the fair market value before the event 

Parcel Number 
Required field 

Parcel identification number 

Property Tax Id 

Required field 

Property tax identification number 

Latitude and Longitude 

Required field 

Latitude and Longitude readings in decimal degrees  
 

HINT: Click the SAMPLE button to see latitude and 
longitude entries (Figure 6-82).  

SHPO Cleared Has the State Historic Preservation Officer (SHPO) 
approved the property action?  Select one of the following: 

• Yes 
• No 
• Not Applicable 
• Unknown  

SHPO Cleared Date Date that the SHPO approved the action. 

Benefit-Cost Analysis 
Performed 

Has a Benefit-Cost Analysis (BCA) been performed?  
Select one of the following: 

• Yes, 
• No 
• Not Applicable 
• Unknown 

Benefit-Cost Ratio Ratio resulting from the BCA if a BCA was performed 

Type of Residence 

Required field 

Type of residence. Select one of the following: 

• Not Applicable 
• Owner Occupied - Principal Residence 
• Owner Occupied - Secondary Residence 
• Rental 
• Other (specify in comments) 
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DATA FIELD INFORMATION TO BE ENTERED 

Structure Type 

Required field 
Type of structure. Select one of the following:  

• Single Family 
• 2-4 Family 
• Multi-Family Dwelling (5 or more units)  
• Manufactured Home  
• Non-residential – private 
• Non-residential – public 
• Vacant Land 
• Other (specify in comments) 

Foundation Type 

Required field 
Type of foundation. Select one of the following: 

• Basement 
• Crawl Space 
• Elevated on Piers, Piles, Posts, Columns 
• Slab on grade 
• Vacant Land 
• Other (specify in comments) 

Basement 

Required field 

Is the structure a basement?  Select one of the following: 

• Yes 
• No 

Base Flood Elevation Computed elevation to which floodwater is anticipated to 
rise during the base flood 

First Floor Elevation Elevation, in feet, of the property.  

HINT: Click the DIAGRAM button to see what is meant 
by the first floor (Figure 6-83). 

Number of Feet Number of feet the lowest floor elevation of the structure is 
being raised above Base Flood Elevation (only applicable 
when Property Action is Elevation) 

Damage Category Percent of Property Damage. Select one of the following: 

• 0–49 percent 
• 50–99 percent 
• 100 percent 
• N/A 
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DATA FIELD INFORMATION TO BE ENTERED 

Post-Mitigation Property 
Use 
While not required 
here, it is required 
before project closeout 

Proposed property use. Select one of the following: 

• Agricultural 
• Park 
• Recreation 
• Vacant Land 
• Wetlands 
• Other (specify in comments) 

NOTE: Once you enter data in one field on a PSI sub-tab, all fields in green 
(required) on that sub-tab must be entered before you can SAVE that data 
and move to another sub-tab. Otherwise, you will have to cancel your 
changes, and your data will be lost. 

a. To see a sample of Latitude and Longitude entries in decimal degrees 
(Figure 6-91), click the SAMPLE button. 

 
Figure 6-91: Latitude and Longitude Sample 

b. To see an illustration of First Floor Elevation (Figure 6-92), click the 
DIAGRAM button. 



Unit 6: Manage the HMGP Application September 2016 
 

Page 6-74  NEMIS HMGP User Manual MR 3.19.01 
 

 
Figure 6-92: First Floor Elevation Diagram 

12. Click the Flood Zone Designation sub-tab (Figure 6-93). To add Flood Zone 
Designation information, complete Steps 11a - 11b. 

 
Figure 6-93: Mitigation > Projects > Application Development > 
Property Site Inventory > Flood Zone Designation Sub-tab 

a. On the left side where the Flood Zone Descriptions are listed, highlight the 
row(s) you wish to select. If you choose Other, you must specify a 
comment. 
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b. Click the ADD or ADD ALL (if you highlighted more than one row) button. 
The Flood Zone Description(s) you selected is (are) now displayed on the 
right side (Figure 6-94). 

 
Figure 6-94: Property Site Inventory - Flood Zone Description Added 

13. Click the NFIP Info sub-tab (Figure 6-95). 

 
Figure 6-95: Mitigation > Projects > Application Development > 
Property Site Inventory > NFIP Info Sub-tab 

To add National Flood Insurance Program (NFIP) Information, enter the 
information listed in Table 6-14. 
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Table 6-14: NFIP Information Data Fields 

DATA FIELD INFORMATION TO BE ENTERED 

Flood Source 

Required field 
Source of the flood hazard. Select one of the following: 

• Coastal Basin 
• Closed Basin 
• Riverine Flooding 
• Storm water Runoff 
• Other (comment required) 

Structure Located 
In 

Geographical location of structure. Select one of the following: 

• Floodway 
• Floodplain 
• Other High Hazard Area 
• Not Applicable 

Repetitive Loss 
Structure 

Required field 

Does this structure experience repetitive loss?  Select one of the 
following: 

• Yes 
• No 
• Unknown 

Repetitive Loss 
Number 

Also known as property locator number this is a unique 7 digit 
number assigned by the NFIP to repetitive loss properties 

NFIP Policy 
Number 

Flood insurance policy number 

Insurance Policy 
Provider 

Name of flood insurance company 

FIRM Available? Is there a Flood Insurance Rate Map (FIRM) available?  Select 
one of the following: 

• Yes 
• No 
• Unknown  

Is the property site marked on the map?  Click inside one of the 
following radio buttons: 

• Yes, map is attached 
• No, hard copy of map will be provided in hard copy 
• Not applicable 

14. Click the Hazard Type sub-tab (Figure 6-96). To add Hazard Type 
information, complete the following steps. 
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Figure 6-96: Mitigation > Projects > Application Development > 
Property Site Inventory > Hazard Type Sub-tab 

NOTE: The left side will display only hazards that were added in the Project Info 
tab  Hazard Types sub-tab. 

a. On the left side where the Hazard Descriptions are listed, highlight the 
row(s) you wish to select. 

b. Click the ADD or ADD ALL (if you highlighted more than one row) button. 
The Hazard Description(s) you selected is (are) now displayed on the right 
side (Figure 6-97). 

 
Figure 6-97: Hazard Description Added 

15. Click the FIRM Info sub-tab (Figure 6-98). To enter Flood Insurance Rate 
Map (FIRM) information, complete Steps 14a - 14k. 
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NOTE: FIRM information is required for Closeout. 

 
Figure 6-98: Mitigation > Projects > Application Development > 
Property Site Inventory > FIRM Info Sub-tab 

a. In the Community Information section, click the ADD button. A new row for 
adding community information is displayed. 

b. Click the drop-down button to display the communities available for 
selection (Figure 6-99). 

 
Figure 6-99: FIRM Info Sub-tab > Community Information Section 

NOTE: The communities in the selection list are those that you added in the 
Project Information tab  Community Names/Codes sub-tab.  If Statewide 
was used as the Community Name, no FIRM information will be displayed.  
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FIRM information is required for project closeout so communities are 
required to be selected for flood type projects. 

c. Select the community you wish to add. The community name is now 
displayed and a blank row is displayed under the section Map Specific 
Information For Selected Community. 

d. Under the Panel Number column, click the drop-down button. The 
Community Panel Numbers and their corresponding date are displayed. 
(Figure 6-100). 

 
Figure 6-100: Map Specific Information for Selected Community 

e. Select the Panel Number you wish to add. 
f. If the Panel Number you wish to add is not in the selection list, click the 

ADD button in the Map Specific Information section. Click Edit Panels. A 
Panels dialog box is displayed. 

g. Click the NEW button. A blank row is displayed (Figure 6-101). 

 
Figure 6-101: Panel Dialog Box 
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h. Enter a FIRM Panel Number and the date from the actual FIRM map 
(Figure 6-102).  

 
Figure 6-102: New FIRM Panel Number and Date Added 

16. Click the OK button. The newly-added FIRM Panel Number is now 
available for selection. 

17. Complete your Panel Number selections. 
18. On the bottom left part of the tab, click the SAVE button. 
19. Click the Property Site Funding sub-tab (Figure 6-103). Enter the 

information listed in Table 6-15. 

 
Figure 6-103: Mitigation > Projects > Application Development > 
Property Site Inventory > Property Site Funding Sub-tab 
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Table 6-15: Property Site Funding Data Fields 

DATA FIELD INFORMATION TO BE ENTERED 

MT Property Site - 
Funds Paid? 

WERE Federal funds expended for the property’s 
mitigation?  Select one of the following: 

• Yes 
• No  

MT Property Site - 
Funds Proposed 

Dollar amount offered to Owner. 

Date Funds Proposed Date the dollar amount was offered to Owner. 

Owner Accepted 
Proposed Funds? 

Did the Owner accept proposed funds?  Select one of the 
following: 

• Yes 
• Pending 
• No 
• Unknown  

Date Owner Responded 
to Proposal 

Date the Owner responded. 

Owner Appealed 
Proposal? 

If the Owner did not accept proposed funds, did Owner 
appeal the proposal? Select one of the following: 

• Yes 
• No 
• Unknown 

Date Owner Appealed Date the Owner appealed. 

Actual Amount Paid Amount paid to Owner. 

Date Actual Amount 
Paid   

Date amount was paid to Owner. 

NOTE:  Some of the fields in Table 6-15 will not be entered until closeout. 

20. Click the Narrative sub-tab (Figure 6-104). To add Property Site Inventory 
Narrative information, complete the following steps. 
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Figure 6-104: Mitigation > Projects > Application Development >  
Property Site Inventory > Narrative Sub-tab 

a. Click the radio button to select either Legal Description or Comment. 

b. Double-click inside the text area. The Comment Editor is displayed. 

c. Enter your text in the Comment Editor. 

d. Click the OK button. The text you entered is displayed on the Narrative 
tab. The system appends your User Name, the date and time to the end of 
the text. 

e. On the bottom left part of the tab, click the SAVE button. 
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Task 13B: Export, Update and Import the PSI Information 

This feature allows a user to export the PSI information from NEMIS HMGP to a 
spreadsheet. The user can then update the information on the spreadsheet, or add new 
properties or both and then import the spreadsheet back into the project application.  

1. Click the Property Site Inventory tab (Figure 6-105). 

 
Figure 6-105: Mitigation > Projects > Application Development > 

Property Site Inventory Tab 

2. Click the Export button. The Select File window will appear (Figure 6-106) 

CAUTION: There must be at least one property entered in the PSI of the project 
(Task 13A). You cannot export a blank spreadsheet; if there are no 
properties in the PSI, the following Error message will appear: There 
are no properties in the project status to export. 

 
Figure 6-106: Mitigation > Projects > Application Development > PSI Tab > 

Export > Select File Window 

3. Identify the location where you want to save the spreadsheet. In the File Name 
field, type a file name for the new exported PSI spreadsheet. If successful, the 
following PSI Export message will appear (Figure 6-107): 
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Figure 6-107: PSI Export Message – Export completed successfully 

4. Select OK. Navigate to where the spreadsheet was exported and open the 
spreadsheet.  

NOTE:  The spreadsheet will list the properties that were exported in numerical 
order by Property ID in the first column.  The spreadsheet column 
headers are color-coded in line with the system.  Green = required to 
submit project, Purple = required before project closeout, Navy = 
Property Attribute, Red = both required before project closeout and a 
property attribute.  The spreadsheet itself has several validations 
included.  Filling out the spreadsheet as completely and accurately as 
possible is the key to a successful import of the data and to maintaining 
the integrity of the property site inventory.  Everything possible should be 
done to avoid exporting and importing the spreadsheet multiple times. 
Comments and Legal Descriptions exported will be imported again 
creating duplicate records.  To avoid duplicate entries delete all 
previously entered comments and Legal Descriptions exported.  

5. Update the spreadsheet as needed. Certain fields in the spreadsheet must be 
entered as formatted by the spreadsheet; for example, if you enter four digits for 
the telephone area code instead of three, the spreadsheet will generate its own 
warning messages. You must correct the data entry before proceeding. 

6. The following fields are required for a successful import; NEMIS HMGP error 
messages reference the row number of the missing data. 
a) First and last name – Both are required fields. An Error message will be 

displayed if one or both of these fields is blank. 
b) Damaged Address Line 1 – An entry in this field is required. 
c) City, State and Zip – These are required fields for new and edited entries. 
d) County – If the county is missing, no error screen will be generated. However 

if a county is entered, as required before closeout, the system will compare 
the entry to the county records for the state and if not on the list or spelled 
incorrectly, an Invalid County error message will be displayed. 

e) Phone Type – If the phone number is entered without a Phone Type, an error 
message will be displayed. 
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f) Hazard -- The hazard the property is exposed to is required for import.  If 
missing or incorrect, you will receive an error message. 

g) Comments and Legal Description – While comments are not required, 
existing comments are exported, and if they remain in the spreadsheet, they 
will be imported along with the rest of the data.  If a spreadsheet is exported 
and imported enough times, the comments will be entered exponentially and 
exceed the maximum allowed characters. To ensure this does not happen 
and to ensure comments are not repeated, it is best to delete the legal 
description and especially the comments from the spreadsheet after export 
and only enter any new comments you wish to have imported with edited or 
newly added property records. 

7. The export/import feature is designed to function the same way as the 
system.  The status of the amendment being edited determines if you can 
import new properties or only edits to existing properties. For example: 

a) A project for which the amendment has already been approved (Figure 6-
108) will allow for an export and an import, but because the Add button is 
not lit you will only be able to edit and import the exported records.  You 
will not be able to import any new records.  Attempting to do so will result 
in the following error message: Project Eligibility has been completed; new 
Property is not allowed to be added to this project. 

 
Figure 6-108: Project with Amendment Approved, Add Button Grayed 
out and Export and Import Buttons Active 

b) A project amendment that has been approved (or otherwise disposed) and 
now has a higher amendment (Figure 6-109) can be exported but not 
imported.  Use the highest amendment when exporting and importing.  
However, if the highest amendment is not in pending status, you will only be 
able to import edited existing records.  Any attempt to import new properties 
when the Add button is not lit will result in an error. 
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Figure 6-109: Project File with a Higher Amendment, Export Only 

c) When importing a spreadsheet, any new properties will be compared to those 
already existing in the project. If an exact match is found, the import will be 
halted and a message similar to this will appear (Figure 6-110):  Property 
already exists in the project. Please note that only exact matches are 
identified, so if any differences exist such as a slightly different zip code or a 
damaged address line 2 in one record or not in the other, the record will not 
be identified as a duplicate and will be allowed to import.  While the message 
states to export and update the spreadsheet as required, it may only be 
necessary to update the existing spreadsheet by editing or removing the 
duplicate entry and then attempting the import again.  

 
Figure 6-110: Error Message – Duplicate Property 

d) If after an export properties are deleted from the PSI in the system, 
attempting to import a spreadsheet that has a property ID that no longer 
exists in the system will result in an error message: Property does not exist 
in the project.  It will not be possible to import the spreadsheet and it will be 
necessary to export the current PSI data and edit the existing records or add 
new records in the system if applicable.  The Property ID deleted from the PSI 
will not be regenerated, leaving a void in the Property ID records.   

8. Import the updated spreadsheet into NEMIS HMGP 
a) Verify that the spreadsheet is complete and accurate, and that new property 

locations are correctly added to the spreadsheet. This is very important to do 
before importing the updated spreadsheet into NEMIS HMGP. 

b) Import the spreadsheet into the existing PSI.  The process is similar to the 
export process except that you will select the Import button, and when the 
Select File screen appears, navigate to the updated spreadsheet you wish to 
import and either double click on the file or highlight the file and select Open.  
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9. If the import is successful, you will receive a PSI Import message indicating the 
Import/Update completed successfully (Figure 6-111). Select OK. 

 
Figure 6-111: PSI Successful Import Message 

CAUTION: Please note that if the number of properties imported is less that the 
number entered in the spreadsheet, one or more of the records was 
missing required information for the property and that record and any 
entered below the incorrect record will not be imported.  Since edited 
records were imported and some new records were possibly imported, it 
will be necessary to export the newly updated PSI again for additional 
edits and new records to be succesfully imported. If you save the new 
export with a new name, it will be possible to copy new property records 
from the old spreadsheet to the new one and then edit the copied data to 
meet the import requirements. 

 

HINT: Users are encouraged to test this PSI export/import process in TDL prior 
to attempting in production to get familiarized with the process. 

 

HINT: Required fields are identified with an asterisk (*) in the spreadsheet. 
Make sure all required fields are filled out. 
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Task 14: Enter Latitude and Longitude Information 

1. Click the Lat/Lon tab (Figure 6-112). 

 
Figure 6-112: Mitigation > Projects > Application Development > Lat/Lon Tab 

2. Click the SAMPLE button in the upper part of the tab. A diagram explaining 
Latitude and Longitude entries and a sample entry is displayed (Figure 6-
113). 

 
Figure 6-113: Sample Latitude/Longitude Information 

3. On the bottom left part of the Lat/Lon tab, click the NEW button. A new row 
for adding Lat/Lon information is displayed. 

4. Enter the Latitude and Longitude information in decimal degrees. 
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CAUTION: The latitude and longitude fields in HMGP - Application Development 
are decimal degrees. These fields will NOT accept latitude and 
longitude values in the form of degrees, minutes, and seconds, nor will 
it automatically convert them to decimal degrees. The user must 
convert the degrees, minutes and seconds to decimal degrees for entry 
into these fields (see Table 6-16). The latitude and longitude fields 
also will not accept State Plan Coordinates. See your GIS specialist for 
assistance. 

Table 6-16: How to Convert from Degrees-Minutes-Seconds to 
Decimal Degrees 

Degrees Minutes/60 Seconds/3600 Add Total Decimal 
Degrees 

39 36/60=0.600 30/3600=0.00833 39+0.600+0.00833 39.608330 

-105 15/60=0.250 45/3600=0.0125 105+0.250+0.0125 -105.262500 

*Divide Each Value By The Number of Minutes Or Seconds In A Degree 

Example: 39° 36’ 30," -105° 15’ 45” 

NOTE: The minus sign is not a mathematic operational symbol but rather 
signifies the quadrant on the globe. Therefore, the minus sign was not 
added to the number until after the totaling of the minutes and seconds 
to the degrees. 

 

HINT: The graphic below (Figure 6-114) provides the general rule for using the 
(+) and (-) signs to signify the quadrant location on the globe. 

 
Figure 6-114: General Rule for Using the + and - Signs 

Reference: ESRI On-Line Course – The Basics of Map Projections, Lesson One 

5. The Lat/Lon Verification field is a drop-down list of likely sources of the data. 
Select the source of the Lat/Lon data. 
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6. Double-click inside the Comment field. The Comment Editor is displayed. 

NOTE: Some examples of comments are: 

Coordinate system used (NAD 83, WGS 84, etc.) 

Accuracy level (very low, low, moderate, accurate, very accurate 

Accuracy value in feet or meters) 

Source (especially if the Lat/Lon Verification selected is “Other”) 

7. On the bottom left part of the Lat/Lon tab, click the SAVE button. 
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Task 15: Enter Authorization Information 

1. Click the Authorization tab. The Plan Information sub-tab is displayed by 
default (Figure 6-115). 

 
Figure 6-115: Mitigation > Projects > Application Development > 
Authorization Tab 

NOTE: All of the fields are auto-filled under the Plan Information sub-tab. If one 
of the required plans has not been entered into NEMIS HMGP under Unit 
4: (Manage the Mitigation Plans), you will get a warning message on the 
screen (see Figure 6-115). 

2. Click the Preparation Information sub-tab (Figure 6-116). Preparer and Title 
are auto-filled from information on the Applicant Information screen. To enter 
additional Preparation Information, complete Steps 2a - 2e. 
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Figure 6-116: Mitigation > Projects > Application Development > 
Authorization > Preparation Information Sub-tab 

a. Enter the Authorized Applicant Agent’s Last Name, First Name, and Title 
in the designated boxes. These are required fields. 

b. Use the drop-down list to choose Yes or No for Applicant Signature on 
File. 

c. Enter the Authorized Recipient Official’s Last Name and First Name in the 
designated boxes. These are required fields. 

d. Use the drop-down list to choose Yes or No for Recipient Official 
Signature on File.  

e. NEMIS HMGP enters the current date, but you can edit the date if 
necessary. 

CAUTION: If NO is selected in the Signature on File question, you will not be 
allowed to submit the application.  

3. Click the Managing Recipient Review sub-tab if it is not grayed out (Figure 
6-117). To add Managing Recipient Review information, complete Steps 3a - 
3c.  

 
Figure 6-117: Mitigation > Projects > Application Development >  
Authorization > Managing Recipient Review Sub-tab 
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a. For each Review Type, enter the Preparer and Reviewer names. 

b. Click on the icon to the right of the Preparer and Reviewer box to have the 
system automatically enter your User Name.  

c. Enter the Review Date. 
4. Click the FEMA Review sub-tab (Figure 6-118). 

 
Figure 6-118: Mitigation > Projects > Application Development >  
Authorization > FEMA Review Sub-tab 

NOTE: The fields will auto-fill as information is entered by FEMA personnel in 
Unit 7: Manage Eligibility Determination. 
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Task 16: Edit an Existing Project Application 

NOTE: A project application can be edited up until FEMA has completed the 
Eligibility Determination (Unit 7: Manage Eligibility Determination 
Information).  

NOTE: Once the project application has been approved or denied, the only task 
permitted is to attach documents, as described in Task 11: Attach 
Documents. To make other changes to an approved, denied, or withdrawn 
project application, follow the instructions in Unit 8: Manage 
Amendments. 

1. On the MITIGATION menu bar, click Projects > Application Development. 
A list of all projects (regardless of status) associated with the disaster number 
is displayed (Figure 6-119). 

 
Figure 6-119: Mitigation > Projects > Application Development > 
Project List 

2. Table 6-17 describes the information displayed on the Select Project screen. 

Table 6-17: Select Project Data Fields 

DATA FIELD INFORMATION DISPLAYED 

Disaster Nr Official number assigned to the disaster by FEMA 

FEMA Proj Nr Project application ID number assigned sequentially when 
the application is submitted to FEMA. 

Amendment Nr Sequential number assigned by the system. 0 is the 
number assigned to the initial application, 1 is assigned to 
the first amendment, etc. 
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DATA FIELD INFORMATION DISPLAYED 

Applic ID Number assigned by NEMIS HMGP or by the Recipient 
when a new record is created 

Suffix Type of funding requested. Codes include: 

• R (Regular Project Funding) 
• M (Recipient State Management Costs) 
• F (Initiative Projects) 
• P (Planning Projects) 

Auto-filled by the system after FEMA Mitigation staff 
complete Task 3 in Unit 7: Manage Eligibility Determination. 

ST Two-letter State code 

Region FEMA Region Number 

Project Title Description of the project application 

3. Highlight the project that you wish to edit. Click the OK button. 

4. The twelve tabs of Application Development are displayed. The Applicant 
Information tab is displayed by default. 

5. Click the tab of the application information that you wish to edit. 

NOTE: To edit Cost Estimate and Match Sources information, follow the 
instructions in Task 7, Step 7. 

 

CAUTION: If you are editing a project application that has been submitted, you 
need to alert FEMA to these changes because the project may be in the 
review process.  

 

HINT: To identify the Mitigation Analyst assigned to this project application, go 
to Mitigation Projects Eligibility Determination  In Process. Scroll to 
the right to view the FEMA Reviewer for the applicable project 
application. Contact that person via phone or email about the changes 
you entered in the system. 
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Task 17: Verify and Submit a Project Application 

1. Click the Authorization tab. On the bottom left part of the tab, click the 
VERIFY button. 

 
2. If any required fields are empty, error messages will be displayed indicating 

the missing field and the Application Development tab where you can enter 
the missing information (Figure 6-120). 

 
Figure 6-120: Pre-Calculated Benefit Missing Warning Message 

3. Make the necessary corrections and click the VERIFY button again. 

4. Table 6-18 provides a list of required fields and their location in Mitigation 
>Projects> Application Development. 

Table 6-18: Required Fields and System Location 

REQUIRED INFORMATION APPLICATION DEVELOPMENT TAB 

Recipient/Subrecipient Applicant Information 

Project Type Project Info  

Project Title Project Info  

Counties Project Info  

Congressional Districts Project Info  

Community Name Project Info  

Hazard Type Project Info  

At least one Work Schedule Item Work Schedule  

At least one Cost Estimate Item Cost Estimate  

At least one non-Federal share Line Item Match Sources 

Cost Effectiveness Information  for each 
Community 

Cost Effectiveness  
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REQUIRED INFORMATION APPLICATION DEVELOPMENT TAB 

At least one Property Inventory: 

Owner, Structure Type, Property Damage 
Category, Foundation Type 

Property Site Inventory  

NFIP Info: 

Flood Source, Repetitive Loss Flag, Flood 
Zone Code, Repetitive Loss Category 

Property Site Inventory  > NFIP Info Sub-
tab 

Environmental Checklist for at least one 
Alternative 

Eligibility Review >Env Checklist Sub-tab 

Authorized Applicant Agent and Authorized 
Recipient Official Names, Titles and  
signatures on file  

Authorization 

Project Reviewer Eligibility Review > OverviewSub-tab 

Eligibility Determination Criteria - Applicant, 
Project type, Project Criteria 

Eligibility Review> OverviewSub-tab 

Other Reviews - C/E Review, Code 
Compliance, Mt Plan Conformance 

Eligibility Review > OverviewSub-tab 

Approval Recommendation Eligibility Review >OverviewSub-tab 

5. Table 6-19 lists attachments that are required for the project application. 
Project applications may be submitted in NEMIS HMGP without these items 
but these documents must be attached before FEMA’s final approval in the 
eligibility determination process (Unit 7: Manage Eligibility Determination). 

Table 6-19: Required Project Application Attachments 

DOCUMENTS TASK 

History, Alternatives, Proposed 
Actions 

Task 3: Attach Problem & Risk Data 

Project Description Task 4: Enter Project Information 

Maintenance Assurance  Task 9: Attach Maintenance Assurance Information 

a. For any missing attachment, you will get the following warning 
message (Figure 6-121) when you click the VERIFY button: 
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Figure 6-121: Missing Required Attachment Message 

6. Click the OK button. A message that all checks were completed successfully 
is displayed (Figure 6-122). 

 
Figure 6-122: Verification Complete Message 

7. Click the OK button. 

8. On the bottom left part of the tab, click the SUBMIT button. The Final 
Submission dialog box is displayed (Figure 6-123). 

NOTE: When you click the SUBMIT button, NEMIS HMGP will automatically verify 
the application before displaying the Final Submission dialog box. 

 
Figure 6-123: Final Submission Dialog Box 

9. Click the YES button. The project application is submitted to FEMA. A 
message is displayed that the work packet for the Receipt and Delegate task 
in the Eligibility Determination process was created (Figure 6-124). 
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Figure 6-124: Work Packet Created Message 

10. On the bottom right part of the tab, click the CLOSE button. 
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Task 18: Zero Out a Project 

1. Click the Match Sources tab (Figure 6-125). Read the warning and click OK. 

 
Figure 6-125: Mitigation > Projects > Application 
Development > Match Sources Tab  

2. Select an item by clicking inside any of the Non-Federal funding fields. On the 
bottom left part of the tab, click the DELETE button. 

3. Repeat Step 2 for additional items that you wish to delete. 

4. Click the Cost Estimate tab and delete all line items.  

5. On the bottom left part of the Cost Estimate tab, click the SAVE button. 

6. Still in the Cost Estimate tab, click the NEW button. A new row for Cost 
Estimate information is displayed. 

7. Enter a line item with a Unit Quantity of "1" and a Unit Cost of "0." 

8. On the bottom left part of the tab, click the SAVE button. 

9. The message "Data has been saved" is displayed. Click the OK button on the 
message box. 

10. Click the Match Sources tab. 
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11. On the bottom left part of the tab, click the NEW button. A set of data fields for 
Non-Federal Funding information is displayed. 

12. Enter the information in the required data fields (boxes are shaded green). In 
the Unit Cost column, you must enter "0." 

13. On the bottom left part of the tab, click the SAVE button. The message "Data 
has been saved" is displayed.  

14. Click the OK button on the message box. 

15. On the bottom right part of the tab, click the CLOSE button. 

16. Verify that the task has been done correctly by completing the following steps. 

a. On the MITIGATION menu bar, click on Projects>Eligibility Determination > 
View All. The project list is displayed. 

b. Select the project that has just been zeroed out. Click the OK button. 

c. Click the Cost Review tab. The project dollar amounts should now be "$0." 
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Task 19: Copy an Un-submitted Project to a More Recent Disaster 

FEMA personnel with the HMO position now have the option of copying an un-
submitted application from one disaster to a more recent disaster. This will reduce or 
eliminate the need to re-enter an application that was not funded in one disaster but can 
be submitted to a more recent disaster for federal eligibility.  

Users who are not FEMA personnel with the HMO position can either re-enter the 
application in its entirety under the more recent disaster, or contact the FEMA regional 
office for assistance. 

If the user chooses to copy a project from one disaster to a more recent disaster, the 
following prerequisites must be met: 

• The status of the more recent disaster where the application shall be copied from 
is OPEN.  If the disaster is CLOSED, the system will generate the following 
Project Copy message: You must select an open disaster to copy the 
project. 

• The status of the project that is to be copied must be OPEN.  If the project 
selected is CLOSED, the system will generate the following Project Copy 
message: You must select an open project for the copy. 

• The project that is to be copied must NOT be obligated. If the project selected for 
copy is obligated for $1 or more, the system will generate the following Project 
Copy message: There is already an accepted obligation for this project. This 
project cannot be copied. 

• The Recipient State or Tribe being used when copying for both the original 
disaster and the more recent disaster must be the same.  If they are not the 
same, the system will generate the following ERROR message: You must use a 
disaster declared in the same state when copying an application. 

• The project must be copied to a disaster with a more recent declaration date than 
the declaration date of the original disaster.  If this is not the case, the system will 
generate the following Project Copy message: You must select different 
disaster with later declaration date to copy the project.  

If every prerequisite above is met, the process to copy an application from one disaster 
to another is as follows.  

1. On the MITIGATION menu, select Projects > Application Development. Make 
sure you are on the disaster where the original application is. When the 
Application Development screen appears, select or highlight the project to be 
copied, and then click on the COPY button (Figure 6-126). 
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Figure 6-126: Mitigation > Projects > Application Development > Copy 

2. The Select Disaster screen will appear. Enter or select the new disaster number 
to which the project is to be copied and select OK (Figure 6-127). 

 
Figure 6-127: Mitigation > Projects > Application Development > 

Copy > Select Disaster Screen 
3. The following Project Copy message will be displayed: Subrecipient Mitigation 

Plan Type, Subrecipient Mitigation Plan Title, Subrecipient Mitigation Plan 
Approval Date, Subrecipient Mitigation Plan Expiration Date and Eligibility 
Review – Overview tab information, will not be copied to the new 
application.   

4. Select OK. If successful, a message will be displayed confirming that the project 
copied over to the new disaster with a new application ID (Figure 6-128). 
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Figure 6-128: Confirmation of Project Copied to a New Disaster 

5. The project will now appear in the Select Project: Application Development 
(Figure 6-129). Change the name of the project, add the Subrecipient plan 
information, complete the eligibility review and make any additional edits before 
submitting the project to federal eligibility. 

  
Figure 6-129: Select Project: Application Development Screen 

Showing Project Copied to the New Disaster 
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References for Manage Project Application 

Flood Zone Codes 
Project Type Codes 
Property Site Inventory - Hazard Types 
Property Site Inventory - Property Actions 
Available Reports 
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Table 6-20: Flood Zone Codes 

CATEGORY CODE DESCRIPTION 

C, X Area of minimal flood hazards 

B, X Area of moderate flood hazards 

N Area of moderate mudslide (i.e., mudflow) hazards 

AR Area of special flood hazard that results from the decertification of a 
previously accredited flood protection system that is determined to be in 
the process of being restored to provide a 100-year or greater level of 
flood protection 

A99 Area of special flood hazard where enough progress has been made on 
a protective system, such as dikes, dams, and levees, to consider it 
complete for insurance rating purposes 

A1-30, AE Area of special flood hazard with water surface elevations determined 

A Area of special flood hazard without water surface elevations 
determined 

A0 Area of special flood hazards having shallow water depths and/or 
unpredictable flow paths between one and three feet 

V0 Area of special flood hazards having shallow water depths and/or 
unpredictable flow paths between one and three feet and with velocity 

AH Area of special flood hazard having shallow water depths and/or 
unpredictable flow paths between one and three feet, and with water 
surface elevations determined 

V1-30, VE Area of special flood hazards with water surface elevations determined, 
and with velocity, that is inundated by tidal floods (coast high hazard 
area) 

V Area of special flood hazards without water surface elevations 
determined, and with velocity, that is inundated by tidal floods (coast 
high hazard area) 

E Area of special flood-related erosion hazards 

M Area of special mudslide (i.e., mudflow) hazards 

D Area of undetermined but possible flood hazards 

P Area of undetermined, but possible mudslide hazards 

Other Specify in comments 
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Project Type Codes 
To see the list of Project Types available complete the following steps: 

1. On the Mitigation menu bar, click Admin > Project Type Matrix Information 
(Figure 6-130). 

 
Figure 6-130: Mitigation > Admin > Project Type Matrix Information 

2. A list of project types is displayed (Figure 6-131). You may use any that are 
checked under the HMGP column. Check this table often because the 
information is subject to change. 
The table displays other pertinent information such as: 

• Code descriptions 

• Whether the code is a legacy code (i.e., a code use in pre–3.0 NEMIS 
HMGP version releases) 

• Whether the code requires a PSI 

• Whether the code is applicable to HMGP, FMA, or the HMGP 
Historical Database 

• Predecessor code (for example, Code 90.1,  Mitigation Plan –Local 
Multi-hazard Mitigation Plan, is the predecessor of Code 91.1, Local 
Multi-hazard Mitigation Plan) 



Unit 6: Manage the HMGP Application September 2016 
 

Page 6-108  NEMIS HMGP User Manual MR 3.19.01 
 

 
Figure 6-131: Project Type Matrix  
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Property Site Inventory - Hazard Types 
• Biological 

• Chemical 

• Civil Unrest 

• Coastal Storm 

• Crop Losses 

• Dam/Levee Break 

• Drought 

• Earthquake 

• Fire 

• Fishing Losses 

• Flood 

• Freezing 

• Human Cause 

• Hurricane 

• Land Subsidence 

• Mud/Landslide 

• Nuclear 

• Severe Ice Storm 

• Severe Storm(s) 

• Snow 

• Special events 

• Terrorist 

• Tornado 

• Toxic Substances 

• Tropical Cyclones 

• Tsunami 

• Typhoon 

• Volcano 

• Wind Storms 

• Other (Specify in 

comments)
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Property Site Inventory - Property Actions 
• Acquisition of Vacant Land 

• Acquisition/Démolition 

• Acquisition/Relocation 

• Elevation 

• Flood-proofed 

• Other (Specify in comments) 

• Safe Room/Wind Shelter 

• Seismic Retrofit 

• Wildfire Retrofit 

• Wind Retrofit 
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Available Reports 
To track and document the process of Managing Project Applications, the 
following reports can be generated, as described in Unit 14 - Generate Standard 
HMGP Reports: 

• Project Cost Line Item Report 

• Non-Federal Share Fund Report 

• Property Site Inventory Report 

• Application Development Report 
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 Overview 

The NEMIS HMGP Manage Eligibility Determination process allows FEMA staff 
to track the review and approval process for each HMGP project application 
submitted for FEMA approval. 
Table 7-1 provides an overview of the Manage Eligibility Determination process. 

Table 7-1: Manage Eligibility Determination Process 

ITEM DESCRIPTION 

Purpose Review and determine project eligibility for HMGP funding 

When does it 
start? 

After the Recipient has submitted the project applications 

Who does it? • FEMA Regional Hazard Mitigation Officers (HMO) 

• FEMA Mitigation Analysts (MA) 

• FEMA Headquarters Staff 

• FEMA Regional Environmental Officer 

How is it 
done?   

Execute 13 tasks: 

Task 1: Access an Eligibility Determination Work Packet  

Task 2: Execute Receipt and Delegate 

Task 3A: Execute Application Completeness Review  

Task 3B: Execute Withdraw or Void 

Task 4:  Execute Laws/Executive Orders Review 

Task 5:  Execute NEPA Documentation Review 

Task 6: Execute Environmental Officer Review  

Task 7: Execute Cost Review  

Task 8: Execute Eligibility Review  

Task 9: Execute Project Approval Decision 

Task 10: Execute Approval Decision Concurrence 

Task 11: Complete the Application Detail Tab   

Task 12: Execute Final Project Approval Decision  
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Work Packets 

To manage the Eligibility Determination process workflow, NEMIS HMGP 
provides system work packets. For each task in the Eligibility Determination 
process, there is a system work packet. While the task is ongoing, the work 
packet status starts out as "REVIEW." When the task gets completed, the work 
packet status changes to "COMPLETE." The system automatically creates the 
work packet for the next task. If concurrent tasks follow the completed task, a 
work packet is created concurrently for each of the tasks. 

Work packets follow the workflow sequence of the HMGP Eligibility 
Determination process. The flow of the work packets can be bidirectional. If, at 
several key points, a reviewer determines that a task needs to be reworked, the 
direction of the workflow is reversed. The work packet is sent back to the 
assigned user for rework and the status changes to "REWORK.” 

 
Figure 7-1: Eligibility Determination Work Packet Sequence 

Figure 7-1 illustrates the Eligibility Determination process workflow in the system. 
The diagram shows that after the Application Completeness Review task is 
completed, the following four tasks are executed concurrently. Thus, the system 
will generate the four work packets simultaneously. 

• Laws/EOs Review 

• NEPA Documentation Review 

• Cost Review 

• Eligibility Review 
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The Project Approval Decision work packet provides an example of a possible 
reverse flow. While completing that task, the reviewer may identify a need for 
rework. Depending on which review needs reworked, the work packet can be 
sent back to the Environmental Officer Review, the Cost Review, or the Eligibility 
Review. 

After projects are submitted for Federal eligibility, any changes made to the 
project are verified to pass validation. If the steps taken do not pass validation, 
an appropriate message is displayed. 

While attempting to “complete work step” during the Federal eligibility a 
notification of missing data may be received. It will be necessary to update the 
project to include missing data to proceed with the Federal eligibility process. Any 
attempts to improperly revise the application by removing required data will be 
prohibited.  

Table 7-2 lists the NEMIS HMGP Group ID and the workflow tasks that each 
group is responsible for. 

Table 7-2: Group ID - Work Packets Assignment Table 
GROUP ID 

ASSIGNED WORKFLOW TASKS 

MT HMO 
Receipt and Delegate 
Approval Decision Concurrence 
Final Project Approval 

MT Analyst (MA) 
Application Completeness Review 
Eligibility Review  
Project Approval Decision 

MT Cost Reviewer (CSTRV) 
Cost Review 

MT Environmental Reviewer (ENVRV) 
Laws/EOs Review 
NEPA Documentation Review 

MT Environmental Officer (ENVOF) 
Environmental Officer Review 
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Task 1: Access an Eligibility Determination Work Packet 

1. On the MITIGATION menu bar, click on Projects > Eligibility Determination > In 
Process (Figure 7-2). 

 
Figure 7-2: Mitigation > Projects > Eligibility Determination > In Process 

2. If you see this message, the project applications for the disaster have not yet 
been submitted (Figure 7-3). 

 
Figure 7-3: No Work Packets Found Message 

3. If project applications have been submitted, the Mitigation Work Packet List is 
displayed (Figures 7-4 and 7-5). Table 7-3 describes the information 
displayed on the screen. 

NOTE: The Group ID of the current user is displayed on the top left part of the 
screen.  
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Figure 7-4: Mitigation Work Packet List - Left Side 

 
Figure 7-5: Mitigation Work Packet List - Right Side 

4. The box on the far left column of each row in the Mitigation Work Packet list 
indicates the following: 

• A green solid box means you can execute that work packet now. 

• A green patterned box means you can execute that work packet once 
other required workflow tasks are completed. 

• A yellow solid box means that the work packet must be executed by a 
user logged in with a different Group ID. You can view the information 
however. 
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Table 7-3: Mitigation Work Packet List Data Fields 

DATA FIELD INFORMATION DISPLAYED 
Region FEMA Region where disaster occurred  

Dstr No FEMA disaster number 

Applic ID Recipient project application number 

Amend Number Project application Amendment Number 

FEMA Proj No System-generated FEMA project application number when 
project is submitted to FEMA 

State State where disaster occurred 

Workflow Description Current task in the Eligibility Determination process 

Status Work Packet status 

Project Title Project Title 

FEMA Reviewer For amendments, the person who executed the Project Approval 
Decision of the project application for which this is an 
amendment 

Previous Reviewer User 
Id 

For amendments, the NEMIS HMGP user identification of the MA 
who processed the original or previous project application 

Assigned Analyst The name of the MA designated to oversee the project 
application’s eligibility review 

Declaration Request 
Letter Prompt Answer 

Was the Declaration Request Letter received? 
0 - No or Unanswered 
1 - Yes 

Public Information 
Officer Notification 

Was the Public Information Officer notified? 
0 - No or Unanswered 
1 - Yes 

SF-424 Notification Was the SF-424 received? 
0 - No or Unanswered 
1 - Yes 

Application Submission 
Date 

Date of project application submission in NEMIS HMGP 

Application Receipt 
Date 

If the project application was submitted in NEMIS HMGP, same 
as the Application Submission Date 
If the project application was submitted in hard copy, date 
received at the FEMA Regional Office 

Workflow Queue Name Internal system name for the workflow queue 

Application Name Work Packet name 
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5. On the bottom part of the Mitigation Work Packet List screen, the following 
buttons are available (Figure 7-6).  

 
Figure 7-6: Mitigation Work Packet List Buttons 

6. On the bottom left part of the screen, click the WORK FLOW MAP button. A 
graphic of the project application's work packets, their place in the eligibility 
determination workflow, and your current Group ID is displayed (Figure 7-7). 6a-
6d describes the steps you can do on the Workflow Map Diagram screen. 

 
Figure 7-7: Workflow Map Diagram 

The squares in the diagram follow the legend below: 

• Blue solid squares represent workflow tasks that have been 
completed. 

• Green solid squares represent workflow tasks that are ready for you to 
execute. 

• Yellow squares (solid or crisscrossed) represent workflow tasks that 
you cannot execute with your current Group ID. You can however view 
the work packet information. 

• Squares with crisscrossed lines represent workflow tasks that cannot 
be completed until other reviews are completed first. 
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a. On the bottom of the Workflow Map Diagram screen, click the CHANGE 
GROUP button. This allows you to change your Group ID without going 
back to the MT Login process. 

b. After you select your new Group ID, the diagram is refreshed 
automatically. 

c. From this diagram screen, you can choose to execute a work packet by 
clicking on a green solid square. Remember, green solid squares 
represent tasks that are ready for you to work on. 

d. If you do not choose to execute or view any of the work packets in the 
diagram, click the CLOSE button. The Mitigation Work Packet List is 
displayed once again. 

7. On the bottom right part of the Mitigation Work Packet List screen, the CHANGE 
GROUP button is available. Clicking that button and selecting another group will 
refresh the Work Packet List automatically. 

8. Clicking the REFRESH button will update the Work Packet List. 

9. You can choose to execute a work packet on the list by completing the following 
steps. Make sure there is a green solid box on the far left column. 

a. Highlight the work packet row that you wish to access. 

b. On the bottom right part of the screen, click the OK button. The selected 
work packet review screen is displayed. 

10. You can choose to view a work packet on the list by repeating Steps 9a - 9b. You 
have read-only access to work packet information if there is a yellow solid box on 
the far left column. The Work Packet review screen will be displayed but you will 
not be able to enter any information. 

11. When the work packet review screen is displayed, the Mitigation Work Packet 
List automatically gets minimized to the bottom left part of the screen. You can 
display the list again by clicking the Restore button (Figure 7-8). 

 
Figure 7-8: Minimized List Screen 
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Task 2: Execute Receipt and Delegate 

1. On the MITIGATION menu bar, click on Projects > Eligibility Determination > 
In Process. The Mitigation Work Packet List is displayed (Figure 7-9). 

 
Figure 7-9: Mitigation Work Packet List 

2. On the top left corner of the screen, check that you are logged in with the 
HMO Group ID. 

3. Highlight the row of the project that says "Receipt and Delegate" under 
Workflow Description. Check that there is a solid green box on the far left 
column of the row. 

4. Click the OK button. The Eligibility Determination screen is displayed with ten 
tabs. The Overall Review tab is displayed by default (Figure 7-10). 

 
Figure 7-10: Mitigation > Projects > Eligibility Determination > Overall 
Review Tab 
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5. On the bottom left part of the Overall Review tab, click the COMPLETE 
WORK STEP button. The Workflow Receipt and Delegate dialog box is 
displayed (Figure 7-11).  

 
Figure 7-11: Receipt and Delegate Dialog Box 

6. Enter the information listed in Table 7-4. 

Table 7-4: Receipt and Delegate Dialog Box Data Fields 

DATA FIELD INFORMATION TO BE ENTERED  

Receipt Date Date the project application was submitted to FEMA. The 
system auto-fills the current date. Edit the date if necessary. 

If the project application was submitted in NEMIS HMGP, 
enter the same date as the Application Submission Date in 
the Mitigation Work Packet List. 

If the project application was submitted in hard copy, date 
received at the FEMA Regional Office.  

Mitigation Analyst Name of the FEMA Mitigation Analyst (MA) who will oversee 
the eligibility review of the project. 

NOTE: Other MAs will not be excluded from viewing this 
project application. 

 

Generate Letter of 
Response 

Should the system launch MS Word to generate a letter of 
response to the Recipient?  Click Yes or No. 

7. Click the OK button. The Forward Work Packet Dialog Box is displayed 
(Figure 7-12). 



Unit 7: Manage Eligibility Determination September 2016 
 

Page 7-12  NEMIS HMGP User Manual MR 3.19.01 

 
Figure 7-12: Forward Work Packet Dialog Box 

8. Click the OK button. This will update the Receipt and Delegate work packet 
status to "COMPLETE.” The next work packet in the workflow, Application 
Completeness Review, will be created by the system. A Workflow Success 
system message is displayed (Figure 7-13). 

 
Figure 7-13: Workflow Success Message 

9. If you selected "Yes" in the Generate a Letter of Response data field, MS 
Word is automatically launched with a form letter. The References section of 
this unit provides a Sample Letter of Response. 

a. Type the project-specific data on the form letter. If your Region uses 
another form letter, open the file for that other form letter. 

b. Address the letter to the State Director or State HMO, depending on 
Regional policy. 

c. Save the document using the Save As feature, making sure to give the 
letter a different file name. 

d. Print the document. 

e. Exit out of MS Word. 

10. Back on the bottom right of the Overall Review tab, click the CLOSE button. 
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11. On the bottom left part of the screen, the Mitigation Work Packet List screen 
remains minimized. Restore the screen by clicking the MAXIMIZE button (the 
square icon). The screen is now maximized. 

12. On the bottom right part of the screen, click the REFRESH button. Notice that 
the project application that just went through the Receipt and Delegate 
process now says "Application Completeness Review" under Workflow 
Description (Figure 7-14). 

 
Figure 7-14: Refreshed Mitigation Work Packet List 
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Task 3A: Execute Application Completeness Review 

1. On the MITIGATION menu bar, click on Projects > Eligibility Determination >  In 
Process. The Mitigation Work Packet List is displayed (Figure 7-15). 

 
Figure 7-15: Mitigation Work Packet List 

2. On the top left corner of the screen, check that you are logged in with the MA 
Group ID.  

3. Highlight the row of the project that says "Application Completeness Review" 
under Workflow Description. Check that there is a solid green box on the far 
left column of the row. 

4. Click the OK button. The Eligibility Determination screen is displayed with ten 
tabs. The Overall Review tab is displayed by default (Figure 7-16). 

 
Figure 7-16: Mitigation > Projects > Eligibility Determination > Overall Review Tab 

5. On the bottom left part of the tab, click the APPLICATION DEV button. The 
system displays the Mitigation > Projects > Application Development tabs for 
that project (Figure 7-17). 
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Figure 7-17: Mitigation > Project > Application Development 

6.  In the Application Development tabs, complete the following steps: 

a. Review the information in all the tabs for consistency, completeness, and 
accuracy. 

b. Click the Project Info tab.  
i. On the bottom half of the tab, click the Project Type sub-tab. 

ii. Note the Project Description(s) listed on the right-hand box. You will 
need this information in Step 12. 

c. Click the Cost Estimate tab. On the bottom right part of the tab, note the 
answer to the question "Is the project part of the initiative?" You will need 
this information in Step 12. 

d. On the bottom right part of the Cost Estimate tab, click the CLOSE 
button. The Overall Review tab of Eligibility Determination is displayed. 

7. On the bottom left part of the Overall Review tab, click the COMPLETE 
WORK STEP button. The Application Completeness Review dialog box is 
displayed (Figure 7-18). 
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Figure 7-18: Application Completeness Review Dialog Box 

8. To obtain the information for each of the questions in the dialog box, complete 
steps 9 - 12.  

9. Question: Has the State HMGP Administrative Plan been Approved? 

a. On the MITIGATION menu bar, click Disaster >  Overview >  Recipient 
Information tab.  

b. In the middle section of the tab, the Recipient HMGP Administrative Plan 
details are displayed. 

c. If there is an Approval Date, the answer to the question is "Yes.” 

10. Question: Has a Letter of Intent been Received? 

HINT: You may also refer to the Governor's Letter of Request to check if 
HMGP assistance was requested. If yes, this is equivalent to receiving 
the State's Letter of Intent. If there is no Letter of Intent, AND, HMGP 
assistance was not requested, contact your Regional MT Help Desk for 
guidance. 

11. Question: Has a SF-424 been received? 

a. On the MITIGATION menu bar, click on Disaster > Overview. The eight 
tabs of Disaster Overview are displayed.  

b. Click the SF424 tab. 

c. Locate the row of the correct Recipient/Subrecipient. 
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d. If there is a number in the SF424 Number column, the answer to the 
question is "Yes.” 

HINT: If the SF424 Number column is blank, indicating that the SF424 has 
not been received, contact your Regional MT Help Desk for guidance. 

12. Question: Suffix Type Code 

SELECT THE CORRECT SUFFIX TYPE CODE! 

CAUTION: If the Suffix Type Code is entered incorrectly, it cannot be changed 
in the Eligibility Determination tabs. The project application must 
first be voided by the HMO (Task 2: Execute Receipt and Delegate 
Review). Second, the Recipient must create a new project 
application and submit it. 

a. The drop-down selection list of Suffix Type Codes includes: 

• Project Planning (P) 

• Management (M) 

• Initiative (I) 

• Regular (R) 

b. In Step 6b you obtained the Project Descriptions(s) for this project 
application.  

i. If the project description refers to a plan, the Suffix Type Code is 
Project Planning. 

ii. If the project description refers to management, the Suffix Type 
Code is Management. 

c. In Step 6c you obtained the answer to the question "Is the project part of 
the initiative?"  If the answer was "Yes,” the Suffix Type Code is Initiative. 

d. If none of the conditions listed in Steps 12b and 12c apply to the project, 
then the Suffix Type Code is Regular. 

13. After you answer all the questions in the Application Completeness Review 
dialog box, click the OK button. 

a. If you selected "No" to any of the first three questions, the system confirms 
if it should continue completing the work step (Figure 7-19). 
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Figure 7-19: Continue Completing Work Step Confirmation Message 

i. Click the CANCEL button to return to the Eligibility Determination - 
Overall Review tab OR 

ii. Click the OK button if you wish to continue. The Forward Work 
Packet dialog box is displayed (Figure 7-20). 

b. If you selected "Yes" for all the three questions in the Application 
Completeness Review dialog box, the Forward Work Packet dialog box is 
displayed (Figure 7-22). 

 
Figure 7-20: Forward Work Packet Dialog Box 

14. Click the OK button in the Forward Work Packet dialog box. The Workflow 
Success system message is displayed (Figure 7-21). 

 
Figure 7-21: Workflow Success Message 

15. Click the OK Button. The Overall Review tab is displayed. 

16. On the bottom right part of the Overall Review tab, click the CLOSE button. 

17. On the bottom left part of the screen, the Mitigation Work Packet List screen 
remains minimized. Restore the screen by clicking the Maximize Button (the 
square icon). The screen is now maximized. 
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18. On the bottom right part of the screen, click the REFRESH button. The project 
application that just went through the Application Completeness Review process 
now has four work packets displayed under the Workflow Description column 
(Figure 7-22):  

• Laws/EOs Review 

• NEPA Documentation Review 

• Cost Review 

• Eligibility Review  

 
Figure 7-22: Work Packets after Application Completeness Review 

The project application is now ready to go through four work packets concurrently and 
can be completed in any order. Refer to the following tasks for each of the three 
processes: 

• Task 4: Execute Laws/EOs Review  

• Task 5: Execute NEPA Documentation Review 

• Task 7: Execute Cost Review  

• Task 8: Execute Eligibility Review 

NOTE: Once the Application Completeness Review is complete, the project 
amounts are added to the figures on the HMGP Budget Planning 
screen. For details on this tab, refer to Unit 5, Task 8: Review Budget 
Planning Information. 
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Task 3B: Execute Withdraw or Void 

HINT: At any point during the Eligibility Determination process, the project 
application can be withdrawn or voided. 

1. Follow Steps 1 – 4 from Task 3A above. The Eligibility Determination screen 
is displayed with ten tabs. The Overall Review tab is displayed by default 
(Figure 7-23). 

 
Figure 7-23: Mitigation > Projects >  Eligibility Determination >  Overall 

Review Tab 

2. On the bottom left part of the tab, in the Amendment Info section, the 
WITHDRAW and VOID buttons are available (Figure 7-24). 

 
Figure 7-24: Withdraw and Void Buttons 

The WITHDRAW and VOID buttons both delete the project application from 
the Eligibility Determination process.  

a. Click the WITHDRAW button if the Recipient wishes to modify the project 
application and resubmit it as an amendment. The project's Application 
Status displays as "Withdrawn.” 
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b. Click the VOID button if the Recipient has decided to permanently 
withdraw the project application. The project's Application Status displays 
as "Voided.” 

c. Whichever button is selected (Withdrawn or Void), the following warning 
message will appear. (Figure 7-25) 

 
Figure 7-25: Confirmation of Withdraw or Void warning 

3. Select OK to continue with the withdrawal or void process. 

NOTE: If the project being withdrawn or voided included a property site 
inventory (PSI), the question, “is this property included as part of  the 
final project” will be set to NO for each property in the PSI. No 
properties in the PSI of a withdrawn or voided project will be 
considered to be missing required data during project closeout. 
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Task 4: Execute Laws/EOs Review 

1. On the MITIGATION menu bar, click on Projects > Eligibility Determination > In 
Process. The Mitigation Work Packet List is displayed (Figure 7-26). 

 
Figure 7-26: Mitigation Work Packet List 

2. On the top left corner of the screen, check that you are logged in with the 
ENVRV Group ID. 

3. Highlight the row of the project that says "Laws/EOs Review" under Workflow 
Description. Check that there is a solid green box on the far left column of the 
row. The Status says "REVIEW.” 

4. Click the OK button. The Laws/EOs tab is displayed by default (Figure 7-27). 

 
Figure 7-27: Mitigation > Projects > Eligibility Determination > 
Laws/EOs Tab  

5. The top half of the Laws/EOs tab displays a list of Environmental Laws and 
Executive Orders. For each item in the list, complete Steps 5a - 5e. 
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a. Select the status of the project application with regards to the Environmental 
Law or Executive Order. Select "In Process,” "Completed" or "Not 
Applicable" (Figure 7-28): 

 
Figure 7-28: Project Application Status of Laws/EOs 

b. Double-click inside the Comments field to access the Comment Editor. 

c. In the Comment Editor text area, enter comments relevant to the project 
application and to the Law/EO. 

d. Click the OK button. The comments you entered are now displayed on 
that row. Your User Name, the date, and the time of entry are appended to 
the end of the text (Figure 7-29). 

 
Figure 7-29: Laws/EOs Tab with Comments Added 

e. If you need to edit existing comments, click the EDIT button. The 
Comment Editor is displayed. Repeat Steps 5c-5d. 

6. In the middle left part of the tab, click the SELECT LAWS/EOS button if you 
need to add Laws/EOs to the list (Figure 7-30). Complete Steps 6a-6d. 
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Figure 7-30: Select Laws/EOs Button 

a. The Laws Selection window is displayed (Figure 7-31). 

 
Figure 7-31: Laws Selection Window 

b. Highlight the Law/EO that you wish to add. 

c. Click the OK button. 

d. The Law/EO is now added to the list on the Laws/EOs tab. Repeat Steps 
5a - 5e for each Law/EO that you added to the list. 

7. The bottom half of the Laws/EOs tab displays the Conditions Required section 
(Figure 7-32). For each condition required, complete Steps 7a - 7g. 
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Figure 7-32: Conditions Required Section 

a. On the bottom left part of the Laws/EOs tab, click the ADD CONDITION 
button. A new row is added with your User Name displayed in the 
Entered By column (Figure 7-33). 

 
Figure 7-33: New Row Added for Conditions Required 

b. In the Law column, click the triangle. A drop-down list of Environmental 
Laws is displayed (Figure 7-34). 
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Figure 7-34: Environmental Laws Selection List 

c. Highlight the Environmental Law that you wish to add conditions to the 
project application for.  

d. In the new row, click the EDIT button. The Comment Editor is displayed. 

e. In the Comment Editor text area, enter the conditions required. Click the OK 
button. 

f. The newly-added required condition is displayed (Figure 7-35). 

 
Figure 7-35: Laws/EOs Tab - Conditions Required - Left Side 
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g. Scroll to the right to display the other Conditions Required data fields 
(Figure 7-36). 

 
Figure 7-36: Laws/EOs Tab - Conditions Required - Right Side 

8. The Laws/EOs Review process is considered complete if each Law/EO in the 
list has a Status of "Completed" or "Not Applicable." At that point, the system 
allows you to click inside the All Environmental Laws/EOS Reviews Complete 
checkbox located on the bottom right part of the tab (Figure 7-37). 

 
Figure 7-37: All Environmental Laws/EOs Reviews Complete Checkbox 
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CAUTION: If at least one of the Laws/EOs in the list has a Status of blank or 
"In Process,” the system does not allow you to click inside the All 
Environmental Laws/EOS Reviews Complete checkbox. The system 
also displays the Status Review dialog box (Figure 7-38). 

 
Figure 7-38: Status Reviews Dialog Box 

9. On the bottom left part of the tab, click the COMPLETE WORK STEP button. 

CAUTION: If you click the COMPLETE WORK STEP button without clicking 
inside the All Environmental Laws/EOs Reviews Complete 
checkbox, the Completed Status validation message is displayed 
(Figure 7-39). 

 
Figure 7-39: Completed Flag Validation Message 

If the checkbox has been completed, the Forward Work Packet dialog box is 
displayed (Figure 7-40). 

 
Figure 7-40: Forward Work Packet Dialog Box 

10. Click the OK button. The Workflow Success Message is displayed (Figure 7-
41). 
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Figure 7-41: Workflow Success Message 

11. Click the OK button. The Laws/EOs tab is displayed. 

12. On the bottom right part of the Laws/EOs tab, click the CLOSE button. 

13. On the bottom left part of the screen, the Mitigation Work Packet List screen 
remains minimized. Restore the screen by clicking the Maximize Button (the 
square icon). The screen is now maximized. 

14. On the bottom right part of the screen, click the REFRESH button. The project 
application that just went through the Laws/EOs Review process now displays 
a status of COMPLETE (Figure 7-42). 

 
Figure 7-42: Work Packets After Laws/EOs Review 
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Task 5: Execute NEPA Documentation Review 

1. On the MITIGATION menu bar, click on Projects >  Eligibility Determination >  
In Process. The Mitigation Work Packet List is displayed (Figure 7-43). 

 
Figure 7-43: Mitigation Work Packet List 

2. On the top left corner of the screen, check that you are logged in with the 
ENVRV Group ID. 

3. Highlight the row of the project that says "NEPA Documentation Review" 
under Workflow Description. Check that there is a solid green box on the far 
left column of the row. The Status says "REVIEW.” 

4. Click the OK button. The NEPA Process tab is displayed by default (Figure 
7-44). 

 
Figure 7-44: Mitigation > Projects > Eligibility Determination > NEPA 
Process Tab  

5. The top portion of the tab is the Level of Review section. Select one of the 
following from the FEMA Status drop-down list. Depending on your selection, 
the top right section displays a different set of data fields and buttons.  
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Proceed to the indicated Step Number for instructions specific to the selected 
FEMA Status. 

• Catex Completed - Step 6 

• Environmental Impact Statement - In Process - Step 7 

• Environmental Impact Statement - Completed - Step 7 

• Environmental Assessment - In Process - Step 8 

• Environmental Assessment - Completed - Step 8 

6. If you selected "Catex Completed" for FEMA Status, complete Steps 6a - 6i. 

a. The top right part of the NEPA Process tab displays the following (Figure 
7-45). 

 
Figure 7-45: FEMA Status - Catex Completed  

b. Click the EXTRAORDINARY CIRCUMSTANCE REF button. The 
description of ten extraordinary circumstances is displayed (Figure 7-46). 
Note the instruction to use the NEPA Process tab's Comment area.  
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Figure 7-46: FEMA Status - Catex Completed: Extraordinary 
Circumstances Reference 

c. Click the CLOSE button. 

d. Click the SELECT APPLICABLE 10.89(d) CATEX(s) button. The Catex 
Categories window is displayed (Figure 7-47).  

 
Figure 7-47: CATEX Categories 

e. On the left side of the window, select the CATEX Type Codes you wish to 
add. Click the ADD button. 

f. The CATEX Type Codes are now displayed on the right side (Figure 7-
48). 
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Figure 7-48: CATEX Categories Added 

g. Click the OK button. The added CATEX Categories are displayed on the 
NEPA Process tab. 

h. If applicable, click inside the No Extraordinary Circumstances Requiring 
an EA checkbox. 

i. Enter the Documentation Complete date. Clicking the triangle displays a 
calendar where you can select the date to auto-fill the field (Figure 7-49). 

 
Figure 7-49: Calendar for Documentation Complete Date Field  

7. If you selected "Environmental Impact Statement - In Process" or 
"Environmental Impact Statement - Completed" for FEMA Status, complete 
Steps 7a - 7c. 

a. The top right part of the NEPA Process tab displays the following (Figure 
7-50). 
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Figure 7-50: FEMA Status - Environmental Impact Statement  

b. Enter the date for Publication of Notice of Intent to Prepare EIS. Clicking 
the triangle displays a calendar where you can select the date to auto-fill 
the field. 

c. Enter the date for Record of Decision.  

8. If you selected "Environmental Assessment - In Process" or "Environmental 
Assessment - Completed" for FEMA Status, complete Steps 8a - 8e. 

a. The top right part of the NEPA Process tab displays the following (Figure 
7-51). 

 

Figure 7-51: FEMA Status - Environmental Assessment 

b. Enter the Draft EA Date. Clicking the triangle displays a calendar where 
you can select the date to auto-fill the field. 

c. Enter the Final EA Date. 

d. Enter the Final Public Notice Publication Date. 

e. Enter the Finding of No Significant Impact (FONSI) date. 
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9. The middle portion of the NEPA Process tab is the Conditions Required 
section (Figure 7-52). 

 
Figure 7-52: NEPA Process Tab - Conditions Required Section 

To add a condition, complete Steps 9a - 9g. 

a. Click the ADD CONDITION button. A new row is added to the Conditions 
Required section with your User Name displayed in the Entered By 
column. 

b. Double-click inside the Conditions Required field. The Comment Editor is 
displayed. 

c. In the Comment Editor text area, enter the description of the conditions 
required. Click the OK button. 

d. The conditions are displayed on the NEPA Process tab. 

e. If applicable, click inside the Monitoring Required checkbox. 

f. If applicable, complete the Monitoring Completed Date and Monitoring 
Completed By data fields. 

g. Figure 7-53 shows a condition required that has been added to the NEPA 
Process tab. 
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Figure 7-53: NEPA Process Tab - Conditions Required Added 

10. The bottom portion of the NEPA Process tab is the Comment section. To 
add, view or append comments, complete Steps 10a - 10g. 

a. Double-click inside the Comment field to access the Comment Editor. 

b. In the Comment Editor text area, enter your review comments. Click the 
OK button. 

c. The comments are displayed on the NEPA Process tab. The system adds 
your User Name, the Date, and the Time of the entry at the end of the 
comments. 

d. To view comments previously entered that are not displayed in full, click 
the VIEW button. 

e. To append to the original comments, click the APPEND button. The 
Comment Editor is displayed. 

f. In the Comment Editor text area, enter additional comments. Click the OK 
button. 

g. Both comments are now displayed on the NEPA Process tab (Figure 7-
54). 
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Figure 7-54: NEPA Process Tab - Comments Added 

11. If you wish to attach any NEPA Process documentation, click the 
Attachments tab. You are strongly urged to read and follow the instructions 
in Appendix A: Attach Documents. The Attachments are now displayed in 
the Attachments tab (Figure 7-55). 

 
Figure 7-55: Attachments Tab - Document List 

12. When you are done attaching documents, click the CLOSE button on the 
bottom right part of the Attachments tab. 

NOTE:  Allow up to one hour to retrieve and view newly attached documents. 

13. Click the NEPA Process tab. 
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14. The NEPA Documentation Review process is considered complete if the 
FEMA Status field on the top left part of the NEPA Process tab has one of 
the following values. All fields to the right of FEMA Status must also be 
completed. 

• "Statex-Completed" 

• "Catex-Completed" 

• "Environmental Assessment-Completed" 

• "Environmental Impact Statement-Completed" 

15. On the bottom left part of the tab, click the COMPLETE WORK STEP button. 
If the NEPA Documentation Review process is not complete, the Completed 
Status validation message is displayed (Figure 7-56). 

 
Figure 7-56: Completed Status Validation Message 

16. If the NEPA Documentation Review process is complete, the Forward Work 
Packet dialog box is displayed (Figure 7-57). 

 
Figure 7-57: Forward Work Packet Dialog Box 

17. Click the OK button. The Workflow Success Message is displayed (Figure 7-
58). 
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Figure 7-58: Workflow Success Message 

18. Click the OK button. The NEPA Process tab is displayed. 

19. On the bottom right part of the NEPA Process tab, click the CLOSE button. 

20. On the bottom left part of the screen, the Mitigation Work Packet List screen 
remains minimized. Restore the screen by clicking the Maximize Button (the 
square icon). The screen is now maximized. 

21. On the bottom right part of the screen, click the REFRESH button. The project 
application that just went through both the Laws/EOs Review and the NEPA 
Documentation Review process now displays "Environmental Officer Review" 
under Workflow Description (Figure 7-59). 

 
Figure 7-59: Work Packets After NEPA Documentation Review 
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Task 6: Execute Environmental Officer Review 

Executing the Environmental Officer Review requires that two tabs be reviewed: 
Laws/EOs and NEPA Process. 

1. On the MITIGATION menu bar, click on Projects >  Eligibility Determination >  
In Process. The Mitigation Work Packet List is displayed (Figure 7-60). 

 
Figure 7-60: Mitigation Work Packet List 

2. On the top left corner of the screen, check that you are logged in with the 
ENVOF Group ID. 

3. Highlight the row of the project that says "Environmental Officer Review" 
under Workflow Description. Check that there is a solid green box on the far 
left column of the row. 

4. Click the OK button. The Laws/EOs tab is displayed by default (Figure 7-61). 

 
Figure 7-61: Mitigation > Projects > Eligibility Determination > Laws/EOs Tab 

5. The top half of the Laws/EOs tab displays a list of Environmental Laws and 
Executive Orders. Steps 5a - 5d describe this section. 
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a. For each Environmental Law/EO, the review status of the project application 
is displayed. The Status could be "Completed,” "Not Applicable" or "Gen 
Revw/NA.” 

b. The Comments box is displayed next to Status. To enter comments, click 
the EDIT button (Figure 7-62).  

 
Figure 7-62: Laws/EOs Tab - Right Side 

c. The Comment Editor is displayed. Enter your comments in the Comment 
Editor text area.  

d. Click the OK button. Your comments are now displayed in the Comments 
column. Your User Name, the date, and the time are appended to the end of 
the text. 

6. The lower half of the Laws/EOs tab displays the Conditions Required data 
fields. Review the information. 

7. Click the NEPA Process tab (Figure 7-63). 
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Figure 7-63: Mitigation >  Projects >  Eligibility Determination >   
NEPA Process Tab 

8. The top portion of the NEPA Process tab is the Level of Review Section. 
Review the information. 

9. The middle portion of the NEPA Process tab is the Conditions Required 
section. To add a condition, complete Steps 9a - 9d. 

a. Click the ADD CONDITION button. A new row is added to the Conditions 
Required section with your User Name displayed in the Entered By 
column. (Figure 7-64). 

 
Figure 7-64: NEPA Process - Conditions Required 

b. Click the EDIT button in the new row. The Comment Editor is displayed. 

c. Enter the conditions in the Comment Editor text area. Click the OK button. 

d. The newly-added required condition is displayed. 
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10. The bottom portion of the NEPA Process tab is the Comment section. 

a. To view comments that are not displayed in full, click the VIEW button. 

b. To add comments complete the following steps. 

i. Click the APPEND button. The Comment Editor is displayed. 

ii. Enter your comments in the text area. Click the OK button.  

iii. The text you entered is now displayed on the bottom section of 
the NEPA Process tab. Your User Name, the date, and the 
time are added to the end of the text. 

11. If you wish to attach any NEPA Process documentation, click the 
Attachments tab. You are strongly urged to follow the instructions in 
Appendix A: Attach Documents. 

12. On the bottom left part of the NEPA Process tab, click the COMPLETE 
WORK STEP button. The Environmental Officer Review dialog box is 
displayed (Figure 7-65). 

 
Figure 7-65: Environmental Officer Review Dialog Box 

13. If no rework is required, and you are ready to select your Region 
Environmental Decision, complete Steps 13a - 13g. 

a. Click inside the Approved or Denied radio button. Click the OK button. 

b. The Forward Work Packet dialog box is displayed. Click the OK button. 

c. The Workflow Success message is displayed (Figure 7-66). 
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Figure 7-66: Workflow Success Message 

d. Click the OK button. The NEPA Process tab is displayed. 

e. On the bottom right part of the NEPA Process tab, click the CLOSE 
button. 

f. On the bottom left part of the screen, the Mitigation Work Packet List 
screen remains minimized. Restore the screen by clicking the MAXIMIZE 
button (the square icon). The screen is now maximized. 

g. On the bottom right part of the screen, click the REFRESH button. The 
project application that just went through the Environmental Officer 
Review process now displays a status of COMPLETE (Figure 7-67). 

 
Figure 7-67: Work Packets After Environmental Officer Review 

14. If rework is required, click inside the checkbox(es) that require rework  Click 
the OK button. 

NOTE: Rework of Laws/EOs and NEPA Documentation Reviews are executed 
by the ENVRV Group ID. Once the Environmental Officer completes the 
review in their queue, it is necessary for the person delegated to the 
project to return to the Overall Review tab as the MA and answer the 
question of “Project conforms to environmental regulations?” 

For instructions, proceed to the tasks below: 

Task 4: Execute Laws/EOs Review 

Task 5: Execute NEPA Documentation Review 
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Task 7: Execute Cost Review 

Executing the Cost Review requires that two tabs be reviewed: Cost Review and 
Cost Effectiveness. 

1.  On the MITIGATION menu bar, click on Projects >  Eligibility Determination >  
In Process. The Mitigation Work Packet List is displayed (Figure 7-68). 

 
Figure 7-68: Mitigation Work Packet List 

2. On the top left corner of the screen, check that you are logged in with the 
CSTRV Group ID. 

3. Highlight the row of the project that says "Cost Review" under Workflow 
Description. Check that there is a solid green box on the far left column of the 
row. The Status says "REVIEW.” 

NOTE: If the Status says "REWORK,” click the Cost Issues Comments tab 
before editing the information in the Cost Review tab (Steps 5-20). The 
comments will provide the questions, issues and comments regarding 
the rework required. These comments may have been entered by the 
MA and HMO reviewers during the Project Approval Decision, 
Approval Decision Concurrence, and Final Project Approval phases. 

4. Click the OK button. The Cost Review tab is displayed by default. 

HINT: To use the IS (Infrastructure Support) or HS (Human Services) 
Reference Cost Code lists for costing items, click inside the IS or HS 
radio button on the bottom left part of the Cost Review tab. Click the 
DISPLAY COST CODES button. These values have not been updated 
recently and are seldom used as a basis for approving costs. 

5. On the Cost Review tab, the cost item information for the project application 
is displayed (Figure 7-69). 
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Figure 7-69: Mitigation > Projects > Eligibility Determination > Cost 
Review Tab 

NOTE: When applicable, processing of a particular application may be halted 
until the user reduces the approved Federal share for the application 
and/or other previously approved applications for the project type so 
that the total Federal share of all of the project applications that have 
passed application completeness and review, for the applicable 
project type is at or below the projected Federal share amount 
available for that project type.  

It may also be necessary to review the status of all project amendments to 
ensure that projects which are not intended to be funded have had all 
amendments voided or withdrawn. This action will ensure the budget 
planning tab of the Funding Estimate screen reflects the true amount 
available for project approval. 

6.  For each cost item, complete the following steps. You might need to scroll 
down to see the other cost items. 

a. Click inside the Elig checkbox if the item is eligible. 

b. In the Approved Cost field, enter the amount of the approved cost. 

c. In the Comments field, enter any comments about the cost item or the 
approved cost. 

7. In the lower half of the screen, review the Total Approved Net Eligible Project 
Cost dollar amount calculated by the system. Edit the amount if necessary. 

8. In the Cost Approval field, select Y or N to approve or disapprove the cost. 
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HINT: A selection in the Cost Approval field is required in order to complete 
the Execute Cost Review task. Once Y is selected and the cost review for 
the project is complete it is either necessary to rework the cost review 
back and select N, or to wait until the review is complete and ammend 
the application to edit the Cost Estimate tab of the application.  

9. Click the Cost Effectiveness tab (Figure 7-70). 

 
Figure 7-70: Mitigation > Projects > Eligibility Determination > Cost 
Effectiveness Tab - Left Side 

10. Scroll to the right to see the remaining data fields (Figure 7-71). 

 

Figure 7-71: Mitigation > Projects > Eligibility Determination > Cost 
Effectiveness Tab - Right Side 
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11. Review the information in the Cost Effectiveness tab. 

12. Click the Cost Issues Comments tab. 

13. On the bottom middle part of the Cost Issues Comments tab, click the 
ADD button. A new row for comments is added, with your User Name and 
the Comment Date/Time displayed (Figure 7-72). 

 
Figure 7-72: Mitigation > Projects > Eligibility Determination > Cost 
Issues Tab 

14. Double-click inside the Comments box. The Comment Editor is displayed. 

15. In the text area, enter any comments, questions or issues that pertain to the 
information in the Cost Review and Cost Effectiveness tabs. 

16. Click the OK button. The comments are now displayed in the Cost Issues 
Comments tab (Figure 7-73). 

 
Figure 7-73: Cost Issues Comments Tab with Comments Added 

17. Click the Cost Review tab. On the bottom left part of the tab, click the 
COMPLETE WORK STEP button. The Forward Work Packet dialog box is 
displayed (Figure 7-74). 
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Figure 7-74: Forward Work Packet Dialog Box 

18. Click the OK button. The Workflow Success dialog box is displayed (Figure 7-
75). 

 
Figure 7-75: Workflow Success Message 

19. Click the OK button. 

20. On the bottom left part of the screen, the Mitigation Work Packet List screen 
remains minimized. Restore the screen by clicking the Maximize Button (the 
square icon). The screen is now maximized. 

21. On the bottom right part of the screen, click the REFRESH button. The project 
application that just went through the Cost Review process now displays 
"Eligibility Review" under the Workflow Description column. This is the next 
step in the Eligibility Determination process (Figure 7-76).  

  
Figure 7-76: Mitigation Work Packet List 
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Task 8: Execute Eligibility Review 

1. On the MITIGATION menu bar, click on Projects >  Eligibility Determination >  
In Process. The Mitigation Work Packet List is displayed. 

2. On the top left corner of the screen, check that you are logged in with the MA 
Group ID. 

3. Highlight the row of the project that says "Eligibility Review" under Workflow 
Description (Figure 7-77). Check that there is a solid green box on the far left 
column of the row. The Status says "REVIEW.” 

 
Figure 7-77: Mitigation Work Packet List 

NOTE: If the Status says "REWORK,” click the General Comments tab before 
editing the information in the Overall Review tab (Step 5). The 
comments will provide the questions, issues and comments that may 
have been entered by the MA and HMO reviewers during the Project 
Approval Decision, Approval Decision Concurrence, and Final Project 
Approval phases. 

4. Click the OK button. The Overall Review tab is displayed by default (Figure 
7-78). 
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Figure 7-78: Mitigation > Projects > Eligibility Determination > Overall 
Review Tab 

5. On the Overall Review tab, complete the following three sections by selecting 
Y, N, or N/A in each of the fields. Each field and its reference document (if any) 
are described in the table number listed below. 

• Regulatory Criteria Section Data Fields - Table 7-5 

• Additional Criteria Section Data Fields - Table 7-6 

• Eligibility Determination Section Data Fields  - Table 7-7 

Table 7-5: Regulatory Criteria Section Data Fields 

DATA FIELD INFORMATION SOURCE 

Project conforms with State Mitigation Plan. Multihazard Mitigation Plan 

Project benefits the designated area. FEMA/State Agreement 

Project conforms with environmental regulations. Environmental Checklist 

Project solves the problem independently or is a 
functional portion of the solution. 

Project description attached to 
project application 

Project is cost-effective. Benefit-Cost Analysis 

The benefit-cost ratio is (Fill in the blank). Benefit-Cost Analysis Worksheet 

Project funds requested will not substitute for 
another Federal funding authority. 

Assurances document attached 
to project application 

Project funds are not matched or intended to be 
matched with another Federal authority. 

Assurances document attached 
to project application 
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Table 7-6: Additional Criteria Section Data Fields 

DATA FIELD INFORMATION SOURCE 

Codes/Standards Rvw Assurances document attached 
to project application 

PW Review (DSR) 

Project Worksheets have been reviewed for 
coordinating this project with projects funded by 
§406 funds. 

• NEMIS PA instructions for 
checking PWs in NEMIS 

• Damage Survey Report (D-1)  
(NEMIS-Wide >   
Management Reporting >  
Management Reporting >  
Infrastructure Support (IS) >  
Project Worksheet Report) 

Engineering Review Engineer's Report 

National Flood Insurance Reform Act (NFIRA) 
Review 

Project complies with NFIRA and local 
regulations. 

Contact Flood Insurance section 

HS Review 

Human Services review has been conducted and 
Duplication of Benefit (DOB) elements have been 
identified. 

 Duplication of Benefits  

Other Document depends on what the 
additional criteria is 

CIS Review 

Community Information System review has been 
conducted. 

Check the CIS data base at 

https://portal.fema.net/famsRu
Web/home  

FMA Review 

Flood Mitigation Assistance review has been 
conducted. 

Data warehouse report 

NFIP Review 

National Flood Insurance Program review has 
been conducted. 

Contact Flood Insurance section. 

State Admin Plan 

Is there a FEMA-approved State Administrative 
Plan? 

Disaster Overview - Recipient 
Information 

https://portal.fema.net/famsRuWeb/home
https://portal.fema.net/famsRuWeb/home
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Table 7-7: Eligibility Determination Section Data Fields 

DATA FIELD INFORMATION SOURCE 

Applicant  

Applicant is eligible. 

44 CFR 206.434(a) 

Project Type 

Project Type is eligible. 

44 CFR 206.434(c) 

Eligibility Criteria 

Eligibility Criteria has been met. 

44 CFR 206.434(b) 

6. Click the General Comments tab (Figure 7-79). 

 
Figure 7-79: Mitigation > Projects > Eligibility Determination >   
General Comments Tab 

7. On the bottom middle part of the tab, click the ADD button. A new row for 
comments is added, with your User Name and the Comment Date/Time 
displayed (Figure 7-80). 
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Figure 7-80: General Comments Tab with New Row 

8. Double-click inside the Comments box. The Comment Editor is displayed. 

9. In the text area, enter any comments, questions or issues that pertain to 
eligibility information. 

10. Click the OK button. The comments are now displayed in the General 
Comments tab (Figure 7-81). 

 
Figure 7-81: General Comments Tab with Comments Added 

11. Click the Overall Review tab. On the bottom left part of the tab, click the 
COMPLETE WORK STEP button. The Forward Work Packet dialog box is 
displayed (Figure 7-82). 
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Figure 7-82: Eligibility Review Forward Work Packet Dialog Box 

12. Click the OK button. The Workflow Success dialog box is displayed (Figure 7-
83). 

 
Figure 7-83: Workflow Success Message 

13. Click the OK button. 

14. On the bottom left part of the screen, the Mitigation Work Packet List screen 
remains minimized. Restore the screen by clicking the MAXIMIZE button (the 
square icon). The screen is now maximized. 

15. On the bottom right part of the screen, click the REFRESH button. The project 
application that just went through the Eligibility Review process now displays 
"Project Approval Decision" under the Workflow Description column. Project 
Approval Decision is the next step in the workflow (Figure 7-84).  

 
Figure 7-84: Work Packet after Eligibility Review 
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Task 9: Execute Project Approval Decision 

1. On the MITIGATION menu bar, click on Projects >  Eligibility Determination >  
In Process. The Mitigation Work Packet List is displayed (Figure 7-85). 

 
Figure 7-85: Mitigation Work Packet List 

2. On the top left corner of the screen, check that you are logged in with the MA 
Group ID. 

3. Highlight the row of the project that says "Project Approval Decision" under 
Workflow Description. Check that there is a solid green box on the far left 
column of the row. The Status says "REVIEW.” 

NOTE: If the Status says "REWORK,” click the General Comments and Cost 
Review tabs before editing any eligibility information (Steps 5-19). 
The comments will provide the questions, issues and comments 
regarding the rework required. These comments may have been 
entered by the HMO reviewers during the Approval Decision 
Concurrence and Final Project Approval phases. 

 

NOTE: If you encounter a “Validation Error For Planning Cost to be 
Allocated,” it will be necessary to adjust the funding allocation or 
project in a manner that brings the allocated totals for the project 
type down to a level equal to or less than the amount identified as 
available for the project type in the Financial Activity tab of the 
Funding Estimate.  

4. Click the OK button. The Overall Review tab is displayed by default (Figure 
7-86). 
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Figure 7-86: Mitigation > Projects > Eligibility Determination > 
Overall Review Tab 

5. On the bottom left part of the Overall Review tab, click the APPLICATION 
DEV button. The Application Development tabs are displayed. 

6.  Review the project application information in the Application Development 
tabs.  

7. On the bottom right part of the tab, click the CLOSE button. The Eligibility 
Determination tabs are displayed with the Overall Review tab displayed by 
default. 

8. In the title bar of the Eligibility Determination tabs, ensure that the Suffix 
Type Code in the FEMA Project Number is correct. 

9. In the Regulatory Criteria section, the third field from the top is "Project 
conforms with environmental regulations." Before selecting Y, N or NA, 
check with the Regional Environmental Officer (REO) if all environmental 
criteria have been met. Once the Environmental Officer completes the 
review in their queue, it is necessary for the person delegated to the project 
to return to the Overall Review tab as the MA and answer this question.  

10. Review all the information in the Eligibility Determination tabs. 

11. If you wish to add Cost Issues Comments, complete Steps 11a - 11e. 
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HINT: If you have questions about the Cost Review and plan to send the 
project application back for Cost Review rework, use the Cost Issues 
Comments tab for your questions or to describe the required rework. 
The CSTRV Group ID user will use the information in this tab once he 
or she receives the Cost Review REWORK task in the Mitigation Work 
Packet List. 

a. Click the Cost Issues Comments tab (Figure 7-87). 

 
Figure 7-87: Mitigation > Projects > Eligibility Determination >   
Cost Issues Comments Tab 

b. On the bottom middle part of the tab, click the ADD button. A new 
comment row is added. 

c. Double-click inside the Comments box. The Comment Editor is 
displayed. 

d. Enter your comments in the Comment Editor text area. Click the OK 
button. 

e. The Cost Issues Comments tab is displayed with the newly-added 
comments (Figure 7-88). 
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Figure 7-88: Cost Issues Comments Tab with New Comments Added 

12. If you wish to add General Comments, complete the following steps. 

HINT: If you have questions about the Eligibility Review and plan to send the 
project application back for Eligibility Review rework, use the General 
Comments tab for your questions or to describe the required rework. 
The MA Group ID user will use the information in this tab once the 
user receives the Eligibility Review REWORK task in the Mitigation 
Work Packet List. 

a. Click the General Comments tab. 

b. On the center bottom part of the tab, click the ADD button. A new 
comment row is added. 

c. Double-click inside the Comments box. The Comment Editor is 
displayed. 

d. Enter your comments in the Comment Editor text area. Click the OK 
button. 

e. The General Comments tab is displayed with the newly-added 
comments (Figure 7-89). 
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Figure 7-89: General Comments Tab with New Comments Added 

13. Click back on the Overall Review tab. On the bottom left part of the tab, 
click the COMPLETE WORK STEP button. The Project Approval Decision 
dialog box is displayed (Figure 7-90). 

 
 Figure 7-90: Project Approval Decision Dialog Box 

14.  If no rework is required, and you are ready to select a Project Approval 
Recommendation, complete Steps 14a - 14f. 

a. In the Recommendation section, click inside the Approve or Deny radio 
button.  

b. Click the OK button. The Workflow Success message is displayed 
(Figure 7-91). 
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Figure 7-91: Workflow Success Message 

c. Click the OK button. The Overall Review tab is displayed. 

d. On the bottom right part of the Overall Review tab, click the CLOSE 
button. 

e. On the bottom left part of the screen, the Mitigation Work Packet List 
screen remains minimized. Restore the screen by clicking the Maximize 
Button (the square icon). The screen is now maximized. 

f. On the bottom right part of the screen, click the REFRESH button. The 
project application that just went through the Project Approval Decision 
process now displays "Approval Decision Concurrence" under Workflow 
Description. 

15. If rework is required, complete Steps 15a - 15f. 

a. In the Rework section, click inside the checkbox(es) of the tasks that 
require rework.  

b. Click the OK button. The Workflow Success message is displayed (Figure 
7-92). 

 
Figure 7-92: Workflow Success Message 

c. Click the OK button. The Overall Review tab is displayed. 

d. On the bottom right part of the Overall Review tab, click the CLOSE 
button. 
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e.  On the bottom left part of the screen, the Mitigation Work Packet List 
screen remains minimized. Restore the screen by clicking the MAXIMIZE 
button (the square icon). The screen is now maximized. 

f. On the bottom right part of the screen, click the REFRESH button. The 
project application that just went through the Project Approval Decision 
process now displays the workflow process that needs to be reworked 
under Workflow Description. The Status now says "REWORK" (Figures 7-
93 and 7-93A). 

 
Figure 7-93: Mitigation Work Packet List - Eligibility Review Rework 

 
Figure 7-93A: Mitigation Work Packet List - Cost Review Rework 
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Task 10: Execute Approval Decision Concurrence 

1. On the MITIGATION menu bar, click on Projects > Eligibility Determination > In 
Process. The Mitigation Work Packet List is displayed (Figure 7-94). 

 
Figure 7-94: Mitigation Work Packet List 

2. On the top left corner of the screen, check that you are logged in with the 
HMO Group ID. 

3. Highlight the row of the project that says "Approval Decision Concurrence" 
under Workflow Description. Check that there is a solid green box on the far 
left column of the row. The Status says "PRJ_APPRV.” 

4. Click the OK button. The Overall Review tab is displayed by default (Figure 
7-95). 

 
Figure 7-95: Mitigation > Projects > Eligibility Determination > Overall 
Review Tab 
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5. On the bottom left part of the Overall Review tab, click the APPLICATION 
DEV button. The Application Development tabs are displayed. 

6.  Review the information in the Application Development tabs.  

7. On the bottom right part of the tab, click the CLOSE button. The Eligibility 
Determination tabs are displayed with the Overall Review tab displayed by 
default.  

8. Review the information in the Eligibility Determination tabs. 

9. If you wish to add Cost Issues Comments, complete the following steps. 

HINT: If you have questions about the Cost Review and plan to send the 
project application back for Cost Review rework, use the Cost Issues 
Comments tab for your questions or to describe the required rework. 
The MA and the CSTRV Group ID users will use the information in this 
tab once he or she receives the REWORK task in the Mitigation Work 
Packet List. 

a. Click the Cost Issues Comments tab (Figure 7-96). 

 
Figure 7-96: Mitigation > Projects > Eligibility Determination >   
Cost Issues Comments Tab 

b. On the center bottom part of the tab, click the ADD button. A new 
comment row is added. 

c. Double-click inside the Comments box. The Comment Editor is 
displayed. 
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d. Enter your comments in the Comment Editor text area. Click the OK 
button. 

e. The Cost Issues Comments tab is displayed with the newly-added 
comments (Figure 7-97). 

 
Figure 7-97: Cost Issues Comments Tab with New Comments Added 

10. If you wish to add General Comments, complete the following steps. 

HINT: If you have questions about the project application and plan to send it 
back for rework, use the General Comments tab for your questions or 
to describe the required rework. The MA and the other reviewers will 
use the information in this tab once he or she receives the REWORK 
task in the Mitigation Work Packet List. 

a. Click the General Comments tab. 

b. On the center bottom part of the tab, click the ADD button. A new 
comment row is added. 

c. Double-click inside the Comments box. The Comment Editor is 
displayed. 

d. Enter your comments in the Comment Editor text area. Click the OK 
button. 

e. The General Comments tab is displayed with the newly-added 
comments (Figure 7-98). 
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Figure 7-98: General Comments Tab with New Comments Added 

11. Click back on the Overall Review tab. On the bottom left part of the tab, 
click the COMPLETE WORK STEP button. The Approval Decision 
Concurrence dialog box is displayed (Figure 7-99). 

 
 Figure 7-99: Approval Decision Concurrence Dialog Box 

12. If no rework is required, and you are ready to select a HMO 
Recommendation, complete Steps 12a - 12j. 

a. In the HMO Recommendation section, click inside the Approve or Deny 
radio button.  

b. Click the OK button. The Workflow Success message is displayed 
(Figure 7-100). 

 
Figure 7-100: Workflow Success Message 
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c. Click the OK button. MS Word is launched to generate a form letter for 
the project approval or decision. 

d. Enter the project-specific data on the form letter or open a different file if 
your Region has another form letter or additional documents to send. 

e. Address the letter to the Recipient Point of Contact(s). Be sure to follow 
your Regional/Recipient procedures. 

f. Save the letter (using the Save As feature, giving the letter a different file 
name) and print it. 

g. Exit from MS Word.  

h. On the bottom right part of the Overall Review tab, click the CLOSE 
button. 

i. On the bottom left part of the screen, the Mitigation Work Packet List 
screen remains minimized. Restore the screen by clicking the Maximize 
Button (the square icon). The screen is now maximized. 

j. On the bottom right part of the screen, click the REFRESH button. The 
project application that just went through the Approval Decision 
Concurrence process now displays "Final Project Approval" under 
Workflow Description. The Status says "REVIEW.” 

13. If rework is required, complete the following steps in the Approval Decision 
Concurrence dialog box. 

a. Click inside the Rework checkbox. 

b. Click the OK button. The Workflow Success message is displayed. 

c. Click the OK button. The Overall Review tab is displayed. 

d. On the bottom right part of the Overall Review tab, click the CLOSE 
button. 

e. On the bottom left part of the screen, the Mitigation Work Packet List 
screen remains minimized. Restore the screen by clicking the Maximize 
Button (the square icon). The screen is now maximized. 

f. On the bottom right part of the screen, click the REFRESH button. The 
project application that just went through the Approval Decision 
Concurrence process now displays "Project Approval Decision" under 
Workflow Description. The Status now says "REWORK" (Figure 7-101). 
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Figure 7-101: Project Approval Decision Rework 
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Task 11: Complete the Application Detail Tab 

For disasters with a declaration on or after October 30, 2012, the Application Detail 
tab (Figure 7-102) must be completed prior to executing Task 12. This tab captures 23 
data elements via 14 separate questions to be used for tracking metrics and the 
initiatives of the Sandy Recovery Improvement Act (SRIA).  

 
Figure 7-102: Application Detail tab 

Any projects approved prior to the release of these requirements will have two options: 

• Amend the project, which will require the completion of the new tab, or 

• The Application Details data will not be available for the project unless it is 
amended in the future. 

NOTE: Data entry on the tab is limited to the HMO role.  All other roles may view but 
may not alter or enter data.   

1. On the MITIGATION menu bar, click on Projects > Eligibility Determination >  In 
Process. The Mitigation Work Packet List is displayed. 

2. On the top left corner of the screen, check that you are logged in with the HMO 
Group ID. 

3. Highlight the row of the project that says "Approval Decision Concurrence" under 
Workflow Description. Check that there is a solid green box on the far left column 
of the row. The Status says "PRJ_APPRV.” 

4. Click the OK button. The Overall Review tab is displayed by default. 
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5. Click on the Application Detail tab. The applicability of some questions depends 
upon the user’s response to a preceding item in sequence (Table 7-8). 

Table 7-8: Eligibility Determination Section Data Fields 

DATA FIELD INFORMATION TO BE ENTERED 

1. Enter date Application submitted to 
FEMA by Recipient 

Enter a valid date between the date of 
the declaration and today’s date. 

2. Did initial Application meet minimum 
requirement for acceptance? 

Enter a YES or NO response.  If NO is 
selected the date field for denial will be 
editable if necessary and applicable.  A 
YES response will render the date field 
null. 

3. Was Application discussed with 
Recipient? 

Enter a YES or NO response.  If YES is 
selected the date field for when the 
discussion took place will be editable.  A 
NO response will render the date field 
null. 

4. Was a complete Application submitted 
(an RFI was not required)? 

4a. If no, enter date of initial RFI: 

4b. If answer to 4=N, enter date 
Application considered complete: 

Enter a YES or NO response.  A YES 
response will render questions 4a and 4b 
moot.   

A NO response will require valid dates 
be entered under question 4a and 4b. 

5. Was FEMA’s approval decision 
completed within 30 days of receipt of 
a complete Application? 

Enter a YES or NO response.  A NO 
response will require the entry of 
comments in the section provided. 

6. Does this Project use data or 
resources provided by advance 
assistance initiative? 

Enter a YES or NO response. 

7. Is this a phased project? 

7a. Is this amendment for phase 2 of a 
phased project? 

Enter a YES or NO response.  A NO 
response will render question 7a, 8, and 
8a, moot.   

A YES response will require a YES or 
NO response to question 7a. If 
applicable based on a YES response to 
question 7, enter a YES or NO response.  
A NO response will render questions 8 
and 8a moot. 



September 2016 Unit 7: Manage Eligibility Determination 
 

NEMIS HMGP User Manual MR 3.19.01  Page 7-71 

DATA FIELD INFORMATION TO BE ENTERED 

8. If phase 2, was FEMA decision 
completed within 30 days of receipt of 
amendment?  

8a. If phase 2, was a complete 
Application submitted? 

If answers to questions 7 and 7a are 
YES, provide a YES or NO response.  

If the answer to question 7 is YES, the 
Application Details tab will remain 
editable for questions 7a, 8, and 8a until 
question 7a is also marked YES and 
Questions 8 and 8a have been 
completed. 

9. Were national or local cost estimates 
used in the Application? 

Enter a YES or NO response unless the 
nature of the project application is such 
that national or local cost estimates are 
not applicable.  If cost estimates are not 
applicable to the project type, enter a 
response of N/A. 

10. Is Project designed to be completed in 
accordance with national standards? 

Enter a YES or NO response. 

11. Were pre-calculated benefits used? Enter a YES or NO response unless the 
nature of the project application is such 
that pre-calculated benefits are not 
applicable.  If pre–calculated benefits are 
not applicable to the project type, enter a 
response of N/A.  If a BCA was required 
for the project, enter the date the BCA 
was approved. 

12. Was this Project reviewed for strategic 
fund management suitability? 

Enter a YES or NO response. 

13. Is strategic fund management 
implemented for the Project? 

Enter a YES or NO response. 

14. Is the Recipient managing any portion 
of HMGP for this DR under the 
Program Administration by State (PAS) 
pilot? 

Enter a YES or NO response.  If YES is 
selected, comments on the extent of 
PSA activities are required to be entered. 

6. As the tab is completed, save data by tabbing off and back to Application Detail 
tab or by selecting Close.  When tabbing off, if any data entered does not pass 
validation a validation message such as the example shown below will appear 
(Figure 7-103).  The user will not be able to tab off until the data is corrected to 
pass validation.   
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Figure 7-103: Validation message example – Information required 

7. If close is selected and data does not pass validation a validation message will 
appear.  Selecting OK will cause a second validation message to appear asking 
if you wish to close the tab without saving the invalidated entries.  This second 
message is shown below (Figure 7-104). 

 
Figure 7-104: Validation error message – Information does not pass validation 

8. Date entries are validated. The date entered must occur after the date of the 
disaster declaration and prior to or on the date of the data entry. If an 
inappropriate date is entered, the user receives the Validation message shown 
above when attempting to save or close the tab and the Application Detail tab 
will not be considered complete (Figure 7-105).  

 
Figure 7-105: Validation error message – Incorrect date 
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9. After the tab is completed and the project is approved, the tab can no longer be 
edited by any amendment, with one exception.  The exception is that if the 
answer to question 7 is YES and the answer to question 7a is NO, Questions 7a, 
8, and 8a will remain editable until question 7a is also marked YES and 
Questions 8 and 8a have been completed.  

10. Once the Application Details tab shows Application Detail form is complete, (see 
Figure 7-106), the user is ready to proceed to the Final Project Approval Decision 
work step.  

 
Figure 7-106: Application Detail form is complete message 
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Task 12: Execute Final Project Approval Decision 

1. On the MITIGATION menu bar, click on Projects > Eligibility Determination > 
In Process. The Mitigation Work Packet List is displayed (Figure 7-107). 

 
Figure 7-107: Mitigation Work Packet List 

2. On the top left corner of the screen, check that you are logged in with the 
HMO Group ID. 

3. Highlight the row of the project that says "Approval Decision Concurrence" 
under Workflow Description. Check that there is a solid green box on the far 
left column of the row. The Status says "PRJ_APPRV.” 

4. Click the OK button. The Overall Review tab is displayed by default (Figure 
7-108). 

 
Figure 7-108: Mitigation > Projects > Eligibility Determination > Overall 
Review Tab 
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5. On the bottom left part of the Overall Review tab, click the APPLICATION 
DEV button. The Application Development tabs are displayed. 

6.  Review the information in the Application Development tabs.  

7. On the bottom right part of the tab, click the CLOSE button. The Eligibility 
Determination tabs are displayed with the Overall Review tab displayed by 
default.  

8. Review the information in the Eligibility Determination tabs. 

9. If you wish to add Cost Issues Comments, complete the following steps. 

HINT: If you have questions about the Cost Review and plan to send the 
project application back for Cost Review rework, use the Cost Issues 
Comments tab for your questions or to describe the required rework. 
The MA and the CSTRV Group ID users will use the information in this 
tab once he or she receives the REWORK task in the Mitigation Work 
Packet List. 

a. Click the Cost Issues Comments tab (Figure 7-109). 

 
Figure 7-109: Mitigation > Projects > Eligibility Determination >   
Cost Issues Comments Tab 

b. On the center bottom part of the tab, click the ADD button. A new 
comment row is added. 

c. Double-click inside the Comments box. The Comment Editor is 
displayed. 
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d. Enter your comments in the Comment Editor text area. Click the OK 
button. 

e. The Cost Issues Comments tab is displayed with the newly-added 
comments (Figure 7-110). 

 
Figure 7-110: Cost Issues Comments Tab with New Comments Added 

10. If you wish to add General Comments, complete the following steps. 

HINT: If you have questions about the project application and plan to send it 
back for rework, use the General Comments tab for your questions or 
to describe the required rework. The MA and the other reviewers will 
use the information in this tab once he or she receives the REWORK 
task in the Mitigation Work Packet List. 

a. Click the General Comments tab. 

b. On the center bottom part of the tab, click the ADD button. A new 
comment row is added. 

c. Double-click inside the Comments box. The Comment Editor is 
displayed. 

d. Enter your comments in the Comment Editor text area. Click the OK 
button. 

e. The General Comments tab is displayed with the newly-added 
comments (Figure 7-111). 
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Figure 7-111: General Comments Tab with New Comments Added 

11. Click back on the Overall Review tab. On the bottom left part of the tab, 
click the COMPLETE WORK STEP button. Any attempt to approve a 
project without an accurately complete Application Details tab will receive 
the following error message (Figure 7-112): 

 
Figure 7-112: Error message - The project package cannot be sent to 
execute final project approval decision until the application tab is completed in 
its entirety. Missing requirements may include non-valid dates or questions for 
which no answer has been chosen, when applicable. 

a. If the Application Details tab is complete, the Final Project Approval 
Decision dialog box is displayed (Figure 7-113): 
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Figure 7-113: Final Project Approval Decision Dialog Box  

b. If the Application Detail form is not complete, you will receive an error 
message (Figure 7-112). Complete the application details tab and return 
to step 11. 

12. To enter the information in the Regional Administrator or DRM Authority Name 
data field, complete Steps 12a - 12p. This is the name of the FEMA official who 
is making the Final Project Approval Decision. 

a. Click the REGIONAL ADMINISTRATOR button. The Look up a Staff 
Member window is displayed (Figure 7-114). 

 
Figure 7-114: Look up a Staff Member Window 

b. Enter information in as many of the fields as you can to limit the 
number of records to be searched.  

c. If you wish to search for the name of an Organization, click the 
ellipsis button … to the right of the Organization data field. The Look 
Up an Organization window is displayed (Figure 7-115). 
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Figure 7-115: Look Up an Organization Window 

d. Enter information in any of the Organization fields to limit the number of 
records to be searched. 

e. On the top right part of the Look Up an Organization window, click the 
SEARCH button. The Organization search results are displayed. 

f. Scroll down to the Organization name you wish to use. Click the OK 
button. 

g. The Organization name is displayed in the Look Up a Staff Member 
window. 

h. If you wish to search for the name of an Office, click the ellipsis button to 
the right of the Office data field. The Look Up an Office window is 
displayed (Figure 7-116). 
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Figure 7-116: Look Up an Office Window 

i. Enter information in any of the Office fields to limit the number of records 
to be searched. 

j. On the top right part of the Look Up an Office window, click the SEARCH 
button. The Office search results are displayed. 

k. Scroll down to the Office name you wish to use. Click the OK button. 

l. The Office Name is displayed in the Look Up a Staff Member window. 

m. On the top right part of the Look Up a Staff Member window, click the 
SEARCH button. 

n. The Staff Member search results are displayed. 

o. Scroll down to the Regional Administrator name you wish to use. Click 
the OK button. 

p. The selected name is displayed in the Final Project Approval Decision 
dialog box (Figure 7-117). 
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Figure 7-117: Regional Administrator Field 

13. In the Signature Date data field, enter the date of project approval or denial if it 
differs from the current date that was auto-filled by the system. 

14. In the Public News Release Date data field, enter the date of the publication of 
the project approval or denial. 

15. If no rework is required, and you are ready to select your Final Project 
Determination, complete Steps 15a - 15k. 

a. In the Final Project Determination section, click inside the Approved or 
Denied radio button. 

b. In the Regional PIO Notified data field, click inside the Yes or No radio 
button to indicate if the Public Information Officer (PIO) was notified. 

NOTE: When the PIO is notified, the Congressional Liaison should also be 
notified. 

c. Click the OK button. The Final Project Approval Decision Forward Work 
Packet dialog box is displayed (Figure 7-118). 
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Figure 7-118: Final Project Approval Decision 

Forward Work Packet Dialog Box 

d. The Workflow Success message is displayed (Figure 7-119). 

 
Figure 7-119: Workflow Success Message 

e. Click the OK button. The Overall Review tab is displayed. 

f. In the Amendment Info section, view the project's Application Status 
(Figures 7-120 to 7-123). 
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Figure 7-120: Application Status - Approved 

 
Figure 7-121: Application Status - Not Approved 

 
Figure 7-122: Application Status - Withdrawn 

 
Figure 7-123: Application Status - Void 

g. On the bottom right part of the Overall Review tab, click the CLOSE 
button. 
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h. On the bottom left part of the screen, the Mitigation Work Packet List 
window remains minimized. Click the Maximize button (the square icon) to 
restore the window. The screen is now maximized. 

i. On the bottom right part of the screen, click the REFRESH button.  

j. If the project application is approved, the project is cleared from the 
Mitigation Work Packet List. It is now available for allocating funds and 
appears in the Allocation List when adding projects to an allocation 
worksheet (Unit 10: Manage Allocations and Obligations). 

k. If the project application is not approved, it can be amended by the 
Recipient to meet the deficiencies cited by FEMA (Unit 8: Manage 
Amendments) or the Recipient can file an appeal (Unit 9: Manage 
Appeals). 

16. If the project application requires rework, complete Steps 14a - 14e in the Final 
Project Approval Decision dialog box. 

a. Click inside the Rework checkbox. 

b. Click the OK button. The Workflow Success message is displayed. 

c. Click the OK button. The Overall Review tab is displayed. 

d. In the Amendment Info section, the project's Application Status displays as 
"Pending" (Figure 7-124). 

 
Figure 7-124: Application Status - Pending 

17. On the bottom right part of the Overall Review tab, click the CLOSE 
button. 
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18. On the bottom left part of the screen, the Mitigation Work Packet List 
screen remains minimized. Click the Maximize button (the square icon) to 
restore the window. The screen is now maximized. 

19. On the bottom right part of the screen, click the REFRESH button. The 
project application that just went through the Final Project Approval 
process now displays "Project Approval Decision" under Workflow 
Description. The Status now says "REWORK" (Figure 7-125). 

 
Figure 7-125: Mitigation Work Packet List - Project Approval Decision 
Rework 
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References for Manage Eligibility Determination 

Available Reports 

To track and document the process of Managing Eligibility Determination, the 
following reports can be generated, as described in Unit 14 - Generate 
Standard HMGP Reports: 

• Federal Eligibility Work Packet Report 
• Project Cost Line Item Report 
• Project Eligibility Report 

Form Letters 

Table 7-9: Sample Form Letters 

FORM LETTER PAGE NUMBER 

Acknowledge Receipt of Project Application 7-95 

Project Approval 7-96 

Project Denial or Withdrawal 7-97 
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Form Letter for Project Application Acknowledgement Receipt 

ADDRESS 
SUBJECT: ACKNOWLEDGEMENT OF APPLICATION 
  FEMA- XXXX -DR-(State) 
  Hazard Mitigation Grant Program 
  Applicant: NAME OF APPLICANT 
  Project Title: TITLE  
Dear___________: 
This is to acknowledge official receipt on _________ (date) of a FEMA, Section 
404, Hazard Mitigation Grant Program (HMGP) project application from 
________________. It has been assigned FEMA project number ________. 
A State Mitigation plan for FEMA-XXXX-DR- (State) has [not] been received [as 
of this date]. [When preparing this plan, please include the above reference 
project as an identified measure]. 
This project is currently being reviewed in the FEMA Regional Office. You will be 
notified of all HMGP actions concerning this application. For information on the 
review and other actions, please contact ______________(name) at 
___________________(telephone number). 
Sincerely, 
 
Hazard Mitigation Officer 
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Form Letter for Project Approval 

ADDRESS 
 
SUBJECT: PROJECT APPROVAL 
  FEMA-XXXX-DR- (State) 
  Hazard Mitigation Grant Program 
  Subrecipient: NAME OF SUBRECIPIENT 
  Project #: FEMA ASSIGNED NUMBER 
 
Dear_________: 
 
The above referenced Hazard Mitigation Grant Program (HMGP) project has been approved 
and is eligible for funding. The estimated Federal share of the eligible project cost is $ ______ 
and has been submitted to Headquarters for funding in that amount. You will be notified when 
the obligated funds are in Smartlink and available for drawdown, a minimum of 15 days after the 
date of public notice. Recipient and Subrecipient administrative costs will be included in the 
funding obligation. 
 
Please refer the Subrecipient to the State HMGP administrative plan for project cost overrun 
regulations. If project costs exceed the approved Federal share, the Subrecipient must contact 
the Governor’s Authorized Representative (GAR). The GAR will evaluate requests for cost 
overruns. Written determination of cost overrun eligibility shall be submitted by the GAR to the 
Regional Administrator. Cost overruns shall meet Federal regulations set forth in 44 CFR 
206.438(b). 
 
The State HMGP administrative plan defines the procedure whereby the GAR may advance 
portions of the approved Federal share to the Subrecipient. Upon completion of the HMGP 
project, the Subrecipient’s closeout reimbursement for the final Federal share of eligible project 
costs must be submitted to the Regional Administrator for review and determination. 
 
Quarterly progress reports for HMGP projects are required. Please include this HMGP project in 
your future quarterly reports. 
 
The National Environmental Policy Act (NEPA) stipulates that additions or amendments to a 
HMGP Subrecipient statement of work (SOW) shall be reviewed by all State and Federal 
agencies participating in the NEPA process. NEPA sign-off for all SOW additions or 
amendments is essential before the revised SOW can be approved by FEMA or implemented 
by the HMGP Subrecipient. 
 
If you have any questions concerning this action or the information on the enclosed report, 
please contact _____________ (name) at _______________ (telephone number). 
Sincerely, 
 
Regional Administrator or  
Mitigation, Disaster Recovery Manager 
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Form Letter for Project Denial or Withdrawal 

Governor’s Authorized Representative 
 
ADDRESS 
 
SUBJECT: CLOSEOUT OF DENIED [OR WITHDRAWN] PROJECT 
  FEMA- XXXX -DR-(State) 
  Hazard Mitigation Grant Program 
  Applicant: NAME OF APPLICANT 
  Project #: FEMA ASSIGNED NUMBER 
 
Dear _______________ : 
 
According to our records, the above project was [denied or withdrawn] on _________ 
[date]. To finalize our records, this project is being officially closed in NEMIS HMGP. 
If you have any questions, please contact me at _______________ (telephone 
number). 
Sincerely, 
 
 
Hazard Mitigation Officer 
Enclosure 
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Overview 

The NEMIS HMGP Manage Amendments process allows Recipient Mitigation 
staff to amend a project application once it has been submitted and either 
“Approved” or “Denied” by FEMA staff. NEMIS HMGP creates another record for 
the project application with an incremental amendment number while the 
Application ID stays the same. The Recipient enters the new information and 
submits the amendment to FEMA. 

CAUTION: Data from most screens are copied from the original application, 
except for the Eligibility Review and Authorization screens, which 
are blank. Data must be re-entered for those screens. NEPA or other 
environmental review revisions must be reflected in the amendment.  

Table 8-1 provides an overview of the Manage Amendments process. 

Table 8-1: Manage Amendments Process  

ITEM DESCRIPTION 

Purpose Make changes to a project application that has been approved or denied 
by FEMA 

When does it 
start? 

After FEMA staff has completed the eligibility review process described in 
Unit 7: Manage Eligibility Determination and determined the status of the 
project application 

Who does it? Recipient Mitigation staff 

How is it done? Execute four tasks: 

Task 1: Determine Status of the Project Application 

Task 2: Select Project to Amend 

Task 3: Create Amendment and Enter New Information 

Task 4: Verify and Submit Amended Project Applications 

CAUTION: For Amendments, Laws/EOs and NEPA Process reviews are optional 
if no environmental information has been changed. The 
Environmental Officer Review must be completed, however, whether 
or not environmental information was changed. 
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Task 1: Determine Status of the Project Application 

NOTE: This task determines whether the project application has gone through 
FEMA’s eligibility review process and has been designated as “Approved,” 
“Denied,” or "Withdrawn.”  

1. On the MITIGATION menu bar, click on Projects > Eligibility Determination > 
View All (Figure 8-1). 

 
Figure 8-1: Mitigation >Projects >Eligibility Determination >View All 

2. A table listing project applications submitted to FEMA for this disaster is 
displayed (Figure 8-2). Table 8-2 describes the Project Application List data 
fields. 

 
Figure 8-2: Project Application List 

HINT: If the project application is not listed in the table, it has not yet been 
submitted to FEMA.  
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Table 8-2: Project Application List Data Fields 

DATA FIELD INFORMATION DISPLAYED 

Disaster Nr FEMA disaster number 

FEMA Proj Nr System-generated FEMA project application number when 
project is submitted to FEMA 

Amendment Nr Project application Amendment Number 

Applic ID Recipient project application number 

Suffix Type of funding requested. Suffix codes are R (Regular 
project funding), M (Management costs), P (Planning  
projects), and F (Initiative projects).   

ST State where disaster occurred 

Region FEMA Region where disaster occurred  

Project Title Project Title 

3. Select the project you wish to display. Click the OK button. 

4. The Overall Review tab is displayed (Figure 8-3). 

 
Figure 8-3: Overall Review Tab 
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NOTE: In the Application Info section, the Application Status field indicates one 
of the following: 

If the status is “Approved,” “Denied,” or “ Withdrawn,”  the project application 
can be amended.  

If the status is “Pending,” the Eligibility Review process is incomplete, and the 
application cannot be amended. However, it may be possible to edit 
certain parts of the current amendment provided the work step 
approving the component in need of amendment has not been completed.  
See the Application Development process (Unit 6: Manage Project 
Application).  

If the status is “Void,” the project could be amended; however, Void indicates the 
intent was to permanently remove the project application from 
consideration, so a new project should be submitted. 

5. Click the CLOSE button.  
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Task 2: Select Project to Amend 

1. On the MITIGATION menu bar, click on Projects >Application Development. 
A table listing project applications for the selected disaster is displayed. 

2. Highlight the highest amendment number for the project to be amended. Click 
the OK button (Figure 8-4). 

 
Figure 8-4: Application Development Project List 

3. The Project Eligibility Completed message is displayed (Figure 8-5). 

 
Figure 8-5: Project Eligibility Completed 

4. Click the OK button. Proceed immediately to Task 3: Create Amendment and 
Enter New Information. 

NOTE: Before you amend a project, it is advisable to print out the “Funding 
Estimate” to ensure the necessary funds are available.  In addition, 
performing a print screen of the cost estimate tab and match sources tab 
screens is also advisable for use as a reference.  The project Management 
report will provide a record of the total approved cost, total approved 
federal and non-federal share, and a record of the financial transactions 
to date.  
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Task 3: Create Amendment and Enter New Information 

1. After you click the OK button, the Applicant Information tab is displayed.  
(Figure 8-6).  

 
Figure 8-6: Applicant Information Tab 

2. Click the AMEND button. The Amendment Checklist is displayed.  
(Figure 8-7). 

 
Figure 8-7: Amendment Checklist 
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NOTE: The Amendment Checklist identifies the changes to the project 
application that are being made with the amendment. 

3. Click inside the checkboxes of the items you will be revising. Click the OK 
button.  

4. The Amend Completed Successfully message is displayed (Figure 8-8). 

 
Figure 8-8: Completed Successfully Message 

5. Click the OK button. 

6. A Checklist tab becomes available. Click the tab to view the Amendment 
items (Figure 8-9). 

 
Figure 8-9: Mitigation > Projects > Application Development  
> Checklist Tab 
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7. Table 8-3 lists the checklist items and where to make the changes in NEMIS 
HMGP. 

CAUTION: Some data fields cannot be changed in an amendment. These include 
the Subrecipient and the Project Type Codes, such as Initiative, 
Planning or Regular. If these fields have been incorrectly entered, 
the project application must be Withdrawn or Voided by FEMA, and 
a new project application must be created by the Recipient.  If 
withdrawn or voided, the project must be zeroed out in the cost 
estimate and then closed out. 

Table 8-3: Location of Checklist Items in NEMIS HMGP 

CHECKLIST ITEM LOCATION IN NEMIS HMGP 

Change in the Recipient Approval 
Status for the Project 

Mitigation > Projects >Application 
Development >Eligibility Review tab 

Changes to the Scope of Work Mitigation > Projects > Application 
Development > Various tabs, i.e., Property 
Site Inventory tab 

Type of Project Mitigation > Projects >Application 
Development >Project Info tab 

Location of Project Mitigation >Projects >Application Development 
>Property Site Inventory and Lat/Lon tabs 

Changes in Materials and/or Methods 
Used 

Mitigation >Projects >Application Development 
>Attachments tab; 

Mitigation >Projects >Application Development 
>Project Info tab >Project Description 

Additional Work/Expanded Scope Mitigation >Projects >Application Development 
> Various tabs, i.e., Property Site Inventory 
tab 

Change to the Maintenance 
Assurance 

Mitigation >Projects >Application Development 
>Maintenance Assurance tab 

Changes to the Budget supporting 
the project (see caution below) 

Mitigation >Projects > Application 
Development >Cost Estimate and Match 
Sources tabs 

Changes in the Amount of Federal 
Funds requested 

Mitigation >Projects >Application Development 
>Cost Estimate tab 

Changes in the Amount of Non-
Federal Funds ascribed to the project 

Mitigation >Projects >Application Development 
>Match Sources tab 
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CHECKLIST ITEM LOCATION IN NEMIS HMGP 

Changes in the type of non-Federal 
funding or source of non-Federal 
funding 

Mitigation >Projects >Application Development 
>Match Sources tab 

Changes in the time frame for 
completion of the project 

Mitigation >Projects >Application Development 
>Work Schedule tab 

Changes to Property Site Inventory 

(see the note below) 

Mitigation >Projects >Application Development 
> Property Site Inventory tab 

Changes to Stormwater Management 
and “Other” Inventories 

Mitigation >Projects >Application Development 
>Project Type tab;  

Mitigation >Projects >Application Development 
>Lat/Lon tab 

Changes to Environmental/Historic 
Compliance Reviews 

Mitigation >Projects >Application Development 
>Eligibility Review tab >Env Checklist sub-
tab 

CAUTION: If you are revising or amending your cost estimate, it is imperative 
that the instructions displayed when selecting the Cost Estimate and 
Match Sources Funds screens be followed.  Failure to do so may 
prevent project approval or allocation/obligation. 

 Once the Cost Review portion of an application has been completed 
and cost approval is marked as Y, it will be necessary to change the Y 
to an N to edit the Cost Estimate screen. 

 

CAUTION: If the Cost Review work step has been completed, it will no longer be 
possible to edit the Cost Estimate screen.  Once the application is 
approved, it will be necessary to amend the application to revise the 
Cost Estimate. 

 Individual line items cannot be modified for quantity, unit of 
measure, or unit cost.  Each line item that is to be revised must be 
deleted in its entirety and reentered using the new desired values. 

 

NOTE: If the project was originally submitted prior to the addition of the 
Number of Properties in Project  field and if a PSI is required, it will be 
required that a number greater than 0 be entered in the field to submit 
the amendment.   
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Task 4: Verify and Submit Amended Project Applications 

1. Click the Authorization tab. On the bottom left part of the tab, click the 
VERIFY button. 

2. If any required fields are empty, error messages will be displayed indicating 
the missing field and the Application Development tab where you can enter 
the missing information (Figure 8-10). 

 
Figure 8-10: Verification Error Warning Message 

3. Make the necessary corrections and click the VERIFY button again. 

4. Table 8-4 provides a list of required fields and their location in Mitigation > 
HMGP > Application Development. 

Table 8-4: Required Fields and System Location 

REQUIRED INFORMATION APPLICATION DEVELOPMENT TAB 

Recipient/Subrecipient  Applicant Information 

Project Type Project Info  

Project Title Project Info  

Counties Project Info  

Congressional Districts Project Info  

Community Name Project Info  

Hazard Type Project Info  

At least one Work Schedule Item Work Schedule  

At least one Cost Estimate Item Cost Estimate  

At least one non-Federal share Line Item Match Sources  

Cost Effectiveness Information  for each 
Community 

Cost Effectiveness  
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REQUIRED INFORMATION APPLICATION DEVELOPMENT TAB 

At least one Property Inventory: 

Owner, Structure Type, Property Damage 
Category, Foundation Type 

Property Site Inventory  

NFIP Info: 

Flood Source, Repetitive Loss Flag, Flood 
Zone Code, Repetitive Loss Category 

Property Site Inventory  > NFIP Info sub-
tab 

Environmental Checklist for at least one 
Alternative 

Eligibility Review > Env Checklist sub-tab 

Authorized Applicant Agent and Authorized 
Recipient Official Names, Titles and  
signatures on file  

Authorization  

Project Reviewer Eligibility Review > Overview sub-tab 

Eligibility Determination Criteria - Applicant, 
Project type, Project Criteria 

Eligibility Review > Overview sub-tab 

Other Reviews - C/E Review, Code 
Compliance, Mt Plan Conformance 

Eligibility Review > Overview sub-tab 

Approval Recommendation Eligibility Review > Overview sub-tab 

5. Table 8-5 lists attachments that are required for the project application. 
Project applications may be submitted in NEMIS HMGP without these items, 
but these documents must be attached before FEMA’s final approval in the 
eligibility determination process (Unit 7: Manage Eligibility Determination). 

Table 8-5: Required Project Application Attachments 

DOCUMENTS LOCATION IN NEMIS 

History, Alternatives, Proposed 
Actions  

Mitigation > Projects > Application Development > 
Problem and Risk Data tab 

Project Description Mitigation > Projects > Application Development > 
Project Info tab 

Maintenance Assurance  Mitigation >  Projects > Application Development > 
Maintenance Assurance tab 
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CAUTION: Attachments cannot be deleted once they have been added to NEMIS 
HMGP. Please make every effort to limit the file attachment size to 
less than 1 GB. Allow up to one hour to retrieve and view newly 
attached documents. 

For any missing attachment, you will get the following warning message 
(Figure 8-11) when you click the VERIFY button: 

 
Figure 8-11: Missing Required Attachment Message 

6. Click the OK button. A message that all checks were completed successfully 
is displayed (Figure 8-12). 

 
Figure 8-12: Verification Complete Message 

7. Click the OK button. 

8. On the bottom left part of the tab, click the SUBMIT button. The Final 
Submission dialog box is displayed (Figure 8-13). 

NOTE: When you click the SUBMIT button, NEMIS HMGP will automatically verify 
the application before displaying the Final Submission dialog box. 



Unit 8: Manage Amendments September 2016 
 

Page 8-14  NEMIS HMGP User Manual MR 3.19.01 
 

 
Figure 8-13: Final Submission Dialog Box 

9. Click the YES button. The project application is submitted to FEMA. A 
message is displayed that the work packet for the Receipt and Delegate task 
in the Eligibility Determination process was created (Figure 8-14). 

 
Figure 8-14: Work Packet Created Message 

10. On the bottom right part of the tab, click the CLOSE button. 

NOTE: The amended project application gets added to the HMGP project lists. 
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Overview 

The Manage Appeals functionality is not yet available in NEMIS HMGP. For the manual 
Appeals process for disasters declared on or after June 1, 2010, please refer to 
the Hazard Mitigation Assistance Unified Guidance in effect at the time of the disaster 
declaration. For disasters declared on or after June 1, 2009, and prior to June 1, 2010, 
please refer to the FY10 Hazard Mitigation Assistance (HMA) Unified Guidance, 
available at http://www.fema.gov/library/viewRecord.do?id=3649. For disasters declared 
prior to June 1, 2009, please refer to the HMGP Desk Reference, available at 
http://www.fema.gov/library/viewRecord.do?id=1472. You may also request guidance 
from your Regional Mitigation office. 

PUBLICATION OF THE HAZARD MITIGATION GRANT PROGRAM APPEALS 
DATABASE 

The Federal Emergency Management Agency (FEMA) announces the availability of the 
Hazard Mitigation Grants Program (HMGP) Appeals Database. 

The Hazard Mitigation Grant Program, available at https://www.fema.gov/hazard-
mitigation-grant-program, provides grants to state, local, tribal and territorial 
governments to implement long-term hazard mitigation measures after a major disaster 
declaration. The purpose of the HMGP is to reduce the loss of life and property due to 
natural disasters and to enable mitigation measures to be implemented during the 
immediate recovery from a disaster. 

An eligible applicant may appeal any FEMA determination regarding applications 
submitted for funding under the HMGP. The appeal process allows applicants to 
request a reconsideration of the decision in conformity with program requirements. 
There are two levels of appeals. The Regional Administrator decides first appeals. If 
FEMA denies the appeal at the Regional Administrator’s level, the applicant may submit 
a second appeal to the Deputy Associate Administrator for Mitigation at FEMA 
Headquarters. If FEMA approves an appeal, FEMA will take the appropriate action to 
implement the decision. If the second appeal is denied, the decision is final. 

To provide an effective means to research and track appeals, FEMA developed a web-
based database that can be accessed online. The online Appeals Database is a 
searchable database containing FEMA responses to applicant appeals for assistance. 
The database houses HMGP second appeal records since 1988 and first level appeals 
since the release of the FY2011 Hazard Mitigation Assistance guidance. In 2011, FEMA 
started monitoring first appeals made in the regions. The purpose of the database is to 
inform the public on how program requirements are applied. The database can be 
accessed at: http://www.fema.gov/hazard-mitigation-grant-program/hmgp-appeals.  

For more information on the terms used in the appeals database and a brief summary of 
the basic program elements, users can reference the Hazard Mitigation Assistance 
Program Digest, available at https://www.fema.gov/media-
library/assets/documents/95109.  

http://www.fema.gov/library/viewRecord.do?id=3649
http://www.fema.gov/library/viewRecord.do?id=1472
https://www.fema.gov/hazard-mitigation-grant-program
http://links.govdelivery.com/track?type=click&enid=ZWFzPTEmbWFpbGluZ2lkPTIwMTQwODE5LjM1MTY0ODMxJm1lc3NhZ2VpZD1NREItUFJELUJVTC0yMDE0MDgxOS4zNTE2NDgzMSZkYXRhYmFzZWlkPTEwMDEmc2VyaWFsPTE2ODg2MTkyJmVtYWlsaWQ9ZXJyb2wuZ2FycmVuQGZlbWEuZGhzLmdvdiZ1c2VyaWQ9ZXJyb2wuZ2FycmVuQGZlbWEuZGhzLmdvdiZmbD0mZXh0cmE9TXVsdGl2YXJpYXRlSWQ9JiYm&&&101&&&http://www.fema.gov/hmgp-appeals
https://www.fema.gov/media-library/assets/documents/95109
https://www.fema.gov/media-library/assets/documents/95109
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FEMA Hazard Mitigation Assistance datasets are also available through OpenFEMA, 
available at https://www.fema.gov/openfema. 

  

https://www.fema.gov/openfema
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Overview 

The NEMIS HMGP Manage Allocations and Obligations process allows FEMA 
Regional and Headquarters staff members to: 

• Allocate funds for approved HMGP projects 

• Obligate HMGP funds for approved HMGP projects 

Table 10-1 provides an overview of the Manage Allocations and Obligations 
process. 

Table 10-1: Manage Allocations and Obligations 
ITEM DESCRIPTION 

Purpose Allocate and obligate funds for approved HMGP project applications 

When does it 
start? 

After project applications have been approved by FEMA staff in the 
Eligibility Determination process 

Who does it? FEMA Regional Mitigation Staff 

• Mitigation Analyst (MA) Role 

• Hazard Mitigation Officer (HMO) Role 

• Division Chief Role 

CAUTION: The same user may not perform both the MA and HMO 
tasks.  

How is it done? Execute two processes: 

Part 1:  Allocation 
Task 1A: Create Allocation and Submit to HMO 

Task 1B: Submit Allocation to Emergency Support (ES) 

 

Part 2:  Obligation 
Task 2A: Create Obligation and Submit to HMO 

Task 2B: Submit Obligation to SOA Financial Services (SFS) 

Task 2C: Verify Obligation 

Task 2D: Notify Recipient of Obligation 
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ITEM DESCRIPTION 
 Part 3:  Deobligation 

Execute only in the following situations: 

• Project has a cost under-run 

• Recipient withdraws a project after funds have been obligated 

• Audit results determine that certain project costs are not allowed or 
were miscalculated previously 

Task 3A: Create Deobligation and Submit to HMO 

Task 3B: Submit Deobligation to SOA Financial Services (SFS) 

 
Part 4:  Deallocation 
CAUTION: Execute only if deobligation will be processed in the current 
fiscal year. Deobligations from previous fiscal years will be 
automatically deallocated. 
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Part 1: Allocation 

An allocation does not have to be created in the system for each individual 
project. Multiple projects can be part of one “Batch” allocation. 

After the allocation is processed, an obligation for each individual project MUST 
be created in the system. Another allocation cannot be processed until all 
projects allocated in the batch allocation are fully obligated. 

Figure 10-1 illustrates the Allocation Workflow in NEMIS HMGP.  

 
Figure 10-1: NEMIS Allocation Workflow 
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Task 1A: Create Allocation and Submit to HMO 

1. On the NEMIS menu bar, click the Mitigation icon. If prompted, select Group 
ID and Disaster. On the MITIGATION menu, click Funding > Allocations > 
New (Figure 10-2).  

 
Figure 10-2: Mitigation > Funding > Allocations > New 

2. The Create Allocation dialog box is displayed with a system-generated 
Allocation Nr (Figure 10-3).  

 
Figure 10-3: Create Allocation Dialog Box 
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3. Click the OK button. Five tabs with Allocation information are displayed. The 
Worksheet tab is displayed by default (Figure 10-4).  

 
Figure 10-4: Mitigation > Funding > Allocations > Worksheet Tab 

NOTE: Administrative cost calculation will not appear for disasters declared 
after November 13, 2007. 

4. On the bottom part of the tab, check that your current role is MA. 

5. Click the ADD PROJECT button. The Allocations Project List is displayed 
(Figure 10-5). 

 
Figure 10-5: Allocations Project List - Left Side 

6. Scroll to the right to see the other Allocations Project List data fields (Figure 
10-6). 
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Figure 10-6: Allocations Project List - Right Side 

NOTE: The list displays the approved projects associated with the current 
disaster number. The list may also include projects for which funds have 
already been partially allocated. 

7. Table 10-2 describes the Allocations Project List data fields. 

Table 10-2: Allocations Project List Data  

DATA FIELD INFORMATION TO BE REVIEWED/ENTERED 

Project Type 
(Select) 

Desired Type of Projects to be Listed. Select one of the 
following: 

• All 
• Regular 
• Initiative 
• Management Costs 
• For Planning Projects, select All 

Project Number assigned by the system to the project application during 
the Eligibility Determination process; also referred to as FEMA 
Project Number 

Aplcn System-generated Recipient Application ID number for the 
project- Number can be overwritten during application 
development. 

Amend System-generated number of the amendment (0 is assigned to 
the initial project application submission, 1 to the first 
amendment, and so on) 
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DATA FIELD INFORMATION TO BE REVIEWED/ENTERED 

Project Type  Funding Type for the project. Possible values are: 

• Regular   
• Initiative  
• Management Costs   
• Planning Project   

Recipient Name of Recipient 

Subrecipient  Name of Subrecipient 

Project Title Name given to the project during the application development 
process 

Approval  Date the project application was approved by FEMA 

Total Aprvd Total project cost approved during the Cost Review in the 
Eligibility Determination process 

Federal Share  Portion of the total project cost that will be funded by FEMA 

8. Select the project you wish to add to the Allocation. Either double click or click 
the OK button.  

9. The Worksheet tab is displayed with the following data fields auto-filled by 
the system (Figure 10-7). 

• Project Total Federal Share 

• Max Fed Share Available 

 
Figure 10-7: Allocations Worksheet Tab - Auto-filled Data Fields 

10. If applicable, note the dollar amount in the Proj Fed Share Prev Allocated 
data field.  

11. In the Federal Share To Be Allocated data field, enter the amount to be 
allocated. The amount entered must be less than, or equal to, the Max Fed 
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Share Available (Figure 10-8). Be sure to account for the leading zero in the 
field. It must be deleted or made part of your allocation amount. 

 
Figure 10-8: Federal Share to be Allocated Data Field 

12. Press the Tab key to move to the next field, and the Admin Est and Total 
Allocation dollar amounts will auto-fill (Figure 10-9).  

HINT: For projects covering State Management Costs (projects with an M suffix), 
enter Recipient and Subrecipient administrative costs as $0. 

 
Figure 10-9: Administrative Estimate and Total Allocation Data Fields 

13. When allocating project funds as well as Recipient and Subrecipient 
Administrative funds, always use the sliding scale radio button to ensure the 
Recipient and Subrecipient Administrative funds are calculated correctly by 
the system and included in the Total Allocation field along with the Project 
Amount to be allocated (Figure 10-10). 
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Figure 10-10: Allocation using the Sliding Scale radio button to ensure 
proper allocation 

NOTE: When encountering the “Project Allocation Amount – You cannot allocate 
an amount exceeding the current maximum available for this allocation” 
information message, it will be necessary to adjust the Fed Share To Be 
Allocated in a manner that brings the allocated total for the project down 
to a level equal to or less than the amount approved for the project. 
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14. If necessary to override the Recipient or Subrecipient Administrative amounts 
generated by the system, the user will be prompted to acknowledge the 
continuation of the override (Figure 10-11). 

 
Figure 10-11: Admin Override acknowledgement message 

15.  Selecting No will return the amount overridden to the previous amount 
calculated by the system. Selecting Yes will prompt a second acknowledgement 
confirmation (Figure 10-12).  

 
Figure 10-12: Admin Override 2nd acknowledgement message 

16. Once again, selecting No will return the amount overridden to the previous 
amount calculated by the system. Selecting Yes will automatically open the 
Comment Editor, which requires that a comment be entered justifying the 
calculation override. This will allow the override, and the user will be able to 
continue with the allocation. 

17.  Close the Comment Editor after entering your comment (Figure 10-13). 
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Figure 10-13: The Comment Editor Screen 

18. To add more projects to the Allocation request, maximize the Allocations Project 
List window. Repeat Steps 5−11. 

19. Click the Details tab. The cumulative Allocations requested thus far are 
displayed (Figure 10-14). 

 
Figure 10-14: Mitigation > Funding > Allocations > Details Tab 

20. Click the Comments tab (Figure 10-15). 
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Figure 10-15: Mitigation > Funding > Allocations > Comments Tab 

21. Click the ADD button. A new row for adding comments is displayed. The system 
auto-fills the User Name, the Date, and the Time of the entry (Figure 10-16). 

 
Figure 10-16: Comments Tab with New Row Added 

22. Double-click inside the Comment field. The Comment Editor is displayed. 

23. In the Comment Editor text area, enter the justification for allocating this project 
or any additional comments that may help the reviewers and approvers.  

24. Click the OK button. The comments you entered are now displayed in the 
Comments tab (Figure 10-17). 
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Figure 10-17: Comments Added 

25. Click the Authorization tab (Figure 10-18). 

 
Figure 10-18: Mitigation > Funding > Allocations > Authorization Tab 

26. Click the SUBMIT FOR HMO APPROVAL button. The Forward Work Packet to 
HMO dialog box is displayed (Figure 10-19). 

 
Figure 10-19: Forward Work Packet to HMO Dialog Box 



September 2016 Unit 10: Manage Allocations and Obligations 
 

NEMIS HMGP User Manual MR 3.19.01  Page 10-15 

27. Click the YES button. The Work Packet Forwarded to HMO message is 
displayed (Figure 10-20). 

 
Figure 10-20: Work Packet Forwarded to HMO 

28. Click the OK button. The Authorization tab now displays the Preparer Name 
and Preparation Date (Figure 10- 21). 

 
Figure 10-21: Preparer Information Displayed 

29. On the bottom right part of the tab, click the CLOSE button.  
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Task 1B: Submit Allocation to Emergency Support (ES) 

1. On the MITIGATION menu, click on Funding > Allocations (Figure 10-22). 

  
Figure 10-22: Mitigation > Funding > Allocations 

2. The Select Allocation list is displayed (Figure 10-23A). Highlight the desired 
allocation and click OK. The selected allocation is displayed. You should not be 
the same User who completed Task 1A: Create Allocation and Submit to HMO. 

 
Figure 10-23A: Select Allocation list 

3. Table 10-3 describes the Allocation Work Packet List data fields. 

Table 10-3: Allocation Work Packet List Data Fields  

DATA FIELD INFORMATION DISPLAYED 

Allocation Nr Number assigned by the system when the Allocation request 
was created 

Total Allocated 
Amt 

Total of all project amounts and administrative estimates 

Preparer Name NEMIS HMGP User Name of the person who created the 
allocation 
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DATA FIELD INFORMATION DISPLAYED 

Prepared Dt Date the allocation was created or the most recent date it was 
edited 

HMO Auth. Name NEMIS HMGP User Name of the person who authorized the 
allocation 

HMO Auth. Dt Date the allocation was authorized by the HMO 

Status System-generated indicator of the status of the workflow in the 
ES Review: At MA = awaiting transmittal to HMO; At HMO = 
awaiting transmittal to ES module; At ES = awaiting approval in 
ES module; Accept = accepted by IFMIS; Void = Allocation was 
voided 

FY Fiscal year for this allocation 

4. The Allocation work packet is ready for HMO approval if it displays the 
following information: 

• Status is At HMO 
5. Highlight the work packet. Click the OK button. 

6. Five tabs with Allocation information are displayed. The Worksheet tab is 
displayed by default (Figure 10-23B). 

 
Figure 10-23B: Mitigation > Funding > Allocations > Worksheet Tab 

7. Review the read-only information in the Worksheet, Details, and Comments 
tabs. 

8. Click the Authorization tab (Figure 10-24). 
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Figure 10-24: Mitigation > Funding > Allocations > Authorization Tab 

9. In the bottom half of the tab, the HMO Approval section is displayed.  

a. Click the VOID ALLOCATION button to void the allocation request. 

b. Click the REWORK TO PREPARER button to send the allocation request 
back to the Mitigation Analyst for rework. 

c. Return to the Comments tab to make any desired comments. If no 
comments are required proceed to item d. below. 

d. Click the SUBMIT TO ES button if you wish to continue processing the 
allocation request. 

10. If you clicked the SUBMIT TO ES button, the Forward Work Packet dialog 
box is displayed (Figure 10-25). 

 
Figure 10-25: Forward Work Packet Dialog Box 
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11.  Click the YES button. The Request for Allocation Advice Worksheet 
(RAAWS) is displayed with nine tabs. The Salaries tab is displayed by default 
(Figure 10-26). 

 
Figure 10-26: Request for Allocation Advice Worksheet (RAAWS) 

12. At the top of the worksheet, in the Program/Office section, check that the MT 
radio button is selected. 

13. Note that User Role has changed to PO (Project Officer).  
14. Click the Grants tab (Figure 10-27). 
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Figure 10-27: RAAWS > Grants Tab - Top 

15. Scroll to the bottom of the tab. In the Object Class 4173 – Hazard Mitigation 
Grant row, under the This Action column, verify that the dollar amount is 
equal to the Allocation amount requested (Figure 10-28). 

 
Figure 10-28: RAAWS > Grants Tab - Hazard Mitigation Grant Row 

16. On the far right column of the Object Class 4173 – Hazard Mitigation Grant 
row, click inside the checkbox. The Allocation Comments window is displayed 
(Figure 10-29). 
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Figure 10-29: Allocation Comments  

17. Click the MT DETAILS button. The Mitigation Details window displays the 
projects to be allocated (Figure 10-30). 

 
Figure 10-30: Mitigation Details  

18. Click the DONE button. The Allocation Comments window is displayed again.  

19. On the Allocation Comments window, enter your comments indicating 
approval (Figure 10-31).  

HINT: Include the Disaster Number, projects, and allocation amount in the text. 
Add the text "Approved by DC." 
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Figure 10-31: Allocation Comments with Approval Text 

20. Click the DONE button. The Grants tab is displayed. The checkbox on the far 
right column of the Object Class 4173 – Hazard Mitigation Grant row now has 
an "X" to indicate that Comments are attached (Figure 10-32). 

 
Figure 10-32: Hazard Mitigation Grant Row with X in Checkbox 
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21. At the bottom of the Grants worksheet, click the ACCEPT button (Figure 10-
33). 

 
Figure 10-33: RAAWS > Grants Tab - Accept Button 

NOTE: If the user does not click on “Accept,” the user will need to go to the ES 
module and open the allocation and click on “Accept.” 

22. The Print Worksheet dialog box is displayed (Figure 10-34). 

 
Figure 10-34: Print RAAWS Dialog Box 
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23. Click the YES button. 

CAUTION: Allocation Worksheets should be printed and placed in project files. 
This is useful for any future audits of the project. 

24. The Print Completed message is displayed. Click the OK button. 

25. The Worksheet Forwarded to the COMP Queue message is displayed (Figure 
10-35). 

 
Figure 10-35: Forward RAAWS to COMP Dialog Box 

26. Click the OK button. 

Processing the Allocation Request  

The COMP referred to in Step 25 above is the Comptroller. After the Comptroller, 
the allocation request goes through the following approval levels.  

• Disaster Recovery Manager (DRM) 
• Financial Policy Division (FPD) 
• Office of Financial Management Planning and Analysis (OFMPA) 

After the request is approved by OFMPA, the allocation is entered automatically 
into the Integrated Financial Management Information System (IFMIS). 

The allocation request can be rejected at any time during the approval process. If 
the request is rejected at the HQ Level, it will be rejected back to the Comptroller, 
who will reject it back to the MT DC. The MT DC then deletes the Allocation work 
packet and rejects it back to the HMO. The work packet will then display a 
"REJECT" status in Mitigation > Projects > Management. 

Allocation Status 

Once the allocation shows “ACCEPT” or “REJECTED” on the Select Allocation 
screen, an email will be sent to the HMO who submitted the allocation request 
(Figure 10-36). 
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Figure 10-36: Email notification to the HMO 

On the bottom right part of the Select Allocation screen (Figure 10-37), click the 
CANCEL button. The funds are now available for the Obligation process.  

 

Figure 10-37: Mitigation > Funding > Allocations 
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Part 2: Obligation 

Unlike the allocation process, in which several projects can be grouped together 
in one allocation request, a single obligation for each individual project MUST be 
created in the system. 

All projects included in the batch allocation must be fully obligated before another 
allocation can be processed. 

For disasters declared on or after March 1, 2015, all obligations and 
deobligations will be made on a project-based basis. This change will add 
transparency to the drawdown process for both FEMA and the Recipient; will 
provide controls to prevent overdrawing of projects; and will allow FEMA to 
provide the Recipient with reports on a daily, weekly, monthly or quarterly basis 
by disaster, by project. While the process remains similar to the old process, 
there is a new look and feel to the obligation screens. 

Some of the benefits of this change include:  

• Enhanced controls for both FEMA and the Recipient. Because funds 
will be obligated and disbursed at the project level, drawdowns for each 
individual project cannot exceed the amount obligated for that project, 
therefore eliminating the possibility of overdrawing funds on an individual 
project.  

• Simplification of data analytics. Analyzing data to perform payment 
reviews and other audit sampling will be selected using information 
contained in FEMA’s systems. This new process will provide greater 
transparency on a nationwide basis, reducing the burden on Recipients 
and FEMA.  

• Streamlined reporting process. Reports will provide both obligations 
and drawdowns by project for quarterly reports that Recipients can use as 
the basis of the quarterly reports or as a reconciliation control for their 
reporting process.  

The change will be effective for disasters occurring after the implementation date 
and will not be applied retroactively to prior disasters. The change was 
implemented March 1, 2015. For disasters declared after March 1, 2015 the 
Recipient will be required to request funding on a project by project basis. Funds 
already in the Recipient’s account will remain in a lump sum until they are fully 
drawn down, but new project obligations will begin to display on a project by 
project basis. 
 
Figure 10-38 illustrates the Obligation Workflow in NEMIS HMGP. 
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Figure 10-38: NEMIS Obligation Workflow 
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Task 2A: Create Obligation and Submit to HMO 

1. On the MITIGATION menu, click Funding > Obligations > New (Figure 10-39). 

 
Figure 10-39: Mitigation > Funding > Obligations > NEW 

2. The Project List for New Obligation is displayed (Figure 10-40). 

 
Figure 10-40: Mitigation > Funding > New Obligation 

NOTE: The list displays projects that have allocated funds and are associated 
with the current disaster number. The list also includes projects that 
have been obligated previously. Obligations are initially sorted by FEMA 
project number. Each Data Field can be sorted from highest to lowest or 
vice versa. Disaster Number is now displayed on the blue banner. 

3. Table 10-4 describes the Project List for Obligation data fields. 
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Table 10-4: Project List for Obligation Data Fields 

DATA FIELD INFORMATION DISPLAYED 

FEMA Project Nr  Number assigned to the project application during the Eligibility 
Determination process; also referred to as FEMA Project number  

Aplcn ID System-generated Recipient Application ID number for the 
project 

Total Previous 
Allocation 

Project amount 

Amount does not include administrative costs that were 
included in the total amount of the allocation submitted and 
approved by ES 

Total Previous 
Obligation 

Amount previously obligated 

Total Pending 
Obligation 

Amount that has been obligated but not yet approved by SFS 

Available 
Obligation 

Amount that has yet to be obligated for the project 
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4. Highlight the project for which you wish to obligate funds (Figure 10-41). 

 

Figure 10-41: Mitigation > Funding > Project List for Obligation 

5. On the bottom right part of the Project List, click the NEW button. Three tabs 
with Obligation information are displayed. The Worksheet tab is displayed by 
default (Figure 10-42). 

 
Figure 10-42: Mitigation > Funding > Obligations > Worksheet Tab 

6. In the top right part of the Title Bar, note the Action Nr. This is a system-
generated sequential number assigned to this obligation unique to the project 
being obligated. 

7. The system auto-fills the Total Obligation dollar amount. 
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8. Click the Comments tab (Figure 10-43). 

 
Figure 10-43: Mitigation > Funding > Obligations > Comments Tab 

9. Click the ADD button. A new row for adding comments is displayed. The 
system auto-fills the User Name, the Date, and the Time of the entry (Figure 
10-44). 

 
Figure 10-44: Comments Tab with New Row 

10. Double-click inside the Comment box. The Comment Editor is displayed. 

11. In the Comment Editor text area, enter the justification for obligating this 
project or any comments that may help the reviewers and approvers.  
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12. Click the OK button. The comments you entered are now displayed on the 
Comments tab (Figure 10-45). 

 
Figure 10-45: Comments Tab with Comments Added 

13. Click the Authorization tab (Figure 10-46). 

 
Figure 10-46: Mitigation > Funding > Obligations > Authorization Tab 

14. Click the SUBMIT FOR HMO APPROVAL button. The Forward Work Packet 
dialog box is displayed (Figure 10-47). 
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Figure 10-47: Forward Work Packet Dialog Box 

15. Click the YES button. The Authorization tab now displays the Preparer 
Name and Preparation Date. These data fields are auto-filled by the system 
(Figure 10-48). 

 
Figure 10-48: Authorization Tab with Preparer Information Added 

16. On the bottom right part of the Authorization tab, click the CLOSE button. 

17. If during the process you wish to delete the obligation without submitting to 
the HMO, select the Delete button on the Worksheet tab. 
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Task 2B: Submit Obligation to SOA Financial Services (SFS) 

1. On the MITIGATION menu, click on Funding > Obligations (Figure 10-49). 

 
Figure 10-49: Mitigation > Funding > Obligations 

2. The list of Obligations for the disaster is displayed. Check that you are logged 
in with the HMO Group ID. You should not be the same User who completed 
Task 2A: Create Obligation and Submit to HMO. 

3. Table 10-5 describes the Obligation Work Packet List data fields. 

Table 10-5: Obligation Work Screen List Data 

DATA FIELD INFORMATION DISPLAYED 

FEMA Proj # Number assigned to the project application during the Eligibility 
Determination process; also referred to as FEMA Project number 

Amend Nr System-generated number of the amendment (0 is assigned to the 
initial project application submission, 1 to the first amendment, and so 
on) 

Aplcn ID System-generated Recipient Application ID number for the project 

Action Nr System generated obligation number assigned sequentially and 
unique to the project being obligated 

Total 
Obligated 
Amt 

Total amount of project funds + Recipient and subrecipient amount 

Suppl Nr System generated supplement number for tracking purposes 

Preparer NEMIS HMGP User Name of the person who created the obligation 

Prepare Date Date the obligation was created or the most recent date it was edited 
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DATA FIELD INFORMATION DISPLAYED 

Status System-generated indicator of the status of the workflow in the ES 
Review: At MA = awaiting transmittal to HMO; At HMO = awaiting 
transmittal to SFS module; At SFS = awaiting approval in SFS Module; 
Accept = accepted by IFMIS; Void = Obligation was voided. 

Fiscal Yr Fiscal year for this obligation 

IFMIS 

Comments 

Should the Obligation be REJECTED, comments are provided to 
explain the cause of the rejection 

4. The Obligation work packet  is ready for HMO approval if it displays the 
following information: 

• At HMO 

5. Highlight the appropriate obligation. Click the OK button.  

6. Three tabs with Obligation information are displayed. The Worksheet tab is 
displayed by default. 

7. Review the read-only information in the Worksheet and Comments tabs. 

8. Click the Authorization tab. Click the SUBMIT TO SFS button (Figure 10-
50). 
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Figure 10-50: Mitigation > Funding > Obligations 

HINT: If you created the Obligation request and you are now submitting the 
request to SFS, the following system error message will be displayed 
(Figure 10-51). Click the OK button on the error message and exit out of 
NEMIS. Another user with the HMO role will need to log in and submit the 
Obligation request to SFS. 

 
Figure 10-51: Preparer Cannot Submit Obligation Message 

9.  The Forward Work Packet to SFS dialog box is displayed (Figure 10-52). 
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Figure 10-52: Forward Work Packet to SFS Dialog Box 

10. Click the OK button. 

11. The "Obligation request submission was successfully transmitted to SFS and 
is pending IFMIS reply”" message is displayed (Figure 10-53). 

 
Figure 10-53: Obligation Submitted Message 

CAUTION: Do not submit more than one obligation at a time. Wait until the first 
obligation is processed before submitting another obligation. This 
process could take from a few minutes to up to an hour but could take 
longer. In every disaster, the first obligation of a new fiscal year is 
required to be accepted in IFMIS before another obligation can be 
submitted. 

12. Click the OK button. On the Authorization tab, note that the system auto-
filled the HMO Approval data fields with your User Name and the current date 
(Figure 10-54). 
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Figure 10-54: Authorization Tab with HMO Approval Information 
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Task 2C: Verify Obligation 

Obligations submitted in Task 2B are normally processed once an hour. An hour 
after submission, the MA or the HMO should verify that the obligation was 
processed. If the obligation is still not processed at the end of a reasonable 
amount of time, a help desk ticket should be submitted to the FEMA Enterprise 
Service Desk at FEMA-Enterprise-Service-Desk@DHS.GOV.   
This task provides steps on how to verify the obligation in the following NEMIS 
HMGP functional areas: 

• Obligations  

• Project Management 

• Funding Estimate 

1. To verify that the obligation has been approved in Obligations, complete 
Steps 1a−1h. 

a. On the MITIGATION menu, click on Funding > Obligations (Figure 10-55). 

 
Figure 10-55: Mitigation > Funding > Obligations 

2. The Obligation Project List is displayed (Figure 10-56). 

Figure 10-56: Obligation Project List 

a. Table 10-6 describes the information displayed in the Obligation 
Project List. 
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Table 10-6: Obligation Project List Data Fields 

DATA FIELD INFORMATION DISPLAYED 
FEMA Proj # Number assigned to the project application during the Eligibility 

Determination process; also referred to as FEMA Project number  

Amend Nr System-generated number of the amendment (0 is assigned to 
the initial project application submission, 1 to the first 
amendment, and so on) 

Aplcn ID  System-generated Recipient Application ID number for the 
project  

Action Nr System-generated obligation number assigned sequentially 

Total Obligated 
Amt 

Total amount of project funds + Recipient and Subrecipient 
amount 

Suppl Nr System-generated supplement number for tracking purposes 

Preparer NEMIS HMGP User Name of the person who created the 
obligation 

Prepare Date Date the obligation was created or the most recent date it was 
edited 

Status System-generated indicator of the status of the workflow in the 
SFS Review: At MA = awaiting transmittal to HMO; At HMO = 
awaiting transmittal to SFS module; At SFS = awaiting 
transmission to SFS Module; Accept = accepted by IFMIS; Void 
= Obligation was voided 

Fiscal Yr Fiscal year for this obligation 

IFMIS 

Comments 

Should the Obligation be REJECTED, comments are provided to 
explain the cause of the rejection 

b. Highlight the row of the obligation you wish to verify. 

c. If the status of the obligation is AT SFS you may need to wait for a few 
minutes—depending on volume—to have the obligation move to the 
IFMIS module. (Figure 10-57). 
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Figure 10-57: Obligation Status at SFS 

d. It is required that a previously-submitted obligation be status at IFMIS 
before a subsequent Obligation can be submitted.  Any attempt to 
submit another obligation prior to the previous obligation being moved 
from AT SFS to AT IFMIS will result in a message similar or identical to 
the one below.  It is anticipated this process will take up to 3 minutes 
on average but may take longer in certain extraordinary circumstances, 
such as high volume or server issues. (Figure 10-58). 

 
Figure 10-58: Obligation not submitted message due to previous 
obligation Status at SFS 

e. If the IFMIS Status for that project is "ACCEPT,” the obligation has 
been approved. 

NOTE: If the IFMIS status is "REJECT,” discuss the message in the IFMIS 
Comments with the system sustainment staff.  After resolving any issues, 
submit a new obligation as described in Task 2A: Create Obligation and 
Submit to HMO. Be sure to incorporate the changes recommended by the 
system sustainment staff.  A remedy ticket may be required. 

3. To verify that the obligation has been approved in Project Management, 
complete steps 3a−3e. 
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a. On the MITIGATION menu, click on Projects > Management (Figure 
10-59). 

 
Figure 10-59: Mitigation > Projects > Management 

b. The Project Management Project List is displayed (Figure 10-60). 

 
Figure 10-60: Project Management Project List 

c. Select the Project whose obligation you wish to verify. If the project has 
several rows, select the row with the highest amendment number. 
Click the OK button. 

d. Two tabs with Project Management information are displayed. The 
HMGP Project Management tab is displayed by default (Figure 10-
61). 
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Figure 10-61: Mitigation > Projects > Management >  
HMGP Project Management Tab 

e. Click the Funding Activity tab. On the bottom right part of the tab, 
note the Total Obligated Amount (Figure 10-62).  

 
Figure 10-62: Mitigation > Projects > Management > 
Funding Activity Tab 
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4. To verify the obligation in Funding Estimate, complete Steps 4a−4e. 

a. On the MITIGATION menu, click on Funding > Estimate (Figure 10-63). 

 
Figure 10-63: Mitigation > Funding > Estimate 

b. The HMGP Financial Activity tab is displayed by default. 

c. At the top left part of the tab, select the Recipient from the drop-down list. 

d. The tab displays five columns of data for various funding amounts: 

• Projected  A 

• Total Allocated in NEMIS B 

• Available C (A-B) 

• Total Obligated in NEMIS D 

• Available E (amount obligated minus the current estimate or A - D) 

e. Note the Obligated dollar amount in Column D (Figure 10-64). This 
amount should now include your latest accepted obligation. 

 
Figure 10-64: Obligated Amount Displayed in HMGP Financial Activity 
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Task 2D: Notify Recipient of Obligation 

NOTE: This task is executed outside of NEMIS HMGP. It is included in this User 
Manual because it completes the Manage Allocations and Obligations 
process. 

Send a letter to the Governor’s Authorized Representative (GAR) indicating 
that the funds are available and have been transferred to the Smartlink 
account, if applicable. 

A copy of this form letter is provided in the References Section of this unit. 
Regions may use a Regional specific format, as long as all necessary 
information is included. Enter the project-specific information in the form 
letter. 

HINT: Save the letter using the “Save As” feature, giving the letter a different file 
name. 



Unit 10: Manage Allocations and Obligations September 2016 
 

Page 10-46 NEMIS HMGP User Manual MR 3.19.01 

Part 3: Deobligation 

Execute the Deobligation process in NEMIS HMGP if any of the following 
conditions are true: 

• A project has a cost under-run during Project Closeout 

• Recipient chooses to withdraw a project after funds have been obligated 

• The Recipient or Subrecipient are returning unearned or unwanted 
administrative funds  

 The Deobligation process is almost exactly the reverse of the Obligation 
process. Figure 10-65 compares the processes of Obligation and Deobligation. 

 
Figure 10-65: Obligation and Deobligation Processes (*if needed – 
see Unit 10 Part 4, Deallocation)  
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Task 3A: Create Deobligation and Submit to HMO 

1. If deobligating Federal funds, after the project has been amended and 
approved, on the MITIGATION menu, click on Funding > Obligations (Figure 
10-66). 

 
Figure 10-66: Mitigation > Funding > Obligations  

2.  The Select Obligation List is displayed. Click the NEW button. 
3. The New Obligation list is displayed (Figure 10-67). Highlight the project for 

which you wish to de-obligate funds. Click the NEW button. 

  
Figure 10-67: Obligation Project List 
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4. Table 10-7 describes the information in the Obligation Project List. 

Table 10-7: Obligation Project List Data Fields 

DATA FIELD INFORMATION DISPLAYED 

FEMA Project Nr Number assigned to the project application during the Eligibility 
Determination process; also referred to as FEMA Project 
number. 

Aplcn ID System-generated Recipient Application ID number for the 
project 

Total Previous 
Allocation 

Project amount allocated 

NOTE: Amount does not include administrative costs 
that were included in the total amount of the 
allocation submitted and approved by ES. 

Total Previous 
Obligation 

Amount previously obligated 

Total Pending 
Obligation 

Amount that has been obligated but not yet approved by ES 

Available Obligation Amount that has yet to be obligated for the project 

5. The Deobligate Funds dialog box is displayed (Figure 10-68). Click the YES 
button to continue.  

 
Figure 10-68: Deobligate Funds Dialog Box 

6. Three tabs with Obligation information are displayed. On the right side of the 
Obligation title bar, note that Action Nr is now "2,” referring to the deobligation 
request. The original obligation created in Task 2A was Action Nr "1.”  

7. The Worksheet tab is displayed by default (Figure 10-69). 
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Figure 10-69: Worksheet tab showing amounts previously Allocated and 
Obligated and selection of the Sliding Scale Radio Button to ensure 
proper calculation 

8. In the Project Amount to Be Obligated field, enter the minus sign "-" followed 
by the dollar amount to be deobligated. 

9. Press the Tab key. The amount is displayed in the Total Obligation field. 
Notice the minus sign before the amount and the red font (Figure 10-70). 

10. When deobligating project funds as well as Recipient and Subrecipient 
Administrative funds, always use the sliding scale radio button to ensure the 
Recipient and Subrecipient Administrative funds are calculated correctly by 
the system and included in the Total Obligation field along with the Project 
Amount to be deobligated (Figure 10-70). 

  
Figure 10-70: Deobligation using the Sliding Scale Radio Button to 
ensure proper calculation 
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11. If necessary to override the Recipient or Subrecipient Administrative amounts 
generated by the system, the user will be prompted to acknowledge the 
continuation of the override (Figure 10-71).  

 
Figure 10-71: Recipient Admin Override acknowledgement message 

12.  Selecting No will return the amount overridden to the previous amount 
calculated by the system. Selecting yes will prompt a second 
acknowledgement confirmation. (Figure 10-72).  

 
Figure 10-72: Recipient Admin Override 2nd acknowledgement 
message 

13. Once again, selecting No will return the amount overridden to the previous 
amount calculated by the system. Selecting Yes will open the Comment 
Editor which will require that a comment be entered justifying the calculation 
override. This will allow the override, and the user will be able to continue with 
the Obligation/Deobligation process. 

14. Click the Comments tab (Figure 10-73). 

 
Figure 10-73: Mitigation > Funding > Obligations > Comments Tab 

15. On the bottom right part of the tab, click the ADD button. A new row for 
adding comments is displayed. The system auto-fills the Date and the Time of 
the entry and the User ID (Figure 10-74).  
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Figure 10-74: New Row for Comments 

16. Double-click inside the Comment field to access the Comment Editor. 

17. In the Comment Editor text area, enter a justification for the deobligation 
request.  

18. Click the OK button. The comments are now displayed on the Comments tab 
(Figure 10-75). 

 
Figure 10-75: Deobligation Comments Added 

19. Click the Authorization tab (Figure 10-76). 
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Figure 10-76: Mitigation > Funding > Obligations > Authorization Tab 
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20. Click the SUBMIT FOR HMO APPROVAL button. The Forward Work Packet 
dialog box is displayed (Figure 10-77). 

 
Figure 10-77: Forward Work Packet Dialog Box 

21. Click the YES button.  
22. The system will notify that the deobligation was successfully submitted to the 

HMO and for what fiscal year it was submitted. (Figure 10-78) 

 
Figure 10-78: Deobligation submitted to HMO for FY notification 

23. Click the OK button. The Authorization tab now displays the Preparer Name 
and Preparation Date (Figure 10-79). 
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Figure 10-79: Authorization Tab with Preparer Information Added 

24. On the bottom right part of the Authorization tab, click the CLOSE button. 

HINT: The system will check IFMIS for availability of funds by Fiscal Year, 
beginning from the oldest Fiscal Year in which funds were obligated for 
this disaster. If the disaster was declared after the implementation of the 
SFS process, the system will only check the applicable project for the 
availability of funds.  The system will keep checking until it finds a Fiscal 
Year with sufficient funds to deobligate.  

If there are not sufficient funds in any one fiscal year, the user will receive 
a message outlining the totals available in different fiscal years. See the 
mocked up screen shot below as an example of the message outlining the 
totals available in different years. (Figure 10-80)  

It may be necessary to create more than one deobligation if there are 
insufficient funds in any one fiscal year. If this is the case, delete the 
deobligation on the Worksheet tab and start over. 
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Figure 10-80: Screen shot showing amounts available for 
deobligation in different years 

Addendum: The figures shown on the available funds by FY screen are potentially 
rounded either up or down as determined by the exact amount remaining in the 
indicated fiscal year.  Should your deobligation be rejected and the IFMIS comment 
read “Credit status only valid for expends or invoices,” the likely cause is that the 
figure shown as available for the applicably FY has been rounded up.  Deobligating 
$1 less than shown available should rectify the reject and allow you to deobligate 
the project successfully.   
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Task 3B: Submit Deobligation to SOA Financial Services (SFS) 

1. On the MITIGATION menu, click on Funding > Obligations (Figure 10-81). 

Figure 10-81: Mitigation > Funding > Obligations 

2. The Select Obligation List is displayed. Check that you are logged in with the 
HMO Group ID. You should not be the same User who completed Task 3A: 
Create Deobligation and Submit to HMO. Select the deobligation with the 
status of At HMO and double click or select OK. (Figure 10-82). 

 
Figure 10-82: Select the deobligation with status At HMO 

3. Three tabs with Obligation information are displayed. The Worksheet tab is 
displayed by default. 

4. Review the read-only information in the Worksheet and Comments tabs. 
5. Click the Authorization tab. On the bottom part of the tab, click the SUBMIT 

TO SFS button (Figure 10-83).  
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Figure 10-83: Mitigation > Funding > Obligations> Authorization Tab 

6.  The Forward Work Packet to SFS dialog box is displayed (Figure 10-84). 

 
Figure 10-84: Forward Work Packet to SFS Dialog Box 

7. Click the OK button.  

8. The Obligation Transmitted to SFS and pending IFMIS reply is displayed 
(Figure 10-85). 

 
Figure 10-85: Obligation Submitted Message 
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9. The Obligation is now shown on the Select Obligation screen as status At 
SFS (Figure 10-86). 

 
Figure 10-86: Obligation Status At SFS 

CAUTION: Do not submit more than one deobligation at a time. Wait about an 
hour, or until the first deobligation is processed, before submitting 
another deobligation. If it is the first obligation or negative obligation 
(deobligation) of the new FY, you must wait until the obligation has 
been accepted by IFMIS before submitting another transaction.  

10. Similar to an obligation, if the status of the obligation is AT SFS you may 
need to wait for a few minutes depending on volume to have the obligation 
move to the IFMIS module.  

11. The Authorization tab now displays the HMO Authorization Name and 
Date (Figure 10-87). 
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Figure 10-87 Authorization Tab with HMO Approval Information 

12. Repeat Task 2C: Verify Obligation, but this time, verify the deobligation. 

13. Repeat Task 2D: Notify Recipient of Obligation, but this time notify Recipient 
of the deobligation. 
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Part 4: Deallocation 

NOTE: If the system displays the message below (Figure 10-88) while you are 
creating the deobligation, this means that the deobligation will be 
processed in the current fiscal year and, therefore, a Deallocation is 
required. 

 
Figure 10-88: Reminder to Process the Deallocation 

The Deallocation tasks are the same as the Allocation tasks described earlier in 
this Unit. When you enter the deallocation dollar amount, be sure to enter the 
minus sign "-" before the dollar amount. 

Table 10-8 provides the task names and the corresponding pages in this Unit. 

Table 10-8: Task Names and Corresponding Unit 

TASK PAGE NUMBER 

Create Allocation and Submit to HMO 10-5 

Submit Allocation to SOA Financial Services (SFS) 10-17 
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References for Managing Allocations and Obligations 

Obligation of Funds Form Letter 

(Page 1 of 2)  

ADDRESS 
SUBJECT: PROJECT APPROVAL 

FEMA-XXXX-DR-(State) 
Hazard Mitigation Grant Program 
Subrecipient: NAME OF SUBRECIPIENT 
Project #: FEMA ASSIGNED NUMBER 
 

Dear__________: 
Funding for the above referenced Hazard Mitigation Grant Program (HMGP) 
project has been approved and is available for drawdown. The Federal share 
of the eligible project cost is $_______ and has been posted in Smartlink 
(enclosed report). Recipient and Subrecipient administrative costs are included 
in the funding obligation. 
Please refer the Subrecipient to the State HMGP administrative plan for project 
cost overrun regulations. If project costs exceed the approved Federal share, 
the Subrecipient must contact the Governor's Authorized Representative 
(GAR). The GAR will evaluate requests for cost overruns. Written 
determination of cost overrun eligibility shall be submitted by the GAR to the 
Regional Administrator. Cost overruns shall meet Federal regulations set forth 
in 44 CFR 206.438(b). 
The State HMGP administrative plan defines the procedure whereby the GAR 
may advance portions of the approved Federal share to the Subrecipient. 
Upon completion of the HMGP project, the Subrecipient's closeout 
reimbursement for the final Federal share of eligible project costs must be 
submitted to the Regional Administrator for review and determination. 
If you have any questions concerning this action or the information on the 
enclosed report, please contact _____________ (name) at _______________ 
(telephone number). 
Sincerely, 
 
Regional Administrator 
Mitigation, Disaster Recovery Manager 
Enclosure: Financial Analysis 
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Obligation of Funds Form Letter 
 

FEDERAL EMERGENCY MANAGEMENT AGENCY 
HAZARD MITIGATION GRANT PROGRAM 

FINANCIAL ANALYSIS 
 

 

DISASTER NUMBER: _____________ 

 

PROJECT:  _________________________________________________________ 

PROJECT NUMBER:  _________________________________________________ 

AMOUNT OBLIGATED (FEDERAL SHARE):  ______________________________ 

RECIPIENT ADMINISTRATIVE EXPENSES:  ______________________________ 

SUBRECIPIENT ADMINSTRATIVE EXPENSES:  ___________________________ 

TOTAL AMOUNT OBLIGATED:  _________________________________________ 

DATE FUNDS POSTED IN SMARTLINK:  _________________________________ 

AMOUNT POSTED FOR DRAWDOWN:  __________________________________ 

AS OF ________, TOTAL FUNDS FOR DRAWDOWN:  ______________________ 

STATE SUBACCOUNT NUMBER:  ______________________________________ 
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Overview 

The NEMIS HMGP Manage Project and Program Oversight process allows 
FEMA Regional Mitigation Staff members to oversee HMGP projects that have 
been approved. The system provides the following tools to assist users in 
implementing the oversight tasks: 

• Field Survey Documentation - Provide access to field survey reports;

• Project Management - Provides project activity and work schedule
information;

• Project Checklist - Provides information and dates for critical project
actions;

• Quarterly Reports - Provide quarterly reporting information throughout the
life of the project; and

• Global Matching - Provide monitoring of the overall Federal share of the
program.

Table 11-1 lists questions and answers about performing project and program 
oversight tasks. 

Table 11-1: Manage Project and Program Oversight Tasks 

ITEM DESCRIPTION 

Purpose Monitor HMGP projects and manage program oversight tasks 

When 
does it 
start? 

Throughout the disaster 

Who 
does it? 

Regional Mitigation staff 

How is it 
done? 

Execute six tasks: 

Task 1: Document Field Surveys 

Task 2: Perform Project Management 

Task 3: Review Project Checklist 

Task 4A: Create and Submit a New Quarterly Report 

Task 4B: Create and Submit a Subsequent Quarterly Report 

Task 4C: Import a Quarterly Report Spreadsheet 

Task 4D: Delete a Previously Submitted Quarterly Report 

Task 5: Monitor SF-424 Information  

Task 6: Perform Global Matching 
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Information Requirements 

Table 11-2: Tasks, Information Needed and Where It Can Be Obtained 

TASK INFORMATION NEEDED LOCATION IN NEMIS 

Task 1:  

Document Field 
Surveys 

Project number and title for which 
survey was conducted 

Mitigation > Projects > 
Application Development > 
Project Info tab 

Task 2:  

Perform Project 
Management Work schedule information  

Mitigation > Projects > 
Application Development > 
Work Schedule tab 

Task 3: 

Review Project 
Checklist 

Application Development and 
Eligibility Determination 
information 

Mitigation > Projects > 
Application Development tabs; 

Mitigation > HMGP > Eligibility 
Determination tabs 

Task 4A, 4B, 4C, 
4D:  

Quarterly Reports Current Quarterly Reports 
Mitigation  > Admin  > Quarterly 
Report 

Task 5:  

Monitor SF-424 
Information 

Funding sources for each project 
to be assigned to the SF-424 

Mitigation > Disaster > Overview 
> SF 424 Information tab 

Task 6:  

Perform Global 
Matching 

Project Federal Share 
Percentage 

Mitigation > Funding > Estimate 
tabs 
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Task 1: Document Field Surveys 

1. On the NEMIS menu bar, click on the MITIGATION icon. On the Mitigation 
menu, click Projects > Field Surveys (Figure 11-1). 

 
Figure 11-1: Mitigation > Projects > Field Surveys 

2. The Field Survey screen is displayed (Figures 11-2 and 11-3). 

 
Figure 11-2: Field Survey Screen - Left Side 

 
Figure 11-3: Field Survey Screen - Right Side 
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3. On the bottom left part of the screen, click the ATTACH button. The 
Attachment dialog box is displayed (Figure 11-4). 

 
Figure 11-4: Attach a Document Dialog Box 

4. Enter a unique Field Survey Title. 

5. You are strongly urged to read and follow the instructions in Appendix A: 
Attach Documents. 

CAUTION: Attachments cannot be deleted once they have been added to NEMIS 
HMGP. Please make every effort to limit the file attachment size to less 
than 1GB. Allow up to one hour to retrieve and view newly attached 
documents. 

6. The Successful Archive of Document message is displayed (Figure 11-5).  

 
Figure 11-5: Successful Archive Message 

7. Click the OK button. The field survey document title is displayed on the left-
most column of the Field Survey screen (Figure 11-6). 
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Figure 11-6: Field Survey Screen with New Document - Left 

8. Highlight the row of the document you attached. Click the LINK TO PROJECT 
button (Figure 11-7). 

 
Figure 11-7: Field Survey Screen with New Document - Right Side 

9. The Field Survey Project List is displayed (Figure 11-8). 

 
Figure 11-8: Field Survey Project Selection Screen 
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10. Table 11-3 describes the Field Survey Project List information.

Table 11-3: Field Survey Project List Data Fields 

DATA FIELD INFORMATION DISPLAYED 

FEMA Proj Nr System-generated FEMA project application number when 
project is submitted to FEMA 

Amend Number Project application Amendment Number 

Applic ID Recipient project application number 

Subrecipient Name Name of Subrecipient 

Project Title Project Title 

Approval Date Date on which the project was given final approval in the 
eligibility determination process 

Grant Amount Total eligible project costs (Federal and non-Federal shares) 

11. Highlight the project to which the field survey should be linked. Click the OK
button. The Project is now linked to the attachment (Figure 11-9).

Figure 11-9: Field Survey Linked to Project 

12. On the bottom right part of the screen, click the CLOSE button.

HINT: To track the Document Field Survey process, generate the standard Field 
Survey Report. Follow the instructions described in Unit 14: Generate 
Standard HMGP Reports. 
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NOTE: To view a document, highlight the row on which it is listed and click the 
VIEW button. 
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Task 2: Perform Project Management 

1. On the MITIGATION menu, click on Projects > Management (Figure 11-10). 

 
Figure 11-10: Mitigation >Projects >Management 

2. The Select Project List is displayed (Figure 11-11). 

 
Figure 11-11: Select Project List 

NOTE: The Select Project List displays all project applications, whether they have 
been approved or not. 

3. Table 11-4 describes the Project List information. 

Table 11-4: Select Project List Data Fields 

DATA FIELD INFORMATION DISPLAYED 

Disaster Nr FEMA disaster number 

FEMA Proj Nr System-generated FEMA project application number when 
project is submitted to FEMA 

Amend Nr Project application Amendment Number 
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DATA FIELD INFORMATION DISPLAYED 

Applic ID Recipient project application number 

Suffix Identifies the funding type of the project—R (Regular); F 
(Initiative); P (Project Management)); or M (Management 
Costs) 

ST State where disaster occurred 

Region FEMA Region where disaster occurred 

Project Title Project Title 

4. Select the project you wish to manage - choose the highest amendment number 
to view the most current information. 

5. Click the OK button. The HMGP Project Management tab is displayed by 
default (Figure 11-12). 

 
Figure 11-12: Mitigation >Projects >Management > 
HMGP Project Management Tab 

6. The top part of the tab displays Mitigation Project Description information. 

7. The bottom part of the tab displays Work Schedule Status information. For each 
work schedule item, edit the Due Date, the Revised Date, and the Completion 
Date if necessary.  

8. On the bottom left part of the HMGP Project Management tab, click the 
FEDERAL ELIGIBILITY button to review eligibility information. 
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9. The Federal Eligibility tabs are displayed (Figure 11-13). Click the tab where you 
wish to view information or add additional comments. 

 
Figure 11-13: Mitigation >Projects >Management >Federal Eligibility  

10. To exit out of the Federal Eligibility tabs, click the CLOSE button on the bottom 
right part of the screen. 

11. On the bottom left part of the HMGP Project Management tab, click the 
APPLICATION DEV button. 

HINT: You may get the Project Eligibility Has Been Completed message (Figure 
11-14). Click the OK button to view application information. 

 
Figure 11-14: Project Eligibility Completed Message 

12. The Application Development tabs are displayed (Figure 11-15). Click the tab 
where you wish to view information or add additional comments. 
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Figure 11-15: Mitigation >Projects > 
Management > Application Development 

13. To exit out of the Application Development tabs, click the CLOSE button on the 
bottom right part of the screen. 

14. On the bottom left part of the HMGP Project Management tab, click the 
ENVIRONMENT CONDITION button. Complete Steps 14a - 14h. 

HINT: The ENVIRONMENT CONDITION button is active only if the Monitoring 
Required checkbox was checked for Conditions Required in the Mitigation 
> Projects > Eligibility Determination > NEPA Process Tab. 

By completing Steps 14a - 14h in the system, you indicate that the required 
monitoring was completed. 

a. The Environment Conditions dialog box is displayed (Figure 11-16). 
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Figure 11-16: Environment Conditions Dialog Box 

b. Enter the Monitoring Complete Date. The system auto-fills your User 
Name in the Monitoring Complete By field (Figure 11-17). 

 
Figure 11-17: Monitoring Complete Data Fields 

c. Scroll to the right to access the Comment field (Figure 11-18). 

 
Figure 11-18: Monitoring Complete Comments Field 

d. Double-click inside the Comment field to access the Comment Editor. 
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e. Enter your comments in the Comment Editor text area. Click the OK 
button. 

CAUTION: Comments entered here cannot be edited or deleted once you click the 
OK button. 

f. The comments you entered are displayed in the Environment Conditions 
dialog box (Figure 11-19). Click the OK button. 

 
Figure 11-19: Monitoring Complete Comments Added 

g. On the MITIGATION menu, click on Projects > Eligibility Determination > 
View All. Highlight the desired project and select OK. Select the NEPA 
Process tab. Note that the system auto-filled the Monitoring Complete 
data fields (Figure 11-20). 

 
Figure 11-20: Monitoring Complete Information Added to Mitigation > 
Projects >Eligibility Determination >NEPA Process Tab 
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HINT: All monitoring requirements for environment conditions required must 
be marked complete before you can closeout the project. 

h. On the bottom right part of the NEPA Process tab, click the CLOSE 
button. The Project Management tabs are displayed. 

15. Click the Funding Activity tab. The Funding Activity tab displays approved 
Project Costs, and Allocation/Obligation history (Figure 11-21). 

 
Figure 11-21: Funding Activity Tab 

16. If you wish to view Funding Activity information only for Approved projects, click 
inside the “Approved” radio button in the Filter field (Figure 11-22). 

 
Figure 11-22: Approved Filter 

17.  When you are done reviewing Funding Activity information, click the CLOSE 
button. 
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Task 3: Review Project Checklist 

1. On the MITIGATION menu, click on Projects > Checklist (Figure 11-23). 

 
Figure 11-23: Mitigation >Projects >Checklist 

2. The Project Status List is displayed (Figure 11-24). 

 
Figure 11-24: Project Status List 

3. Table 11-5 describes the Project Status List information. 

Table 11-5: Select Project List Data Fields 

DATA FIELD INFORMATION DISPLAYED 

Dstr Nr FEMA disaster number 

Aplcn Id Project application ID number 

Project Amend Nr Project application Amendment Number 

Project Status FEMA review status of the project, represented by 5 
descriptors: Approved, Not Approved, Withdrawn, Voided or 
Pending 
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DATA FIELD INFORMATION DISPLAYED 

Aplcn Submit Date System-generated project application submission date 

Aplcn Rcvd Date If the project application was submitted in NEMIS HMGP, 
same as the Application Submit Date 

If the project application was submitted in hard copy, date 
received at the FEMA Regional Office. 

Final Apprv Date Date the FEMA application approval was reported in NEMIS 
HMGP  

Title Project Title 

4. Click the OK button. The Project Checklist screen is displayed. 

5. In the Select field, scroll down to select the project whose checklist you wish 
to view (Figure 11-25). 

 
Figure 11-25: Project Checklist Select Field 

6. Click the RETRIEVE button. The Project Checklist information is displayed 
(Figure 11-26). 
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Figure 11-26: Project Checklist Information 

7. You may select multiple projects by holding down the Ctrl key and selecting 
the desired rows (Figure 11-27). 

 
Figure 11-27: Selecting Multiple Projects 

8. Click the RETRIEVE button. The system retrieves the checklist for each of 
the selected projects. Scroll arrows are displayed on the top left part of the 
screen to allow you to scroll to each project checklist (Figure 11-28). 
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Figure 11-28: Scroll Arrows for Navigating Between Projects 

9. On the right side of the Project Checklist screen, buttons provide access 
to the different NEMIS HMGP areas (Figure 11-29). 

 
Figure 11-29: Buttons to NEMIS HMGP Areas 

10. Clicking the desired button displays the NEMIS HMGP screen where the 
information was entered. 

11. On the bottom right part of the screen, (See Figure 11-27), click the 
PROJECT SUMMARY button. The Project Summary report is displayed 
(Figure 11-30). 
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Figure 11-30: Project Summary Report 

12. On the bottom right part of the screen, click the CLOSE button to exit out 
of Project Checklist. 
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Task 4A: Create and Submit a New Quarterly Report 

1. On the MITIGATION menu, click on Admin > Quarterly Report (Figure 11-31). 

  
Figure 11-31: Mitigation > Admin > Quarterly Report 

2. The Quarterly Report screen is displayed. To create a new Quarterly Report for a 
project, highlight the project and click the NEW button (Figure 11-32). 

  
Figure 11-32: Mitigation > Admin > Quarterly Report > New 

3. Select the Fiscal Year and Quarter Number from the pull down menu. After the 
Fiscal Year and Quarter Number pulldowns are selected, the rest of the project 
information(Application ID, Amendment Number, etc.) auto populates and the 
lower half fields are available for data entry (Figure 11-33). 
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Figure 11-33: Quarterly Report Input Screen 

4. Enter data in the available fields. After entering data, you may Save the report, or 
Delete the report and start over.  

5. After data entry always save the report before submitting.  
6. When the SUBMIT button is selected a series of validations is conducted to 

ensure the data entered is appropriate.  
7. Once a report is submitted by selecting the SUBMIT button and by completing 

the validations, it can not be edited or deleted.  An exception is that if the status 
is Closed, which automatically generates Final Report = Yes, the status of a 
Submitted closed report may be amended, then saved and submitted as 
ammended.  The Final Report will revert to = NO.  Every project is required to 
have a status of Closed, Final Report = YES and be Submitted when all project 
activities are completed.  

8. Except when importing several Quarterly Reports for a single project, a second 
report for a project cannot be newly created manually unless the previous report 
has been submitted. Attempting to do so will generate an error message (Figure 
11-34). 
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Figure 11-34: Validation error message 

9. Ensure you have entered all of the required information before submitting a 
report. As data is entered, certain validations will be performed (Figure 11-35). 

 
Figure 11-35: Validation message: Item does not pass the validation test 

10. A series of Warning messages are generated as you attemp to submit a 
Quarterly Report. The first message will ask if you are sure you want to submit 
(Figure 11-36). Select Yes or No. 

 
Figure 11-36: Validation warning 

11. After selecting Yes, the validation messages will begin.  The Total Properties 
field and the Property ID list are required entries (Figure 11-37). After selecting 
OK, enter the required data and select the Submit button again. The validation 
will continue. 
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Figure 11-37: Validation message: Federal Funds Disbursed must be entered 

12. Additional validation messages may be received. Each time a message is 
received, select OK, correct or enter the validated data and start the submittal 
process again.  

13. If Yes is selected in the Time Extension field, a time extension date must be 
entered. If a date for Time Extension Date is entered, Yes must be selected 
(Figure 11-38). 

 
Figure 11-38: Time Extension and Time Extension Date fields 

NOTE:  Validation messages will be displayed if the Time Extension Date is not 
after the declaration date or is not a date in the future  

14. If project Status = Closed then Date Final Payment made to Subrecipient is 
required (Figure 11-39). 
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Figure 11-39: Validation message: Date Final Payment made to Subrecipient is 

required if Status is Closed 

15. If project Status = Closed and Final Report = Yes is selected then Actual 
Completion Date is required (Figure 11-40).  Validation will also be conducted to 
verify date entered is equal to or less than the current date but greater than the 
declaration date. 

 
Figure 11-40: Validation message: Actual Completion Date must be entered 

16. Once the validation is completed and the report is submitted it cannot be deleted.  
The Delete button is greyed out and not active when a submitted report is 
selected. 

17. Other Validation messages that will be received if appropriate are: 

a. Status must be selected / Cost Code must be Selected / Subrecipient 
Expenditures to Date must be entered / Last Drawdown Date is required if 
Status is closed.   

b. When submitting a Final Report for a closed project, entries must be made 
in the FEMA user’s only section by a FEMA employee with the appropriate 
position.  When attempting to submit a Final Report Validation messages 
may include:  Calculation of UDO must be entered / Excess Funds must 
be entered / and Deobligation Amount must be entered. 

18. Any attempt to create a new report for a project in a Fiscal Year and Quarter that 
already exists as a submitted report will result in the message below when 
attempting to Save or submit the duplicate report. The message will be specific 
as to the FY and Quarter of the duplicate data (Figure 11-41). 
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Figure 11-41: Validation message: Actual Completion Date must be entered 

19. Select OK, and then delete the duplicate report by highlighting and selecting the 
Delete button.  

NOTE:  You can now submit all the validated reports for the current quarter in 
process with the “Submit All” button.  

The “Submit All” button will submit all the quarterly reports for the current 
quarter in progress and will not apply to those quarters that are past 
due. During submission, reports that fail validation will be shown by their 
project number and quarter number on the quarterly report screen. Only 
those reports that pass all the validations will be submitted.  

The “Submit All” button will not be available for use by HMOS users (will appear 
grayed out).  

The “Submit All” button is displayed at the bottom of the screen, next to the 
“Submit” button. 
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Task 4B: Create and Submit a Subsequent Quarterly Report 

1. On the MITIGATION menu, click on Admin > Quarterly Report (Figure 11-42). 

  
Figure 11-42: Mitigation > Admin > Quarterly Report 

2. The Quarterly Report screen is displayed. To create and submit the Quarterly 
Report for the next quarter, highlight the appropriate project and select New. 

3. Select the subsequent Fiscal Year if applicable and/or the next Quarter Number 
(Figure 11-43).   

 
Figure 11-43: Subsequent Fiscal Year and Quarter Number 
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NOTE: To avoid duplication of effort the information in the previously submitted 
report is replicated in the new report.  Update or edit the existing 
information, add any new information such as a change in Status or Cost 
Code or Time Extension, and select Submit.  The new report will go 
through the validation process. 
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Task 4C: Import a Quarterly Report Spreadsheet 

1. Enter the project data into the spreadsheet. The spreadsheet template is 
available within the HMGP MR 3.17.00 Release Notes or contact your FEMA 
Regional Office.  

2. The spreadsheet can be used to import a single report, or to import data for 
either multiple projects within a single disaster (Figure 11-44), or to import 
multiple Quarterly Reports for a single project within a disaster (Figure 11-45).  

 
Figure 11-44: Import a single report or multiple projects 
within a single disaster 

 
Figure 11-45: Import multiple Quarterly Reports for a single 
project within a disaster 

NOTE: To be successful, the data for the project must be entered in near entirety 
and must be entered correctly.  No duplicates within the spreadsheet or of 
existing reports is allowed.   

3. After entering the data for a single project or multiple projects in the spreadsheet,  
select the Import button.  Navigate to the location of the saved spreadsheet, 
highlight the spreadsheet file, and select open. You can also double click on the 
spreadsheet to open (Figure 11-46). 
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Figure 11-46: Select the spreadsheet file 

4. The system will go through the spreadsheet row by row and column by column 
and report any missing or ill-formatted data in need of validation. When 
importing, the spreadsheet data is validated. You may receive one or more 
importing error messages (Table 11-7). When you receive an importing error 
message, select OK, go back to the spreadsheet, fix the error identified in the 
message and repeat the import process. 

HINT: To save time attempting to conduct multiple imports of the same 
spreadsheet, ensure you fill out the spreadsheet to accurately identify the 
disaster number, project number, and application ID, as well as the Fiscal 
Year and Quarter Number the import is intended to populate.  It is best if 
all requested data can be entered on the spreadsheet in the format 
expected prior to attempting to import the first time.  

5. If there are no importing errors, the “Import completeled successfully” message is 
displayed. 

6. Select OK. The data imported for the project is displayed (Figure 11-47).   



September 2016 Unit 11: Manage Project and Program Oversight Tasks 
 

NEMIS HMGP User Manual MR 3.19.01 Page 11-31 

 
Figure 11-47: Data imported into Quarterly Report screen 

7. Once imported, the Quarterly Report information can be edited, saved, 
submitted, or all three. The import process is not considered complete until the 
report has been submitted and all potential data validations, as discussed in Task 
4A, have been cleared. 

8. If you try to import or enter the same Quarterly Report as was imported or 
entered previously, the system will display a validation message: Duplicate Fiscal 
Year and Quarter Number combination. The report will not be imported a second 
time. 

9. Select OK. The “Quarterly Import Failed” message is displayed.  If you try to 
import a blank spreadsheet, a “No valid rows found in the spreadsheet to import” 
validation is displayed. 

10. When attempting to import a spreadsheet with one project or several, you could 
encounter any one of the validation messages. Please refer to the Reference 
section at the end of Unit 11. 
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Task 4D: Delete a Previously Submitted Quarterly Report 

1. Ensure you are signed on with the Hazard Mitigation Operations Specialist 
(HMOS) group ID. If you are not, change the group ID to HMOS. 

NOTE: In rare instances, a  deletion may be necessary to allow for the submittal 
of a corrected QPR. Only users with the Hazard Mitigation Operations 
Specialist (HMOS) role can delete a submitted QPR.  The deletion must be 
approved by the Grants Implementation Branch at Headquarters. To 
obtain approval, the Regional Branch Chief should email the HMA inbox 
at HMAProgram@fema.dhs.gov 

2. On the MITIGATION menu, click on Admin > Quarterly Report.  

3. The Quarterly Report screen is displayed. To delete a previously submitted 
Quarterly Report, highlight the report (Figure 11-48). If the report meets the initial 
criteria for deletion, the Delete button will be available.  

 
Figure 11-48: Submitted Quarterly Report 

4. Click on the Delete button. The warning window is displayed (Figure 11-49): Are 
you sure you want to delete? Select Yes or No. If yes, the selected QPR will be 
deleted. 
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Figure 11-49: Warning window - Are you sure you want to delete? 

NOTE:  The deleted report can be recreated as new and saved by any of the 
approved users (HMO, MA, MTSU and SAO).  However, if outside of the 45 
day submittal window for the selected QPR, only the HMOS user while in 
the HMOS group can submit the replacement QPR.  Until the newly 
created QPR is submitted by the HMOS, the Fiscal Year and Quarter 
Number of the QPR will display in Red Font and when selected the QPR 
will display NOT SUBMITTED across the body of the QPR (Figure 11-47). 
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Task 5: Monitor SF-424 Information 

NOTE: NEMIS HMGP assumes that one SF-424 is submitted for each Recipient 
with a total funding estimate including total Recipient and Subrecipient 
Administrative costs. As that estimate changes, subsequent SF-424s that 
are submitted are considered revisions that supersede the previous 
version. 

As you perform project and program monitoring, check to see that the  
SF-424 is up to date. See Unit 3, Task 8: Enter SF-424 Information. 
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Task 6: Perform Global Matching 

Execute this task if the project has a Federal share other than 75 percent and 
after projects have been approved and obligated. 

1. On the MITIGATION menu, click on Funding > Estimate (Figure 11-50). 

 
Figure 11-50: Mitigation >Funding >Estimate 

2. The Funding Estimate tabs are displayed. Click the scroll arrow or enlarge 
your screen to display the rest of the tabs (Figure 11-51). 

 
Figure 11-51: Funding Estimate Tabs 

3. Scroll to the right and click the Project Global Match tab. The top section of 
the tab lists all approved projects for the disaster (Figure 11-52). 
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Figure 11-52: Mitigation > Funding > Estimate >  
Project Global Match Tab 

4. Table 11-6 describes the Approved Projects List information. 

Table 11-6: Approved Projects List Data Fields 

DATA FIELD INFORMATION DISPLAYED 

FEMA Project 
Number 

System-generated FEMA project application number when 
project is submitted to FEMA 

Application ID Recipient project application number 

Amendment Number Project application Amendment Number 

Suffix Funding type of the project—R (Regular); F (Initiative); P 
(Planning); or M (Management Costs) 

St State where disaster occurred 

Proj Fed Share Pct  percent of the project costs funded by HMGP 

HINT: If this is greater than 75 percent, the project 
must be globally matched with other projects to 
balance the total Federal share to 75 percent or 
less. 

Project Title Project Title 

5. Scroll down to find the project that has a Project Fed Share Pct other than 75 
percent. Highlight the project (Figure 11-53). 
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Figure 11-53: Select Project for Global Match 

6. Click the ADD PROJECT TO MATCH button. The project gets added to 
the list of projects in the bottom section of the tab (Figure 11-54).  

 
Figure 11-54: Project Added to Match 

7. Repeat Steps 5 and 6 for all projects that have a Project Fed Share Pct other 
than 75 percent. 

CAUTION: The Total Project Fed Share Pct, (Figure 11-54), must be equal to or 
less than 75 percent. 
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8. Closely monitor the Total Project Fed Share Pct (Figure 11-54) throughout the 
obligation process.  

CAUTION: Amended projects do not automatically update in the selected 
projects screen. The latest approved amendment will appear as 
available for selection to the match. However, if the total eligible 
project cost or Federal share percentage have changed, it will be 
necessary to manually delete the old amendment from the match and 
then add the new amendment to the match.  
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References for Errors Importing a Spreadsheet 

The system will go through the spreadsheet row by row and column by column and 
report any missing or ill formatted data in need of validation. Table 11-7 shows a list 
of possible importing errors and validation messages. 

Table 11-7: Possible Importing Errors and Validation Messages 

POSSIBLE IMPORTING ERRORS AND VALIDATION MESSAGES 

No valid rows found in the spreadsheet to import  

Error Importing, "Disaster Number in row #" must be same as the selected Disaster 
in the application 

Disaster Number cannot contain characters, in row # 

Project Number does not exist in the application, in row # 

Application ID does not exist or is not approved in the application, in row # 

Application ID cannot be empty, in row # 

Application ID cannot contain characters, in row # 

Closed Project in the application cannot be imported, in row # 

Fiscal Year must be 'Year'  

Fiscal Year cannot contain characters, in row # 

Quarter Number must be between 1 and 4, in row # 

Quarter Number cannot contain characters, in row # 

Subrecipient Expenditure to Date must be an amount, in row # 

Total Recipient Drawdown must be an amount, in row # 

Last Drawdown Date has an invalid format, in row #, expected format is 
mm/dd/yyyy' 

Federal Funds Disbursed must be an amount, in row # 

Time Extension Date has an invalid format, in row #, expected format is 
mm/dd/yyyy 

Invalid Time Extension flag, in row #, expected value is Y or N 

Percent Work Completed must be number, in row # 

Comment cannot exceed 500 characters, in row # 

Total Properties must be number, in row # 

Property ID List cannot exceed 500 characters, in row # 

Date Final Payment made to Subrecipient has an invalid format, in row # expected 
format is mm/dd/yyyy 



Unit 11: Manage Project and Program Oversight Tasks September 2016 
 

Page 11-40  NEMIS HMGP User Manual MR 3.19.01 

POSSIBLE IMPORTING ERRORS AND VALIDATION MESSAGES 

Approved Completion Date has an invalid format, in row #, expected format is 
mm/dd/yyyy 

Actual Completion Date has an invalid format, in row #, expected format is 
mm/dd/yyyy 

Invalid Cost Code, in row # 

Invalid Status, in row # 

Actual Completion Date is required, in row # 

Actual Completion Date must be less than or equal to the current date, in row # 

Actual Completion Date must be greater than or equal to Declaration Date, in row # 

Date Final payment made to Subrecipient is required if Status is Closed, in row # 

Last Drawdown Date is required if Status is Closed, in row # 

Time Extension Date is required, in row # 

Time Extension Date must be a future date, in row # 

Time Extension Date must be after Declaration Date, in row # 

Quarterly Report import failed 

Import Completed Successfully – Total Number of Reports Imported _. 

Error Examples: 

1. In this example, the user is attempting to import reports for several different 
projects within the same disaster. However, the user has transposed the Disaster 
Number in Row 2 (Figure 11-55). 

 
Figure 11-55: Disaster Number transposed in the spreadsheet 

SUPER CIRCULAR TERMINOLOGY NOTATION:  While the figure above shows the 
terms Grantee and/or Subgrantee, please note that the new terminology 
under the Super Circular is Recipient and Subrecipient. 
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HINT: Row 1 of the spreadsheet is the header, so the first row of project data is 
row 2. 

2. The system will return the following Error Importing message (Figure 11-56).  
Select OK, correct the Disaster Number and attempt to import the spreadsheet 
again using the process described previously.  

 
Figure 11-56: Disaster Number 6358 must be same as the 
selected Disaster 6358 in the application error message 

3. In this example the Application ID in Row 2 was entered incorrectly (Figure 11-
57). The Application ID cannot be blank and must match exactly the Application 
ID of the Project Number. 

 
Figure 11-57: Application ID entered incorrectly 

SUPER CIRCULAR TERMINOLOGY NOTATION:  While the figure above shows the 
terms Grantee and/or Subgrantee, please note that the new terminology 
under the Super Circular is Recipient and Subrecipient. 

4. The system will return the following Error Importing message (Figure 11-58).  
While the message says “Project Number does not exist”, this message or 
another possible message, “Application ID does not exist or is not approved in 
the application” will be displayed anytime the MT Project Number and Application 
ID do not match or if the project does not exist in the system as eligible to be 
reported out. Select OK, correct or enter the Application ID or Project Number or 
both and attempt to import the spreadsheet again.  
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Figure 11-58: Project Number does not exist error message 

5. In this example the date entered under Last Drawdown Date in Row 3 was not 
entered in the correct format (Figure 11-59). The forward slash (/) separators are 
missing.  The expected format is MM/DD/YYYY.  Also, in this instance the date is 
required for a Status of Closed. 

 

Figure 11-59: Date not entered in the correct format 

SUPER CIRCULAR TERMINOLOGY NOTATION:  While the figure above shows the 
terms Grantee and/or Subgrantee, please note that the new terminology 
under the Super Circular is Recipient and Subrecipient. 

6. The system will return the following Error Importing message (Figure 11-60).  
Select OK, enter the date in the correct MM/DD/YYYY format and attempt to 
import the spreadsheet again.  

 
Figure 11-60: Last Drawdown Date has an invalid format error message 

7. In this example, the Status of Closed in Row 3 requires the Actual Completion 
date be entered and the date is missing (Figure 11-61). 
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Figure 11-61: Actual Completion Date is missing in spreadsheet 

SUPER CIRCULAR TERMINOLOGY NOTATION:  While the figure above shows the 
terms Grantee and/or Subgrantee, please note that the new terminology 
under the Super Circular is Recipient and Subrecipient. 

8. The system will return the following Validation message (Figure 11-62). Select 
OK, enter the missing Actual Completion Date in the correct MM/DD/YYYY 
format and attempt to import the spreadsheet again.  

 
Figure 11-62: Actual Completion Date must be less than 
or equal to the current date validation message 

9. In this example, in Row 4, Time Extension has been entered as Y and thus the 
Time Extension Date is required and the date is missing (Figure 11-63). 

 

Figure 11-63: Project Date is missing 

SUPER CIRCULAR TERMINOLOGY NOTATION:  While the figure above shows the 
terms Grantee and/or Subgrantee, please note that the new terminology 
under the Super Circular is Recipient and Subrecipient. 



Unit 11: Manage Project and Program Oversight Tasks September 2016 
 

Page 11-44  NEMIS HMGP User Manual MR 3.19.01 

10. The system will return the following Validation message (Figure 11-64). Select 
OK, enter the missing Time Extension Date in the correct MM/DD/YYYY format 
and attempt to import the spreadsheet again.  

 
Figure 11-64: Time Extension Date is required validation message 

11. While this should not occur frequently, in this example in Row 5 the Comments 
entered exceed 8000 characters (Figure 11-65). 

 

Figure 11-65: Comments entered exceed 8000 characters in spreadsheet 

SUPER CIRCULAR TERMINOLOGY NOTATION:  While the figure above shows the 
terms Grantee and/or Subgrantee, please note that the new terminology 
under the Super Circular is Recipient and Subrecipient. 

12. The system will return the following Error Importing message (Figure 11-66). 
Select OK, limit the comments to 8000 characters and attempt to import the 
spreadsheet again.  

 
Figure 11-66: Comment cannot exceed 8000 characters message 
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13. Some data errors made on the spreadsheet will not be validated by the system 
until the import process. In this example the Approved Completion Date is 
missing for all of the projects (Figure 11-67). Approved Completion Date is 
required for all projects but is only validated during the Submit process (Figure 
11-68). 

 

Figure 11-67: Missing Approved Completion Date fields 

SUPER CIRCULAR TERMINOLOGY NOTATION:  While the figure above shows the 
terms Grantee and/or Subgrantee, please note that the new terminology 
under the Super Circular is Recipient and Subrecipient. 

 
Figure 11-68: Approved Completion Date must be entered validation message 

14. There are also additional validations for projects that have previously been 
submitted as closed. For example, if you try to import a new report for a project 
that was closed in the previous quarter, the system will return the Error Importing 
message shown below (Figure 11-69). To import or enter an updated report for a 
project submitted as closed it will be necessary to change the status of the 
submitted closed report to something other than closed which along with Final 
Report = Yes, are the only changes that can be made to a submitted report.  

 
Figure 11-69: Closed Project in the application cannot be imported message 
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15. The last example is of the message that will be generated should the user 
attempt to import reports using a spreadsheet that does not have the approved 
pull down menus or if the user attempts to enter data in a field that deviates from 
the data in the pull down menus. For example, the user below has overridden the 
pull-down for Time Extension using a small n (Figure 11-70). 

 
Figure 11-70: Unapproved spreadsheet entry 

SUPER CIRCULAR TERMINOLOGY NOTATION:  While the figure above shows the 
terms Grantee and/or Subgrantee, please note that the new terminology 
under the Super Circular is Recipient and Subrecipient. 

16. When attempting to import the spreadsheet the system returned the following 
message (Figure 11-71). The entry will need to be changed to N before the 
spreadsheet can be imported. 

 
 Figure 11-71: Invalid Time Extension flag message 

17. While examples of all of the possible Submit or Import Validation and Error 
Importing messages were not replicated in this document, they are all well 
described and it should be intuitive to the user as to what steps are necessary to 
successfully submit a Quarterly Report regardless of whether it was manually 
entered or imported via the approved spreadsheet. 

18. To save time attempting to conduct multiple imports of the same spreadsheet, 
ensure you fill out the spreadsheet to accurately identify the disaster number, 
project number, and application ID, as well as the Fiscal Year and Quarter 
Number the import is intended to populate. It is best if all requested data can be 
entered on the spreadsheet in the format expected prior to attempting to import 
the first time. Please keep in mind that closed projects and Final Reports have 
special validation issues over and above those reports for ongoing projects. 
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Overview  

The NEMIS HMGP Manage Project Closeout process allows FEMA Regional 
Mitigation staff to close out HMGP projects.  
Projects with "Approved" status are closed out when: all project activities have 
been completed; project funds have been reconciled; and administrative, 
financial and reporting requirements have been complied with. Regional 
Mitigation Staff verify that all applicable fields in the following areas of the 
Mitigation module are completed: 

• Projects > Application Development 
• Admin > Quarterly Report 
• Admin > Environmental Conditions 
• Projects > Management 

All other project applications that were entered in NEMIS are required to be 
closed out through the project closeout process irrespective of whether they were 
submitted to the Eligibility Determination process or not. This is required before 
Program Closeout (described in Unit 13). Table 12-1 provides an overview of the 
Manage Project Closeout process in NEMIS HMGP. 

Table 12-1: Manage Project Closeout Overview 

 DESCRIPTION 
Purpose Close out HMGP projects when all applicable administrative and 

required work has been completed   

When does it start? Upon receipt of request from the Recipient to close out the 
project 

Who does it? Hazard Mitigation Officer (HMO) 

How is it done? Execute eight tasks: 

Task 1: Determine Project Status 

Task 2: Enter General Information 

Task 3: Enter Financial Information 

Task 4: Enter Property Information 

Task 5: Enter State Management Cost Information 

Task 6: Review Environmental Conditions 

Task 7: Enter Closeout Report Information 

Task 8: Close Out the Project 

CAUTION: Project closeout cannot be completed in the system if any of the 
following conditions are true: (1) An amendment is open, (2) 
Environmental conditions information is incomplete, (3) Property site 
inventory information is incomplete. 
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Information Requirements 

FEMA Regional Mitigation staff needs the Recipient's Final Project Report with 
the following supporting documentation (where applicable): 

• Closeout Inspection Report 

• Final Performance Report 

• Final Financial Report 

• SF270 - Request for Advance or Reimbursement 

• FF20-18 - Report of Government Property 

• Project Documents such as: 
o Administrative Costs 
o Project Scope 
o Project Finances 
o Copyright Issues 
o Substantial Completion Certificate 
o Work Schedules 
o Procurement Contracts 

• Property Site Inventory type projects may include the following 
documents: 

o Applicable Assurances 
o No Use of Eminent Domain 
o Duplication of Benefits Verification 
o Appraisals 
o Privacy Act Release 
o Hazardous Materials 
o Covenants 
o Closing Statements 
o Copies of Recorded Deeds 
o Relocation Assistance 
o Permits 
o Engineering Certifications 
o Elevation Certificates 

CAUTION: Allow up to one hour before retrieving and viewing newly attached 
documents. 
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Task 1: Determine Project Status 

1. On the NEMIS menu bar, click on the Mitigation icon. On the MITIGATION 
menu, click Projects > Closeout (Figure 12-1). 

 
Figure 12-1: Mitigation >Projects >Closeout 

2. The Project Closeout List is displayed (Figure 12-2). 

 
Figure 12-2: Project Closeout List  

3. Table 12-2 describes the Project Closeout List information. 
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Table 12-2: Project Closeout List Data Fields 

DATA FIELD INFORMATION TO BE REVIEWED/ENTERED 

Disaster Nr FEMA disaster number 

FEMA Proj Nr System-generated FEMA project application number when 
project is submitted to FEMA 

Amendment Nr Number assigned to the amendment by the system during the 
Amendments process 

Applic ID Recipient project application number 

Suffix Type of funding requested;  Suffix codes are R (Regular project 
funding), P (Planning), M (Management Costs), and F (Initiative 
projects) 

Closeout System-generated date project was closed out 

Project Title Name given to the project during the application development 
process 

4. Select the project that needs to be closed out. Click the OK button. 

5. If the project meets the conditions for closeout, the Project Closeout tabs are 
displayed without any project closeout validation message.  

a. The General tab is displayed by default. 

b. On the bottom left part of the tab, take note of the Project Status. If the 
status is "Approved," execute Tasks 2 − 8 of this unit. 

c. If the status is "Void," "Withdrawn," or "Denied," proceed to Task 8: 
Closeout the Project. 

6. If the approved project does not meet the conditions for closeout, the 
appropriate project closeout validation message is displayed. Figure 12-3 is 
an example of the message you receive in approved projects when the 
Property Site Inventory (PSI) has missing information. 
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Figure 12-3: Missing PSI Information Validation Message 

7. With the V3.15.04 release of June 2013, a new project closeout validation 
message was introduced. Figure 12-4 shows the new validation message 
related to the validation of the Number of Properties in Project field found in 
the Property Site Inventory (PSI) tab. (See Figure 12-5) 

 
Figure 12-4: Number of properties in project not validated message 

 
Figure 12-5: Number of Properties in Project field 
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8. When encountering the validation message displayed in Figure 12-4, the user 
will have up to two options for resolving the message. Option #1 as detailed 
below will be available for all project types and will be the only option 
available for project types that require detailed property information to be 
captured by the PSI, such as acquisition and elevation projects. 

Option #1 — The Number of Properties in Project field must match the PSI 
number on the input field “Is this property included as part of the final project” that 
are selected as YES. To remove the message, it will be necessary to either 
revise the number entered in the Number of Properties in Project box to match 
the PSI or update the PSI inventory to include the same number of properties 
marked YES to the part of final project question as are identified by the Number 
of Properties in Project field. 

Option #2 — Project types that could include hundreds or thousands of 
properties within their scope of mitigation, such as dams, flood control, 
stormwater management, or flood wall projects, have the option of requesting a 
FEMA HQ validation of the Number of Properties in Project field in lieu of 
entering extensive detailed property information in the PSI, which is not required 
for these types of projects. 

The projects that have been identified as eligible for HQ Validation are identified 
under Project Matrix Admin on the Project Types tab. As shown in Figure 12-6 
below, project types that can be HQ Validated have a check mark in the newly 
created Hmos Valid Flg column.  

 
Figure 12-6: Project Matrix Admin screen and HMOS Valid Flg 
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Option #2 (Cont.) — For project types that only require the total number of 
properties mitigated and not detailed property information as indicated by the 
HMOS validation flag, the project can be closed if the requirements of Option #1 
are met or if the new HMOS validation process described below is used: 

a. Send an email to your HMO Specialist indicating the DR number, the 
project number, the number of properties protected by the project, and 
either the documentation to support the number of properties claimed 
or the source for the documentation necessary to support the claim. 

b. The HMO Specialist will review the documentation and validate your 
claim. This may include revising the Number of Properties in the 
Project Field (See figure 12-5). 

c. The HMO Specialist will select the HQ Validation box (See Figure 12-
7). Once the HQ Validation box is checked, the Number of Properties 
in Project field can no longer be revised. To revise the field, the HQ 
Validation box must be unchecked. 

 
Figure 12-7: HQ Validation box in project closeout 

CAUTION: The validation messages are only required for closeout of an 
approved project. For any Withdrawn or Void project, all properties in 
the PSI will automatically be marked as “NO” under the Part of Final 
Project question. 

 

HINT: You are required to address any validation errors before proceeding 
with the Project Closeout process. An amendment may be required. 
However, an amendment is not necessary to enter a missing funds 
commitment letter date or a missing lat/long. 

a. If the validation message says that an amendment is pending (Figure 12-
8), you have the option to void the amendment by completing Steps  
6b − 6d. 
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Figure 12-8: Amendment Pending Validation Message 

b. On the bottom part of the General tab, click the VOID AMENDMENT 
button (Figure 12-9). 

 
Figure 12-9: Void Amendment Button 

c. The Void Amendment dialog box is displayed (Figure 12-10). 

 
Figure 12-10: Void Amendment Dialog Box 
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d. Click the YES button. 

e. The amendment is now voided and the project becomes available for 
closeout. 
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Task 2: Enter General Information 

Execute Tasks 2 − 8 if both of the following are true: 

• No closeout validation messages are displayed, which means that the 
project meets all the conditions for closeout 

• The Project Status is "Approved" 

1. After selecting the project in the Project Closeout List, the project closeout 
tabs are displayed. The General tab is displayed by default (Figure 12-11). 

 
Figure 12-11: Mitigation >Projects >Closeout >General Tab 

2. In the Closeout Dates section of the tab, enter the information described in 
Table 12-3. 

Table 12-3: Closeout Dates Section Data Fields 

DATA FIELD INFORMATION TO BE ENTERED 

Notified Project Completion 
Date 

Date that FEMA received notice from the Recipient 
that the project was completed 

Project Completion Date - 
From Quarterly Report 

Date filled-in from the most recently generated 
Quarterly Report 

Project Completion Verification 
Date 

Date when FEMA verified that the project was 
completed 
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DATA FIELD INFORMATION TO BE ENTERED 

Closeout Inspection Date Date of Recipient's final verification inspection 

Recipient Closeout Letter to 
FEMA Date 

Date of the letter from the Recipient requesting 
closeout 

Recipient Final Performance 
Report Received Date 

Date the Final Performance Report was received 
by FEMA 

Recipient Final Financial 
Report Received Date  

Date the Finance Report was received 

Financial Report Approved 
Date 

Date the Finance Report was approved 

Smartlink Report Approved 
Date  

Date the Recipient certified that all funds were 
drawn down 

Ltr FEMA to Recipient Date 
Requesting Addl Info  

Date the letter requesting information from the 
Recipient was sent by FEMA 

Final Project Closeout Letter 
To Recipient Signed Date 

Date of FEMA's final project letter to the Recipient 

NOTE: Many of the date fields may have the same values depending on the 
regional closeout process. 

3. In the Other Closeout Reviews section of the General tab, select "N," "Y" or 
"N/A" for each field described in Table 12-4.  

CAUTION: The system selects "N" by default so you need to edit the selection if 
necessary. 

Table 12-4: Other Closeout Reviews Section Data Fields 

DATA FIELD QUESTION TO BE ANSWERED 

Admin Cost  Was the Administrative Cost Review completed?   

Financial  Was the Financial Review completed?   

Scope  Was the Scope Review completed?   

Procurement Contracting  Was the Procurement Contracting Review 
completed?  
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DATA FIELD QUESTION TO BE ANSWERED 

Form 20-18 on File Is Form 20-18 on file?   

Copyright  Was the copyright issues review completed?   

Final Finance Rpt Aprvd Was the Final Financial Report approved?   

HMTAP Has the HM Technical Assistance Program contract 
been completed?  

4. In the Closeout Requirements section of the General tab, select "N," "Y" or 
"N/A" for each field described in Table 12-5.  

CAUTION: The system selects "N" by default so you need to edit the selection if 
necessary. 

Table 12-5: Closeout Requirements Section Data Fields 

DATA FIELD QUESTION TO BE ANSWERED 

Fed Owned Prpty Provided  Did the project affected Federally-owned property?   

Fed Owned Inv  Were costs related to Federally-owned property 
invoiced?   

Closeout Inspn Required  Is a Closeout Inspection required?   

Work Schedule Met  Was the Work Schedule met?   

5. Select the (National Flood Insurance Reform Act) NFIRA Update Status. 

6. Click the Comments tab (Figure 12-12). 

 
Figure 12-12: Mitigation >Projects >Closeout >Comments Tab 
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7. A new row for comments is added. The system auto-fills the Date and Time of 
entry and your User Name (Figure 12-13). 

 
Figure 12-13: New Row for Comments 

8. Double-click inside the Comment field to access the Comment Editor. 

9. In the Comment Editor text area, document the changes you made to the 
Project Closeout Information. 

10. Click the OK button. The comments are now displayed on the Comments tab 
(Figure 12-14). 

 
Figure 12-14: New Comments Added 
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Task 3: Enter Financial Information 

Financial information is taken from the Final Financial Report, the Quarterly 
Report submitted by the Recipient, or the Project Closeout Report. 

1. Click the Financials tab (Figure 12-15).  

 
Figure 12-15: Mitigation >Projects >Closeout >Financials Tab 

2. The top section of the tab displays read-only financial information. Table 12-6 
describes the read-only data fields. 

Table 12-6: Financials Tab Data Fields - Top 

DATA FIELD SOURCE OF INFORMATION 

Total Project Cost Mitigation > Projects > Application Development > Cost 
Estimate tab > Total Project Cost Estimate field 

Total Eligible Project 
Amount 

Mitigation > Projects > Eligibility Determination > Cost 
Review tab > Total Approved Net Eligible Project Cost field 

Federal Share Mitigation > Projects > Application Development > Match 
Sources tab > Proposed Federal Share field 

Non-Federal Share Mitigation > Projects > Application Development > Match 
Sources tab > Proposed Non-Federal Share field 

3. In the middle section of the tab, review the read-only Allocated Amounts, 
Obligated Amounts, and the Difference (Allocated Amounts minus Obligated 
Amounts). 
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4. In the bottom section of the Financials tab, enter the information described in 
Table 12-7. You can obtain the information from the Final Financial Report 
provided by the Recipient. 

Table 12-7: Financials Tab Data Fields - Bottom 

DATA FIELD INFORMATION TO BE REVIEWED/ENTERED 

Total Eligible Federal 
Project Expenditures 

Final total amount of expenditures reported by the 
Recipient that are attributed to the Federal portion of the 
project 

Total Federal Share 
Program Income 

Reported income attributed to the Final Federal portion 

Total Eligible Non-
Federal Project 
Expenditures 

Final total amount of expenditures reported by the 
Recipient that are attributed to the non-Federal portion of 
the project 

Total Non-Federal 
Share Program Income 

Reported income attributed to the Final non-Federal portion 
of the project 

Current Project Federal 
Share Balance 

Remaining funds to be expended from the HMGP — auto-
filled by the system 

Current Project Non-
Federal Share Balance 

Remaining funds to be expended from  non-Federal 
sources of funding — auto-filled by the system 

NOTE: The Current Project Federal Share Balance must be zero to close out 
the project. If the balance is not zero, contact your Regional Point of 
Contact for assistance. 

5. On the bottom right part of the Financials tab, click the CLOSE button. 
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Task 4: Enter Property Information 

1. Click the Properties tab (Figure 12-16). This tab is active only if properties 
are included in the project. 

 
Figure 12-16: Mitigation >Projects >Closeout >Properties Tab 

2. Table 12-8 describes the data fields to be completed in the top section of the tab. For 
each field except HQ Validation, select "N," "Y" or "N/A." 

CAUTION: The system selects "N" by default, so you need to edit the 
selection if necessary. 

Table 12-8: Properties Tab Data Fields - Top 

DATA FIELD QUESTION TO BE ANSWERED 

Eminent Domain not Used to 
Acquire Property 

Was Eminent Domain not used to acquire 
property? 

DOB Verification Was a Duplication of Benefits Verification 
conducted? 

Appraisals On File Are appraisals on file? 

Privacy Act Release Was a Privacy Act Release required? 

Hazardous Materials Checklist Is this checklist on file? 

Statement of Assurances Is the Statement of Assurances on file? 

Covenants on File Are covenants on file? 
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DATA FIELD QUESTION TO BE ANSWERED 

Demolition Completed Is the Demolition Permit on file? 

Relocation Assistance Letter Is the Relocation Assistance Letter on file? 

Property Inventory Completed Was the Property Inventory completed? 

Deed Restrictions Were required restrictions recorded with the 
property deed? 

HQ Validation If applicable, HQ validates that the correct number 
of properties in project was entered in PSI 

3. In the bottom part of the Properties tab, review the Project Closeout Required 
Property Closeout Data Error Report (See figure 12-16 above). 

HINT: If any checkboxes appear on the screen, required information is 
missing. Checkboxes with an "X" represent missing information. 
Missing information must be provided before an approved project 
can be closed out.  

Withdrawn or voided applications will not be considered to be 
missing property information. 

Go to Mitigation > Projects > Application Development > Property Site 
Inventory tab to enter the required information. 

4. On the bottom right part of the tab, click the PRINT button to print the report. 
You may use the report as a source of information when creating an 
amendment to the project application.  
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Task 5: Enter State Management Cost Information 

State Management Cost information is taken from the project file and the 
Smartlink report. 

1. Click the State Management Costs tab (Figure 12-17). 

 
Figure 12-17: Mitigation >Projects >Closeout >State Management 
Costs Tab 

2. Enter the State Management Costs information described in Table 12-9. 

CAUTION: If one or more fields have $0 dollar amount and you click the 
VERIFY or CLOSEOUT button, the system displays the Data 
Fields validation message (Figure 12-18). 

 
Figure 12-18: Data Fields Validation Message 
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Table 12-9: State Management Costs Data Fields 

DATA FIELD INFORMATION TO BE ENTERED 

Payroll Budget Amt Amount budgeted for the project payroll 

Payroll Actual Amt  Actual amount spent on the project payroll 

Supplies Budget Amt Amount budgeted for supplies 

Supplies Actual Amt Actual amount spent on project supplies 

Equip Inv Budget Amt Amount budgeted for equipment inventory 

Equip Inv Actual Amt Actual amount spent on equipment inventory 

Equip Lease Budget Amt Amount budgeted for lease of equipment 

Equip Lease Actual Amt Actual amount spent on lease of equipment 

Lease End Flg Has the lease for equipment ended? If yes, click inside 
the checkbox. 
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Task 6: Review Environmental Conditions 

1. If the tab is active, click the Environment Conditions tab (Figure 12-19).  

 
Figure 12-19: Mitigation > Projects  > Closeout  > Environment 
Conditions Tab 

2. Review the Conditions Required items displayed in the table. 
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Task 7: Enter Closeout Report Information 

1. Click the Report tab. The Report Table listing 112 project closeout items is 
displayed. The Date and Item Description columns display read-only 
information (Figure 12-20).  

 
Figure 12-20: Mitigation >Projects >Closeout >Report Tab 

2. If applicable, enter the Action Required for the checklist item by completing 
Steps 2a − 2c.  

a. Double-click inside the Action Required field. The Comment Editor is 
displayed. 

b. In the Comment Editor text area, enter a description of the action required 
for the checklist item. 

c. Click the OK button. The comments you entered are displayed on the 
appropriate row on the Report tab (Figure 12-21). 

 
Figure 12-21: Action Required Added 

3. On the bottom right part of the Report tab, click the RE-GENERATE button. 
The Report table is refreshed with the new entries. 
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4. Some items require a "Yes," "No" or "N/A" selection. Click on the selection 
field to display the drop-down list (Figure 12-22). 

 
Figure 12-22: Drop-down Selection List 

HINT: Table 12-10 in the References section lists the Report Table 
Checklist Items and the information source of each item. 

5. On the bottom right part of the Report tab, click the PRINT button. 

HINT: For audit purposes, include a hard copy of the Project Closeout 
Report in the Project File. 



Unit 12: Manage Project Closeout September 2016 
 

Page 12-24 NEMIS HMGP User Manual MR 3.19.01 

Task 8: Close Out the Project 

Generally, the HMO is authorized to execute this task. This task must be executed 
for all projects before completing Unit 13: Manage Program Closeout 

1. Click the General tab. Review all the information to make sure that everything 
is complete. 

2. On the bottom left part of the tab, click the VERIFY button. If the project is not 
ready for closeout, the system displays a validation message appropriate to the 
closeout requirements. 

3. Address and resolve each validation item. 

4. Click the CLOSEOUT button. The project is now closed.  

5. Follow the Regional procedures to notify the Recipient that the project is 
closed.  

6. To re-open a closed project, click the RE-OPEN button. The project is re-
opened. 
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References 

Report Table Checklist Items 

Table 12-10: Report Table Checklist Item - NEMIS Location 

CHECKLIST ITEM SOURCE OF INFORMATION 

Date Recipient Mitigation Plan 
Approved  

Mitigation > Disaster > Overview > Recipient Information 
tab > Aprvl Date field 

Date Recipient Administrative Plan 
Approved  

Mitigation > Disaster > Overview > Recipient Information 
tab > Approval Date field 

Date SF-424 Received Mitigation > Disaster > Overview > SF424 Information 
tab > 

SF-424 Federal Funding Amt Mitigation > Disaster > Overview > SF424 Information 
tab > Fed Est Funding Amt field 

SF-424 Applicant Funding Amt Mitigation > Disaster > Overview > SF424 Information 
tab > Applicant Est Funding Amt field 

SF-424 State Funding Amt Mitigation > Disaster > Overview > SF424 Information 
tab > State Est Funding Amt field 

SF-424 Local Funding Amt Mitigation > Disaster > Overview > SF424 Information 
tab > Local Est Funding Amt field 

SF-424 Other Funding Amt Mitigation > Disaster > Overview > SF424 Information 
tab > Other Est Funding Amt field 

SF-424 Program Income Funding 
Amt 

Mitigation > Disaster > Overview > SF424 Information 
tab > Prgm Inc Es Funding Amt  field 

SF-424 Total Funding Amt Mitigation > Disaster > Overview > SF424 Information 
tab > Total Est Funding Amt field 

Date Project Received Mitigation > Projects > Eligibility Determination > 
Authorizations tab > Application Received  Date field 

Date Project Approved Mitigation > Projects > Eligibility Determination > 
Authorizations tab > Final Project Approval Date field 

Statement of Work Approved Mitigation > Projects > Eligibility Determination > 
Authorizations tab > FEMA Review sub-tab > FEMA 
Project Approval Decision 

Last Statement of Work Amendment  Mitigation > Projects > Eligibility Determination > 
Authorizations tab > FEMA Review sub-tab > FEMA 
Project Approval Decision of the last amendment 
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CHECKLIST ITEM SOURCE OF INFORMATION 

Initial Federal Public Notice Mitigation > Disaster > Overview > Federal Public Notice 
tab > Appearance Date field 

Benefit-Cost Reviewed Mitigation > Projects > Eligibility Determination > Overall 
Review tab > Regulatory Criteria section > Project is 
cost effective field 

Benefit-Cost Ratio Mitigation > Projects > Eligibility Determination > Overall 
Review  tab > Regulatory Criteria section > The benefit 
cost ratio is: field 

NHPA Completed Mitigation > Projects > Eligibility Determination > 
Laws/EOs tab > Laws/EOs section > NHPA Status field 

Signed CATEX Mitigation > Projects > Eligibility Determination > NEPA 
Process tab > Level of Review section > CATEX -
Completed FEMA Status > Documentation Complete 
field 

Final Notice Published for FONSI or 
EA Date 

Mitigation > Projects > Eligibility Determination > NEPA 
Process  tab > Level of Review section > Environmental 
Assessment - Completed FEMA Status > Finding of No 
Significant Impact field 

News Release Date Environmental Impact Statement News Release Date 

Federal Register Notice of Intent to 
Prepare an EIS 

Mitigation > Projects > Eligibility Determination > NEPA 
Process tab > Level of Review section > Environmental 
Impact Statement - Completed FEMA Status 
>Publication of Notice of Intent to Prepare EIS field 

Initial EIS of the Scoping Process Field no longer in NEMIS HMGP 

EIS Monitoring Program Field no longer in NEMIS HMGP 

Draft EIS Available Field no longer in NEMIS HMGP 

Final EIS Available Field no longer in NEMIS HMGP 

Signed EIS Field no longer in NEMIS HMGP 

News Release Field no longer in NEMIS HMGP 

EIS Record of Decision Mitigation > Projects > Eligibility Determination > NEPA 
Process  tab > Level of Review section > Environmental 
Impact Statement - Completed FEMA Status >  Record 
of Decision field 

Notified that project was completed Mitigation > Projects > Closeout > General tab > Notified 
Project Completion Date field 
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CHECKLIST ITEM SOURCE OF INFORMATION 

Project completion verified and/or 
field inspection of construction 
project 

Mitigation > Projects > Closeout > General tab > Project 
Completion Verification Date field 

Final Project Performance Report 
received 

Mitigation > Projects > Closeout > General tab > 
Recipient Final Performance Report Received Date 
field 

Work schedule milestones met Mitigation > Projects > Closeout > General tab > Work 
Schedule Met field 

Final Quarterly Reports Received NEMIS Wide > Management Reporting > Management 
Reporting > Mitigation (MT) > Quarterly Report Tracking  

Initial Closeout Letter to Recipient 
from FEMA requesting closeout of 
project 

Mitigation > Projects > Closeout > General tab > Ltr 
FEMA to Recipient Date Requesting Addl Info field 

Recipient Letter to FEMA requesting 
project closeout 

Mitigation > Projects > Closeout > General tab > 
Recipient Closeout Letter to FEMA Date field 

Bills/Invoices – Provided by 
Recipient 

Documentation in project file or closeout package 

Bills/Invoices calculated correctly 
and in project file 

Documentation in project file or closeout package 

Amended Budget Non-Construction 
Projects Approval Date 

Documentation in project file or closeout package 

Cumulative Transfers Among Direct 
Cost Categories >10% or 
>$100,000 

Documentation in project file or closeout package 

Transfer of Training Funds Documentation in project file or closeout package 

Increased Budget for Construction 
Projects Approval Date 

Documentation in project file or closeout package 

Construction/Non-Construction 
Funding Transfers Approval Date 

Documentation in project file or closeout package 

Extending Time Period for 
Availability of Funds Approval Date 

Documentation in project file or closeout package 

Non-Construction Contracting Out, 
Third Party Services or 
Subcontracting Approval Date 

Documentation in project file or closeout package 
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CHECKLIST ITEM SOURCE OF INFORMATION 

Changes in Key Personnel Approval 
Date 

Documentation in project file or closeout package 

Copy of Notification that Eminent 
Domain would not be used to 
acquire property 

Documentation in project file or closeout package; 

Mitigation > Projects > Closeout > Properties tab > 
Eminent Domain Not Used to Acquire Property field 

DOB Verification for All Properties Documentation in project file or closeout package; 

Mitigation > Projects > Closeout > Properties tab > DOB 
Verification field 

Appraisals on File for All Properties Documentation in project file or closeout package; 

Mitigation > Projects > Closeout > Properties tab > 
Appraisals on File field 

Privacy Act Release required only if 
pre-flood property value is used 

Documentation in project file or closeout package; 

Mitigation > Projects > Closeout > Properties tab > 
Privacy Act Release field 

Hazardous Materials Checklist 
completed for each property 

Documentation in project file or closeout package; 

Mitigation > Projects > Closeout > Properties tab > 
Hazardous Materials Checklist field 

Statement of Assurances signed by 
Subrecipient, GAR, or Regional 
Administrator 

Documentation in project file or closeout package; 

Mitigation > Projects > Closeout > Properties tab > 
Statement of Assurances field 

Restrictive Covenants on all 
property deeds 

Documentation in project file or closeout package; 

Mitigation > Projects > Closeout > Properties tab > 
Covenants on File field 

Demolition or Removal of all 
Structures Completion Date 

Documentation in project file or closeout package; 

Mitigation > Projects > Closeout > Properties tab > 
Demolition Completed field 

Relocation Assistance 
Determination Letters in File 

Documentation in project file or closeout package; 

Mitigation > Projects > Closeout > Properties tab > 
Relocation Assistance Letter field 

Floodplain Management and 
Protection of Wetlands Decision- 
Making Process Completed and in 
File 

Documentation in project file or closeout package; 
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CHECKLIST ITEM SOURCE OF INFORMATION 

Engineering Certificates Documentation in project file or closeout package 

 

Property Inventory Form Completed 
by Project Monitor 

Documentation in project file or closeout package 

 

Property Inventory Form Sent to 
FEMA HQ 

Documentation in project file or closeout package 

Verify Staffing Level and that Time 
and Attendance Records Exist 

Documentation in project file or closeout package 

 

Payroll Wages Mitigation > Projects > Closeout > State Management 
Costs tab > Payroll fields 

Budgeted Amount Mitigation > Projects > Closeout > State Management 
Costs tab > Payroll Budget Amt field 

Actual Cost Mitigation > Projects > Closeout > State Management 
Costs tab > Payroll Actual Amt field 

Supplies Mitigation > Projects > Closeout > State Management 
Costs tab > Supplies fields 

Supply Budget - Budgeted Amount Mitigation > Projects > Closeout > State Management 
Costs tab > Supplies Budget Amt field 

Supply Budget - Actual Cost Mitigation > Projects > Closeout > State Management 
Costs tab > Supplies Actual Amt field 

Disposition of Supplies with 
Aggregate Value >$5,000, FEMA 
Form 20-18 

Documentation in project file or closeout package 

 

Equipment  

Inventory of Equipment Mitigation > Projects > Closeout > State Management 
Costs tab > Equip Inv fields 

Equipment Budget – Budgeted 
Amount 

Mitigation > Projects > Closeout > State Management 
Costs tab > Equip Inv Budget Amt field 

Equipment Budget – Actual Cost Mitigation > Projects > Closeout > State Management 
Costs tab > Equip Inv Actual Amt field 

Lease Agreements Disposition of 
Equipment 

Mitigation > Projects > Closeout > State Management 
Costs tab > Equip Lease fields 
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CHECKLIST ITEM SOURCE OF INFORMATION 

Lease Agreements - Budgeted 
Amount 

Mitigation > Projects > Closeout > State Management 
Costs tab > Equip Lease Budget Amt field 

Lease Agreements - Actual Cost Mitigation > Projects > Closeout > State Management 
Costs tab > Equip Lease Actual Amt field 

Did Lease End on or Before the 
Ending Date of the Award? 

Mitigation > Projects > Closeout > State Management 
Costs tab > Lease End Flg field 

Federally-Owned Property  

Inventory Mitigation > Projects > Closeout > General tab > 
Closeout Requirements section > Fed Owned Inv field 

Disposition Report Documentation in project file or closeout package 

FEMA Form 20-18 in File Mitigation > Projects > Closeout > General tab > Other 
Closeout Reviews section > Form 20-18 on File field 

Were Copyrights or Patents 
Awarded for any Action as a Result 
of this Grant? 

Mitigation > Projects > Closeout > General tab > Other 
Closeout Reviews section > Copyright field 

Approved Project Estimate Mitigation > Projects > Eligibility Determination > Cost 
Review  tab > Total Approved Net Eligible Project Cost 
field 

Federal Share Percentage Mitigation > Projects > Application Development > Match 
Sources  tab > Federal Share Percentage field 

Federal Share $ Mitigation > Projects > Application Development > Match 
Sources  tab > Proposed Federal Share field 

Non-Federal Share Percentage Calculate (100 minus Federal Share Percentage) 

Non-Federal Share $ Mitigation > Projects > Application Development > Match 
Sources  tab > Proposed Non-Federal Share field 

Date of Last Budget Amendment Documentation in project file or closeout package 

Total Project Costs Mitigation > Projects > Closeout > Financials tab > Total 
Project Cost field 

Net Eligible Mitigation > Projects > Closeout > Financials tab > Total 
Eligible Project Amount field 

Net Eligible Fed Share Mitigation > Projects > Closeout > Financials tab > 
Federal Share field 
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CHECKLIST ITEM SOURCE OF INFORMATION 

Allocated Project Funds Mitigation > Projects > Closeout > Financials tab > 
Allocated Amounts row/Project Amount column 

Obligated Project Funds Mitigation > Projects > Closeout > Financials tab > 
Obligated Amounts row/Project Amount column 

Subrecipient Admin. Obligation Mitigation > Projects > Closeout > Financials tab > 
Obligated Amounts row/Subrecipient Admin Amount 
column 

Recipient Admin. Obligation Mitigation > Projects > Project Closeout > Financials tab 
> Obligated Amounts row/Recipient Admin Amount 
column 

State Management Project 
Allocations 

Documentation in project file or closeout package 

State Management Obligations Documentation in project file or closeout package 

Income Generated by Project SmartLink Report 

Total Federal Share Mitigation > Projects > Closeout > Financials tab > 
Current Project Federal Share field 

Total Non-Federal Share Mitigation > Projects > Closeout > Financials tab > 
Current Project Non-Federal Share field 

Final Request for Payment Documentation in project file or closeout package 

Cost Adjustment Documentation in project file or closeout package 

Cost Overrun Documentation in project file or closeout package 

Cost Under-run Documentation in project file or closeout package 

Cash Adjustment Documentation in project file or closeout package 

Unobligated Federal Funds Documentation in project file or closeout package 

Deobligated Federal Funds Documentation in project file or closeout package 

Deallocated Federal Funds Documentation in project file or closeout package 

Reconciliation Documentation in project file or closeout package 

Final Financial Reports Approved Mitigation > Projects > Closeout > General tab > Final 
Finance Rpt Aprvd field 

IFMIS Documentation in project file or closeout package 
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CHECKLIST ITEM SOURCE OF INFORMATION 

NEMIS Documentation in project file or closeout package 

SmartLink Mitigation > Projects > Closeout > General tab > 
SmartLink Report Approved Date field 

Final Project Closeout Letter from 
FEMA to State Signed 

Mitigation > Projects > Closeout > General tab > Final 
Project Closeout Letter to Recipient Signed Date field 
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Overview 
The NEMIS HMGP Program Oversight and Closeout process allows FEMA 
Regional Mitigation Staff to close out the Hazard Mitigation Grant Program 
(HMGP) when all applicable administrative requirements have been completed.  

NOTE: Closeout of a disaster can be delayed if the Hazard Mitigation Technical 
Assistance Program (HMTAP) has not been closed at FEMA HQ. When 
the NEMIS HMGP Disaster is finally closed, FEMA HQ will enter the 
closeout date. It is advisable that all project records be made available 
for audit purposes. 

 

HINT: To ensure that the program financial and project activity reporting are 
complete, each project entered into the system must be closed out (Unit 
12: Manage Project Closeout). 

Table 13-1 provides an overview of the program closeout process in NEMIS 
HMGP.  

Table 13-1: Manage Program Closeout 

 DESCRIPTION 

Purpose Complete HMGP closeout 

When does it 
start? 

When all projects have been closed out and all funds have been 
reconciled 

Who does it? Regional Mitigation Staff, usually the Hazard Mitigation Officer (HMO)  

How is it 
done? 

Execute one task: 

Task 1: Close out the Program 
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Task 1: Close out the Program 
Events A − H below occur outside of NEMIS HMGP before the program is closed 
out in the system. 

A. FEMA Regional Office sends the Recipient the Letter from FEMA to 
Governor's Authorized Representative* (GAR) to Close out HMGP
(Sample on Page 13-13).

B. The Recipient sends the FEMA Regional Office the Letter from State to 
FEMA to Close out HMGP (Sample on Page 13-14). The letter is 
signed by the GAR. The following must be sent together with the letter:

• Completed FEMA Form 20-10 for each project (Sample on Page
13-15)

• Final Quarterly Report indicating all projects have been closed and 
all funding has been drawn down from Smartlink

C. FEMA Regional Office reviews the letter and information submitted by 
the Recipient. If correct, the documentation is forwarded to FEMA HQ 
together with the Letter to FEMA HQ Requesting Grant Closeout
(Sample on Page 13-16).

D. FEMA HQ concurs that the Hazard Mitigation Grant Program is 
financially reconciled and sends the FEMA Regional Office the 
Notification that Program is Closed (Sample e-mail on Page 13-17).

E. FEMA Regional Office sends the Recipient the Request from FEMA for 
GAR’s Concurrence on Disaster Closeout (Sample on Page 13-18).

F. GAR signs the Concurrence and sends the letter back to the FEMA 
Regional Office.

G. FEMA Regional Office sends FEMA HQ the Memo to HQ Disaster 
Finance Division to Close out Disaster (Sample on Page 13-19).

H. FEMA HQ closes the Disaster FEMA/State Agreement Contract and 
sends the FEMA Regional Office the Memo to Region from HQ Closing 
FEMA/State Agreement  (Sample on Page 13-20). 

* In cases where Indian tribal governments receive a declaration under their own 
authority, the term Tribal Chief Executive's Authorized Representative (TAR) is used 
instead of Governor's Authorized Representative (GAR). For more information, go to 
your favorite browser and search for "FEMA Tribal Declarations Pilot Guidance," "42 
USC 5122 (6)" and "42 USC 5122 (8)."
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1. After Event D above occurs, enter the Reconciliation date in NEMIS HMGP 
by completing Steps 1a − 1d.  

a. On the NEMIS menu bar, click on the Mitigation icon. On the MITIGATION 
menu, click Disaster > Overview. The Disaster Information tab is 
displayed by default. 

b. In the HMGP - Closeout Date (Reconciliation) field, enter the date when 
FEMA HQ notified the Regional Office that the program is closed (Figure 
13-1). 

 
Figure 13-1: HMGP - Closeout Date (Reconciliation) 

c. Click the Recipient Information tab. Enter the same date in the HMGP - 
Closeout Date (Reconciliation) field (Figure 13-2). 

 
Figure 13-2: HMGP - Closeout Date (Reconciliation) 

d. Repeat Step 1c for each Recipient. 

2. After Event H above occurs, enter the Disaster Closeout Date (FEMA-State 
Agreement closed by HQ) in NEMIS HMGP by completing Steps 2a − 2b. 
a. On the MITIGATION menu, click Disaster > Overview. The Disaster 

Information tab is displayed by default. 
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b. In the Disaster Closeout Date (FEMA-State Agreement closed by HQ) 
field, enter the date of the FEMA HQ Memo to Region closing the FEMA-
State Agreement (Figure 13-3). 

 
Figure 13-3: Disaster Closeout Date (FSA closed by HQ) 

3. On the MITIGATION menu, click Disaster > Closeout (Figure 13-4).  

 
Figure 13-4: Mitigation > Disaster > Closeout 

4. If some projects are still open, the system displays the Projects Still Open 
message (Figure 13-5). All project applications, irrespective of status or 
regardless if submitted for eligibility review, are considered open unless 
closed out. 

 
Figure 13-5: Projects Still Open Message 

5. Click the OK button. The Disaster Closeout tab is displayed. The top section 
displays read-only information about the program (Figure 13-6).  
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Figure 13-6: Mitigation >Disaster >Closeout >Disaster Closeout 
Tab - Program Information 

6. Table 13-2 describes the program information read-only data fields. 

Table 13-2: Program Information Read-Only Data Fields 

DATA FIELD INFORMATION TO BE REVIEWED 

Total Number of 
Projects 

The number of project applications developed either partially or 
fully regardless of status or if submitted for eligibility review 

Total Number of 
Closed Out Projects 

The number of projects closed out 

Total Number of 
Projects Open 

The number of projects still to be closed out 

Closeout Date Auto-filled by the system when the DISASTER CLOSEOUT 
button is clicked 

HMGP-Total 
Obligation Date 

Date all HMGP funds were obligated 

HMGP-Closeout Date 
(Reconciliation) 

Date FEMA HQ concurred with the Region's financial 
reconciliation and closed the HMGP program for the disaster 

Disaster Closeout 
Date (FEMA-State 
Agreement closed by 
HQ) 

Date FEMA HQ financially reconciled ALL funds for the disaster 
and closed the FEMA-State Agreement (FSA) 

Userid Auto-filled by the system with the User Name of person who 
clicked the DISASTER CLOSEOUT button 

HINT: If the Total Number of Projects Open is "0,” the program can be closed 
out. If not, resume closing out individual projects as described in Unit 
12: Manage Project Closeout. 
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7. The bottom section of the Disaster Closeout tab displays read-only 
information about each project in the program (Figure 13-7). 

 
Figure 13-7: Mitigation >Disaster >Closeout >Disaster Closeout 
Tab - Project Information 

8. Scroll to the right to see the rest of the data fields (Figure 13-8). 

 
Figure 13-8: Mitigation >Disaster >Closeout >Disaster Closeout 
Tab - Project Information 

9. Table 13-3 describes the project information read-only data fields.  
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Table 13-3: Project Information Read-Only Data Fields 

DATA FIELD INFORMATION TO BE REVIEWED 

FEMA Project  FEMA project number assigned when the project application is 
submitted 

Suffix Type Funding type: R (Regular), M (Management Costs), F (Initiative), 
or P (Planning) 

Application ID Project number entered by the Recipient during the application 
development process 

Amendment 
Number 

The highest amendment submitted for the project 

Final Decision Project approved or denied, as determined in the eligibility 
determination process 

Decision Date Date of the project approval or denial decision 

Closeout Date Date the project was closed out 

Closeout Agent NEMIS HMGP User Name of the person who closed out the 
project 

NFIRA Update 
Status 

NFIRA update status of the project 

10. Click the Attachments tab. Allow up to one hour to retrieve and view newly 
attached documents.  

11. Click the Comments tab to add any comments to the program closeout 
(Figure 13-9). 



September 2016 Unit 13: Manage Program Oversight and Closeout 

NEMIS HMGP User Manual MR 3.19.01 Page 13-9 
 

 
Figure 13-9: Mitigation >Disaster >Closeout >Comments Tab 

12. Click the ADD button. A new row for comments is added. The system auto-
fills the Comment Date, Time, and User Name (Figure 13-10). 

 
Figure 13-10: New Row for Comments 

13. Double-click inside the Comment field. The Comment Editor is displayed. 

14. In the Comment Editor Text area, enter your comments. Click the OK button. 

15. The comments are now displayed on the Comments tab (Figure 13-11). 
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Figure 13-11: Comments Added 

16. At the bottom of the Comments tab, the system displays the warning 
message that clicking the ADD button will delete your entry (Figure 13-12). 

 
Figure 13-12: Comments Warning Message 

HINT: Save the comment you just entered by clicking on another tab first. Then 
click back on the Comments tab to add another comment.  

17. Click the Disaster Closeout tab. At the bottom of the tab, click the 
DISASTER CLOSEOUT button (Figure 13-13). 

 
Figure 13-13: Disaster Closeout Button 

18. The Disaster Closeout message is displayed (Figure 13-14). 
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Figure 13-14: Disaster Closeout 

19. Click the OK button. On the top right part of the Disaster Closeout tab, the 
system fills in the Closeout Date and Userid fields (Figure 13-15). 

 
Figure 13-15: Closeout Date and User id Fields 

20. You can re-open the program by clicking the RE-OPEN DISASTER button 
(Figure 13-16). 

 
Figure 13-16: Re-open Disaster Button 

21. If you click the RE-OPEN DISASTER button, the Disaster Re-opened 
message is displayed (Figure 13-17). 

 
Figure 13-17: Disaster Re-opened 

22. On the bottom right part of the tab, click the CLOSE button. 
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References for Manage Program Closeout 

Sample Letters 

 NAME OF LETTER PAGE 
NUMBER 

Letter from FEMA to GAR to Close out HMGP 13-13 

Letter from State to FEMA to Close out HMGP 13-14 

FEMA Form 20-10 13-15 

Sample Letter to FEMA HQ Requesting Grant Closeout 13-16 

Notification that Program is Closed 13-17 

Request from FEMA for GAR’s Concurrence on Disaster Closeout 13-18 

Memo to HQ Disaster Finance Division to Close out Disaster 13-19 

Memo to Region from HQ Closing FEMA/State Agreement 13-20 
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Sample Letter from FEMA to GAR to Close out HMGP 
 

 
DATE 

 
 
Governor’s Authorized Representative 
 
Re: FEMA-DR-1268-ND 
 
 
Dear: 
 
Upon review of our records for the above disaster, it appears that the Hazard Mitigation 
Grant Program (HMGP) is ready to be closed. 
 
Please review your records and if you concur, please submit the following: 
 
1. Letter from the Governor’s Authorized Representative (sample enclosed), 

recommending closeout of the HMGP and stating that all Federal assistance has 
been provided and no claims are outstanding. 

 
2. FEMA Form 20-10. We have enclosed a blank form for your use and a sample 

completed 20-10 to assist you in completing the form by project. 
 
3. Your Mitigation Final Quarterly Report indicating the total project funds disbursed by 

project, total Subrecipient funds disbursed by project and the total disbursed for the 
disaster including Recipient admin. (see attached) 

 
Recipient and Subrecipients must retain all programmatic and financial records for three 
(3) years including documentation as to how the administrative costs were spent. 
Administrative allowances provided for such costs are auditable in accordance with 
financial grant audit procedures. 
 
If you have any questions, please contact (staff name) or me. 
 
 Sincerely, 
 
 Mitigation Division Director 
 
Enclosures 
 FEMA Form 20-10 
 Sample Letter 
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Sample Letter from State to FEMA to Close out HMGP 
 

 
DATE 

 
 
Regional Administrator 
FEMA Region ______ 
ADDRESS 
 
 
Attn: MITIGATION DIRECTOR 
 
Re: FEMA-DR-XXXX-(STATE) 
 HMGP PROGRAM CLOSEOUT 
 
Dear ______________: 
 
Our records indicate that we have disbursed $________ for Federal Projects, $______ in 
State Management Costs, $______ in Subrecipient and $______ in Recipient admin for 
a total of $_______. FEMA Form 20-10 is enclosed covering the total project costs. 
 
All grant actions have been completed with no pending bills or claims. Our Final Quarterly 
Report dated ____________________ on grant activities is also enclosed. 
 
The Hazard Mitigation Grant Program (HMGP) for the above disaster is ready to be 
closed. 
 
If you have any questions, please contact me. 
 
 Sincerely, 

 Governor’s Authorized Representative 
 
 
Enclosures 
 FEMA Form 20-10 
 Final Quarterly Report 
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FEMA Form 20-10 
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Sample Letter to FEMA HQ Requesting Grant Closeout 
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Notification That Program is Closed 
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Request from FEMA for GAR’s Concurrence on Disaster Closeout 
 
 DATE 
 
 
Governor’s Authorized Representative 
Address 

Reference: FEMA –XXXX-DR-State 
 
Dear State Director/Governor’s Authorized Representative: 
 
Our records indicate that all actions in connection with the Disaster Assistance 
Grants for FEMA-XXXX-DR-State have been completed. If you agree that you have 
complied with all of the terms and conditions of the FEMA/State agreement, that 
there are no outstanding claims, and that the FEMA-XXXX-DR-State contract can 
be closed, please sign the statement below in the space provided and return this 
letter to me. 
 
If you have any questions, please contact ______________of my staff at _______. 
 
 Sincerely, 

 Regional Administrator 
 
CONCUR: 
 
________________________________ 
Name   Date 
Governor’s Authorized Representative 
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Memo to HQ Disaster Finance Division to Closeout Disaster 
 
 
DATE 

 
 

MEMORANDUM FOR: _____________________, Director 
 Disaster Finance Division 
 
 
ATTENTION:  _____________________, Name 
 Disaster Closeouts 
 
 
FROM: 
 Regional Administrator 
 Region VIII 
 
 
SUBJECT:   Request for Closure of FEMA-XXXX-STATE 
 State of________________________ 
 
 
Our records indicate that all required actions have been completed for FEMA-XXXX-
STATE. The Governor’s Authorized Representative concurred with this by his signature on 
the enclosed letter. His signature also certifies that the State will file no further claims 
against this disaster. We recommend that the FEMA/State Agreement for this disaster be 
closed. 
 
If you have any questions, please contact ___________________at 303-
_______________. 

Enclosure 
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Memo to Region from HQ Closing FEMA/State Agreement 
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Unit 14 – Generate Standard HMGP Reports 
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Overview 

The NEMIS HMGP Generate Standard HMGP Reports process allows FEMA 
and Recipient users to monitor HMGP information one disaster at a time. 

NOTE: To prepare ad hoc and cross-disaster reports, use the Enterprise Data 
Warehouse (EDW).  

Table 14-1 provides an overview of the process. 

Table 14-1: Generate Standard HMGP Reports 

ITEM DESCRIPTION 

Purpose Produce reports of HMGP information 

When does it start? Throughout the disaster response 

Who does it? FEMA and Recipient users  

How is it done? Execute two tasks: 

Task 1: Generate Reports from the NEMIS Wide 
Management Reporting Tool 

Task 2: Generate Reports from the Mitigation > Admin Area 

The system provides standard format reports that may be generated at any time. 
Table 14-2 provides the list of NEMIS HMGP processes and the corresponding 
system reports. 

Table 14-2: NEMIS HMGP Process - System Reports – NEMIS Wide 

NEMIS HMGP PROCESS  SYSTEM REPORT 

Unit 3: Manage Disaster Information Disaster Overview 

Unit 4: Manage MT Plans Repository Recipient HMGP Administrative Plan 

Multihazard Mitigation Plan 

Unit 5: Manage Funding Estimate Funding Estimate 

Funding Estimate Budget Planning 

Funding Estimate Financial Activity 
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NEMIS HMGP PROCESS  SYSTEM REPORT 

Unit 6: Manage Project Applications Application Development 

Environmental Report 

Project Cost Line Item 

Project Non-Federal Share 

Property Site Inventory 

State Application 

Unit 7: Manage Eligibility Determination  Federal Eligibility Work Packets 

Project Eligibility 

*Project Worksheet Report 

Unit 8: Manage Amendments Application Development 

Environmental Report 

Project Cost Line Item 

Project Non-Federal Share 

Property Site Inventory 

State Application 

Unit 10: Manage Allocations and Obligations Allocation Request 

Allocation Request with Signature 

Fiscal Year Management Report  

Obligation 

Obligation with Signatures 

Unit 11: Manage Project and Program Oversight 
Tasks 

Field Survey 

Full Project History  

Project Management 

Project Status  

Quarterly Report by Project 

Quarterly Report Tracking 

Unit 12: Manage Project Closeout  Project Closeout 

Unit 13: Manage Program Closeout  Disaster Closeout 

*The Project Worksheet Report is listed under the Infrastructure Support (IS) folder in the 
NEMIS Wide Management Reporting Tool. 
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Task 1: Generate Reports from the NEMIS Wide Management 
Reporting Tool 

1. On the NEMIS menu bar, click on NEMIS Wide > Management Reporting > 
Management Reporting (Figure 14-1). 

 
Figure 14-1: NEMIS Wide >Management Reporting >Management 
Reporting 

2. The NEMIS Wide Management Reporting Tool is displayed (Figure 14-2). 

 
Figure 14-2: NEMIS Wide Management Reporting Tool 

3. To generate a standard Mitigation report, complete Steps 3a − 3i. 

a. Double-click the Mitigation (MT) folder. The list of Mitigation Reports is 
displayed (Figure 14-3).  
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Figure 14-3: Mitigation Reports List 

b. Double-click on a Mitigation report. The Select Disaster window is 
displayed. 

c. In the Disaster field, enter the Disaster Number you wish to generate 
reports for. 

d. Click the OK button. The MT Report Generator is displayed (Figure 14-4). 

 
Figure 14-4: MT Report Generator 

e. The top portion of the screen provides the report criteria fields. Enter a 
selection in each field. 
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HINT: Use the SORT, FILTER, and FIND buttons to refine the report 
criteria. In the Sort, Filter or Find window, enter the requested 
information to reorder, select, or locate information. 

f. Click the RETRIEVE button. 
The Mitigation report is displayed (Figure 14-5). 

 
Figure 14-5: Generated Standard Report 

g. Use the scroll bars to view the entire report. 

h. If you need a hard copy of the report, click the PRINT button. 

i. Click the CLOSE button. The NEMIS Wide Management Reporting Tool is 
displayed. 

4. To generate a standard Infrastructure Support (IS) report, complete Steps 4a 
− 4g. 

a. Double-click the Infrastructure Support (IS) folder. The list of Infrastructure 
Support Reports is displayed (Figure 14-6). 
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Figure 14-6: Infrastructure Support Reports List 

b. Double-click on an Infrastructure Support report. The Report Generator is 
displayed (Figure 14-7). 

 
Figure 14-7: Infrastructure Support Report Generator 

c. The top portion of the screen provides the report criteria fields. Enter a 
selection in each field. 

d. Click the RETRIEVE button. The Infrastructure Support report is displayed 
(Figure 14-8). 
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Figure 14-8: Generated Standard Report 

e. Use the scroll bars to view the entire report. 

f. If you need a hard copy of the report, click the PRINT button. 

g. Click the CLOSE button. The NEMIS Wide Management Reporting Tool is 
displayed. 

5. To generate a standard NEMIS-Wide (NW) report, complete Steps 5a − 5g. 
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a. Double-click the Infrastructure (IS) folder. The list of NEMIS-Wide (NW) 
Reports is displayed (Figure 14-9). 

 
Figure 14-9: NEMIS-Wide Reports List 

b. Double-click on a NEMIS Wide report. The Report Generator is displayed 
(Figure 14-10). 

 
Figure 14-10: NEMIS-Wide Report Generator 

c. The top portion of the screen provides the report criteria fields. Enter a 
selection in each field. 

d. Click the RETRIEVE button. The NEMIS-Wide report is displayed (Figure 
14-11). 
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Figure 14-11: Generated Standard Report 

e. Use the scroll bars to view the entire report. 

f. If you need a hard copy of the report, click the PRINT button. 

g. Click the CLOSE button. The NEMIS Wide Management Reporting Tool is 
displayed. 
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Task 2: Generate Reports from the Mitigation > Admin > Area 

1. To generate the Financial Reconciliation Report, complete Steps 1a − 1e. 

a. On the MITIGATION menu, click on Admin > Financial Reconciliation 
Report (Figure 14-12). 

 
Figure 14-12: Mitigation >Admin >Financial Reconciliation Report 

b. The blank Reconciliation Analysis Report is displayed (Figure 14-13). 

 
Figure 14-13: Blank Financial Reconciliation Analysis Report 

c. The top portion of the screen provides the report criteria fields. Enter a 
selection in each field. 

d. Click the RETRIEVE button. The generated Reconciliation Analysis 
Report is displayed (Figure 14-14). 

e. Use the scroll bars to view the entire report. 
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Figure 14-14: Generated Financial Reconciliation Analysis Report 

f. If you need a hard copy of the report, click the PRINT button. 

2. To generate the Benefit Cost Report, complete Steps 2a − 2e. 

a. On the MITIGATION menu, click on Admin >  Benefit Cost Report (Figure  
14-15). 

 
Figure 14-15: Mitigation >Admin >Benefit Cost Report 

b. The blank Benefit Cost Report is displayed (Figure 14-16). 
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Figure 14-16: Blank Benefit Cost Report 

c. The top portion of the screen provides the report criteria fields. Enter a 
selection in each field. 

d. Click the RETRIEVE button. The generated Benefit Cost Report is 
displayed (Figure 14-17). 

 
Figure 14-17: Generated Benefit Cost Report 

e. If you need a hard copy of the report, click the PRINT button. 
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References for Generating Standard Reports 

Save a Report in a Different File Type 
Reports can be saved in a different file type whenever the SAVE AS button is 
available.  

CAUTION: Once a report is saved in a different file type, the report is no longer 
connected to the system database. If you make a change to the report, 
it will not update the information in the system database. If there is a 
change in the system database, the report you saved as a different 
file will not reflect the latest information. 

1. To save a report as an HTML table, complete Steps 1a − 1g. 

HINT: Not all reports, especially the Property Site Inventory (PSI), will format 
well as an HTML table. In such cases, try using Excel5 with Headers 
instead. 

a. From any generated report screen, click the SAVE AS button. The Save 
As dialog box is displayed. 

b. In the Save as type field, click the drop-down list. Select "HTML Table" 
(Figure 14-18). 

 
Figure 14-18: Save As HTML Table 

c. In the Save in field, navigate to the folder where you wish to save the 
HTML file. 

d. In the File name field, enter a descriptive file name. 

e. Click the SAVE button. 

f. Navigate to the HTML file you just saved. 
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g. Double-click the file name. The report is displayed as a table in an HTML 
page (Figure 14-19). 

 
Figure 14-19: Report Saved as HTML Table 

2. To save a report as a Word document, complete Steps 2a − 2j. 

a. Execute Steps 1a − 1g. 

b. On the menu bar of the HTML page, click File > Edit with Microsoft Office 
Word (Figure 14-20). 

 
Figure 14-20: Edit HTML File with Microsoft Office Word 
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c. The document opens as a Microsoft Word file. 

d. On the top left part of the screen, click the Office button. 

e. Select Save As > Word Document. The Save As dialog box is displayed. 

f. In the Save in field, navigate to the folder where you wish to save the 
Microsoft Word file. 

g. In the File name field, enter a descriptive file name. 

h. Click the SAVE button. 

i. Navigate to the Microsoft Word file you just saved. 

j. Double-click the file name. The report is displayed as a Word document. 

3. To save a report as an Excel 5 Document with Headers, complete Steps 3a − 
3g. 

a. From any generated report screen, click the SAVE AS button. The Save 
As dialog box is displayed. 

b. In the Save as type field, click the drop-down list. Select "Excel 5 with 
headers" (Figure 14-21). 

 
Figure 14-21: Save As Excel5 with Headers 

c. In the Save in field, navigate to the folder where you wish to save the 
Excel file. 

d. In the File name field, enter a descriptive file name. 

e. Click the SAVE button. 

f. Navigate to the Excel file you just saved. 
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g. Double-click the file name. The report is displayed as an Excel 
spreadsheet (Figure 14-22). 

 
Figure 14-22: Report Saved as Excel Spreadsheet with Headers 

NOTE: The system provides many other file formats for saving the 
report file. Select the one that suits your documentation needs. 
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Overview 

The process of attaching documents is performed throughout numerous tasks 
within NEMIS. It is used to link documents to a NEMIS record. 

In the NEMIS−Mitigation functional module, the record is usually a project 
application. The supporting documentation is linked to the project application 
record to make the documents available for viewing by NEMIS HMGP users. 
This includes documents required by NEMIS HMGP (such as the project 
description and maintenance assurance documents) and any other documents 
that users elect to add (such as environmental review reports, maps, and 
photographs). Whether you are attaching a plan, a map, or a Declaration 
Request Letter, the instructions are the same. 

CAUTION: Attachments cannot be deleted once they have been added 
to NEMIS HMGP. Please make every effort to limit the file 
attachment size to less than 1 GB. Allow up to one hour to 
retrieve and view newly attached documents.  

When you select the ATTACH button from various screens in NEMIS HMGP, the 
Attachment dialog box is displayed (Figure A-1). 

 
Figure A-1: Attachment Dialog Box 

This appendix describes the following tasks: 

• Attach a document 
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DMARTS Information 

DMARTS is a component of FEMA’s National Emergency Management Information 
System (NEMIS), an agency-wide system that provides a technology base to FEMA and 
its partners.  

DMARTS supports NEMIS by providing document capture, repository, and workflow 
functions. NEMIS HMGP will use DMARTS to attach project documents. ViewStar will 
no longer be supported in NEMIS HMGP. 
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Task 1: Attach a Document 

1. Click the Attachments tab (Figure A-2). 

NOTE: The Attachments tab displayed here is located in the NEMIS > 
Mitigation > Disaster > Overview area. All Attach screens are 
similar. 

 
Figure A-2: Attachments Tab 

2. On the bottom right part of the tab, click the ATTACH button. The Attachment 
dialog box is displayed (Figure A-3). 

 
Figure A-3: Attachment Dialog Box 
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3. In the Document Type field, select the document category from the drop-
down list. 

4. In the Document Name field, enter a descriptive name for the document. 

5. Click the ARCHIVE button. The Select Attachment dialog box is displayed. 

6. Navigate to the file to be attached. Select the file (Figure A-4). 

 
Figure A-4: Select Attachment Dialog Box with Selected File 

7.  Click the OPEN button. The Successful Archive of Document message is 
displayed (Figure A-5). 

 
Figure A-5: Successful Archive Message 

8. Click the OK button.  

9. The document name is displayed on the Attachments tab (Figure A-6). 
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Figure A-6: Attachments Tab with Document List 

10. To view a document, highlight the document row and click the VIEW button. 

11. Document may not be immediately archived in DMARTS. It will be available 
to view only after the archival process is complete (Figure A-7). 

 
Figure A-7: DMARTS View Attachments Window 
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Overview 

The NEMIS Personnel Databases provide information on: 

• Contacts 

• FEMA Staff Members 

• Mitigation Property Owners 
The Contacts database includes names and information on a variety of non-
FEMA contacts such as: 

• Representatives of State, county and local governments 

• Managers and Directors for Recipients and Subrecipients 

• Contacts for specific sites (i.e., floodplain managers)  
The database gets updated when a new contact is entered. 

The FEMA Staff Members database includes: 

• Permanent Full-Time (PFT) employees 

• Disaster Employees  

• Local hires 

• Cadre of On-call Response Employees (COREs) 
This database is downloaded from the Automated Deployment Database (ADD) 
and is updated periodically.  

The Mitigation Property Owners database is populated by property owners added 
to the Property Site Inventory tab in the Mitigation > Projects > Application 
Development area.  

Because all three databases contain the same elements, the instructions for 
entering, editing or selecting names are the same. 
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Enter a Name from the Personnel Databases 

1. NEMIS HMGP displays one of the following windows, depending on the 
personnel database that needs to be accessed: 

• Look up a Contact window — for searching the Contacts database 

• Look up a FEMA Staff Member window — for searching the FEMA Staff 
Members database 

• Look up a Mitigation Owner window — for searching the Mitigation 
Property Owners database 

This appendix provides instructions for the Look up a Contact window (Figure 
B-1), but all three windows operate the same way.  

 
Figure B-1: Look Up a Contact Window 

2. To speed up the search, enter as much information as you have about the 
person.  

HINT: If you are not sure how the person’s name is entered in the database, use 
only the initial of the first name followed by an asterisk (*). All forms of 
the name will be retrieved (i.e., T* will find Tom, Tommy, Thomas). You 
may also want to follow the last name with an * in order to retrieve 
personnel records whose last name may end with a name suffix. 
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a. To the right of the Organization field, click the ellipsis (…) button to access 
a database of organizations including FEMA, other Federal agencies, 
contractors, and State and local organizations. The Look up an 
Organization window is displayed. 

b. Select an organization type from the drop-down list. Click the Search 
button. 

HINT: If the organization type drop-down list is not working, click the 
Search button to retrieve all the records, or leave the field blank. 

c. Scroll through the organizations listed. If the organization you want is 
displayed, click the OK button. 

d. The organization you selected is displayed in the Look up a Contact 
window. 

3. Click the SEARCH button. The system displays records that match your 
criteria (Figure B-2). 

 
Figure B-2: Search Results 

4. If the personnel record you want is displayed, click the OK button. The record 
you selected is displayed in the correct NEMIS field. 
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5. If the personnel record with the specified criteria is not found, the Search 
Results: 0 of 0 records message is displayed on the top left corner of the 
Look up a Contact window (Figure B-3). 

 
Figure B-3: Zero Search Results 

6. The Search for Similar Records dialog box is displayed (Figure B-4).   

 
Figure B-4: Search for Similar Records Dialog Box 

7. Click the YES button if you want to search for records that are similar to the 
specified criteria. 

8. Click the NO button if you do not want the system to search for similar 
records. 

9. Click the ADD button to enter information for a new personnel record. 

10. Enter the information listed in Table B-1. 

Table B-1:  Personnel Record Data Fields 

DATA FIELD INFORMATION TO BE ENTERED 

Name 

First and last 
names are required 
fields 

First, middle, and last name of personnel 

Nickname Nickname of personnel 

Prefix Name prefix of personnel 

Suffix Name suffix of personnel 

Title Title of personnel 
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DATA FIELD INFORMATION TO BE ENTERED 

Organization Organizations including FEMA, other Federal agencies, 
contractors, and State and local organizations 

Address 1 and 2 Do not abbreviate 

Street Num Street number of personnel address 

Street Name Street name of personnel address 

Unit Type Unit type of personnel address, if applicable 

Unit Num Unit number of personnel address, if applicable 

City 

Required field 
City of personnel address 

State 

Required field 
State of personnel address 

ZIP  

Required field   

Zip code of personnel address 

If you do not know the ZIP code, select 00000  from the drop-
down list 

ZIP+4 Four additional digits to identify a geographic segment within 
the five-digit delivery area 

Directions Instructions to get to the address 

Note E.g., agency name, point of contact 

Carrier Code  Nine-digit Carrier Route Code 

USPS Bar Code Address USPS bar code 

Location Code Address location code 

Longitude and 
Latitude 

Longitude and Latitude of location in decimal degrees 

E-mail E-mail address of personnel 

11. Click the SAVE button to add the personnel to the database. 

12.  Click the OK button to place the personnel's name in the correct NEMIS field. 
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CAUTION: If you just click the OK button without first clicking the SAVE 
button, the personnel’s name will be on the NEMIS field, but the 
record will not be added to the database. If you click only the 
SAVE button, it adds the name to the database but not to the 
NEMIS field. 

13. To add a telephone number to the record, click the ADD PHONE button. 

14.  Enter the information listed in Table B-2. 

Table B-2:  Add Phone Data Fields  

DATA FIELD INFORMATION TO BE ENTERED 

Area Area code of the phone number 

Phone Last seven digits of the phone number 

EXT Extension number, if applicable 

PIN Personal Identification Number, if applicable 

Type Type of phone number.  Select one of the following: 
• Home 
• Home Voice 
• Home Fax 
• Work 
• Work Voice 
• Work Fax 
• Pager 
• Car Phone 

Description or Note Description or note to assist in reaching the person, such as 
available times 

15.  Click the SAVE button to save the personnel's telephone number to the 
database. 

16.  Click the OK button to return to the original NEMIS screen. 
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Appendix C − NEMIS HMGP Positions and Roles 
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Overview 

NEMIS HMGP provides access control mechanisms that protect the system and 
the viewing and editing of information. These mechanisms control the users' level 
of access to the application and to the application objects, which are the menus, 
screens and data fields.  

At the highest access level, there are two main teams of NEMIS HMGP users:  
the Emergency Response Team (ERT) and the Regional Operations and 
Managements Team (ROM). 

Currently, there are three generally accepted positions under the ERT (Deputy 
FCO for Mitigation, Deputy Hazard Mitigation Officer, and Hazard Mitigation 
Officer) and thirteen under the ROM including two non-FEMA positions. 

Each Position has several associated roles. The role names used in both teams 
are the same. Thus, there is an MT Hazard Mitigation Officer (HMO) role in the 
ERT team and an MT Hazard Mitigation Officer (HMO) role in the ROM team. 
This is important to note because some system processes, such as allocation, 
can be executed only by users who have the assigned role in both the ERT and 
ROM teams. 

Each role is also referred to as a Group ID. Each role has pre-defined privileges 
to view and/or edit the application objects. 

When a user is given access to the system, a User Name is established and 
assigned to the ERT or to the ROM, or to both. Depending on the user's position, 
the user receives the roles for that position. 

The access process and structure described above is disaster-specific. Thus, the 
same user may be in the ERT team for Disaster A, and, at the same time, be in 
both the ERT and ROM teams for Disaster B. 
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NEMIS HMGP Teams, Positions and Roles 

Table C-1 lists the positions and roles in the Emergency Response Team (ERT).  

NOTE: The Regional user must have at least one ROM position containing the MA or 
HMO role to enter data in the HMGP module. 
 
An "X" in any of the three columns to the far right indicates what capability 
exists for each role. 
 
ES Module stands for the Emergency Support Module, where 
allocations/obligations get final approval from the Office of Financial 
Management. 
 
The three ERT positions and associated roles below are the primary ones for 
processing project applications in the HMGP module and for 
allocations/obligations in the HMGP and ES modules. 

Table C-1:  NEMIS HMGP Positions and Roles in the ERT; 
Deputy FCO for Mitigation (HZM014) 

ROLE 
HMGP 
DATA 
ENTRY 

HMGP 
ALLOC/ 
OBLGN 

ES 
ALLOC/ 
OBLGN 

MT Division Chief - dc (4)   X 

MT Hazard Mitigation Officer - HMO (5) X X X 

MT Analyst - MA (6) X X  

PO (16)    

Disaster Recovery Manager - DRM (32)   X 

Program Head - ph (49)    

Project Officer - PRJO (71)    

MT Branch Chief - BC (102)   X 

IS Reviewer Specialized - ISRSPEC (150)    

Declaration User (250)    

AT Requestor - ATREQ (255)    

COR Requestor - CORREQ (256)    

Help Desk Requestor - HDREQ (259)    

DEC_RGN_READ_ROLE    

EIS_ROLE    

NEMIS_READ_ROLE    
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ROLE 
HMGP 
DATA 
ENTRY 

HMGP 
ALLOC/ 
OBLGN 

ES 
ALLOC/ 
OBLGN 

PDA_MOBILE_ROLE    

PDA_READ_ROLE    

PDA_USER_ROLE    

Table C-2:  NEMIS HMGP Positions and Roles in the ERT; 
Deputy Hazard Mitigation Officer (HZM016) 

ROLE 
HMGP 
DATA 
ENTRY 

HMGP 
ALLOC/ 
OBLGN 

ES 
ALLOC/ 
OBLGN 

MT Division Chief - DC (4)   X 

MT Hazard Mitigation Officer - HMO (5) X X X 

MT Analyst - MA (6) X X  

MT Cost Reviewer - CSTRV (7) X   

MT Environmental Officer - ENVOF (8) X   

MT Environmental Reviewer - ENVRV (9) X   

PO (16)    

Action Officer - AO (18)    

Project Officer - PRJO (71)    

MT Branch Chief - BC (102)    

AT Requestor - ATREQ (255)    

COR Requestor - CORREQ (256)    

Help Desk Requestor - HDREQ (259)    

DEC_RGN_READ_ROLE    

EIS_ROLE    

NEMIS_READ_ROLE    

PDA_MOBILE_ROLE    

PDA_USER_ROLE    
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Table C-3:  NEMIS HMGP Positions and Roles in the ERT; 
Hazard Mitigation Officer (HZM030) 

ROLE 
HMGP 
DATA 
ENTRY 

HMGP 
ALLOC/ 
OBLGN 

ES 
ALLOC/ 
OBLGN 

MT Division Chief - DC (4)   X 

MT Hazard Mitigation Officer - HMO (5) X X X 

MT Analyst - MA (6) X X  

MT Cost Reviewer - CSTRV (7) X   

MT Environmental Officer - ENVOF (8) X   

MT Environmental Reviewer - ENVRV (9) X   

PO (16)    

Action Officer - AO (18)    

Program Head - PH (49)    

Project Officer - PRJO (71)    

MT Branch Chief - BC (102)   X 

IS Reviewer Specialized - ISRSPEC (150)    

AT Requestor - ATREQ (255)    

COR Requestor - CORREQ (256)    

Help Desk Requestor - HDREQ (259)    

DEC_RGN_READ_ROLE    

EIS_ROLE    

NEMIS_READ_ROLE    

PDA_MOBILE_ROLE    

PDA_USER_ROLE    

Tables C-4 − C-16 lists the positions and roles in the Regional Operations and 
Management (ROM). 

NOTE: The Regional user must have at least one ROM position containing the MA or 
HMO role to enter data in the HMGP module. 
 
An "X" in any of the three columns to the far right indicates what capability 
exists for each role. 
 
Effective September 1, 2011, FEMA Office of the Chief Financial Officer (OCFO) 
issued FEMA Directive # 257-3-OFMIS User Access and Termination. Issue this 
This Directive is adhered to prior to assigning users who must obtain access to 
IFMIS positions and roles. 
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ES Module stands for the Emergency Support Module, where 
allocations/obligations get final approval from the Office of Financial 
Management. 
 
The positions and associated roles below are the primary ones in the ROM for 
processing project applications in the HMGP module and for 
allocations/obligations. 

Table C-4:  NEMIS HMGP Positions and Roles in the ROM: MT: 
Regional Environmental Officer (RT.32.06) 

ROLE 
HMGP 
DATA 
ENTRY 

HMGP 
ALLOC/ 
OBLGN 

ES 
ALLOC/ 
OBLGN 

MT Analyst - MA (6)  X  

MT Environmental Officer - ENVOF (8) X   

Action Officer - AO (18)    

Project Officer - PRJO (71)    

AT Requestor - ATREQ (255)    

COR Tracker - CORTR (257)    

COR Requestor - CORREQ (256)    

Help Desk Requestor - HDREQ (259)    

NEMIS_READ_ROLE    

PDA_MOBILE_ROLE    

PDA_USER_ROLE    

Table C-5:  NEMIS HMGP Positions and Roles in the ROM: MT: 
Environmental Specialist (RT.32.07) 

ROLE 
HMGP 
DATA 
ENTRY 

HMGP 
ALLOC/ 
OBLGN 

ES 
ALLOC/ 
OBLGN 

MT Analyst - MA (6) X X  

MT Environmental Officer - ENVOF (8) X   

Action Officer - AO (18)    

Project Officer - PRJO (71)    

AT Requestor - ATREQ (255)    

COR Tracker - CORTR (257)    

COR Requestor - CORREQ (256)    
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ROLE 
HMGP 
DATA 
ENTRY 

HMGP 
ALLOC/ 
OBLGN 

ES 
ALLOC/ 
OBLGN 

Help Desk Requestor - HDREQ (259)    

NEMIS_READ_ROLE    

PDA_MOBILE_ROLE    

PDA_USER_ROLE    

Table C-6:  NEMIS HMGP Positions and Roles in the ROM: MT: 
Hazard Mitigation Analyst (RT.32.04) 

ROLE 
HMGP 
DATA 
ENTRY 

HMGP 
ALLOC/ 
OBLGN 

ES 
ALLOC/ 
OBLGN 

MT Analyst - MA (6) X X  

MT Cost Reviewer - CSTRV (7) X   

Action Officer - AO (18)    

Project Officer - PRJO (71)    

AT Requestor - ATREQ (255)    

COR Tracker - CORTR (257)    

COR Requestor - CORREQ (256)    

Help Desk Requestor - HDREQ (259)    

NEMIS_READ_ROLE    

PDA_MOBILE_ROLE    

PDA_USER_ROLE    

Table C-7:  NEMIS HMGP Positions and Roles in the ROM: MT: 
Hazard Mitigation Grants Specialist (RT.32.03) 

ROLE 
HMGP 
DATA 
ENTRY 

HMGP 
ALLOC/ 
OBLGN 

ES 
ALLOC/ 
OBLGN 

MT Hazard Mitigation Officer - HMO (5) X X X 

MT Analyst - MA (6) X X  

MT Cost Reviewer - CSTRV (7) X   

MT Environmental Reviewer - ENVRV (9) X   

Action Officer - AO (18)    

Project Officer - PRJO (71)    

Declaration User (250)    
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ROLE 
HMGP 
DATA 
ENTRY 

HMGP 
ALLOC/ 
OBLGN 

ES 
ALLOC/ 
OBLGN 

AT Requestor - ATREQ (255)    

COR Tracker - CORTR (257)    

COR Requestor - CORREQ (256)    

Help Desk Requestor - HDREQ (259)    

DEC_RGN_ROLE    

EIS_ROLE    

NEMIS_READ_ROLE    

PDA_MOBILE_ROLE    

PDA_USER_ROLE    

Table C-8:  NEMIS HMGP Positions and Roles in the ROM: MT: 
Hazard Mitigation Officer (RT.32.02) 

ROLE 
HMGP 
DATA 
ENTRY 

HMGP 
ALLOC/ 
OBLGN 

ES 
ALLOC/ 
OBLGN 

MT Hazard Mitigation Officer - HMO (5) X X X 

MT Analyst - MA (6) X X  

MT Cost Reviewer - CSTRV (7) X   

MT Environmental Reviewer - ENVRV (9) X   

PO (16)    

Action Officer - AO (18)    

Program Head - PH (49)    

Project Officer - PRJO (71)    

MT Branch Chief - BC (102)    

Declaration User (250)    

AT Requestor - ATREQ (255)    

COR Requestor - CORREQ (256)    

COR Tracker - CORTR (257)    

Help Desk Requestor - HDREQ (259)    

DEC_RGN_ROLE    

EIS_ROLE    

NEMIS_READ_ROLE    

PDA_COORDINATOR_ROLE    



September 2016 Appendix C: NEMIS HMGP Positions and Roles 
 
 

NEMIS HMGP User Manual MR 3.19.01 Page C-9 
  

ROLE 
HMGP 
DATA 
ENTRY 

HMGP 
ALLOC/ 
OBLGN 

ES 
ALLOC/ 
OBLGN 

PDA_MOBILE_ROLE    

PDA_USER_ROLE    

Table C-9:  NEMIS HMGP Positions and Roles in the ROM; MT: 
Senior Hazard Mitigation Officer (RT.32.01) 

ROLE 
HMGP 
DATA 
ENTRY 

HMGP 
ALLOC/ 
OBLGN 

ES 
ALLOC/ 
OBLGN 

MT Division Chief - DC (4)   X 

MT Hazard Mitigation Officer - HMO (5) X X X 

MT Analyst - MA (6) X X  

MT Cost Reviewer - CSTRV (7) X   

MT Environmental Reviewer - ENVRV (9) X   

PO (16)    

Action Officer - AO (18)    

Program Head - PH (49)    

Project Officer - PRJO (71)    

MT Branch Chief - BC (102)   X 

Declaration User (250)    

AT Requestor - ATREQ (255)    

COR Requestor - CORREQ (256)    

COR Tracker - CORTR (257)    

Help Desk Requestor - HDREQ (259)    

DEC_RGN_ROLE    

EIS_ROLE    

NEMIS_READ_ROLE    

PDA_COORDINATOR_ROLE    

PDA_MOBILE_ROLE    

PDA_USER_ROLE    
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Table C-10:  NEMIS HMGP Positions and Roles in the ROM; MT: 
Reg Community Mitigation Program Branch Chief (RT.31.00) 

ROLE 
HMGP 
DATA 
ENTRY 

HMGP 
ALLOC/ 
OBLGN 

ES 
ALLOC/ 
OBLGN 

MT Division Chief - DC (4)   X 

MT Hazard Mitigation Officer - HMO (5) X X X 

MT Analyst - MA (6) X X  

PO (16)    

Action Officer - AO (18)    

Program Head - PH (49)    

Project Officer - PRJO (71)    

MT Branch Chief - BC (102)    

Declaration User (250)    

AT Requestor - ATREQ (255)    

COR Requestor - CORREQ (256)    

COR Tracker - CORTR (257)    

Help Desk Requestor - HDREQ (259)    

DEC_RGN_ROLE    

EIS_ROLE    

NEMIS_READ_ROLE    

PDA_COORDINATOR_ROLE    

PDA_MOBILE_ROLE    

PDA_USER_ROLE    

Table C-11:  NEMIS HMGP Positions and Roles in the ROM; MT: 
Reg Hazard Ident and Risk Assmt Branch Chief (RT.32.00) 

ROLE 
HMGP 
DATA 
ENTRY 

HMGP 
ALLOC/ 
OBLGN 

ES 
ALLOC/ 
OBLGN 

MT Division Chief - DC (4)   X 

MT Hazard Mitigation Officer - HMO (5) X X X 

MT Analyst - MA (6) X X  

PO (16)    

Action Officer - AO (18)    

Program Head - PH (49)    
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ROLE 
HMGP 
DATA 
ENTRY 

HMGP 
ALLOC/ 
OBLGN 

ES 
ALLOC/ 
OBLGN 

Project Officer - PRJO (71)    

MT Branch Chief - BC (102)    

Declaration User (250)    

AT Requestor - ATREQ (255)    

COR Requestor - CORREQ (256)    

COR Tracker - CORTR (257)    

Help Desk Requestor - HDREQ (259)    

DEC_RGN_ROLE    

EIS_ROLE    

NEMIS_READ_ROLE    

PDA_COORDINATOR_ROLE    

PDA_MOBILE_ROLE    

PDA_USER_ROLE    

Table C-12:  NEMIS HMGP Positions and Roles in the ROM; MT: 
Division Director (RT.30.00) 

ROLE 
HMGP 
DATA 
ENTRY 

HMGP 
ALLOC/ 
OBLGN 

ES 
ALLOC/ 
OBLGN 

MT Division Chief - DC (4)   X 

MT Hazard Mitigation Officer - HMO (5) X X X 

PO (16)    

Action Officer - AO (18)    

Program Head - PH (49)    

Project Officer - PRJO (71)    

MT Branch Chief - BC (102)    

Declaration User (250)    

AT Requestor - ATREQ (255)    

COR Requestor - CORREQ (256)    

COR Tracker - CORTR (257)    

Help Desk Requestor - HDREQ (259)    

DEC_RGN_ROLE    

EIS_ROLE    
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ROLE 
HMGP 
DATA 
ENTRY 

HMGP 
ALLOC/ 
OBLGN 

ES 
ALLOC/ 
OBLGN 

NEMIS_READ_ROLE    

PDA_COORDINATOR_ROLE    

PDA_MOBILE_ROLE    

PDA_USER_ROLE    

Table C-13:  NEMIS HMGP Positions and Roles in the ROM; 
Hazard Identification and Risk Assessment Branch Ch (RT.03.03) 

ROLE 
HMGP 
DATA 
ENTRY 

HMGP 
ALLOC/ 
OBLGN 

ES 
ALLOC/ 
OBLGN 

MT Division Chief - DC (4)   X 

MT Hazard Mitigation Officer - HMO (5) X X X 

MT Analyst - MA (6) X X  

MT Read Only - MTRO (11)    

PO (16)    

Program Head - PH (49)    

Project Officer - PRJO (71)    

MT Branch Chief - BC (102)    

COR Requestor - CORREQ (256)    

COR Tracker - CORTR (257)    

Help Desk Requestor - HDREQ (259)    

EIS_ROLE    

PDA_ADMIN_ROLE    

PDA_COORDINATOR_ROLE    

PDA_MOBILE_ROLE    

PDA_USER_ROLE    

MT_READ_ROLE    
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Table C-14:  NEMIS HMGP Positions and Roles in the ROM; 
Community Mitigation Program Branch Chief (RT.03.02) 

ROLE 
HMGP
DATA
ENTRY 

HMGP
ALLOC/
OBLGN 

ES
ALLOC/
OBLGN 

MT Division Chief - DC (4) X 

MT Hazard Mitigation Officer - HMO (5) X X X 

MT Analyst - MA (6) X X 

MT Read Only - MTRO (11) 

PO (16) 

Program Head - PH (49) 

Project Officer - PRJO (71) 

MT Branch Chief - BC (102) 

COR Requestor - CORREQ (256) 

COR Tracker - CORTR (257) 

Help Desk Requestor - HDREQ (259) 

EIS_ROLE 

PDA_ADMIN_ROLE 

PDA_COORDINATOR_ROLE 

PDA_MOBILE_ROLE 

PDA_USER_ROLE 

MT_READ_ROLE 

Table C-15:  NEMIS HMGP State Positions. State positions and roles are found 
ONLY in the ROM; MT: State Hazard Mitigation Officer (RT.32.30) 

ROLE 
HMGP
DATA
ENTRY 

HMGP
ALLOC/
OBLGN 

ES
ALLOC/
OBLGN 

MT Read Only - MTRO (11) View 
Only 

MT State User - MTSU (13) 
(Data Entry in Project Applications) 

X 

State Approving Official - SAO (43) 

AT Requestor - ATREQ (255) 

MT_READ_ROLE 
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Table C-16:  NEMIS HMGP State Positions. State positions and roles are found 
ONLY in the ROM; MT: Hazard Mitigation Specialist – State (RT.32.31) 

ROLE 
HMGP 
DATA 
ENTRY 

HMGP 
ALLOC/ 
OBLGN 

ES 
ALLOC/ 
OBLGN 

MT Read Only - MTRO (11) View 
Only 

View 
Only  

MT_READ_ROLE View 
Only 

View 
Only  
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Startup 

Help: 
User Manual: For the latest version of the NEMIS HMGP User Manual, go to the 
FEMA website at http://www.fema.gov and enter the search term “NEMIS HMGP 
User Manual.” 
 
Helpdesk 
• HLPFEMAFEMA-enterprise-service-desk@fema.dhs.gov 
• 1-888-HLP-FEMA (1-888-457-3362) 

Password 
Change your password every 90 days by following FEMA IT security protocols. 
For password help or questions, contact the FEMA Help Desk at 1-888-HLP-
FEMA.  

Closeout dates 
Do not enter future/anticipated closeout dates on the Disaster Overview Tab. 

 

http://www.fema.gov/
mailto:HLPFEMAFEMA-enterprise-service-desk@fema.dhs.gov
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Attachments 

• Try to limit the file attachment size to less than 1GB. 
• Once uploaded, attachments cannot be deleted. 
• Allow up to one hour to retrieve and view the newly attached documents. 

 



Appendix D: Quick Reference Guide September 2016 

Page D-4 NEMIS HMGP User Manual MR 3.19.01 

Managing HMGP Applications 

Get it right the first time 
Once entered, the following information cannot be changed. If this information is 
entered incorrectly, you must withdraw the application and submit a new application.  

• Suffix code 
• Project type 
• Subrecipient 

Link to Recipient 
• HMGP project applications cannot be entered in the system until the user is linked 

to the Recipient. 

Zero-out 
• Void or withdraw all project amendments. Zero-out means amending the project to 

have a $0 cost estimate, submitting the amendment for approval, and then, once 
approved, voiding or withdrawing the $0 amendment as well as ALL previously 
approved amendments for the project. 

Edit or Amend? 
• You can edit projects before they are approved or denied. After a project has 

been approved or denied, the project can only be amended, not edited. 

Green Fields 
• All “green fields” must be completed before the system will allow the application to 

be submitted for FEMA review. 

Cost Estimate Tab 
• You can now use a pre-approved spreadsheet to import the cost estimate items 

into the project application. Contact your Regional POC for a copy of the 
approved spreadsheet template. 

Property Site Inventory  
• Account for existing zeroes when entering amounts in PSI funding tab. 
• The city and state are required to search for a property record you wish to add to 

the PSI. 
• Complete all fields shaded in green prior to submitting the application for Federal 

approval 
• You can now export, update and import PSI information spreadsheets to and from 

NEMIS HMGP. 
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Managing Project Eligibility 

Workflow Map Legend 
• Blue solid squares represent workflow tasks that have been completed. 

• Green solid squares represent workflow tasks that are ready for you to execute 
under your current Group ID. 

• Yellow squares (solid or crisscrossed) represent workflow tasks that you cannot 
execute with your current Group ID. You can however, view the work packet 
information. 

• Squares with crisscrossed lines represent workflow tasks that cannot be 
completed until other reviews are completed first. 

• Refresh after each submittal. 

 
Figure D-1: Workflow Map Diagram 

Withdraw, void or amend? 

If project is… You can… 
Submitted and approved Amend, Withdraw, Void 
Submitted and denied Amend, Withdraw, Void 
Submitted and pending Edit, Withdraw, Void 
Not submitted Submit, Withdraw, Void 

• Documents can be attached regardless of project status. 

Other eligibility tips 
• Check all eligible boxes (Y for cost approved). 
• If status of any amendment is approved, the project is considered approved. 
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Managing Project Funding 

• A deobligation of current fiscal year funds requires a manual deallocation of 
same funds. 

• When entering financial information, use the Tab key to move from field to field. 
Using the tab key ensures proper funding calculations and saves the information 
entered. Do not use the mouse to navigate from field to field.  

• Perform global match if federal share for any project is greater than 75 percent.  

Obligation and Deobligation Process 

 
Figure D-2: Obligation and Deobligation Processes 

* If needed. See User Manual Unit 10, Part 4: Deallocation. 
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Miscellaneous 

• The best way to save information is to use the Tab key or the Save button. 
• All projects—not just those submitted for Federal eligibility—must be closed out 

before the disaster can be closed. 
• To exit a window, use the Close or Cancel button; do not “x-out” of the window. 
• To generate reports, see User Manual Unit 14: Generate Standard HMGP 

Reports. 
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